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关于本文档

信息
•	 本使用说明书中出现的插图和 LCD 画面仅用于说明。
•	 如非特别指出，本使用说明书中出现的插图和画面都基于 MODX M6 截图（采用英文）。
•	 Windows 是 Microsoft Corporation 在美国和其他国家 / 地区的注册商标。
•	 Lightning 和 Mac 是 Apple Inc. 在美国和其他国家 / 地区的注册商标。
•	 MIDI 是 Musical Electronics Industry (AMEI) 的注册商标。
•	 MIDI 2.0 徽标 ( ) 是 Association of Musical Electronics Industry (AMEI) 和 THE MIDI MANUFACTURERS 

ASSOCIATION INCORPORATED (MMA) 的商标或注册商标。
•	 本使用说明书中所使用的公司名和产品名都是各自公司的商标或注册商标。

本文档中的指示

型号名称
MODX M6、MODX M7 和 MODX M8 统称为“MODX M”。

其它
属性 说明

须知 表示可能发生失灵、故障或数据丢失。

注 表示补充信息。

[  ] 印在产品上的按钮或端子名称
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1.	 MODX M 的工作原理

什么是 MODX M ？

框图和数据流

本乐器由八个主要功能块组成 ：控制器、动态音序器、音源、效果器、音序器、琶音、包络跟随器和 A/D 输入。

(1) 控制信息

(2) 音频信号

(3) 控制器

(4) 动态音序器

(5) 音源

(6) 效果器

(7) 音序器

(8) 琶音

(9) 包络跟随器

(10) A/D 输入

(11) 控制矩阵

(12) 计算机

(13) 外接MIDI 设备

(14) 麦克风、音频设备等

(15) 有源音箱等

(1) Control message (2) Audio signal

MIDI IN AUDIO IN AUDIO OUTMIDI OUT

USB [TO HOST]
MIDI [OUT]

USB [TO HOST]
MIDI [IN]

USB [TO DEVICE]

USB [TO HOST]
A/D INPUT [L/MONO], [R]

USB [TO HOST]
OUTPUT [L/MONO], [R]

(12) Computer (12) Computer
(14) Microphone,
Audio equipment,

etc.
(12) Computer

(15) Powerd
speakers,

etc.
(13) Extermal MIDI equipment 

(3) Controller
Keyboard, Knobs, Pedals, etc.

(4) Motion Sequencer

(11) Controll Matrix

(9) Envelope Follower

(8) Arpeggio(7) Sequencer (10) A/D Input

(6) Effects(5) Tone Generator
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音源模块
音源模块配备了结合三个合成系统的混合声音引擎。

AWM2 声音引擎

AWM2 声音引擎的波形包含采样的波形数据，您可以将其分配给每个音素，然后使用滤波器和 EG（包络发生器）修改声音。

标准声部
标准声部使用多达 128 个音素生成丰富的声音，帮助您制作富有表现力的声音。从原声乐器采样的“原始”波形经过处理，
可与各种不同类型的音乐兼容，从而能够逼真地还原钢琴、管乐器等乐器的声音。您还可以尝试使用滤波器和 EG 等功能创
建新的声音。

Filter EQAmplitude

Waveform 2-Band EQ

3-Band EQ

Insertion A

Insertion B

Master EQ

Master FX

Reverb

Variation

Element

Part

× 128

鼓声部
对于鼓声部，最多可以使用 73 个鼓钥匙，将打击乐器音色的波形分配给键盘上的每个键，以创建所需的打击乐器组。

Key (C0-C6)

Part

× 73

Filter EQAmplitude

Waveform 2-Band EQ

3-Band EQ

Insertion A

Insertion B

Master EQ

Master FX

Reverb

Variation

独立鼓声（每个键都不同）（C0 至 C6）

C0 F1 C6
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FM-X 声音引擎

FM-X 声音引擎通过对八个称为“操作器”的波形发生器进行频率调制 (FM) 来产生具有复杂泛音的声音。
八个操作器的排列称为“算法”，共有 88 种不同的模式可供选择。操作器有两个角色 ：“载波器”和“调制器”。 
调制器对其所连接的操作器进行调制，最终从载波器输出声音。调制器还具有“反馈”功能，让操作器可以对声音本身进行
调制。
也可以使用参数来控制操作器波形的谐波结构，让您可以应用 AWM2 声音引擎中提供的相同高品质滤波器、效果和 EQ 等，
从而制作富有表现力的声音，而这些声音很难使用常规的 FM 声音引擎来制作。

2-Band EQ

3-Band EQ

Insertion A

Insertion B

Master EQ

Master FX

Reverb

Variation

Part

(6) Algorithm

(2) Modulators

(3) Carriers

3

4

5

Filter Amplitude

(1) Feedback(1) Feedback

(7)

(8)

(9)

7

1 82 6

(4) Operators

(5) Frequency
     modulation

(1) 反馈

(2) 调制器

(3) 载波器

(4) 操作器

(5) 频率调制
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(6) 算法

(7) 调制波

(8) 载波

(9) 调制波

AN-X 声音引擎

AN-X 声音引擎是一种虚拟模拟声音引擎，能以完全数字化的方式再现模拟合成器的行为和特点。这是融合了传统与创新元
素的新一代 AN 声音引擎，能够表现出各种声音，从逼真的古典声音到前卫和极致的声音。
AN-X 声音引擎由三个振荡器和一个噪声音源组成。每个振荡器都配备了 Pulse Width、OSC Self Sync 和 Wave Shaper 等
波形控制功能，为声音创作提供了极大的自由度和灵活性。
此外，振荡器 3 (OSC 3) 可以使用 FM 或环形调制对振荡器 1 (OSC 1) 和振荡器 2 (OSC 2) 进行调制，并且每个振荡器的输出
目的地可以设置为在 Filter1 或 Filter2 之前或之后。

2-Band EQ

3-Band EQ

Insertion A

Insertion B

Master EQ

Master FX

Reverb

Variation

Part

FM Ring
Mod

Ring
Mod

FM

Modifier Filter1 Filter2 AmpOSC 1

OSC 2

OSC 3

Noise
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内置存储器

本乐器的内置存储器存储已保存的演奏组、Live Set、乐曲和其他设置。
该图显示了内置存储器和外接设备之间的数据流。

与外接设备的内部通信

内部数据通信

临时存储区域（关闭电源时擦除）

• 用户波形编辑
• 用户动态音序编辑
• 用户曲线编辑
• 用户微调编辑
• 用户现场设置编辑

• 演奏组
• 琶音
• 动态音序
• 试听乐句

• 用户波形
• 用户动态音序
• 用户曲线
• 用户微调
• 用户现场设置

• 用户试听乐句

• 波形
• 现场设置
• 曲线
• 微调

MIDI 设备或计算机
DAW软件

MONTAGE和
其他兼容文件

（.X7A、.X7U、.X7L等）

库区域
*与用户区域相同

（不包括工具设置和快速设置）

• 用户琶音

• 工具设置
• 快速设置

• 用户演奏组

音频文件
(.WAV)

音频录音播放

音频文件
（.WAV和.AIF）

用户文件
(.Y2U)

备份文件
(.Y2A)

库文件
(.Y2L)

MIDI文件(.MID)模板/乐曲区域

用户区域

用户存储器

批量转储

保存
加载

USB闪存

存储

预设存储器

比较缓存
（演奏组）

调用缓存
（演奏组）

• 模板/乐曲录音

• 工具设置

• 演奏组编辑

编辑缓存

MODX M内置存储器
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预设存储器

包含预置演奏组、预置琶音、预置试听乐句和其他设置。无法覆盖预设存储器中的数据，因为它是只读存储器。

编辑缓存

编辑缓存是用于编辑演奏组、Live Set、乐曲和其他设置的工作区域。
该工作区域允许读取和写入，在关闭乐器时，会擦除该工作区域内的内容。
切换演奏组或关闭乐器之前，必须将编辑过的数据保存到用户存储器中（但是，演奏组和动态音序之外的数据会自动保存）。

用户存储器

用户存储器有两个区域 ：“用户”和“库”。

用户区域
“用户”区域用于保存存储的演奏组和动态音序，以及整个乐器的其他设置，例如工具设置和在编辑缓存中编辑的其他用户

数据。
编辑用户演奏组后，您可以将其存储为新演奏组或覆盖现有演奏组。

库区域
“库”区域最多可从 USB 闪存加载 24 个库文件 (.Y2L)。无法编辑保存在“库”区域中的设置。要编辑“库”区域中的设置，

请通过选择“库”区域中存储的演奏组或从“库”区域加载动态音序，将数据发送到编辑缓存。编辑完成后，数据将存储在
“用户”区域。

用户存储器用于读取和写入，该区域内的数据在乐器关闭后仍将保留。

调用缓存和比较缓存

调用缓存和比较缓存是用于临时保存正在编辑的设置的区域。

调用缓存
调用缓存用作编辑缓存的备份。
如果您在未先存储设置的情况下意外更改为不同的演奏组，则可以使用调用功能将临时保存的设置从调用缓存恢复到编辑 
缓存。

比较缓存
比较缓存是在进行编辑之前保存设置的区域。通过使用比较功能，您可以将临时保存在比较缓存中的设置用于比较已编辑和
未编辑的声音。

这些缓存用于读取和写入数据，但当乐器关闭时，设置将丢失。



10MODX M 使用说明书

2.	 现场演奏组设置

下面显示的是本乐器的一般工作流程指南。

选择演奏组
从 Live Set 画面或从 Performance 画面（Category Search 画面）进行选择。

	 

编辑设置
	 

保存编辑的设置
	 

创建 Live Set
	 

选择 Live Set
	 

弹奏键盘
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选择演奏组

选择 Live Set 画面。

1.	 按下 [LIVE SET] 按钮。
Live Set 画面会打开。

2.	 点击以从显示的列表中选择您想要的演奏组。
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选择 Category Search 画面。

Category Search 功能可用于搜索演奏组、声部、节奏模板、琶音和波形，以找到您想要使用的内容。要搜索演奏组，请在
Performance 画面打开的情况下按 [CATEGORY] 按钮以打开 Performance Category Search 画面。
即使在显示 Category Search 画面时，您也可以使用上方面板中的按钮切换声部和静音。
注
也可以通过将光标移动至 Home 画面的演奏组名称上，并使用数据轮、[INC/YES] 按钮或 [DEC/NO] 按钮来选择演奏组。

画面说明

(1) (2) (3) (4) (6)(5) (7)

(1)	 Filter
您可以使用过滤器来搜索演奏组列表。
•	 Category

您可以从 Main 和 Sub 中各选择一个。
•	 Attribute

选择一个属性或属性组合。过滤器将根据组合而变化。
过滤器 ：

完全匹配 AWM2、FM-X、AN-X

AND 条件 MC、SSS、Smart Morph

OR 条件 Single、Multi
MOTIF XF、MONTAGE、MODX M OS Vx.x（x.x 是操作系统版本编号）

注
“MONTAGE”包括 MODX 和 MODX+。

(2)	 Bank

(3)	 通过关键词搜索

(4)	 Job
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(5)	 演奏组列表
显示与所选 Category 和 Attribute 对应的演奏组。

文本颜色 说明

白色 当前所选演奏组

绿色 单声部演奏组

蓝色 多声部演奏组

(6)	 更改排序顺序

(7)	 Audition

步骤

1.	 按 [CATEGORY] 按钮。
此时显示 Performance Category Search 画面。
也可以通过从演奏组名称的上下文菜单中选择 Category Search 来打开此画面。

2.	 根据需要使用过滤器。
通过切换过滤器、库和排序来搜索演奏组。

3.	 从列表中选择。
从画面右侧显示的演奏组列表中选择。
使用数据轮、[INC/YES] 按钮、[DEC/NO] 按钮或向上和向下按钮进行选择。
您也可以使用显示旋钮在画面上滚动，而无需更改当前选择的演奏组。

4.	 关闭画面。
按上方面板的 [ENTER] 按钮、[EXIT] 按钮或 [PERFORMANCE (HOME)] 按钮，或者点击画面上的 [ ]（主页）图标
或 [ ]（退出）图标。

注
如果您希望更改多声部演奏组（具有多个声部的演奏组）中的某一声部，可以使用 Part Category Search 功能。选择要更改的声部，然后
在按住 [SHIFT] 按钮的同时按 [CATEGORY] 按钮，即可显示 Part Category Search 画面。
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选择初始化演奏组或单声部演奏组

初始化演奏组
将 Bank/Favorite 设置为 All 或 Preset。
将筛选条件设置为 Category 并选择 Init。

单声部演奏组
将筛选条件设置为 Attribute 并选择 Single。
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播放试听乐句

通过播放试听乐句，您可以检查演奏组。您还可以在播放期间操纵控制器，聆听演奏组的声音如何变化。

1.	 按上方面板的 [AUDITION] 按钮，或点击 Category Search 画面上的 Audition 按钮。
此时将播放当前演奏组的试听乐句。
如果您在播放期间切换演奏组，则会播放新演奏组中的乐句。
注
如果 [AUDITION] 按钮禁用，则所选演奏组的试听功能不可用，按下该按钮时不会有任何反应。

2.	 要停止播放试听乐句，请再次按上方面板的 [AUDITION] 按钮，或点击 Category Search 画面上的 Audition
按钮。
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对整个演奏组使用整体功能

还有其他功能可用于调整演奏组内声部之间的平衡，或用于快速切换到预先注册到按钮的不同设置组。

Mixing

混音功能可用于调整声部之间的平衡。
您可以检查每个声部（例如，声像、音量和 EQ）的设置，并调整参数。

画面说明

(1)(2)(3)

(4)(7) (5)(6)

(1)	 各声部的主类别

(2)	 切换 Solo、Mute 和 Kbd Ctrl 的视图

(3)	 在 3-band EQ 和 2-band EQ 之间切换

(4)	 各声部的 EQ设置

(5)	 各声部的参数

(6)	 切换到 16声部视图
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(7)	 切换到音频声部视图（声部 9至 16 隐藏）
您可为音频声部设置以下音频参数。
•	 AD 声部 ：A/D INPUT 插孔的音频输入
•	 数字声部 ：USB [TO HOST] 端口的音频输入
* 指音频通道中设置为数字 L/R 的音频

步骤

1.	 按 [PERFORMANCE (HOME)] 按钮并点击 Mixing。
此时显示 Mixing 画面。

2.	 选择一个参数。
使用 PART 按钮或光标按钮选择参数，或点击画面上的图标和按钮。

3.	 使用数据轮或相关显示旋钮更改值。
注
如果需要微调值，请在画面上显示 Mixing 画面时按 [EDIT/ ] 按钮以打开 Edit 画面。



18MODX M 使用说明书

Scene

场景是各种设置（如琶音类型、动态音序类型和声部参数）的“快照”。通过将不同的场景注册到八个 SCENE 按钮中的每
一个，您可以使用 SCENE 按钮立即调用不同的设置。
例如，当您希望仅更改琶音和动态音序类型而不更改演奏组，以便跟唱或展现演奏组的不同方面时，这会很方便。

画面说明

(1)

(2)

(3)

(1)	 Scene 选项卡

(2)	 记忆开关

(3)	 选项卡的设置
当记忆开关为 On 时，该功能的参数将显示在画面上。

步骤

1.	 按 [PERFORMANCE (HOME)] 按钮并点击 Scene。
此时显示 Scene 画面。

2.	 设置 Scene 1–8。
记忆开关 (Memory) 已设置为打开的功能将注册到所选的 SCENE 按钮。
现在，当按相应的 SCENE 按钮时，新设置的 Scene 将变为活动状态。

3.	 按 [STORE] 按钮保存演奏组。

须知
在更改为不同的演奏组或关闭乐器之前，请确保保存（存储）您刚刚编辑的场景设置。如果不执行存储操作，场景设置将会丢失。

注
如果可以注册到 SCENE 按钮的参数已分配给某个旋钮或滑杆，请转动旋钮或移动滑杆。然后就可以在按住 [SHIFT] 按钮的同时按下 SCENE
按钮之一，将设置注册到按钮。
之后，按 [STORE] 按钮将场景设置保存到演奏组中。
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编辑设置

使用分割和层叠

什么是分割？
此设置将整个键盘分成多个组，并为每个组分配一个声部。在此乐器上，您可以指定分割点并为每个组设置键区域。

什么是层叠？
此设置让您可以将多个声部相互层叠组合在一起并同时播放这些声部。通过将两个或更多声部分配到同一组，您可以演奏多
种音调的组合。

Split Job 画面

有关画面上各个项目的描述，请参阅 Split Job。

分割设置程序

1.	 按 [SPLIT] 按钮。
此时显示演奏组的 Split Job 画面。

2.	 通过点击画面上的项目来指定分割点的编号和位置，您可以设置每个组的键区域。
按住 [SHIFT] 按钮的同时点击组按钮，将单个声部分配到多个组。

3.	 按 [EXIT] 按钮或点击画面上的 Done 来确认设置。
点击左上角的 [×]（关闭）可取消设置。

音符范围设置程序

1.	 按住 [SHIFT] 按钮并按 [SPLIT] 按钮。
Performance 画面上会显示 Part - Note 视图。

2.	 使用键盘或数据轮更改每个声部的音符范围。
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编辑步骤

1.	 选择演奏组。

2.	 在 Performance 画面上，将光标移至要编辑的所需演奏组名称或声部上。

3.	 按 [EDIT/ ] 按钮或点击上下文菜单中的 Edit。
当光标位于演奏组名称上时，将显示 Common Edit 画面。
当光标位于声部上时，将显示声音引擎的 Part Edit 画面。
注
您可以通过从 Edit 画面打开 Common Edit 画面并从导航栏中选择所需项目来更改要编辑的参数。

4.	 选择第一行和第二行上的选项卡以打开画面。
建议从上到下更改每个选项卡中的设置。

示例 ：标准声部 (AWM2)

5.	 通过更改选项卡右侧显示的参数来编辑设置。

6.	 如有必要，继续编辑不同选项卡上的参数。
供编辑的目标将显示在导航栏上。
选择 Common 以编辑整个演奏组的设置。
选择声部 Common 以编辑整个声部的设置。
如果要进入详细设置，请选择以下选项之一 ：Element 1–128、Operator 1–8、Oscillator 1–3、Noise 和 C0–C6。

7.	 编辑完成后，按 [STORE] 按钮保存演奏组。
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使用Navigation 画面

1.	 按 [NAVIGATION] 按钮。
此时显示 NAVIGATION 画面。

此外，在编辑过程中按 [NAVIGATION] 按钮会调出当前位置图标 ( )。

2.	 选择项目进行编辑。
选择声部 Common 以编辑整个声部的设置。
如果要进入详细设置，请选择以下选项之一 ：Element 1–128、Operator 1–8、Oscillator 1–3、Noise 和 C0–C6。

3.	 选择要编辑的参数的图标。
使用光标按钮移动光标，然后按 [ENTER] 按钮。或者，点击画面上的图标。

4.	 选择要编辑的设置的图标。

5.	 更改画面上显示的参数。

6.	 保存演奏组。
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创建音调变化

要创建音调变化，可以使用振荡器、滤波器、EG（包络发生器）、LFO（低频振荡器）和效果。通过更改这些参数，可以更
改声音的亮度、共鸣或其他音质。
详细设置因声音引擎而异，但常见的设置如下 ：

振荡器 (Osc) 创建波形

音高 (Pitch) 控制音高

滤波器 (Filter) 控制截止频率

EG 确定声音如何随时间变化

LFO 确定声音的周期性变化

动态音序器 随着时间的推移，声音会发生复杂的变
化

效果 (Effects) 处理声音

LFO

EG
Motion Sequencer
Envelope Follower

Osc
(Oscillator)

Filter Amp Effects Output

效果配置

系统效果
此效果应用于演奏组的所有声部。
系统效果包括两种类型 ：变奏和混响。您还可以将混响添加到变奏的输出声音 (Variation to Reverb)。

插入效果
此效果应用于各个声部。

主控效果
此效果应用于最终输出的总体音色。

声部均衡
3 频段和 2 频段均衡器应用于各个声部。
声部 EQ 可以在插入效果之前或之后应用。

主 EQ
5 频段均衡器应用于最终输出的总体音色。
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效果关系和设置
按下图所示进行连接，并使用方法 (1) 至 (4) 设置每个效果。

Part
Insertion A
Insertion B

Part EQ
3-Band EQ

Part EQ
2-Band EQ

Performance

(1)

(2)

(3)

(4)

System Effect

Master Effect

Master EQ

Reverb

Variation

Variation to Reverb

Send Level

Return Level

(1)	 设置声部 EQ和插入效果
[PERFORMANCE (HOME)] → Part 选择 → [EDIT/ ] → Effect → Routing
[PERFORMANCE (HOME)] → Part 选择 → [EDIT/ ] → Effect → Ins A
[PERFORMANCE (HOME)] → Part 选择 → [EDIT/ ] → Effect → Ins B
[PERFORMANCE (HOME)] → Part 选择 → [EDIT/ ] → Effect → 3-band EQ
[PERFORMANCE (HOME)] → Part 选择 → [EDIT/ ] → Effect → 2-band EQ

(2)	 设置变奏和混响
[PERFORMANCE (HOME)] → Part 选择 → [EDIT/ ] → Effect → Routing
[PERFORMANCE (HOME)] → Common 选择 → [EDIT/ ] → Effect → Variation
[PERFORMANCE (HOME)] → Common 选择 → [EDIT/ ] → Effect → Reverb

(3)	 设置主控效果
[PERFORMANCE (HOME)] → Common 选择 → [EDIT/ ] → Effect → Master FX

(4)	 设置主 EQ。
[PERFORMANCE (HOME)] → Common 选择 → [EDIT/ ] → Effect → Master EQ

注
按如下所示为 A/D INPUT 插孔的音频输入信号设置效果 ：[PERFORMANCE (HOME)] → Common 选择 → [EDIT/ ] → Audio In。

有关效果类别和效果类型的信息，请参阅效果类型。有关效果参数的信息，请参阅效果参数。
有关每种效果类型的预置程序的信息，请参阅 Data List。
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更改效果设置
在按住 [SHIFT] 按钮的同时按 [NAVIGATION] 按钮，将显示 FX Overview 画面，可以在其中看到效果设置的概览。点击效
果名称上的按钮（如 Ins A 和 Var）可以打开 Edit 画面。
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使用琶音

琶音是一种只需按下键即可自动播放节奏模式组和和弦背景的功能。
不仅能够为您提供现场演奏时的灵感和完整的节奏片段，还可提供各种音乐流派的全格式乐器伴奏声部，用以轻松制作 
乐曲。

此乐器琶音功能的特性
借助本乐器，您可以为每个声部设置八种琶音类型，并同时为八个声部播放琶音。
您还可以设置琶音播放使用的键区域 (Note Limit) 以及按键压力强度的上限和下限 (Velocity Limit)。

琶音功能可用于演奏重音乐句（仅当以高于指定值的力度弹奏键盘时演奏的音序乐句）或使用随机 SFX 功能演吉他按弦杂
音等效果音。
您可以在 Arp Category Search 画面搜索包含这些声音的预置琶音。在 Attribute 中指定 Accent（重音乐句）或 Random 
SFX 将缩小匹配琶音的范围。

打开和关闭琶音
要打开或关闭琶音功能，请按上方面板上的 [ARP] 按钮。

使用旋钮更改琶音
使用 [QUICK EDIT] 按钮选择 ARP/MSEQ，然后使用旋钮 1 和 2 更改琶音的发音方式。
通过转动旋钮并聆听琶音播放来修改声音。
有关旋钮 1 和 2 效果的详细信息，请参阅 Common Edit 画面上的 Arp/MS → Arp Common。

更改琶音播放的打开或关闭方式
您可以自由地更改琶音播放方法，例如从仅在按住琴键时播放的设置更改为即使将手指从琴键上移开后仍继续播放的设置。
按照以下步骤更改此设置 ：

Hold
[EDIT/ ] 按钮 → Part 选择 → Common → Arpeggio → Common

Trigger Mode
[EDIT/ ] 按钮 → Part 选择 → Common → Arpeggio → Advanced

设置 Hold Trigger Mode

仅在按下琴键时播放 Off Gate

手指离开琴键后继续播放 On Gate

每次按下琴键都会打开或关闭播放 无论是 On/Off Toggle

注
当 Arp Master 和 Arp Part 为 ON 时，打开上方面板上的 [KEYBOARD HOLD] 按钮可实现与将 Hold 设置为 On 时相同的效果。



26MODX M 使用说明书

使用动态控制

动态控制功能可用于实时创建动态（有节奏和动态的声音变化），从而可以找到全新的表达方式。
此功能允许您提前进行设置，无需实际操作踏板或音轮即可更改参数。
这样，您就可以跟随音乐节拍，创作出戏剧性且强有力的表现力变化。

(1) Continuous control of Motion changes
(2) Switch between Motions
(3) Trigger

Motion SequencerEnvelope Follower Super Knob

Beat Audio Beat Sync
External MIDI
Internal Tempo

Audio Part 1-16
A/D Input Part
Master

Tone Generator Effect Arpeggio Motion Sequencer

(5) Rhythmic change

(4) Control the Motion Sequencer in real time

(6) Automation

(7) Multi-dimensional sonic change(7) Multi-dimensional sonic change

(1)	 连续控制动态变化
(2)	 在动态之间切换

(3)	 触发器

(4)	 实时控制动态音序器

(5)	 节奏变化

(6)	 自动化

(7)	 多维声波变化
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设置动态控制
可通过设置控制器的 Source 以及从 Control Assign 画面设置 Destination 和 Parameter 来设置动态控制。

如何打开 Control Assign 画面
[PERFORMANCE (HOME)] → 点击 Common → [EDIT/ ] → Control → Control Assign
[PERFORMANCE (HOME)] → 选择 Part → [EDIT/ ] → Mod/Control → Control Assign

设置为超级旋钮
将 Display Filter 设置为 SuperKnob，并选择 Source (AsgnKnob 1–8)、Destination 等。

设置为动态音序
对于动态音序，将 Source 设置为 1 至 4 的动态音序通道。

设置为包络跟随器
将 Source 设置为 EnvFollow。

自定义超级旋钮设置
使用超级旋钮可以同时控制分配给旋钮 1 至 8 的 Assign 1–8 值（对所有声部通用）。
将超级旋钮和动态音序器结合使用，可以实现更复杂的声音变化。

从踏板控制超级旋钮
您可以通过连接到本乐器的踏板控制器 (FC7)（另售）来控制超级旋钮。

1.	 将踏板控制器 (FC7) 连接到 FOOT CONTROLLER 插孔（[1] 或 [2]）。

2.	 通过以下方法打开画面 ：[PERFORMANCE (HOME)] → [EDIT/ ] → Control → Control Number。

3.	 根据踏板控制器 (FC7) 连接到的插孔，为 Foot Ctrl1 或 Foot Ctrl2 选择 SuperKnob。

4.	 关闭画面以完成设置。



28MODX M 使用说明书

超级旋钮设置示例
可以自定义超级旋钮设置。
您可以设置两个或三个固定值，以便使用超级旋钮对声音进行变形。通过三个固定值，您可以设置中间值。

使用三个固定值进行变形的示例
在这里，我们将解释如何向由三个预置演奏组（原声钢琴、打击垫声音和电钢琴）制作的叠加声音添加变形效果。此外，我
们将解释如何在保留这些演奏组的原始设置的同时添加变形效果。

MID

LEFT RIGHT

Acoustic Piano
(CFX PopStudioGrand)

Electric Piano
(TV Show FM EP)

Pad sound
(AN-X Sine Pad PAT)

1.	 选择声部 1 至 3 的声音。
1-1.	 按 [CATEGORY] 按钮并选择 CFX PopStudioGrand。
1-2.	 从 Home 画面中，点击声部 2 的 [+] 图标以打开 Part Category Search 画面，并选择 AN-X Sine Pad PAT。
1-3.	 从 Home 画面中，点击声部 3 的 [+] 图标以打开 Part Category Search 画面，并选择 TV Show FM EP。

2.	 设置声部 1 的参数。
2-1.	 选择声部 1。
2-2.	 在按住 [SHIFT] 按钮的同时按 [CONTROL ASSIGN] 按钮可打开 Control View 画面。
2-3.	 转动超级旋钮以打开 Control Assign 画面。
2-4.	 转到 Page 2 并点击 [+] 图标以添加 Destination 10。
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2-5.	 点击 Destination 10 选项卡，然后从 Part Param 选择 Volume。
2-6.	 将 Polarity (Curve Polarity) 设置为 Bi，并将 Ratio (Curve Ratio) 设置为 +127。

3.	 设置声部 2 的参数。
3-1.	 选择声部 2。
3-2.	 在按住 [SHIFT] 按钮的同时按 [CONTROL ASSIGN] 按钮，然后转动超级旋钮。声部 2 Control Assign 画面会打开。
3-3.	 点击 [+] 图标以添加 Destination 8。
3-4.	 点击 Destination 8 选项卡，然后从 Part Param 选择 Volume。
3-5.	 将 Polarity (Curve Polarity) 设置为 Bi，并将 Ratio (Curve Ratio) 设置为 +127。

4.	 设置声部 3 的参数。
4-1.	 选择声部 3。
4-2.	 在按住 [SHIFT] 按钮的同时按 [CONTROL ASSIGN] 按钮，然后转动超级旋钮。声部 3 Control Assign 画面会打开。
4-3.	 点击 [+] 图标以添加 Destination 8。
4-4.	 点击 Destination 8 选项卡，然后从 Part Param 选择 Volume。
4-5.	 将 Polarity (Curve Polarity) 设置为 Bi，并将 Ratio (Curve Ratio) 设置为 +127。



30MODX M 使用说明书

5.	 检查以确保声部 1 至 3 的参数设置为 Common Assignable Knob。
5-1.	 按 [COMMON] 按钮。
5-2.	 在按住 [SHIFT] 按钮的同时按 [CONTROL ASSIGN] 按钮，然后转动超级旋钮。Common Control Assign 画面会打开。
5-3.	 点击 Destination 6 至 8 选项卡，检查 Source 是否分别设置为 AsgnKnob 6 至 8，Destination Parameter 是否设置

为 Part1 至 3Volume。

6.	 设置超级旋钮上的 LEFT 位置。
这是超级旋钮向左转到底时的设置。

6-1.	 按下 KNOB POSITION [LEFT] 按钮。
6-2.	 确保在声部选择时选择了 COMMON，然后按 [ASSIGN] 按钮。确保旋钮设置为 5 至 8。
6-3.	 要仅将声部 1 上的 CFX PopStudioGrand 设置为发声，请将旋钮 6 (Assign6) 向右转到底（转至最大值），将旋钮 7 

(Assign7) 和旋钮 8 (Assign8) 向左转到底（转至最小值）。
6-4.	 在按住 [SHIFT] 按钮的同时按下 KNOB POSITION [LEFT] 按钮保存设置。

7.	 设置超级旋钮上的 RIGHT 位置。
这是超级旋钮向右转到底时的设置。

7-1.	 按下 KNOB POSITION [RIGHT] 按钮。
7-2.	 要仅将声部 3 上的 TV Show FM EP 设置为发声，请将旋钮 8 (Assign8) 向右转到底（转至最大值），将旋钮 6 (Assign6)

和旋钮 7 (Assign7) 向左转到底（转至最小值）。
7-3.	 在按住 [SHIFT] 按钮的同时按下 KNOB POSITION [RIGHT] 按钮保存设置。
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8.	 设置超级旋钮上的 MID 位置。
启用 MID 位置，然后转动超级旋钮以设置中间位置的值。

8-1.	 按 [NAVIGATION] 按钮以打开 NAVIGATION 画面。
8-2.	 点击 Super Knob，打开超级旋钮设置画面。
8-3.	 将 Mid Position 的值设置为 512。

8-4.	 按下 KNOB POSITION [MID] 按钮。
8-5.	 要仅将声部 2 上的 AN-X Sine Pad PAT 设置为发声，请将旋钮 7 (Assign7) 向右转到底（转至最大值），将旋钮 6 (Assign6)

和旋钮 8 (Assign8) 向左转到底（转至最小值）。
8-6.	 在按住 [SHIFT] 按钮的同时按下 KNOB POSITION [MID] 按钮保存设置。

主要设置现已完成。

9.	 进行微调。
调整每个声部的 Curve Type、Ratio 和 Param，如果需要，调整 KNOB POSITION 的 LEFT、RIGHT 和 MID。
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使用动态音序器

动态音序器功能可用于根据预先创建的音序控制参数时间来创建声音变化。它允许您设置与演奏速度、琶音或从连接设备输
入的节奏同步的节奏变化，并根据歌曲的进行以交互方式实时控制这些变化。

您可以在一个声部中使用最多四个通道，或者在整个演奏组中使用最多八个通道。每个通道最多可以设置八个音序模式。与
琶音一样，您可以设置 Velocity Limit 和音序播放方法、步级数等来播放音序。

如何设置各个通道的参数：
[PERFORMANCE (HOME)] → Part 选择 → [EDIT/ ] → Motion Seq → Lane

打开或关闭动态音序器
要打开或关闭动态音序器，请按上方面板上的 [MSEQ] 按钮。

使用旋钮更改动态音序器
使用 [QUICK EDIT] 按钮选择 ARP/MSEQ 以使用旋钮 3 和 4 更改动态音序器。
通过转动旋钮并聆听动态音序器播放来修改动态音序器设置。
有关旋钮 3 和 4 效果的详细信息，请参阅 Common Edit 画面上的 Arp/MS → MS Common。

更改动态音序的触发方式
可通过 LaneSw 和 Trigger 参数设置动态音序器的触发方式。

LaneSw，Trigger
[PERFORMANCE (HOME)] → Part 选择 → [EDIT/ ] → Motion Seq → Lane 

设置 Lane Sw Trigger Sync

按某个琴键时播放动态音序器 On Off -

按 [MSEQ TRIGGER] 按钮时播放动态音序器 On On Other than 
Arp

编辑动态音序器
动态音序最多由 16 个步骤组成。
点击 Edit Sequence 以打开 Motion Sequence 设置画面，并编辑每个步级。
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使用包络跟随器

包络跟随器是从音频输入中提取波形包络的功能，用作产生声音变化的控制器。它允许声部的输出以及连接到 A/D INPUT
插孔的外接设备的输出。

例如，您可以将一个已分配节奏模板的声部的包络跟随器用作源，以将变奏添加到另一个声部。例如，如果您希望设置闪避
（在播放一个声部时降低另一个声部的音量），那么此功能非常有用。

每个包络跟随器都有自己的输入源，例如声部 1 的 EnvFollow 1，声部 2 的 EnvFollow 2，以及音频声部的 EnvFollow AD。
可以通过从 Control Assign 画面选择不同的源来更改每个包络跟随器的输出。

例如，您可以为声部 1 设置包络跟随器 (EnvFollow 1) 以在声部 2 中产生变化。可以从 Control Assign 画面设置每个包络
跟随器的输出修改声音的方式。

Envelope Follower

Input Source

Env Follower
MST

Env Follower
AD

Part 1
Performance

(16 parts and Audio Part) A/D IN PartPart 2

Env Follower
2

EnvFollower
1

(1) Input signal to Envelope Follower (Fixed)

(2) Output signal from Envelope Follower
     (The Destination can be changed)

(1) 输入到包络跟随器的信号	 (2) 来自包络跟随器的输出信号

包络跟随器的设置：
[PERFORMANCE (HOME)] → Common 选择 → [EDIT/ ] → Effect → Routing → Envelope Follower (EnvFollow MST)
[PERFORMANCE (HOME)] → Common 选择 → [EDIT/ ] → Audio In → Routing → Envelope Follower (EnvFollow AD)
[PERFORMANCE (HOME)] → Part 选择 → [EDIT/ ] → Effect → Routing → Envelope Follower (EnvFollow 1–16)

从Rhythm Pattern 画面设置包络跟随器
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您可以在 Rhythm Pattern 画面设置包络跟随器。这样，您就可以快速访问通常用于节奏模板的包络跟随器参数。

1.	 在按住 [SHIFT] 按钮的同时按 [SONG/PATTERN] 按钮可打开 Rhythm Pattern 画面。

2.	 从画面右侧显示的列表中选择鼓声。

3.	 点击 Envelope Follower 并打开开关。
您可以弹奏键盘，试听包络跟随器的效果。

4.	 调整设置。
设置示例
• Polarity (Curve Polarity) ：Bi
• Ratio (Curve Ratio) ：− 63
• Gain (Envelop Follower Gain) ：− 12.0 dB

5.	 如需进行更精细的调整，请点击画面上的 Edit。
Envelope Follower Edit 画面会打开。

注
•	可以在按住 [SHIFT] 按钮的同时按 [SONG/PATTERN] 按钮返回到 Rhythm Pattern 画面，为节奏模板选择新组或琶音类型。
•	为节奏模板选择新组或琶音后，将保留包络跟随器的设置。
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使用 Smart Morph

Smart Morph 是一项使用机器学习来使 FM-X 声部或 AN-X 声部变形的功能。通过这种方式，您可以从多个 FM-X 声部或
AN-X 声部中为声部 1 创建新声音以在键盘上演奏。

Smart Morph 的特性
Smart Morph 功能可分析分配给声部 9 至 16 的每个声音，并在地图上为每个声部绘制一个点。地图上的每个点代表一种声
音，点之间的距离表示这些声音的相似性。

创建新声部 (Learn)
Learn 特性会自动生成声音来填充地图上点之间的空隙。当您点击地图上的点时，系统将为声部 1 选择该点的声音。您可以
从地图中找到喜欢的新地点，并保存其设置以创建新的声部。

通过在弹奏键盘时拖动地图上的点，或者通过移动超级旋钮并配合预先分配的 2 至 8 个点的移动，可以创建全新的声音。
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保存编辑的设置

编辑后，将您创建的演奏组保存到内置存储器中。将设置保存到内置存储器中称为“Store”操作。

须知
•	如果选择不同的演奏组或在未先存储演奏组的情况下关闭乐器，则会丢失正在编辑的设置。
•	当您覆盖User Bank 上的现有演奏组时，这些演奏组将会丢失。当您保存编辑过的演奏组时，请确保不要覆盖现有的演奏组。您进行的
重要设置应保存到USB闪存中 (Save)。有关保存操作，请参阅“将设置作为备份文件保存到USB闪存中 (Save)”。

如何存储演奏组

1.	 按 [STORE] 按钮。

•	 如果您正在保存新的演奏组，将显示 Store As New Performance。
•	 如果已经存储演奏组，则会显示 Overwrite Current Perf. 和 Store As New Performance。

2.	 要存储为新的演奏组，请点击 Store As New Performance。
如果要覆盖已存储的演奏组，请点击 Overwrite Current Perf.，然后点击 Store (YES)。

3.	 在键盘画面上输入演奏组名称。
使用主画面上显示的键盘。您最多可以使用 20 个字母数字字符。

4.	 输入名称后，点击 Done。
当存储操作完成时，画面上将显示 Performance 画面。



37MODX M 使用说明书

创建 Live Set

例如，当您播放歌单中的歌曲时，Live Set 功能可以非常方便地在不同演奏组之间进行切换。
在本乐器上，只需将您喜欢的演奏组注册到每个插槽，即可创建 Live Set。

将演奏组注册到插槽

您可以按照以下步骤将演奏组注册到 Live Set。

须知
•	请先存储刚刚编辑的演奏组，然后再将演奏组注册到 Live Set。但是，当您注册到 Live Set 并选择 Store As New Perf. and Register
或 Overwrite Current Perf. and Register 时，无需提前存储演奏组。

•	如果选择不同的演奏组或在未先存储演奏组的情况下关闭乐器，则会丢失已编辑的设置。

1.	 从 Performance 画面中选择演奏组。
确保 [LIVE SET] 按钮亮起或半亮。

2.	 在按住 [SHIFT] 按钮的同时按 [LIVE SET] 按钮。
此时显示 Live Set Register 画面。

3.	 点击想要注册到的插槽以选择该插槽。

4.	 选择可用的存储操作之一，然后按 [ENTER] 按钮，或者直接在画面上点击您的选择。

存储方法 说明

Store As New Perf. and Register 存储为新演奏组并注册

Overwrite Current Perf. and Register 覆盖当前演奏组并注册

Register 注册

根据需要更改演奏组名称。确认更改以在插槽中注册演奏组。
注
如果要在已注册插槽之前注册新的演奏组，请按照以下步骤操作。
1. 在按住 [SHIFT] 按钮的同时点击插槽。在插槽前面会出现光标。
2. 按住 [SHIFT] 按钮的同时，选择存储方法，然后按 [ENTER] 按钮或点击画面。
此时将会删除在 Live Set 页面的最后一个插槽（右下角）中注册的演奏组。
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交换注册到插槽的演奏组

您可以交换插槽的内容。

1.	 通过以下方法打开画面 ：[LIVE SET]（或 Live Set 图标） → User Bank 选择 → [EDIT/ ]。
此时显示 Live Set Edit 画面。
当预置库或资料库上的 Live Set 页面打开时，将不会显示 Live Set Edit 画面。

2.	 点击画面上的 Job。
Job 画面将出现在画面的底部。

3.	 点击要从中移动演奏组的插槽，然后点击 Exchange。
Job 画面将出现在画面的底部。

4.	 点击要将演奏组移动到的插槽。
两个插槽的演奏组将交换。

5.	 交换完成后，点击 Done。
注
如果您希望复制或交换整个 Bank 或整个 Page，请在显示了 Live Set 画面的情况下，在按下 [SHIFT] 按钮的同时按 [EDIT/ ] 按钮。随
即显示对话框。
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将模板、乐曲或音频文件注册到插槽

您还可以将模板、乐曲或音频文件添加到 Live Set 插槽。这样，您就可以选择一个插槽来播放所需的模板、乐曲或音频文
件，然后在键盘上同时播放演奏组。

1.	 通过以下方法打开画面 ：[LIVE SET]（或 Live Set 图标） → User Bank 选择 → [EDIT/ ]。
此时显示 Live Set Edit 画面。
当预置库或资料库上的 Live Set 页面打开时，将不会显示 Live Set Edit 画面。

2.	 选择一个插槽或点击画面上的 [+]。

3.	 选择想要从 Slot Type 注册的插槽。

Slot Type 类型

Perform 演奏组

Song 乐曲

Audio 音频文件

Pattern 模板

4.	 点击 Pattern Name、Audio Name 等，以便打开 Load 画面。

5.	 选择所需的模板或文件以注册到插槽。

6.	 设置完成后，点击 Done。
注
您还可以通过按 Pattern 画面或 Song 画面上的 [SHIFT] 和 [LIVE SET] 按钮将模板或乐曲注册到 Live Set。
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用脚踏开关交换插槽

您可以使用 FC4A 或 FC5 等脚踏开关（另售）来选择不同的 Live Set 插槽。
请按照以下步骤操作。

1.	 将脚踏开关（FC4A 或 FC5）连接到 FOOT SWITCH [ASSIGNABLE] 插孔。

2.	 按如下所示打开画面 ：[UTILITY] → Settings → MIDI I/O。
此时显示 MIDI I/O 画面。

3.	 将 FS Assign 设置为 Live Set+ 或 Live Set −。
使用 Live Set+，您可以按正向顺序选择下一个 Live Set 插槽。
使用 Live Set −，您可以按相反顺序选择下一个 Live Set 插槽。
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从 Live Set 中选择演奏组

从 Live Set 画面选择歌单的演奏组。

1.	 按 [LIVE SET] 按钮打开画面。
此时显示 Live Set 画面。

2.	 根据需要在 Bank 和 Page 之间切换。

3.	 点击一个插槽来选择它。
此时会选定歌单的演奏组。
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弹奏键盘

确保在弹奏键盘之前从 Live Set 选择演奏组。
如果需要，您还可以在键盘演奏的同时播放特定模板、乐曲或音频文件（注册到 Live Set 插槽）。

播放注册到 Live Set 插槽的模板、乐曲或音频文件

您可以随注册到插槽的模板、乐曲或音频文件一起弹奏键盘。
注
当播放乐曲或模板时，无法更改演奏组或选择不同的插槽。如果您尝试更改它们，会出现错误消息。

1.	 在 Live Set 画面上选择一个插槽。

2.	 按 []（播放）按钮。
然后将播放注册到所选插槽的模板、乐曲或音频文件。
注
播放模板、乐曲或音频文件时，按 []（播放）按钮会显示与 Pattern 画面、Song 画面或 Audio 画面相同的画面。

3.	 按 []（停止）按钮停止播放。
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3.	 录制和播放

您可以使用本乐器录制和播放模板、乐曲和音频文件。
模板和乐曲录制到乐器内的存储区域中，而音频文件则录制到连接的 USB 闪存中。

术语

模板

模板由 MIDI 音序数据组成，其中包含录制为 MIDI 事件的短乐句。它们可以循环播放或与场景功能一起使用。本乐器的内
存区域最多可保存 128 个模板。

乐曲

乐曲由 MIDI 音序数据组成，其中包含有关录制为 MIDI 事件的键盘和其他控制器操作的信息。本乐器的内存区域最多可保
存 128 首乐曲。

音轨

音轨是用于录制键盘演奏的单独存储位置。音轨保存一个声部的信息。
本乐器上最多可提供 16 个音轨，因此您最多可以使用 16 个声部进行录制和播放。
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录制和播放模板

在音轨上录制旋律。

录制模板

1.	 选择需要在音轨 1 上录制的声音。

2.	 按 [SONG/PATTERN] 按钮并点击 Pattern。
此时显示 Pattern 画面。
注
还可从以下位置打开同一画面 ：[PERFORMANCE (HOME)] 按钮 → Play/Rec → Pattern。

3.	 根据需要更改场景长度 (Length)、速度 (Tempo) 和其他设置。

4.	 按 [SCENE] 按钮之一选择所需的录制场景。

5.	 按 []（录制）按钮。
录制将设置为待机状态。

(1) (2)(3) (4)

(6)

(8) (9) (10) (11)

(5)

(7)

(1)	 模板名称

(2)	 当前所选演奏组的名称

(3)	 拍号

(4)	 播放和录制的起始位置

(5)	 Tempo

(6)	 Quantize

(7)	 切换录制类型（录制新模板时不显示）

(8)	 Scene

(9)	 模板长度

(10) 打开或关闭在触键时开始录制的功能

(11) 打开或关闭循环设置
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6.	 按 []（播放）按钮开始录制。

7.	 弹奏键盘。
当 Loop 打开时，录制时弹奏的乐句会循环播放，让您可以在保持录制状态的同时将其录制到另一个音轨上。
注
在录制过程中按下 []（录制）按钮时，该按钮将闪烁并启用排练模式。在此模式下，您可以暂时禁用音轨上的录制，但继续播放。
要试听某个声音时，此选项很有用。
在排练模式下再次按下 []（录制）按钮将返回到录制模式。

8.	 为音轨 2 选择所需的声音，然后播放键盘以及您在音轨 1 上录制的乐句。

9.	 根据需要录制其他音轨。
乐曲和模板在录制时会自动存储。
如果要在录制后和存储前更改乐曲或模板的速度或音调，请点击 Store Pattern&Perf Settings（或对于乐曲，请点击
Store Song&Perf Settings）来存储。
注
如果您有已编辑的演奏组参数，则还需要存储演奏组。

取消上次录制操作（Undo、Redo）
Undo 会取消上次录制操作并删除刚刚录制的内容。
Redo 还原通过 Undo 取消的录制。

Undo Media Record （没有录制时不会出现）
点击此按钮可取消上次录制操作并将录制还原到原始状态。
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Redo Media Record （只有完成 Undo 后才会出现）
点击此按钮可将录制还原为 Undo 之前的状态。

播放模板

要播放录制的模板，请使用音序器传送按钮。
您可以使用 SCENE 按钮选择要播放的场景。
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录制和播放乐曲

录制乐曲

不仅是键盘演奏，控制器和旋钮的操作也会作为 MIDI 数据录制到音轨中。
弹奏键盘或操作控制器时，会录制 Keyboard Control Switch 设置为 On 的声部。
对于旋钮操作，也将录制控制变化和参数变化信息。有关控制变化的更多信息，请参阅 Data List。
注
•	当 Arp Rec 设置为 ON 时，将仅录制琶音播放的结果。
•	当 Arp Rec 设置为 Off 时，会录制整个键盘演奏的数据，以便您稍后更改琶音模板。

1.	 选择演奏组。

2.	 按 [SONG/PATTERN] 按钮打开 Play/Rec 画面并选择 Song 选项卡，然后按 []（录制）按钮。
[]（录制）按钮将闪烁，录制设置为待机状态。
注
也可以通过以下方法打开画面，将录制设置为待机状态 ：[PERFORMANCE (HOME)] → Play/Rec → Song，然后按 []（录制） 
按钮。

3.	 根据需要更改 Time Signature 和 Rec Quantize。

(1) (2)(3) (4)

(9)

(8)

(6)

(5)

(7)

(1)	 乐曲名称

(2)	 当前所选演奏组的名称

(3)	 拍号

(4)	 播放和录制的起始位置

(5)	 Quantize

(6)	 音序总长度和当前播放位置

(7)	 整个音序的时间

(8)	 打开或关闭音轨播放

(9)	 打开或关闭琶音录制.
（仅适用于新录制）
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4.	 准备完成后，按 []（播放）按钮开始录制。
如果设置了 Click Settings，则按 [（播放）按钮时 Precount 会启动。预计数后开始弹奏键盘。

5.	 键盘演奏结束后，按 []（停止）按钮停止录制。

重新录制一些声部（切入 /切出录制）
本乐器提供三种录制类型 (Record Type) ：Replace、Overdub 和 Punch。
•	 Replace ：覆盖现有数据。
•	 Overdub ：为音轨上现有的声音添加一层。
•	 Punch ：覆盖现有数据的指定乐段。

如果要重新录制指定乐段，可以为 Punch 录制设置 Punch-in/Punch-out 参数。
当您开始 Punch 录制时，录制的乐曲将从头开始播放。当播放达到为 Punch-in 设置的小节时，录制会自动开始。当达到
为 Punch-out 设置的小节时，录制会自动结束，并且已录制乐曲的其余部分将播放到最后。例如，如果要重新录制八小节
乐曲的第 3 到 5 小节，请按照以下说明进行操作。

1 2 3 4 5 6 7 8

1 2 3 4 5 6 7 8

Punch In Punch Out

对于上述切入 / 切出录制，请在 Record Setup 画面中设置以下参数。

(1) (2) (3)

(1)	 Record Type = Punch

(2)	 Punch In（开始重新录制的小节和节拍）= 003:01
从此处指定的小节和节拍开始，将关闭相应音轨的声音，并将录制您的键盘演奏。

(3)	 Punch Out（结束重新录制的小节和节拍）= 006:01
从此处指定的小节和节拍开始，将播放音轨。

取消上次录制操作（Undo、Redo）
Undo 会取消上次录制操作并删除刚刚录制的内容。
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Redo 还原通过 Undo 取消的录制。

Undo Media Record （没有录制时不会出现）
点击以查看确认画面。Continue(YES) 取消上次录制操作并将录音机恢复到原始状态。

Redo Media Record （只有完成 Undo 后才会出现）
点击以查看确认画面。Continue(YES) 将录制还原为 Undo 之前的状态。

播放乐曲

要检查录制的乐曲，请使用音序器传送按钮。
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录制音频和播放音频文件

录制音频

您可以使用本乐器录制和播放立体声音频文件（44.1kHz，24 位 wav）。录制电平固定，最长可连续录制 74 分钟（假设 USB
存储设备有足够的可用内存）。

1.	 将 USB 闪存连接到乐器的 USB [TO DEVICE] 端口。

2.	 从以下位置打开画面 ：[PERFORMANCE (HOME)] → Play/Rec → Audio。
此时显示音频录音画面。

3.	 按 []（录制）按钮。
[]（录制）按钮将闪烁，录制设置为待机状态。

(1)

(5)

(2)

(4)

(3)

(1)	录制的位置

(2)	音频文件总长度和当前录制位置

(3)	可用录音时间

(4)	电平表

(5)	Trigger Level

4.	 设置 Trigger Level。
如果将 Trigger Level 设置为 manual，则每当按 []（播放）按钮时便开始录制。
或者，如果将 Trigger Level 设置为 1 到 127 之间的值，则按 []（播放）按钮后将自动开始录制，然后每当播放音量
超过该电平时，便开始录制。
设置的 Trigger Level 将用电平表 (4) 中的蓝线来指示。为获得出色效果，请将此参数设置得尽可能低，以便捕获整个
信号，但也不要太低，以免录制不必要的噪音。

5.	 按 []（播放）按钮。
如果已将 Trigger Level 设置为 manual，则按 []（播放）按钮后会立即开始录制。录制时，[]（录制）按钮将呈
红色亮起，[]（播放）按钮将呈绿色亮起。
如果已将 Trigger Level 设置为 1 到 127 之间的值，则只要播放音量超过该电平，就会自动开始录制。
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6.	 弹奏键盘。

7.	 弹奏完毕后，按 []（停止）按钮。
录制的音频文件将保存到 USB 闪存。

播放音频文件

如下所述，本乐器可以播放 USB 闪存中的音频文件（44.1kHz，24 位或 16 位立体声 .wav）。
在播放音频文件的同时，您还可以在键盘上演奏。

1.	 将 USB 闪存连接到乐器的 USB [TO DEVICE] 端口。

2.	 从以下位置打开画面 ：[PERFORMANCE (HOME)] → Play/Rec → Audio。

3.	 点击 Audio Name (1)，然后点击上下文菜单中的 Load。

4.	 选择所需的源 USB 闪存和包含设置的文件夹。

5.	 在 USB 闪存上选择需要加载的 .wav 文件。

(1)

(3)

(2)

(1)	音频名称

(2)	播放音量

(3)	音频长度

6.	 按 []（播放）按钮。
将播放音频文件。

7.	 将光标移至 Audio Volume (2)，然后使用数据轮调节播放音量。

8.	 按 []（停止）按钮停止播放。



52MODX M 使用说明书

4.	 管理备份

您可以将在乐器上创建并保存（存储）的演奏组、Live Set 和工具设置的备份保存到 USB 闪存，也可以将备份文件中的设
置从 USB 闪存加载到本乐器。
本节介绍如何将用户存储器中的所有设置保存到 USB 闪存以及如何将设置加载回乐器。
还可以使用 Soundmondo（声音管理和共享服务）来备份在此设备上创建的演奏组设置。
Soundmondo ：https://www.yamaha.com/2/soundmondo

可用的文件格式

保存到 USB 闪存

MONTAGE M 和 MODX M 通用的格式
•	 备份文件 (.Y2A)

用户存储器中的所有内容（包括“用户”区域、“库”区域、乐曲和模板）
•	 用户文件 (.Y2U)

用户存储器的“用户”区域中的所有内容（包括工具设置和快速设置）
•	 库文件 (.Y2L)

用户存储器中的用户区域（不包括工具设置和快速设置）。Live Set 仅 1 个库

如果文件大小超过约 2GB，该文件将分为两部分。分割文件将具有不同的文件扩展名。
•	 备份文件 (.Y2B)
•	 用户文件 (.Y2W)
•	 库文件 (.Y2M)

通用文件格式
•	 模板和乐曲 (.MID)

保存到用户存储器中的模板和乐曲

https://www.yamaha.com/2/soundmondo
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从 USB 闪存加载

MONTAGE M 和 MODX M 上保存的文件（.Y2A、.Y2U、.Y2L、.MID）

通用文件格式
•	 音频文件（.WAV 和 .AIF）

用作用户波形的文件
•	 MIDI 文件 (.MID)

用作模板和乐曲的文件

用于旧型号的文件格式
•	 MONTAGE（.X7A、.X7U、.X7L）
•	 MODX、MODX+（.X8A、.X8U、.X8L）
•	 MOTIF XF（.X3A、.X3V、.X3G、.X3W）
•	 MOTIF XS（.X0A、.X0V、.X0G、.X0W）
•	 MOXF（.X6A、.X6V、.X6G、.X6W）
注
如果 MONTAGE M 上保存的备份文件超出了 MODX M 用户波形存储器的容量，则无法加载该文件。
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USB 闪存将格式化。

我们建议在本乐器上格式化 USB 闪存。在其他设备上格式化的 USB 闪存可能无法在本乐器上正常工作。

须知
格式化USB闪存会删除闪存上存储的所有数据。格式化之前，请确保闪存上没有必需的数据。

格式化步骤

1.	 将 USB 闪存连接到乐器的 USB [TO DEVICE] 端口。

2.	 通过转至 [UTILITY] → Contents → Load 来打开画面。
您可以通过按住 [SHIFT] 按钮的同时按 [STORE] 按钮来打开同一画面。

3.	 点击画面右上角的 Job，然后点击已连接的 USB 闪存。

4.	 点击上下文菜单中的 Format。

5.	 点击 Format(YES)。
格式化完成。
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将设置保存到 USB 闪存

1.	 将 USB 闪存连接到乐器的 USB [TO DEVICE] 端口。

2.	 通过转至 [UTILITY] → Contents → Save 来打开画面。
您可以通过按住 [SHIFT] 按钮的同时按 [STORE] 按钮，然后选择 Save 选项卡来打开同一画面。

3.	 在 Content Type 下，选择 Backup File。

4.	 选择 USB 闪存和所需的文件夹来保存文件。

(1) (2)

(3)

(4)

(1)	父文件夹名称

(2)	USB 闪存中当前选择的目标文件夹的名称

(3)	保存到的文件

(4)	文件夹中已保存的文件列表
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5.	 点击 Save As New File 对应的 [+]。
这会调出用于输入名称的画面。
注
要覆盖现有文件，请点击画面上的文件名以确认该过程。点击 Save(YES) 保存文件。

6.	 输入要使用的文件名。
有关如何输入文件名的具体信息，请参考快速指南。

7.	 点击 Done 完成名称输入。
备份文件随后将保存到 USB 闪存。
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从 USB 闪存加载设置

须知
加载设置后，乐器上的现有设置将被覆盖并丢失。加载设置之前，应将要保留的重要设置保存到USB闪存 (Save)。

1.	 将 USB 闪存连接到乐器的 USB [TO DEVICE] 端口。

2.	 通过转至 [UTILITY] → Contents → Load 来打开画面。
您可以通过按住 [SHIFT] 按钮的同时按 [STORE] 按钮来打开同一画面。

3.	 在 Content Type 下，选择 Backup File。

4.	 选择所需的源 USB 闪存和包含设置的文件夹。

5.	 在 USB 闪存上选择要加载的所需文件。

(1) (2)

(3)

(1)	父文件夹名称

(2)	USB 闪存中当前选择的所需文件夹的名称

(3)	文件夹中已保存的文件列表
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5.	 连接外接MIDI 乐器

连接麦克风或音频设备
您可以将音频设备（如麦克风和 CD 播放机）以及电子乐器（如合成器）连接至此设备的 A/D INPUT 端口，以音频输入声
部（A/D INPUT 声部）形式播放输入音频。
与其他声部一样，您可以设置音量、声像、效果等。音频输入声部与其他声部混合并作为本乐器的声音输出。

连接麦克风和音频设备

1.	 确保关闭本乐器并将 A/D INPUT [GAIN] 旋钮设置为最小值。

2.	 将外接设备连接到后面板上的 A/D INPUT 插孔。
 连接麦克风时

A/D INPUT [L/MONO]

Mic.

注
确保使用动圈话筒。不能使用电容式麦克风。

 连接音频设备、电子乐器等的时候

A/D INPUT [R ]A/D INPUT [L /MONO]

L

R

(1) Stereo audio equipment 
     (CD player, etc.)

(1)	立体声音频设备（CD播放机等）

3.	 打开连接的设备，然后打开本乐器。

4.	 通过转至 [UTILITY] → Settings → Audio I/O 来打开画面。
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5.	 为连接到 A/D INPUT 插孔的设备选择 A/D Input 设置。
当连接麦克风或任何具有低输出电平的设备时，设置为 Mic。当连接音频设备、电子乐器或任何具有高输入电平的设
备时，设置为 Line。

6.	 按 [A/D INPUT] 按钮。
该按钮亮起，并启用连接到本乐器的音频设备的输入。

7.	 聆听连接到MODX M 的外接设备的声音，然后转动 A/D INPUT [GAIN] 旋钮来调节增益。

8.	 按 [PERFORMANCE (HOME)] 按钮并选择要与连接到MODX M 的外接设备一起使用的演奏组。

9.	 在对着麦克风唱歌或使用音频设备播放音频的同时弹奏键盘。
通过控制滑杆调节 A/D 输入音量。
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使用声码器

本乐器配备声码器。声码器是一种效果器，使用从麦克风接收到的音色输入的特征来处理此设备内部声音引擎的声音。如果
您一边弹奏键盘，一边对着麦克风说话，则乐器的声音将变为听起来像机器人的声音。
此机制基于人类发声的原理。声带发出的声音在口腔和鼻子中产生共鸣。口腔和鼻子就像滤波器一样，可以增强某些频率，
在声音中产生共振峰（特定频率的峰值）。
声码器效果应用此原理，从麦克风的音色输入中提取滤波特性，并使用多个带通滤波器再现共振峰。通过声码器传递乐器的
声音，可以产生机器人的音色效果。

Vocoder

(3)

(5)

(1)
Mic Input

Part Output

(2)
Part Output

(Keyboard Performance)
(4)

(1)	麦克风输入或声部输出

(2)	声部输出（乐器输出）

(3)	提取音色特点

(4)	使用滤波器再现共振峰

(5)	机器人般的声音

要使用声码器，请连接麦克风，在 Utility 画面中设置 A/D Input，然后调整增益。最后，选择使用声码器效果的演奏组，如
下所示。

1.	 在Performance 画面中，按 [CATEGORY] 按钮。

2.	 点击画面上的按钮以选择Pad/Choir 类别。
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3.	 点击 Category Search 画面上的搜索框，然后输入“Vocoder”。

4.	 将 Filter 设置为 Attribute 并选择 Single。
此时将显示声码器效果的演奏组列表。

5.	 选择所需的演奏组并按 [ENTER] 按钮确认。
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连接到计算机或外接MIDI 设备
后面板上的 USB 和 MIDI 端口用于连接计算机和外接 MIDI 设备。更改演奏组时，您可以使用这些端口将程序变更信息发送
到外接 MIDI 设备。

区域功能对于设置外接 MIDI 设备非常有用。

设置区域功能

区域功能可通过本乐器的键盘控制多个外接设备。
每个演奏组最多可以设置八个区域。
例如，您可以使用此功能按力度或音符范围在内部声音引擎和连接的外部声音引擎之间切换。

1.	 按 [PERFORMANCE (HOME)] 按钮打开 Performance 画面。

2.	 选择一个声部，然后通过选择 [EDIT/ ] → General/Pitch → Zone Settings 来打开画面。

3.	 检查Part Mode 设置。
选择 Internal 可播放来自声音引擎的声音，选择 External 可播放来自外部声音引擎的声音。
注
您可以在 [PART SELECT] 按钮启用时快速按两次 PART 按钮，在 Part Mode Internal 和 External 之间切换。

4.	 如有必要，设置 Tx/Rx Ch (Transmit-Receive Channel) 和 Note Limit 的参数。

5.	 按 [STORE] 按钮保存演奏组。
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连接并设置计算机

通过将计算机连接到本乐器，您可以使用计算机上的 DAW 或音序器软件来创作自己的音乐。
缩写词 DAW（数字音频工作站）是指用于录制、编辑和混合音频和 MIDI 的音乐软件。典型的 DAW 软件包括 Cubase、Logic、
Pro Tools 和 Live。

连接计算机并设置
通过将计算机连接到 USB [TO HOST] 端口，您可以发送和接收音频信号和 MIDI 信息。
需要 AB 型 USB 线缆以及用于发送和接收音频和 MIDI 的驱动程序来进行连接。
在 Windows 中，您必须安装 Yamaha Steinberg USB Driver。在 Mac 中，只需使用操作系统中包括的通用驱动程序即可正
常工作，因此不需要安装驱动程序。

如何安装 Yamaha Steinberg USB Driver

1.	 从下面显示的URL下载最新驱动程序。
https://download.yamaha.com/
注
•	也可以从上述 URL 获取有关系统要求的信息。
•	出于改进目的，Yamaha Steinberg USB Driver 可能会更新，恕不另行通知。欲了解更多详细信息和最新信息，请检查上述 URL。

2.	 解压下载的文件，并在计算机上安装 Yamaha Steinberg USB Driver。
有关如何安装驱动程序的说明，请参考下载文件中包含的安装指南。
将本乐器连接到计算机时，按下图所示，将 USB 线缆将 USB [TO HOST] 端口连接到计算机的 USB 端口。

(1) USB terminal (3) USB [TO HOST] terminal

(2) USB cable

(4) MODX M
     (Rear panel)

(1)	USB 端口

(2)	USB 线缆

(3)	USB [TO HOST] 端口

(4)	本乐器的后面板

https://download.yamaha.com/
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设置音频和MIDI 的发送和接收
使用 USB 线缆连接计算机，然后通过 USB 连接设置处理音频和 MIDI 的参数。

•	音频
只需连接 USB 线缆即可使用。如有必要，请更改采样频率和增益等设置。

• MIDI
连接线缆，然后设置用于发送和接收的参数。请按照以下步骤进行设置。
从 [UTILITY] → Settings → MIDI I/O → MIDI IN/OUT 打开画面，然后选择 USB。
设置本乐器以支持通过 USB [TO HOST] 端口发送和接收 MIDI。

关于音频通道
对于音频信号的输出，您可以使用 USB [TO HOST] 端口和 OUTPUT 插孔。音频信号输出到 USB [TO HOST] 端口，在采样
频率为 44.1kHz 时使用可达 10 个通道（5 个立体声通道）。
要选择将哪个信号输出到特定通道，请从 [PERFORMANCE (HOME)] → Part 选择 → [EDIT/ ] → General/Pitch → Part 
Settings 打开画面，然后选择适当的 Part Output。

对于音频信号的输入，您可以使用 USB [TO HOST] 端口和 A/D INPUT 插孔。
音频信号通过 USB [TO HOST] 端口传入，最多可包含 4 个通道（或 2 个立体声通道），在 Mixing 画面或 Performance Edit
画面上设置 Digital In L/R 和 Main L/R 的输出电平，并输出到 OUTPUT 端口。
此外，来自 A/D INPUT 端口的音频信号发送到本乐器的 A/D 输入部分，最多两个通道（一个立体声通道）。

MIDI 通道和MIDI 端口
MIDI 有 16 个通道，但对于大乐曲数据来说，16 个通道可能不够用。
因此，可使用 MIDI 端口的概念来处理超过 16 个通道的数据。每个 MIDI 端口可以处理 16 个通道。
•	 一条 MIDI 电缆一次可传输一个端口（16 个通道）的数据。
•	 但是，一条 USB 线缆能够同时处理最多 8 个端口（或 16×8=128 个通道）的 MIDI 数据。

在本乐器上，确定为 USB 端口提供的端口如下所示。

端口 1：端口用于处理本乐器的声音引擎部分
如果要在外接 MIDI 设备或计算机上播放声音引擎，请确保在外接 MIDI 设备或计算机上设置为端口 1。

端口 2：专用于使用DAW遥控器。

端口 3：专用于从MIDI 设备接收MIDI 信息并将其发送到另一台MIDI 设备（对于MIDI Thru）。
•	 通过 MIDI [OUT] 端口传递 USB [TO HOST] 端口接收的 MIDI 端口 3 数据。
•	 通过 USB [TO HOST] 端口以 MIDI 端口 3 数据形式传递 MIDI [IN] 端口接收的 MIDI 数据。

要通过 USB 线缆在乐器和计算机之间发送 MIDI 信息，需要选择适当的 MIDI 端口以及 MIDI 通道。在外接设备上设置适合
具体情况的端口设置。
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使用MIDI 2.0 功能
本乐器支持 MIDI 2.0 功能。通过将本乐器连接到符合 MIDI 2.0 操作要求的计算机，您可以使用比任何 MIDI 1.0 乐器的分辨
率都更高的数据。
有关 MIDI 2.0 的更多信息，请参阅 MIDI2.0 网站 (https://www.yamaha.com/2/midi-2-0/)。

有关支持的 MIDI 2.0 消息的详细信息，请参阅 Data List。
https://download.yamaha.com/

要使用 MIDI 2.0 功能，请先从 [UTILITY] → Settings → Advance → USB Driver Mode 访问设置，并将 Legacy Mode 设置
为 Off，然后连接符合 MIDI 2.0 操作要求的计算机。

关于使用计算机制作音乐
通过连接本乐器和计算机，您可以使用 DAW 软件，如以下示例所示。
•	 使用计算机上的 DAW 软件以 MIDI 或音频形式录制键盘演奏
•	 使用音源模块播放 DAW 软件上录制的乐曲

这些说明假设乐器和计算机已连接。下面是一些使用 DAW 软件和本乐器的示例。

在DAW上对键盘演奏进行MIDI 录音
这展示了如何在 DAW 上将键盘演奏录制为 MIDI 数据。

此乐器上的设置

1.	 通过转至 [UTILITY] → Settings → Quick Setup 来打开画面。

2.	 选择MIDI Rec on DAW。

3.	 按 [EXIT] 按钮关闭Quick Setup 画面，或按 [PERFORMANCE (HOME)] 按钮打开 Performance 画面，
然后选择要录制的演奏组。

https://www.yamaha.com/2/midi-2-0/
https://download.yamaha.com/
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DAW软件上的设置

1.	 启用MIDI Thru。
MIDI Thru 是一种设置，用于根据录制音轨上的设置，将 MIDI 信息从内置键盘发送到计算机并返回到乐器的音源 
模块。
如下所示，例如，从本乐器输入的 MIDI 数据将发送到通道 1。如果计算机上的 MIDI Thru 设置为 ON，则 MIDI 数据
将从计算机发送到通道 3 以在通道 3 处播放声音引擎。通过使用此设置，您可以录制键盘演奏，同时聆听与最终输出
相同的声音。

MODX M

USB [TO HOST] terminal

(1) Tone Generator 
(recognizing data 
over MIDI Channel 3)

(2) Keyboard 
(output via 
MIDI Channel 1)

MIDI Thru = on

IN
Ch1

OUT
Ch3

(3) Local Control = off

(4) Computer 
(DAW software such as Cubase)

(1)	音源模块（通过MIDI 通道 3识别数据）

(2)	键盘 (Ch1)

(3)	本地控制 = 关

(4)	计算机（DAW 软件，例如 Cubase）

2.	 在DAW上录制乐器演奏组。

使用声音引擎在DAW上播放乐曲
这展示了如何使用 DAW 软件作为多音色音源。
它允许您使用高品质 MIDI 音源，而不会对计算机的 CPU 造成太大负担。

此乐器上的设置

1.	 选择演奏组。
选择演奏组后，您可能会发现通过以下方法使用 [PERFORMANCE (HOME)] → Mixing 的 Mixing 画面将声部 1 至 16
进行混音很有帮助。
从 [UTILITY] → Effect Switch 画面中，将 Kbd Ctrl Lock 设置为 ON，以便设置每个声部的 Tx/Rx Ch. 来启用信息接
收。

DAW软件上的设置

1.	 对于要用于播放声音引擎的音轨，请将MIDI 输出设置为本乐器上的端口 1。

2.	 输入每个音轨的MIDI 数据。
在本乐器的 Mixing 画面上设置与每个音轨的 MIDI 通道对应的声音引擎。
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使用 Expanded Softsynth Plugin for MONTAGE M/MODX M
Expanded Softsynth Plugin for MONTAGE M/MODX M 是一款软件合成器，具有与硬件 MONTAGE M 和 MODX M 相同的声
音引擎系统。
由于该软件与硬件 MONTAGE M 或 MODX M 同步工作，因此相同的 MONTAGE M 或 MODX M 声音可以无缝集成到您的音
乐制作（软件对于 DAW 来说最为方便），以及您的现场表演（在舞台上使用实际乐器）中。这使您可以根据您的个人喜好
和特定应用使用任一版本的 MONTAGE M 或 MODX M。
有关 ESP 安装和激活的更多信息，请访问乐器附带的 Expanded Softsynth Plugin for MONTAGE M/MODX M Download 
Information 传单中的 MODX M 欢迎页面。

ESP 说明书可从下面的网站下载。
https://download.yamaha.com/

使用DAW Remote 功能
借助 DAW Remote 功能，您可以从本乐器上方面板的控制器控制 DAW 软件。
仅当乐器使用 USB 线缆连接到计算机时才可使用此功能。使用 MIDI 线缆连接时无法使用。

此乐器上的设置

1.	 使用 AB型 USB线缆将计算机连接到乐器的USB [TO HOST] 端口。

2.	 从以下位置选择DAW软件：[DAW REMOTE] → Settings → DAW。

DAW软件上的设置
本节介绍如何设置 DAW 软件。
根据 DAW 软件版本的不同，设置步骤可能有所不同，或者无法进行设置。有关详细信息，请参考所用 DAW 软件的相关使
用说明书。
注
一旦计算机和本乐器之间的连接丢失，即使重新连接后，DAW 软件也可能无法识别本乐器。如果发生这种情况，请在重新连接后重新启动
DAW。

•	 Cubase
1.	 Device/Studio → Device Settings.../Studio Setup... 打开对话框。

2.	 选择 MIDI → MIDI 端口设置，并为 MODX M-2 或 MODX M 的 Port 2 取消选中 All MIDI Input。

3.	 按下对话框左上角的 [+] 按钮，然后从列表中选择 Mackie Control。

4.	 选择 Remote Devices → Mackie Control。

5.	 将 MIDI 输入和 MIDI 输出设置为 MODX M-2 或 MODX M Port2。

6.	（可选）将所需功能分配给的 User Commands 的 F1–F8。

•	 Logic Pro
1.	 选择 Logic Pro X → Preferences → Advanced → 并选中“Show [Advanced Tools]”。

2.	 Logic Pro X → Control Surfaces → Setup... 打开对话框。

3.	 在 New → Install... 中，从 Mackie Control 选择 Mackie Designs。

4.	 将 Mackie Control 的输出端口和输入端口设置为 MODX M Port2。

5.	（可选）在 Logic Pro X → Control Surface → Controller Assignments... 中，将 Zone 设置为 Control Surface: Mackie 
Control，然后将功能分配给 Control F1–F8。

https://download.yamaha.com/
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•	 Pro Tools
1.	 Setup → Peripherals... 打开对话框。

2.	 选择 MIDI Controllers 选项卡。

3.	 将 Type 设置为 HUI，并将 Receive From 和 Send To 设置为预定义的选项 (Predefined) MODX M-2 或 MODX M，Port2。

•	 Live
1.	 Live → Preferences... 打开对话框。

2.	 选择 Link/MIDI 选项卡。

3.	 为 Control Surface 选择 MackieControl。

4.	 将 MIDI 输入和 MIDI 输出设置为 MODX M-2 或 MODX M Port2。

5.	（可选）通过在 MIDI Map 分配模式中设置 MIDI Note F#2–C#3 的操作，将所需功能分配至 F1–F8。
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连接智能设备

您可将智能手机和平板电脑等智能设备连接到本乐器。

与本乐器兼容的智能设备应用程序提供了更多方便和愉快的方式来使用本乐器。
有关应用程序和支持的设备的更多信息，请参阅 Yamaha 网站。

有关如何连接的详细信息，请在 Yamaha 网站上搜索“Smart Device Connection Manual”。
要与 iOS 设备进行音频通信，请根据接口 / 端口的类型准备以下适配器。
•	 Lighting 端口 ：Lightning 转 USB 3 相机适配器
•	 USB Type-C 端口 ：USB-C 数字 AV 多端口适配器
连接智能设备时，在乐器上转到 [UTILITY] → Settings → USB Driver Mode 并将其设置为 Generic。

连接外接MIDI 乐器

使用 USB 线缆和标准 MIDI 线缆（市售），您可以将外接 MIDI 乐器连接到本乐器。
可从内置键盘播放外接 MIDI 乐器，也可以从外接 MIDI 键盘或音序器播放音源模块。
注
您可以使用 USB [TO DEVICE] 端口或 MIDI 端口连接外接 MIDI 设备。

将外接MIDI 设备连接到MIDI 端口
使用 MIDI 端口时，请使用 MIDI 线缆连接外接 MIDI 设备，然后从 [UTILITY] → Settings → MIDI I/O 中选择 MIDI。

使用本乐器控制外接MIDI 声音引擎
您可以使用本乐器上的键盘或通过乐曲播放从外接 MIDI 声音引擎播放声音。
要单独播放内部声音引擎和外接 MIDI 声音引擎的声音，请使用区域功能。确保外接 MIDI 设备的 MIDI 发送通道与乐器的
MIDI 接收通道匹配。

设置本乐器的MIDI 接收通道
本乐器上的 MIDI 输出通道应设置为不同的值，具体取决于是否有任何声部将 Part Mode 设置为 External。

•	如果Part Mode 没有任何 External 声部
声部的 Common 或 Keyboard Control Switch 设置为 ON ：MIDI I/O Ch.
声部的 Keyboard Control Switch 设置为 OFF ：Tx/Rx Ch.

•	如果Part Mode 有 External 声部
声部的 Common 或 Keyboard Control Switch 设置为 ON：Tx Ch. 为此，Part Mode 设置为 External，Keyboard Control 
Switch 设置为 ON
声部的 Keyboard Control Switch 设置为 OFF ：Part Mode 设置为 External 和其他声部的 Tx Ch.
*Part Mode 设置为 Internal 的任何声部都不会发送 MIDI 信息。

为外接MIDI 声音引擎设置接收通道
请参阅外接 MIDI 声音引擎的使用说明书。

如果只想播放外接声音引擎的声音，请调低本乐器的音量，或从以下位置将 Local Control 设置为 OFF ：[UTILITY] →  
Settings → MIDI I/O。
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使用外接MIDI 键盘播放本乐器的声音
您可以使用外接 MIDI 键盘上的键来弹奏本乐器的演奏组并更改演奏组。
确保外接 MIDI 设备的 MIDI 发送通道与 MODX M 的 MIDI 接收通道匹配。

设置本乐器的MIDI 接收通道
声部的 Keyboard Control Switch 设置为 ON ：MIDI I/O Ch.
声部的 Keyboard Control Switch 设置为 OFF ：Tx/Rx Ch.
* 如果 Part Mode 设置为 External，声部将不会从外接设备接收 MIDI 信息。

设置外接MIDI 键盘的发送通道
请参阅外接 MIDI 键盘的使用说明书。

将USB MIDI 键盘连接到USB [TO DEVICE] 端口
通过将 USB MIDI 键盘连接到 USB [TO DEVICE] 端口，您可以像使用内置键盘一样使用所连接的键盘，具体取决于所连接
USB MIDI 键盘的功能。

须知
•	USB [TO DEVICE] 端口的额定值最大为 5 V/500 mA。请勿连接高于额定值的USB设备，否则可能造成本乐器的损坏。
•	请使用长度小于 3米的 AB型 USB线缆。

兼容的MIDI 设备
•	 符合 USB 标准的 MIDI 设备

USB MIDI 键盘等
•	 经过兼容性测试的 Yamaha MIDI 设备

CP88、CP73、MODX、MODX+、MONTAGE、MOTIF XF、MOXF、MX、reface、YC、MONTAGE M、SEQTRAK

有关MIDI 通信的特别说明
与通过 USB [TO DEVICE] 端口连接的设备进行 MIDI 通信时要遵循特殊规则，使设备能像内置键盘一样工作。
•	 MIDI 通信只能单向进行（从外接 MIDI 设备发送并由本乐器接收）。
•	 无论 MIDI IN/OUT 和 MIDI I/O Ch. 设置如何，都会接收所有 MIDI 数据。
•	 对于 Keyboard Control Switch 设置为 ON 的声部，会共享所有相应通道上接收到的数据。 
（例如，当声部 1 至 3 的 Keyboard Control Switch 设置为 ON 时，从通道 1 至 3 中任意一个接收的数据都将传送至声部

1 至 3。）
•	 Keyboard Control Switch 设置为 OFF 的每个声部仅接收该声部相应通道的数据。
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6.	 画面和参数

导航栏
本章介绍始终显示在画面上的导航栏。

(3)(1) (2) (4) (5) (7) (8) (9)(6)

(1)	HOME图标
该图标与上方面板上 [PERFORMANCE (HOME)] 按钮的功能相同。点击可显示 Performance 画面 (HOME)。

(2)	EXIT 图标
该图标与上方面板上 [EXIT] 按钮的功能相同。点击返回上一级画面。

(3)	INFORMATION区域
此区域显示当前选定画面的名称、声部、音素、操作器、振荡器和鼓键等信息。
点击  以切换声部、音素、操作器、振荡器和鼓键。
•	 标准声部

当选择标准声部时，音素、操作器和振荡器的状态显示在该区域的右侧。
当静音时，编号下方会显示 M 图标。

1 2 3 4 5 6 7 8
M S

音素 (AWM2)
当一个音素发声时，编号下方的  会点亮为 。当根据力度划分音素时，您可以检查正在
播放哪个音素。

Elements: 18 音素组的总数
指示灯显示正在播放的音素的音量

1 2 3 4 5 6 7 8
M S 操作器 (FM-X)

1 2 3 N
M S 振荡器 (AN-X)

•	 鼓声部
当选择鼓声部时，鼓键的状态显示在该区域的右侧。

Drum Keys: 73 鼓键组的总数
指示灯显示正在播放的鼓声部的音量
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(4)	VIEW图标
借助此功能，您可以选择 Performance 画面上的视图。点击可显示 Performance 画面上的视图列表。

(5)	EFFECT 图标
点击可显示 Effect Switch 画面。当插入效果器、系统效果器或主控效果器关闭时，指示灯熄灭。

(6)	QUICK SETUP图标
点击可显示 MIDI I/O 画面。

打开或关闭本地控制
图标亮时打开，图标灭时关闭。

当 MIDI IN/OUT 设置为 MIDI 时显示

当 MIDI IN/OUT 设置为 USB 时显示

(7)	TEMPO SETTING 图标
显示当前所选演奏组的速度。点击可显示 Tempo Settings 画面。

(8)	LIVE SET 图标
点击可显示 Live Set 画面。
当前所选插槽显示为蓝色。

(9)	UTILITY 图标
点击可显示最近打开的 Utility 画面。
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Performance 画面
您可以在 Performance 画面选择在键盘上演奏的演奏组或修改演奏组设置来自定义演奏组。

HOME

操作
按 [PERFORMANCE (HOME)] 按钮
点击 HOME 图标 ( )

(1) (2) (3)

(14)(13)

(4)

(11) (12)

(5)
(6)

(7)

(8)

(9)

(10)

(1)	Performance Name
显示所选演奏组的名称。点击可显示 Category Search、Edit、Recall 等的上下文菜单。

您可以使用数据轮、[INC/YES] 按钮和 [DEC/NO] 按钮切换演奏组。有两种切换方法。
•	 Default ( )

按照 Performance Category Search 画面上的演奏组列表的顺序切换。
•	 Live Set ( )

按照 Live Set 插槽的顺序切换。

您可以从 [UTILITY] → Settings → System → Perf Inc/Dec 设置切换方法。

您可以通过标记来检查演奏组的状态。
•	 喜好标记 ( )

打开 Favorite 开关时，会显示 。在 Performance Category Search 画面上也会显示该标记。
•	 编辑标记 ( )

当您更改演奏组中的参数时，将显示蓝色旗帜。当您使用 [STORE] 按钮保存设置时，编辑标志会关闭。
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(2)	Performance Flag
显示演奏组标记。

属性 说明

AWM2 演奏组仅由 AWM2 声音引擎声部组成

FM-X（1 种颜色） 演奏组仅由 FM-X 声音引擎声部组成

FM-X（2 种颜色） 使用包含 Smart Morph 信息的 FM-X 声部进行演奏

AN-X（1 种颜色） 使用 AN-X 声音引擎进行演奏

AN-X（2 种颜色） 演奏组使用包含 Smart Morph 信息的 AN-X 声部

MC 具有动态控制的演奏组

SSS 演奏组支持 Seamless Sound Switching

* 组合多种声音引擎类型的演奏组使用“+”符号来指示。

(3)	Oscilloscope
 Main L&R 输出显示为波形。

(4)	Part Indicator
当光标位于 Performance Name 或声部 1 至 8 上时，将显示声部 9 至 16 的状态。
当光标位于声部 9 至 16 时，将显示声部 1 至 8 的状态。
如果未使用声部 9 至 16，则不会显示任何内容。

(5)	各种参数的视图区域
根据 Display Mode，在这个视图区域中显示不同的参数。

(6)	Part Name
这里显示声部类型和类别，或声部名称。
点击可显示 Category Search、Edit、Copy 和 Property 的上下文菜单。
当选择了声部 1 以外的声部且已为该声部设置声音时，会显示 Category Search、Edit、Copy 和 Delete 的上下文菜单。

(7)	Keyboard Control Switch
您可以通过打开或关闭各个声部的 Keyboard Control Switch，来设置将同时播放哪些声部。
如果声部设置为 Common 或声部的 Keyboard Control Switch 设置为 On，您可以同时播放其 Keyboard Control Switch
设置为 On 的声部。
如果声部的 Keyboard Control Switch 设置为 Off，则在选定该声部的情况下弹奏键盘时，将会播放这些声音。
设置 ：Off、On

(8)	Part Mute
打开或关闭声部静音。
设置 ：Off、On

(9)	Part Solo
打开或关闭声部独奏。
设置 ：Off、On

(10)	Part Volume
设置声部的音量。
设置 ：0–127

(11)	Part Level Meter
显示声部的音频输出电平。
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(12)	[+] (Add)
点击可显示 Part Category Search 画面或 Performance Merge 画面，让您可以添加声部。

(13)	更改 Display Mode

(14)	更改 View Mode

更改 Display Mode
当您更改 Display Mode 时，Home 画面的视图区域中会显示不同的参数。
您可以通过转动相应的显示旋钮来选择不同的 Display Mode。

	� Range

Navigation
Navigation 画面会打开。

Fx Overview
FX Overview 画面会打开。

Control View
Control View 画面会打开。

Favorite
打开或关闭 Favorite 开关。
设置 ：Off、On

Note Limit
设置声部的音符范围（最低音符和最高音符）。
当指定的第一个音符高于第二个音符（例如，C5 至 C4）时，将演奏 C–2 至 C4 和 C5 至 G8 范围内的音符。
设置 ：C–2–G8

Velocity Limit
设置声部的力度范围。
设置 ：1–127
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	� FX/Pan

Var Return
设置变奏效果器处理的信号的输出电平（返回电平）。
设置 ：0–127

Rev Return
设置混响效果器处理的信号的输出电平（返回电平）。
设置 ：0–127

Pan
调整当前所选演奏组的声相位置（立体声位置）。
设置 ：L63–C（中央）–R63

Volume
调整当前所选演奏组的音量。
设置 ：0–127

Var (Part Variation Send)
设置发送到声部变奏效果器的信号电平。
设置 ：0–127

Rev (Part Reverb Send)
设置发送到声部混响效果器的信号电平。
设置 ：0–127

Dry (Part Dry Level)
设置声部的干音音量级别（或未经系统效果器处理的信号电平）。
设置 ：0–127

Pan (Part Pan)
调整声部的声相位置（在立体声场中）。
设置 ：L63–C（中央）–R63
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	� Arp/MS/Porta

Arp Select
选择琶音。
设置 ：1–8

MS Select
更改动态音序选择。
设置 ：1–8

Portamento Switch
将 Portamento Part Sw 设置为 On，即可为声部设置打开或关闭滑音。
此开关与上方面板的 [PORTAMENTO] 按钮关联。
设置 ：Off、On

Portamento Time
设置声部的滑音音高变化的时间长度（或速度）。
这是该声部的滑音时间的偏移值（相对于参考调整的值）。
设置 ：–64–+0–+63

Arp On/Off (Arpeggio Part Switch)
设置声部的琶音打开或关闭。
当琶音和琶音保持都打开时，将显示 Arp Hold On。
当琶音设置为 On 时，您可以在按住 [SHIFT] 按钮的同时点击画面上的 Arp On/Off 按钮来打开或关闭 Arp Hold。
设置 ：Off、On

MS On/Off (Motion Sequencer Part Switch)
打开或关闭声部的动态音序器。
设置 ：Off、On

Prt On/Off (Portamento Part Switch)
打开或关闭声部的滑音。
设置 ：Off、On

Time (Portamento Part Time)
设置声部的滑音音高变化的时间长度。
设置 ：0–127
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	� Mode/Transpose

MIDI I/O Ch.
为 Common 声部和 Keyboard Control Switch 设置为 On 的声部的输入和输出设置 MIDI 通道。
设置 ：Ch1–Ch16

Octave Shift (Keyboard Octave Shift)
以八度为单位改变琴键的音高。
这与上方面板的 OCTAVE 按钮关联。
设置 ：–3–+0–+3

Transpose (Keyboard Transpose)
以半音为单位改变琴键的音高。
设置 ：–11semi 至 +0semi 至 +11semi

注
如果音高超出了设备的声音来源部分可以播放的范围（C-2 到 G8），则会输出高一个（或低一个）八度的音符。

Int/Ext (Part Mode)
设置是使用乐器的内置声音来源 (Int) 还是外部声音来源 (Ext)。
设置 ：Int、Ext

Ch (Tx/Rx Ch)
当 Part Mode 设置为 Internal 且 Keyboard Control Switch 设置为 Off 时，设置用于发送和接收区域 MIDI 信息的通道。
设置 ：Ch1–Ch16、Off

Ch (Transmit Ch)
当 Part Mode 设置为 External 时，设置用于发送和接收区域 MIDI 信息的通道。
设置 ：Ch1–Ch16

Oct (Zone Octave)
以八度为单位改变区域的音高。
设置 ：–3–+0（标准）–+3

Trans (Zone Transpose)
以半音为单位改变区域的音高。
设置 ：–11–+0（标准）–+11
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	� Filter

Cutoff (Cutoff Frequency)
通过设置滤波器的截止频率来改变声音。
选择低通滤波器时，此处的值越大，声音越明亮，值越小，声音越低沉。
此值指定为声部滤波器截止频率的偏移值。
设置 ：–64–+0–+63

Resonance
通过调整接近截止频率的信号电平来为声音增加特殊特性。
此值指定为声部滤波器共鸣的偏移值。
设置 ：–64–+0–+63

FEG Depth
设置 FEG 控制的截止频率变化的深度范围。
此值指定为声部的 FEG 深度的偏移值。
设置 ：–64–+0–+63

Cut (Part Cutoff Frequency)
通过设置声部的滤波器截止频率来改变声音。
选择低通滤波器时，此处的值越大，声音越明亮，值越小，声音越低沉。
此值指定为 Filter Type 画面上设置的滤波器截止频率的偏移值。
设置 ：–64–+0–+63

Res (Part Resonance)
通过调整接近声部截止频率的信号电平来为声音增加特殊特性。
此值指定为在 Filter Type 画面上设置的滤波器共鸣的偏移值。
设置 ：–64–+0–+63

FEG (Part FEG Depth)
调整通过 Filter Type 画面中的 FEG 设置来控制的截止频率变化范围。
当设置为 0 时，将按原样使用 Filter Type 画面中的设置。
设置 ：–64–+0–+63
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更改 View Mode
您可以使用 View Mode 从 Home 画面访问更多详细信息。
您可以通过转动相应的显示旋钮来选择不同的 View Mode。
当光标位于 Performance Name 上时，按 [PERFORMANCE (HOME)] 按钮也会更改视图。

	� Part Info
•	 Element Sw/Level
在当前所选声部为标准声部 (AWM2) 时显示。

Element Sw (Element Switch)
打开 / 关闭音素。
设置 ：Off、On

Element Level
设置音素的输出电平。
设置 ：0–127

•	 Drum Key
在当前所选声部为鼓声部时显示。

Drum Key Level
设置鼓键的输出电平。
设置 ：0–127
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•	 Algorithm
在当前所选声部为标准声部 (FM-X) 时显示。

Algorithm (Algorithm Number)
更改算法。
点击算法图像会调出 Algorithm Search 画面。
设置 ：请参阅 Data List

Feedback (Feedback Level)
设置反馈（使用调制器调制的载波的输出波形来调制调制器本身）的程度（电平）。
设置 ：0–7

•	 Virtual Analog
在当前所选声部为标准声部 (AN-X) 时显示。

1–3 (Oscillator 1–3)
打开 Part Edit (AN-X) 的 OSC/Tune 画面。

N (Noise)
打开 Part Edit (AN-X) 的 Noise 画面。

Oscillator Level
设置振荡器的输出电平。
设置 ：0–511
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Noise Level
设置噪声电平。
设置 ：0–511

Filter 1, 2
打开 Part Edit (AN-X) 的 Filter Type 画面。

Amplifier
打开 Part Edit (AN-X) 的 Amp EG 画面。

	� Smart Morph
此时会显示 Smart Morph 贴图。
但是，当没有 Smart Morph 信息时，则不会显示贴图。

	� Motion Seq
显示在当前所选声部的 View Lane 中设置的通道。
但是，如果通道设置为 Off，则不会显示该通道。
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	� Velocity - Note
此时会显示 Velocity - Note 视图。
当使用多个声部时，此选项对于设置力度分割很方便。

	� Part - Note
此时会显示 Part - Note 视图。
当 View Mode 设置为 Part Info 且所选声部为 Common 时显示。
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	� Ribbon
当 View Mode 为 Ribbon 时显示。
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Motion Control

在 Motion Control 画面上，您可以设置应用于整个演奏组的动态控制设置。

Super Knob
在 Super Knob 画面上，您可以设置用于控制超级旋钮的值。
您可以设置超级旋钮和每个可指定旋钮之间的关联。

操作
[PERFORMANCE (HOME)] → Motion Control → Super Knob

(1)

(2)

(3)

(4)

(5)

(1)	Super Knob Link

(2)	Assignable Knob 1–8 Value

(3)	Assignable Knob 1–8 Value Left

(4)	Assignable Knob 1–8 Value Mid

(5)	Assignable Knob 1–8 Value Right

MS Master (Motion Sequencer Master Switch)
将整个演奏组的动态音序器设置为打开或关闭。
此开关与上方面板的 [MSEQ] 按钮关联。
设置 ：Off、On

Super Knob MS (Super Knob Motion Sequencer Switch)
将超级旋钮所用的动态音序器设置为打开或关闭。
设置 ：Off、On

Edit Super Knob
Common Edit Control Assign 画面会打开。您可以将参数设置为由超级旋钮控制。
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LED Pattern
设置超级旋钮的发光模式。
设置 ：	 Off、Type 1、Type 2-1、Type 2-2、Type 3-1、Type 3-2、Type 4-1、Type 4-2、Type 5-1、Type 5-2、Type 6、

Type 7-1、Type 7-2、Type 8-1、Type 8-2、Type 9、Type 10、Type 11、Type 1B、Type 2-1B、Type 2-2B、
Type 3-1B、Type 3-2B、Type 4-1B、Type 4-2B、Type 5-1B、Type 5-2B、Type 6B、Type 7-1B、Type 7-2B、
Type 8-1B、Type 8-2B、Type 9B、Type 10B、Type 11B、Rotary 1、Rotary 2、Rotary 3、Rotary 4、Rotary 
5、Rotary 6、Rotary 7、Rotary 8、Rotary 9、Rotary 10

Super Knob (Super Knob Value)
设置超级旋钮值。
设置 ：0–1023

Mid Position (Super Knob Mid Position)
设置超级旋钮的 Mid 值。
设置 ：Off、1–1022

Super Knob Link
设置与超级旋钮关联的相应旋钮。
当这些开关设置为 Off 时，超级旋钮的操作不会影响旋钮的参数。
设置 ：Off、On

Assignable Knob 1 – 8 Value
显示可指定旋钮（旋钮 1–8）的当前值。
设置 ：0–1023

Assignable Knob 1 – 8 Value Left
当 Super Knob Value 设置为 0（或超级旋钮向左转到底）时，显示可指定旋钮（旋钮 1–8）的值。
设置 ：0–1023

Assignable Knob 1 – 8 Value Mid
当 Super Knob Value 设置为 Mid Position 时，显示可指定旋钮（旋钮 1–8）的值。
当 Mid Position 为 Off 时，此参数不可用。
设置 ：0–1023

Assignable Knob 1 – 8 Value Right
当 Super Knob Value 设置为 1023（或超级旋钮向右转到底）时，显示可指定旋钮（旋钮 1–8）的值。
设置 ：0–1023

注
•	当您将 Value Left 设置为较小的值并将 Value Right 设置为较大的值时，旋钮 1-8 将沿着与超级旋钮相同的方向移动。
•	当您将 Value Right 设置为较小的值并将 Value Left 设置为较大的值时，旋钮 1-8 将沿着与超级旋钮相反的方向移动。
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Knob Auto
在 Knob Auto 画面中，您可以为超级旋钮设置动态音序器（超级旋钮动态音序器）。您可以将动态音序器设置为自动控制超
级旋钮值。
超级旋钮只能使用一个通道。
注
整个演奏组最多可同时使用八个通道。然而，为 Knob Auto 画面使用的通道不包括在此处提到的八个通道中。

操作
[PERFORMANCE (HOME)] → Motion Control → Knob Auto

Motion Seq Master Sw (Motion Sequencer Master Switch)
将整个演奏组的动态音序器设置为打开或关闭。
此开关与上方面板的 [MSEQ] 按钮关联。
设置 ：Off、On

Super Knob MS Sw (Super Knob Motion Sequencer Switch)
将超级旋钮动态音序器设置为打开或关闭。
设置 ：Off、On

MS FX (Super Knob Motion Sequencer FX Receive)
设置受超级旋钮操作影响的旋钮。
设置 ：Off、On

Trigger (Super Knob Motion Sequencer Trigger Receive)
设置为从 [MSEQ TRIGGER] 按钮接收信号。
设置为 On 时，除非按 [MSEQ TRIGGER] 按钮，否则不会播放动态音序。
设置 ：Off、On

Sequence Select (Motion Sequence Select)
更改动态音序类型选择。
设置 ：1–8

SK MS Random (Super Knob Motion Sequencer Randomness)
设置音序步进值变化的随机性。
设置 ：0–127

Edit Sequence
Super Knob Motion Sequence Edit 画面会打开。
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	� Sync/Speed 选项卡
Sync (Super Knob Motion Sequencer Sync)
选择超级旋钮动态音序的播放速度和时间。
设置 ：	 Off、Tempo、Beat

Off：单独播放超级旋钮动态音序器
Tempo：以演奏组速度播放。
Beat ：与节拍同步播放。

•	当 Sync 设置为Off时

Speed (Super Knob Motion Sequencer Speed)
设置动态音序的播放速度。
设置 ：0–127

Delay Time (Super Knob Motion Sequencer Lane Key On Delay Time Length)
设置开始播放动态音序的延迟时间。
设置 ：0–127

Fade In Time (Super Knob Motion Sequencer Lane Fade In Time Length)
设置动态音序达到最大振幅的时间。
设置 ：0–127

•	当 Sync 设置为Off之外的其他设置时

Unit (Super Knob Motion Sequencer Unit Multiply)
设置拉伸或压缩超级旋钮动态音序器播放时间的百分比。
设置 ：	 50%–6400%，Common

200%:播放时间加倍，速度减半
100%:播放时间保持不变
50%:播放时间减半，速度加倍
Common：应用在 Unit 中设置且对所有声部通用的值

Delay Steps (Super Knob Motion Sequencer Lane Key On Delay Step Length)
设置开始播放动态音序的延迟时间。
设置 ：0–32

Fade In Steps (Super Knob Motion Sequencer Lane Fade In Step Length)
设置动态音序达到最大振幅的时间。
设置 ：0–32

Vel Limit (Super Knob Motion Sequencer Velocity Limit)
设置播放动态音序的力度范围（最低和最高值）。
设置 ：1–127
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	� Loop/Length 选项卡
Key On Reset (Super Knob Motion Sequencer Key On Reset)
当您按键盘上的任意键时重置动态音序播放。
当 Trigger 为 On 时，此参数不可用。
设置 ：	 Off、Each-On、1st-On

Each-On ：每次演奏任何音符时，都会从头开始播放
1st-On ：从弹奏的第一个音符处开始播放。如果在保持第一个音符时演奏第二个音符，则播放不会复位。

Loop (Super Knob Motion Sequencer Loop)
将动态音序设置为循环播放（重复）或单次播放。
设置 ：Off、On

Loop Start (Super Knob Motion Sequencer Loop Start)
指定动态音序循环播放的起点。
设置 ：1–16（应低于 Length 设置）

Length (Super Knob Motion Sequence Length)
设置动态音序长度。
设置 ：1–16（应高于 Loop Start 设置）

MS Grid (Super Knob Motion Sequence Grid)
设置动态音序中的步级长度。
设置 ：60, 80, 120, 160, 240, 320, 480
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	� Super Knob Motion Sequence Edit
超级旋钮动态音序器的设置画面。
您可以创建最多 16 个步级的音序。

Loop Start (Super Knob Motion Sequencer Loop Start)
指定动态音序循环播放的起点。
设置 ：1–16（应低于 Length 设置）

Length (Super Knob Motion Sequence Length)
设置动态音序长度。
设置 ：1–16（应高于 Loop Start 设置）

MS Grid (Super Knob Motion Sequence Grid)
设置动态音序中的步级长度。
设置 ：60, 80, 120, 160, 240, 320, 480

Sequence Select (Motion Sequence Select)
更改动态音序类型选择。
设置 ：1–8

Polarity (Super Knob Motion Sequence Polarity)
设置动态音序的极性。
设置 ：	 Unipolar、Bipolar

Unipolar ：参数更改仅使用正值
Bipolar ：参数更改使用正值和负值

Amplitude (Super Knob Motion Sequence Amplitude)
设置动态音序的变化程度。
设置 ：0–127

Smooth (Super Knob Motion Sequence Smoothness)
设置动态音序随时间变化的平滑度。
设置 ：0–127
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Job
调出作业菜单。

•	 Store Sequence
保存（存储）编辑过的动态音序。

•	 Load Sequence
加载动态音序。

•	 Copy Sequence
复制动态音序。

Super Knob Motion Sequence Step Value
设置动态音序中每个步级的值。
您可以使用控制滑杆 1 至 8 来更改步级 1 至 8 以及步级 9 至 16 的值，具体取决于光标位置。
设置 ：0–127

Super Knob Motion Sequence Step Type
设置动态音序中每个步级的类型和方向。
设置 ：A、B、Reverse A、Reverse B

Pulse A (Super Knob Motion Sequence Step Curve Type A)
Pulse B (Super Knob Motion Sequence Step Curve Type B)
选择 Pulse A 和 Pulse B 的参数变化曲线。
使用 Super Knob Motion Sequence Step Type 来选择每个步级要使用的曲线类型。
纵轴表示时间，横轴表示步进值。
设置 ：	� （当选定了预置库时）Standard、Sigmoid、Threshold、Bell、Dogleg、FM、AM、M、Discrete Saw、Smooth 

Saw、Triangle、Square、Trapezoid、Tilt Sine、Bounce、Resonance、Sequence、Hold、Harmonic、Steps
（当选定了用户库时）Init Curve 1–32
（加载库文件时）Library 1–24 内的 Curve

Edit User Curve
当为 Pulse A 和 Pulse B 选定了 Init Curve 时显示。
User Curve Edit 画面会打开。

Prm 1 (Super Knob Motion Sequence Step Curve Parameter 1)
Prm 2 (Super Knob Motion Sequence Step Curve Parameter 2)
调整动态音序中步进曲线的形状。此外，参数值的范围因 Curve Type 而异。
根据 Curve Type，此设置不可用。

Control (Super Knob Motion Sequence Step Curve Shape Control Switch)
启用或禁用使用旋钮来控制动态音序的步进曲线形状。
仅当 MS FX (Super Knob Motion Sequencer FX Receive) 设置为 On 时显示。
根据 Curve Type，此设置不可用。
设置 ：Off、On
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	� User Curve Edit
这是用户曲线的设置画面。
您可以创建 8 点 Linear 曲线或 8 步曲线。

Curve No. (Curve Number)
指示当前曲线编号。
设置 ：1–32

Curve Name
您可以使用新名称来保存正在编辑的曲线。您可以使用最多 20 个字母数字字符。

Curve Type
设置曲线类型。
设置 ：Linear、Step

Input
设置曲线的输入电平。
Input 1 固定为值 0。当 Curve Type 设置为 Linear 时，Input 8 固定为值 1023。
设置 ：0–1023

Output
设置曲线的输出电平。
设置 ：0–1023
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Mixing

在 Mixing 画面上，您可以通过调整每个声部的音量来更改混音并进行效果器设置。
Mixing 画面中的设置会保存（存储）在演奏组中。

操作
[PERFORMANCE (HOME)] → Motion Control → Super Knob

Part 1–16 (Part 1–16 Switch)
Audio (Audio Switch)
更改视图。
设置 ：Part 1–16、Audio（Part 1–8、Audio Part、Master）

	� Part 1–16 视图
设置声部 1 至 16 的混音。

(1)(2)

(4)(3)
(1)	Part Category

(2)	Keyboard Control

(3)	Volume

(4)	Part Level Meter



94MODX M 使用说明书

Part Category
显示所选声部的主类别。
点击可显示 Category Search、Edit、Property 等的上下文菜单。
当选择了声部 1 以外的声部且已为该声部设置声音时，会显示 Category Search、Edit、Copy 和 Delete 的上下文菜单。点
击 [+] 可添加一个声部。
设置 ：请参阅 Data List

Mute/Solo Switch
Kbd Ctrl Switch
在 Mute/Solo 视图和键盘控制视图之间切换。

Mute (Part Mute)
Solo (Part Solo)
打开或关闭声部的静音和独奏。
设置 ：Off、On

Keyboard Control
打开或关闭键盘控制。
对于声部 9 至 16，不会显示按钮，因为这些声部的键盘控制无法设置为 On。
设置 ：Off、On

3-band (3-band EQ Switch)
2-band (2-band EQ Switch)
在声部 1 至 16 的 2 频段 EQ 视图和 3 频段 EQ 视图之间切换。
设置 ：3-band、2-band

EQ (Equalizer)
以 3-band 或 2-band 视图显示 EQ 设置。
点击该区域可调出声部 EQ 的上下文菜单。

Rev Send (Reverb Send)
设置从声部 1 至 16 发送到混响效果器的信号电平。
设置 ：0–127

Var Send (Variation Send)
设置从声部 1 至 16 发送到变奏效果器的信号电平。
设置 ：0–127

Dry Level
设置声部 1 至 16 的干音音量级别（或未经系统效果器处理的信号电平）。
设置 ：0–127

Pan
调整声部 1 至 16 的声相位置（在立体声场中）。
设置 ：L63–C（中央）–R63

Volume
设置声部 1 至 16 的音量。
设置 ：0–127

Part Level Meter
显示声部 1 至 16 的电平。
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	� Audio 视图
设置音频声部的混音。

(1)

(9)(8) (12)(11)(10) (14)(13) (15)

(2) (3) (4) (5)

(6)

(7)

(1)	Part Category

(2)	Digi (Digital Part)

(3)	Main (USB Main Part)

(4)	AD (A/D Part)

(5)	Mst (Master)

(6)	A/D Part EQ

(7)	Master EQ

(8)	Digital Part Volume

(9)	Part Level Meter

(10)	Digi (Digital Part Level Meter)

(11)	USB Main Monitor Volume

(12)	Main (USB Main Monitor Level 
Meter)

(13)	A/D Part Volume

(14)	AD (A/D Part Level Meter)

(15)	Performance Volume

Part Category
显示所选声部的主类别。
点击可显示 Category Search、Edit、Property 等的上下文菜单。
当选择了声部 1 以外的声部且已为该声部设置声音时，会显示 Category Search、Edit、Copy 和 Delete 的上下文菜单。点
击 [+] 可添加一个声部。
设置 ：请参阅 Data List

Digi (Digital Part)
Main (USB Main Part)
AD (A/D Part)
Mst (Master)
点击可显示 Edit 等的上下文菜单。

Mute/Solo Switch
Kbd Ctrl Switch
在 Mute/Solo 视图和键盘控制视图之间切换。
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Mute (Part Mute)
Solo (Part Solo)
打开或关闭声部的静音和独奏。
设置 ：Off、On

A/D Part EQ
点击该区域可调出声部 EQ 的上下文菜单。

Digital Part Reverb Send
A/D Part Reverb Send
设置从 A/D 声部或数字声部发送到混响效果器的信号电平。
设置 ：0–127

Digital Part Variation Send
A/D Part Variation Send
设置从 A/D 声部或数字声部发送到变奏效果器的信号电平。
设置 ：0–127

Digital Part Dry Level
A/D Part Dry Level
设置数字声部或 A/D 声部的干音音量级别（或未经系统效果器处理的信号电平）。
设置 ：0–127

Digital Part Pan
A/D Part Pan
调整数字声部或 A/D 声部或数字声部的声相位置（在立体声场中）。
设置 ：L63–C（中央）–R63

Digital Part Volume
A/D Part Volume
USB Main Monitor Volume
设置音频声部的音量。
设置 ：0–127

Master EQ
显示 5 频段参数 EQ。
点击该区域可调出 Master EQ Edit 的上下文菜单。

Rev Return (Reverb Return)
Var Return (Variation Return)
设置混响效果器或变奏效果器处理的信号的输出电平（返回电平）。
设置 ：0–127

Rev Send (Reverb Send)
设置发送到混响效果器的信号电平。
设置 ：0–127

Var Send (Variation Send)
设置发送到变奏效果器的信号电平。
设置 ：0–127
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Pan (Performance Pan)
设置演奏组的声相位置（在立体声场中）。
此参数值补偿每个声部的 Pan 设置。
设置 ：L63–C（中央）–R63

Performance Volume
设置演奏组的音量。
设置 ：0–127

Part Level Meter
Digi (Digital Part Level Meter)
Main (USB Main Monitor Level Meter)
AD (A/D Part Level Meter)
显示声部 1 至 8 以及音频声部的电平。
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Scene

在 Scene 画面上，您可以将琶音类型、动态音序类型和声部参数的设置注册到每个 SCENE 按钮。
在这个画面中，将相应的 Memory (Memory Switch) 设置为 On，并编辑所需的参数值，以便可以将设置保存到场景中。
注
可以从 Scene 以外的画面设置场景功能。您可以通过移动相应的旋钮和滑块来更改分配的 Scene 参数，并通过同时按住 [SHIFT] 按钮和所
需的 SCENE 按钮来注册设置。

操作
[PERFORMANCE (HOME)] → Scene

(1)

(1)	Scene Select

Scene Select
选择 Scene 选项卡来注册设置。
Scene1 至 Scene8 选项卡与上方面板的 SCENE 按钮关联。
设置 ：1–8

Memory (Memory Switch)
选择每个参数值（例如琶音、动态音序器、超级旋钮、超级旋钮链接、混音、键盘控制、振幅包络发生器和 Arp/MS FX）来
注册到场景。
当这些开关设置为 Off 时，即使选择了相应的选项卡，画面中也不会显示参数值。
设置 ：Off、On

Part 1–16 / Common
在 Part1-16 视图和 Common 视图之间切换。
在 Mixing 1、Mixing 2、Kbd Ctrl、AEG、Arp/MS FX1 和 Arp/MS FX2 选项卡中显示。

Offset (Scene Mixing / AEG Value Mode Switch)
通过将 Offset 设置为 Off，可以对某些 Scene 参数进行微调。
在 Mixing 1、Mixing 2 和 AEG 选项卡中显示。
设置 ：Off（绝对值）、On（偏移）
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当 Arp 和Motion Seq 的 Memory Switch 设置为On时

Motion Seq Master (Motion Sequencer Master Switch)
将整个演奏组的动态音序器设置为打开或关闭。
设置 ：Off、On

Motion Seq Select (Motion Sequence Select)
更改动态音序选择。
设置 ：1–8

Arp Master (Arpeggio Master Switch)
将整个演奏组的琶音设置为打开或关闭。
设置 ：Off、On

Arp Select (Arpeggio Select)
更改琶音选择。
设置 ：1–8

当 Super Knob 和 Link 的 Memory Switch 设置为On时

Super Knob (Super Knob Value)
设置超级旋钮值。
设置 ：0–1023

Super Knob Link
将超级旋钮和 Assignable Knob 1–8 之间的关联设置为打开或关闭。
当此开关设置为 Off 时，超级旋钮的操作不会影响 Assignable Knob 的参数。
设置 ：Off、On
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当Mixing 1 和 Mixing 2 的 Memory Switch 设置为On时

	� Mixing 1
Part 1–16 视图 ：显示 Part 1–16 的 Scene 参数。
Common 视图 ：显示 Part 1–8 和 Common 的 Scene 参数。
Common 参数应用于整个演奏组。

•	 Part 1–16 视图

Rev Send (Reverb Send)
设置每个声部的混响发送。
设置 ：0–127

Var Send (Variation Send)
设置每个声部的变奏发送。
设置 ：0–127

Dry Level
设置每个声部的干音音量级别。
设置 ：0–127

Pan
调整每个声部的声相位置（在立体声场中）。
设置 ：L63–C（中央）–R63

Volume (Part Volume)
设置每个声部的音量。
设置 ：0–127

•	 Common视图

Rev Return (Reverb Return)
设置混响返回。
设置 ：0–127

Var Return (Variation Return)
设置变奏返回。
设置 ：0–127

Pan (Performance Pan)
调整演奏组的声相位置（在立体声场中）。
设置 ：L63–C（中央）–R63
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	� Mixing 2
•	 Part 1-16 视图

当Offset 设置为On时

Cutoff (Filter Cutoff Frequency)
设置每个声部的截止频率。
设置 ：–64–+0–+63

Res (Filter Resonance/Width)
设置每个声部的滤波器共鸣或滤波器宽度。
设置 ：–64–+0–+63

FEG Depth
设置每个声部的 FEG 深度。
设置 ：–64–+0–+63

当Offset 设置为Off时
通过将 Offset 设置为 Off，可以对某些 Scene 参数进行微
调。

Cutoff 
设置 ：（AN-X、FM-X）：0–1023

Res
设置 ：(AN-X) ：0–255
设置 ：(FM-X) ：0–127

FEG Depth
设置 ：(AN-X) ：–9600–+0–+9600
设置 ：(FM-X) ：–64–+0–+63

注
当您希望同时使用 Smart Morph 和 Scene 时，建议将 Offset 设置
为 On。

Mute (Part Mute)
打开或关闭声部的静音。
设置 ：Off、On

Volume (Part Volume)
设置声部的音量。
设置 ：0–127

•	 Common视图

Cutoff (Cutoff Frequency)
设置声部截止频率的偏移值。
设置 ：–64–+0–+63

Res (Filter Resonance/Width)
设置声部滤波器共鸣或滤波器宽度的偏移值。
设置 ：–64–+0–+63

FEG Depth
此值指定为 Part FEG Depth 的偏移值。
设置 ：–64–+0–+63
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当Kbd Ctrl Memory Switch 设置为On时

Kbd Ctrl (Part Keyboard Control Switch)
打开或关闭声部的键盘控制。
当声部的键盘控制设置为 Off 时，弹奏键盘时不会发出声音。
设置 ：Off（灰色）、On（绿色）
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当 AEG的Memory Switch 设置为On时

•	 Part 1-16 视图

当Offset 设置为On时

Attack (AEG Attack Time)
设置声部的 AEG 起音时间。
设置 ：–64–+0–+63

Decay (AEG Decay Time)
设置声部的 AEG 衰减时间。
设置 ：–64–+0–+63

Sustain (AEG Sustain Level)
设置声部的 AEG 延音电平。
设置 ：–64–+0–+63

Release (AEG Release Time)
设置声部的 AEG 释音时间。
设置 ：–64–+0–+63

当Offset 设置为Off时
通过将 Offset 设置为 Off，可以对某些 Scene 参数进行 
微调。

Attack
设置 ：(AN-X) ：0–255

Decay
设置 ：(AN-X) ：0–255

Sustain
设置 ：(AN-X) ：0–511

Release
设置 ：(AN-X) ：0–255

•	 Common视图

Attack
设置声部的 Attack (AEG Attack Time) 偏移值。
设置 ：–64–+0–+63

Decay
设置声部的 Decay (AEG Decay Time) 偏移值。
设置 ：–64–+0–+63

Sustain
设置声部的 Sustain (AEG Sustain Level) 偏移值。
设置 ：–64–+0–+63

Release
设置声部的 Release (AEG Release Time) 偏移值。
设置 ：–64–+0–+63
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当 Arp/MS FX 1 和 Arp/MS FX 2 的 Memory Switch 设置为On时

	� Arp/MS FX 1
•	 Part 1-16 视图

Swing
设置每个声部的琶音或动态音序器的摇摆值。
设置 ：–120–+0–+120

Unit (Part Unit Multiply)
设置每个声部的琶音或动态音序器播放时间的拉伸或压缩
百分比。
设置 ：		  50%–400%，Common

200%:播放时间加倍，速度减半
100%:播放时间保持不变
50%:播放时间减半，速度加倍
Common：应用在 Unit (Common Unit Multiply)
中设置且对所有声部通用的值

Gate Time (Arp Gate Time Rate)
设置每个声部的琶音门限时间率。
设置 ：0%–200%

Velocity (Arp Velocity Rate)
设置每个声部的琶音力度率。
设置 ：0%–200%

•	 Common视图

Swing
设置每个声部的 Swing 偏移值。
设置 ：–120–+0–+120

Unit (Common Unit Multiply)
设置所有声部的 Unit Multiply。
设置 ：		  50%–400%

200%:播放时间加倍，速度减半
100%:播放时间保持不变
50%:播放时间减半，速度加倍

Gate Time (Arp Gate Time Rate)
设置每个声部的 Arpeggio Gate Time Rate 偏移值。
设置 ：–100–+0–+100

Velocity (Arp Velocity Rate)
设置每个声部的 Arpeggio Velocity Rate 偏移值。
设置 ：–100–+0–+100
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	� Arp/MS FX 2
•	 Part 1-16 视图

Amp (Motion Sequencer Amplitude Part Offset)
设置每个声部的 Motion Sequencer Amplitude 偏移值。
设置 ：–127–+0–+127

Shape (Motion Sequencer Pulse Shape Part Offset)
设置每个声部的 Motion Sequencer Pulse Shape 偏移值。
设置 ：–100–+0–+100

Smooth (Motion Sequencer Smoothness Part Offset)
设置每个声部的 Motion Sequencer Smoothness 偏移值。
设置 ：–127–+0–+127

Random (Motion Sequencer Randomness)
设置每个声部的 Motion Sequencer Randomness 偏移值。
设置 ：0–127

•	 Common视图

Amp (Motion Sequencer Amplitude Performance 
Offset)
设置所有声部的 Motion Sequencer Amplitude 偏移值。
设置 ：–127–+0–+127

Shape (Motion Sequencer Pulse Shape Performance 
Offset)
设置所有声部的 Motion Sequencer Pulse Shape 偏移值。
设置 ：–100–+0–+100

Smooth (Motion Sequencer Smoothness 
Performance Offset)
设置所有声部的 Motion Sequencer Smoothness 偏移值。
设置 ：–127–+0–+127

Random (Motion Sequencer Randomness 
Performance Offset)
设置所有声部的 Motion Sequencer Randomness 偏移值。
设置 ：–127–+0–+127
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Play/Rec

在 Play/Rec 画面中，您可以将模板和乐曲录制到本乐器的内置存储器中，将音频录制到 USB 闪存上，以及播放录音。

Pattern

	�播放和播放待机

操作
[SONG/PATTERN] 按钮 → Pattern 
[PERFORMANCE (HOME)] → Play/Rec → Pattern
[]（播放）按钮 → Pattern

(1)

(1)	Link Icon

Pattern Name
显示所选模板的名称。
点击可显示 Load、Rename 和 New Pattern 的上下文菜单。
当光标位于 Pattern Name 上时，您可以使用 [INC/YES] 和 [DEC/NO] 按钮选择模板。

Link Icon
如果用于录制模板的演奏组与所选演奏组相同，则会显示 Link Icon。如果不同，则显示断开的 Link Icon。

Performance Name
显示所选演奏组的名称。
注
当您更改演奏组中的参数时，Performance Name 的右上角将显示蓝色旗帜。

Click Settings
打开 Tempo Settings 画面。
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Time Signature
显示模板的仪表。

Position
设置开始播放和录制的位置，以及当前播放位置。
左边显示的数字是小节，右边显示的数字是节拍和击打声。

Tempo
设置模板播放的速度。
设置 ：5–300

Store Pattern & Perf Settings (Store Pattern and Performance Settings)
保存编辑的模板和使用的演奏组之间的链接。
注
如果您有已编辑的演奏组参数，则还需要存储演奏组。

Edit/Job
打开模板编辑和作业画面。通过使用模板功能，您可以为每个场景注册一个音序。

Scene
显示所选场景编号。
此开关与上方面板上的 SCENE 按钮关联。

Length (Section Length)
设置所选场景的音序长度。
设置 ：1–256

Key On Start
将模板设置为在按下键盘上的某个键时开始录制或播放。
设置 ：Off、On

Chain
启用连接播放。
设置 ：Off、On

Undo ***
取消上一个操作并返回之前的状态。
在录制一个音序后，使用一个或多个作业时，此按钮变得可用。

Redo ***
恢复使用撤销按钮取消的操作。仅在使用 Undo *** 后才会激活此按钮。

Part 1–8
Part 9–16
在声部视图之间切换
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	�录音待机

操作
[SONG/PATTERN] 按钮 → Pattern → []（录音）按钮
[PERFORMANCE (HOME)] → Play/Rec → Pattern → []（录音）按钮

Time Signature
设置场景的电平表。
设置 ：1/16–16/16, 1/8–16/8, 1/4–8/4

Rec Quantize (Record Quantize)
量化是一项功能，可将录制的音符校正为节拍的精确分数（以音符值表示）。
设置 ：	� Off、60（三十二分音符）、80（十六分音符三连音）、120（十六分音符）、160（八分音符三连音）、240（八分音符）、

320（四分音符三连音）、480（四分音符）

Loop
当设置为 On 时，模板录制将在循环中继续。
设置 ：Off、On

注
按 []（录音）按钮在乐曲录制期间将录音机设置为排练模式并使 []（录音）按钮闪烁。
在排练模式下，模板的播放会继续，但录制会暂时暂停，这对于练习很有用。
您可以再次按 [] 按钮返回录制模式。
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	�录音

操作
[SONG/PATTERN] 按钮 → Pattern → []（录音）按钮 → []（播放）按钮
[PERFORMANCE (HOME)] → Play/Rec → Pattern → []（录音）按钮 → []（播放）按钮

Hold [SHIFT] + key to erase
Erase
可通过按住 [SHIFT] 按钮并按下想要删除的音符所对应的琴键来删除特定音符事件。
或者，您也可以点击 Erase 画面上的按钮来开启该功能，然后按键盘上的相应按键来删除音符事件。
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	�叠加录制
在叠加录制过程中操作控制器时，可以删除该控制器的现有事件并将该操作录制为新事件。

操作
[PERFORMANCE (HOME)] → Play/Rec → Pattern → （乐曲已录制） → []（录音）按钮 → 点击 Record Type → 从菜单
中选择 Overdub → []（播放）按钮

Record Type
选择 Replace 或 Overdub 录制。
设置 ：Replace、Overdub
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Pattern Edit Overview

操作
[]（播放）按钮 → Pattern → [EDIT/ ] → Overview
[PERFORMANCE (HOME)] → Play/Rec → Pattern → Edit/Job → Overview

Type
点击此按钮可查看声部的主类别和子类别。
这还会更改 Play/Rec 画面上显示的列表。

Name
点击可查看声部名称。
这还会更改 Play/Rec 画面上显示的列表。

Part Mute Icon
Part Solo Icon
显示声部的静音和独奏设置的状态。

Undo ***
取消上一个操作并返回之前的状态。
在录制一个音序后，使用一个或多个作业时，此按钮变得可用。Pattern Edit 画面上所有选项卡的通用操作。

Redo ***
恢复通过 Undo 按钮取消的录制。仅在使用 Undo *** 后才会激活此按钮。Pattern Edit 画面上所有选项卡的通用操作。

Scene
显示所选场景编号。

Save As .mid File
打开 Save 画面。可以将所选场景的音序保存为 MIDI 文件。

Load .mid File
打开 Load 画面以加载 MIDI 文件。
选择 MIDI 文件后，在加载位置选择模板和场景。

Length
设置所选场景的音序长度。

Position
显示场景播放的当前位置，并让您可以指定播放位置。
设置 ：001–256
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Pattern Edit Note

	� Quantize
量化是指通过让音符事件靠近最近的准确节拍来调节其时机的过程。例如，您可以使用此功能改善实时录制的模板的时机。

操作
[]（播放）按钮 → Pattern → [EDIT/ ] → Note → Quantize
[PERFORMANCE (HOME)] → Play/Rec → Pattern → Edit/Job → Note → Quantize

Track
指定作业的音轨。
设置 ：All、1–16

Scene
指定作业的场景。
设置 ：1–8

Start Measure
指定作业的起始小节位置。
设置 ：001–257

Start Beat
指定作业的起始节拍位置。
设置 ：取决于 Time Signature 设置

Start Clock
指定作业的起始时钟位置。
设置 ：取决于 Time Signature 设置
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End Measure
指定作业的结束小节位置。
设置 ：001–257

End Beat
指定作业的结束节拍位置。
设置 ：取决于 Time Signature 设置

End Clock
指定作业的结束时钟位置。
设置 ：取决于 Time Signature 设置

Quantize
设置量化分辨率（或用作量化基音的音符）。
设置 ：	 三十二分音符、十六分音符三连音、十六分音符、八分音符三连音、八分音符、四分音符三连音、四分音符、 

十六分音符 + 十六分音符三连音、八分音符 + 八分三连音

Strength
设置量化的“磁力强度”。
当此参数设置为 100% 时，所有音符将移动到 Quantize 中指定的位置，而设置为 0% 则不会进行量化。
设置 ：0%–100%

Swing Rate
更改根据 Quantize 中指定的值计数的偶数节拍（后拍）的时间，为节奏添加摇摆感。
设置 ：	 取决于 Quantize （量化分辨率）设置。

当Quantize 设置为四分音符、八分音符、十六分音符或三十二分音符时：0 至格栅的一半
当Quantize 设置为四分音符三连音、八分音符三连音或十六分音符三连音时：0 至格栅的一半
当Quantize 设置为八分音符 + 八分音符三连音，或十六分音符 + 十六分音符三连音时：0 至三连音格栅的一半

Gate Time
更改根据 Quantize 中指定的值计数的偶数节拍（后拍）的门限时间（或要演奏的音符的实际时间），从而为节奏增加 
摇摆感。
设置 ：0%–200%

Execute
对 MIDI 音序执行选定的作业。Pattern Edit 画面上所有选项卡的通用操作。
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	� Velocity
改变指定范围内音符的声音强度（力度）。
注
使用以下公式修改力度
调整后的力度 = ( 原始力度 × 比率 ) + 偏移
如果结果为 0 或更小，则该值设置为 1。如果结果大于 128，则该值设置为 127。

操作
[]（播放）按钮 → Pattern → [EDIT/ ] → Note → Velocity
[PERFORMANCE (HOME)] → Play/Rec → Pattern → Edit/Job → Note → Velocity

Set All
设置所选乐段中所有音符的力度。
当设置为 Off 时，Set All 将不起作用。
当设置为除 Off 之外的其他值时，将禁用 Rate 和 Offset。
设置 ：Off、001–127

Rate
设置改变力度的百分比。
当设置为 99% 或更低时，力度会变慢。当设置为 101% 或更高时，力度会变快。在 100% 时，力度将保持不变。
当 Set All 设置为 Off 之外的其他值时，无法更改此参数。
设置 ：0%–200%

Offset
设置要添加到原始力度值或从原始力度值中减去的值。
当设置为 –1 或更小时，力度会变慢。当设置为 +1 或更大时，力度会变快。当设置为 0 时，力度将保持不变。
当 Set All 设置为 Off 之外的其他值时，无法更改此参数。
设置 ：–127–0–+127
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	� Gate Time
改变指定范围内音符的声音时间（门限时间）。
注
使用以下公式修改门限时间
调整后的门限时间 = ( 原始门限时间 × 比率 ) + 偏移
如果结果为 0 或更低，则该值设置为 1。

操作
[]（播放）按钮 → Pattern → [EDIT/ ] → Note → Gate Time
[PERFORMANCE (HOME)] → Play/Rec → Pattern → Edit/Job → Note → Gate Time

这与 Pattern Edit Note → Velocity 相同，但 Set All 设置值不同。

Set All
设置 ：Off、001–9999
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	� Cresc.(Crescendo)
在指定范围内逐级增加（渐强）或减少（渐弱）音符的速度

操作
[]（播放）按钮 → Pattern → [EDIT/ ] → Note → Cresc.
[PERFORMANCE (HOME)] → Play/Rec → Pattern → Edit/Job → Note → Cresc.

Velocity Range
设置渐强或渐弱的强烈程度。
在规定的范围内，根据初始力度逐级增大或减小中间力度，使最终力度成为“初始力度值 + Velocity Range 值”。如果最终
力度为 0 或更低，则将最终力度设置为 1，如果最终力度为 128 或更高，则将最终力度设置为 127。
正值会产生渐强，而负值会产生渐弱。
为 0 时，力度没有变化。
设置 ：–127–0–+127
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	� Transpose
此作业可以让您在指定范围内改变音符的调子或音高。
注
进行移调操作时，如果音符的音高超出了从 C-2 到 G8 这个范围，则会自动调整至 C-2 至 G8 的范围内。

操作
[]（播放）按钮 → Pattern → [EDIT/ ] → Note → Transpose
[PERFORMANCE (HOME)] → Play/Rec → Pattern → Edit/Job → Note → Transpose

Note
指定要移调的琴键（音符）的范围。
点击打开上下文菜单，然后将 Keyboard 设置为 On，以便您可以使用键盘上的按键。
设置 ：C–2–G8

Transpose
设置要以半音为单位移动的音符范围。
+12 的设置会向上移动一个八度，而 -12 的设置会向下移动一个八度。值为 0 则不会发生任何变化。
设置 ：–127–0–+127
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	� Roll
此作业可超过指定范围创建一系列重复的音符（如同滚鼓）。

操作
[]（播放）按钮 → Pattern → [EDIT/ ] → Note → Roll
[PERFORMANCE (HOME)] → Play/Rec → Pattern → Edit/Job → Note → Roll

Track
设置 ：1–16

Start Step
设置滚奏中各音符间的步级（例如时钟数）大小。
通过设置较小的值，您可以演奏更快的滚奏。此处指定的时钟用于范围的开始。
设置 ：015–999

End Step
设置滚奏中各音符间的步级（例如时钟数）大小。
通过设置较小的值，您可以演奏更快的滚奏。此处指定的时钟用于范围的结束。
设置 ：015–999

Note
设置滚奏的音符。
点击打开上下文菜单，然后将 Keyboard 设置为 On，以便您可以使用按键来设置音符。
设置 ：C–2–G8

Start Velocity
设置滚奏强度的力度。此处指定的力度用于范围的开始。
设置 ：001–127

End Velocity
设置滚奏强度的力度。此处指定的力度用于范围的结束。
设置 ：001–127

注
通过设置 Start Velocity 和 End Velocity，您可以为滚奏创建渐强或渐弱。
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Pattern Edit Track

	� Copy/Exchange
此作业将数据从指定的源音轨复制到指定的目标音轨，或在两个指定的音轨之间交换数据。

操作
[]（播放）按钮 → Pattern → [EDIT/ ] → Track → Copy/Exchange
[PERFORMANCE (HOME)] → Play/Rec → Pattern → Edit/Job → Track → Copy/Exchange

Copy
将数据从指定音轨复制到另一个音轨。

须知
执行Copy Track 时，会覆盖目标音轨上的现有数据且现有数据会
丢失。

Exchange
在两个音轨之间交换数据。

Pattern Name * 源
指定要从中复制的模板。

Track * 源
指定要从中复制的音轨。
设置 ：All、1–16

Scene * 源
指定要从中复制的场景。
设置 ：All、1–8

Pattern Name * 目的地
指定要复制到的目标模板。

Track * 目的地
指定要复制到的目标音轨。
当 Source 设置为 All 时，此参数不可用。
设置 ：1–16

Scene * 目的地
指定要复制到的目标场景。
当 Source 设置为 All 时，此参数不可用。
设置 ：1–8

Copy Track
执行复制操作。
注
当执行 Copy Track 且 Track 和 Scene 均设置为 All 时，也会复制
链数据。

Exchange Track
执行交换。
注
当执行 Exchange Track 且 Track 和 Scene 均设置为 All 时，也会
复制链数据。
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	� Mix
混合（合并）来自指定音轨 A 和音轨 B 的数据，并将结果放入音轨 B 中。

操作
[]（播放）按钮 → Pattern → [EDIT/ ] → Track → Mix
[PERFORMANCE (HOME)] → Play/Rec → Pattern → Edit/Job → Track → Mix

Pattern Name * 源 A
指定要混合的第一个模板。

Track * 源 A
指定作业的音轨。
设置 ：1–16

Scene * 源 A
指定作业的场景。
设置 ：All、1–8

Pattern Name * 源 B
指定要混合的第一个模板。

Track * 源 B
指定作业的音轨。
设置 ：1–16

Scene * 源 B
指定作业的场景。
当 Source A 设置为 All 时，此参数不可用。
设置 ：1–8

Pattern Name * 目的地 B
显示要混合到的模板的名称。

Track * 目的地 B
显示作业的音轨编号。

Scene * 目的地 B
显示作业的场景编号。
当 Source A 设置为 All 时，此参数不可用。

Mix Track
执行混音操作。
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	� Append
将指定音轨中的数据添加到另一个音轨的末尾。

操作
[]（播放）按钮 → Pattern → [EDIT/ ] → Track → Append
[PERFORMANCE (HOME)] → Play/Rec → Pattern → Edit/Job → Track → Append

Pattern Name * 源
指定要从中添加的模板。

Track * 源
设置作业的目标音轨。
设置 ：All、1–16

Scene * 源
指定作业的场景。
设置 ：1–8

Pattern Name * 目的地
指定要添加到的模板。

Track * 目的地
设置作业的目标音轨。
当 Source 设置为 All 时，此参数不可用。
设置 ：1–16

Scene * 目的地
指定作业的场景。
设置 ：1–8

Append Track
执行添加操作。



122MODX M 使用说明书

	� Split
以指定小节分割指定音轨的数据，并将后半部分移动到另一个指定音轨。

操作
[]（播放）按钮 → Pattern → [EDIT/ ] → Track → Append
[PERFORMANCE (HOME)] → Play/Rec → Pattern → Edit/Job → Track → Append

Pattern Name * 源
指定要分割的模板。

Track * 源
设置作业的目标音轨。
设置 ：All、1–16

Scene * 源
设置作业的目标场景。
设置 ：1–8

Measure * 源
指定要分割数据的小节。
设置 ：2–256

Pattern Name
显示要分割成的模板。

Track
显示作业的音轨。

Scene
显示作业的场景。

Pattern Name * 目的地
指定要将分割数据发送到的模板。

Track * 目的地
设置作业的目标音轨。
当 Source 设置为 All 时，此参数不可用。
设置 ：1–16

Scene * 目的地
设置作业的目标场景。
设置 ：1–8

Spilt Track
执行分割操作。
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	� Clear
删除指定音轨的数据。

操作
[]（播放）按钮 → Pattern → [EDIT/ ] → Track → Clear
[PERFORMANCE (HOME)] → Play/Rec → Pattern → Edit/Job → Track → Clear

Pattern Name
指定要删除的模板。

Track
指定作业的音轨。
设置 ：All、1–16

Scene
指定作业的场景。
设置 ：All、1–8

Clear Track
执行清除操作。
注
当执行 Clear Track 操作且 Track 和 Scene 设置为 All 时，也会删除链数据。
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	� Divide Drum Tr (Divide Drum Track)
从指定音轨中取出录制的鼓并将每个乐器（鼓组中的单个打击乐器）分配到音轨 9 至 16。
注
当音轨 9 至 16 以及声部 9 至 16 上已有数据时，执行 Divide Drum Track 操作会覆盖现有数据。Undo 和 Redo 不能与此操作一起使用。

操作
[]（播放）按钮 → Pattern → [EDIT/ ] → Track → Divide Drum Tr
[PERFORMANCE (HOME)] → Play/Rec → Pattern → Edit/Job → Track → Divide Drum Tr

Pattern Name
设置作业的目标模板。

Track
设置作业的目标音轨。
设置 ：1–16

Divide Drum Track
执行鼓轨分割操作。
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Pattern Edit Song/Event

	� Get Phrase
将乐曲的特定乐段复制到指定音轨。

须知
此操作会覆盖复制目的地的数据，且数据会丢失。

操作
[]（播放）按钮 → Pattern → [EDIT/ ] → Song/Event → Get Phrase
[PERFORMANCE (HOME)] → Play/Rec → Pattern → Edit/Job → Song/Event → Get Phrase

Song Name
指定要从中复制的乐曲。

Track * 源
设置作业的目标音轨。
设置 ：All、1–16

Start Measure
设置作业的目标开始小节。
设置 ：001–998

End Measure
设置作业的目标结束小节。
设置 ：002–999

Pattern Name
指定要复制到的目标模板。

Track * 目的地
指定要复制到的目标音轨。
当 Source 设置为 All 时，此参数不可用。
设置 ：1–16

Scene
指定要复制到的目标场景。
设置 ：1–8

Get Phrase from Song
复制一个乐句。
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	� Put Phrase
将指定模板音轨的指定小节复制到指定的乐曲音轨。
注
复制的数据会合并到目的地音轨上的现有数据中。

操作
[]（播放）按钮 → Pattern → [EDIT/ ] → Song/Event → Put Phrase
[PERFORMANCE (HOME)] → Play/Rec → Pattern → Edit/Job → Song/Event → Put Phrase

Pattern Name
指定要从中复制的模板。

Track * 源
设置作业的目标音轨。
设置 ：1–16

Scene
设置作业的目标场景。
设置 ：1–8

Song Name
指定要复制到的乐曲。

Track * 目的地
设置作业的目标音轨。
设置 ：1–16

Measure
指定要复制到的目标小节。
设置 ：001–999

Put Phrase to Song
复制一个乐句。
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	� Erase Event
删除事件。

操作
[]（播放）按钮 → Pattern → [EDIT/ ] → Song/Event → Erase Event
[PERFORMANCE (HOME)] → Play/Rec → Pattern → Edit/Job → Song/Event → Erase Event

许多参数与 Pattern Edit Note → Quantize 相同。

Auto Select
打开或关闭 Event Type 的自动选择设置。
当此项设置为 On 时，您只需移动要擦除其数据的控制器，系统会根据 Event Type 自动设置相应控制器的事件。
设置 ：Off、On

Event Type
指定您要删除的事件类型。
设置 ：Note、Poly、CC、NRPN、RPN、PC、AfterTouch、PitchBend、Superknob、SysEx、All

CC Number
当 Event Type 设置为 CC 时显示。指定要擦除的事件的控制变化编号。
设置 ：All、1–127

Erase Event
执行事件删除。
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	� User Arp (User Arpeggio)
将场景指定小节中的数据注册为用户琶音。

操作
[]（播放）按钮 → Pattern → [EDIT/ ] → Song/Event → User Arp
[PERFORMANCE (HOME)] → Play/Rec → Pattern → Edit/Job → Song/Event → User Arp

Scene
指定作业的场景。
设置 ：1–8

Start Measure
指定作业的起始小节位置。
设置 ：1–256

End Measure
指定作业的结束小节位置。
设置 ：2–257

Arp (Arp Number)
设置要进行转换的用户琶音的琶音编号。
最初，将设置下一个未使用的编号。
请记住，如果您将其更改为已使用的编号，则会覆盖琶音，这意味着您将丢失该编号的现有用户琶音。
设置 ：1–256

Category (Arpeggio Category)
Sub Category (Arpeggio Sub Category)
设置转换后的琶音的主类别和子类别。
设置 ：请参阅 Data List

Name (Arpeggio Name)
为用户琶音设置名称。名称最多可以使用 20 个字母数字字符。

Track
设置每个琶音音轨要转换的音轨编号。
设置 ：Off、1–16
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Convert Type
选择将音轨中记录的 MIDI 音序数据转换为琶音的方法。
您可以为每个琶音音轨使用不同的 Convert Type。
设置 ：	 Normal、Fixed、Org Notes

Normal ：以与录制的 MIDI 音序相同的八度音程播放琶音。
Fixed：无论您如何弹奏键盘，都会以相同的方式播放录制的 MIDI 音序。
Org Notes：与 Fixed 基本相同，但 MIDI 音序根据您在键盘上弹奏的和弦而变化。

Org Notes Root
当任何音轨的 Convert Type 设置为 Org Notes 时设置根音音符。
当没有任何音轨设置为 Org Notes 时，此参数不可用。
设置 ：C–2–G8

Store As User Arp (Store As User Arpeggio)
使用画面上的设置将模板转换为用户琶音。
当所有 Track 均设置为 Off 时，此参数不可用。
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Pattern Edit Play FX (Play Effects)
在模板播放期间将效果器应用到 MIDI 音序。设置指定音轨的每个参数的效果器范围和电平。

操作
[]（播放）按钮 → Pattern → [EDIT/ ] → Play FX
[PERFORMANCE (HOME)] → Play/Rec → Pattern → Edit/Job → Play FX

	� Common
Track
指定要标准化的音轨。
设置 ：All、1–16

Scene
指定要标准化的场景。
设置 ：All、1–8

Normalize Play FX
将 Play FX 中指定的效果器固定为 MIDI 数据。

Length
设置所选场景的音序长度。

Position
显示场景播放的当前位置，并让您可以指定播放位置。
设置 ：001–256
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	� Play FX1
控制 Qntz Value、Qntz Str、Swing Vel、Swing Gate 和 Swing Rate。

Qntz Value (Quantize Value)
设置量化分辨率（或用作量化基音的音符）。
设置 ：	� Off、60（三十二分音符）、80（十六分音符三连音）、120（十六分音符）、160（八分音符三连音）、240（八分音符）、

320（四分音符三连音）、480（四分音符）

Qntz Str (Quantize Strength)
设置量化的“磁力强度”。
当此参数设置为 100% 时，所有音符将移动到 Qntz Value (Quantize Value) 中指定的位置，而设置为 0% 则不会进行量化。
设置 ：0%–100%

Swing Vel (Swing Velocity Rate)
更改根据 Qntz Value (Quantize Value) 中指定的值计数的偶数节拍（后拍）的力度，为节奏添加摇摆感。当 Qntz Value 
(Quantize Value) 设置为 Off 时，此参数不可用。
设置 ：0%–200%

Swing Gate (Swing Gate Time Rate)
更改根据 Qntz Value (Quantize Value) 中指定的值计数的偶数节拍（后拍）的门限时间（或要演奏的音符的实际时间），从
而为节奏增加摇摆感。当 Qntz Value (Quantize Value) 设置为 Off 时，此参数不可用。
设置 ：0%–200%

Swing Rate (Swing Offset)
更改根据 Qntz Value (Quantize Value) 中指定的值计数的偶数节拍（后拍）的时间，为节奏添加摇摆感。当 Qntz Value 
(Quantize Value) 设置为 Off 时，此参数不可用。
设置 ：0 至 Qntz Value (Quantize Value) 的一半
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	� Play FX2
控制 Note Shift、Clock Shift、Gate Time、Velocity Rate 和 Velocity Offset。

Note Shift
以半音为单位调整音高。
设置 ：–99–+0–+99

Clock Shift
以时钟增量向后或向前移动音符的时间。
设置 ：–120–+0–+120

Gate Time
更改音符事件的门限时间（要生成音符的声音的实际时间）。
设置 ：0%–200%

Velocity Rate
以指定的百分比改变力度。
设置 ：0%–200%

Velocity Offset
以指定的值增大或减小力度。
设置 ：–99–+0–+99
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Pattern Edit Chain
此作业串联场景以进行播放。

操作
[]（播放）按钮 → Pattern → [EDIT/ ] → Chain
[PERFORMANCE (HOME)] → Play/Rec → Pattern → Edit/Job → Chain

Chain
启用连接播放。
设置 ：Off、On

Measure
指定场景播放的起始小节位置。
设置 ：001–999

Scene
将场景设置为在指定的 Measure 播放。
设置 ：1–8，End

Page
当 Measure 和 Scene 的列表超过八行时，会显示向上或向下箭头。

Convert to Song
将链存储为乐曲。

Length
显示整个音序的长度。

Position
显示连接播放的当前位置，并让您可以指定播放位置。
设置 ：001–999
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Song
在 Song 画面中，您可以在 MIDI 乐曲中录制键盘演奏，并播放乐曲。
键盘演奏以及控制器和旋钮操作的数据都记录到 MIDI 音轨中。
您还可以选择要录制到乐曲中的琶音播放。

	�播放和播放待机

操作
[SONG/PATTERN] 按钮 → Song
[PERFORMANCE (HOME)] → Play/Rec → Song
[]（播放）按钮 → Song

(1)

(2)

(3)

(1)	Link Icon

(2)	Song Length 

(3)	Track Play Switch

Song Name
显示所选乐曲的名称。
点击可显示 Load、Rename、New Song 和 User Arp 的上下文菜单。
当光标位于 Song Name 上时，您可以使用 [INC/YES] 和 [DEC/NO] 按钮选择乐曲。

Performance Name
显示所选演奏组的名称。
注
当您更改演奏组中的参数时，Performance Name 的右上角将显示蓝色旗帜。

Link Icon
如果用于录制乐曲的演奏组与所选演奏组相同，则会显示 Link Icon。如果不同，则显示断开的 Link Icon。

Click Settings
这会调出 Tempo Settings 画面。

Time Signature
显示模板的仪表。
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Position
设置开始播放和录制的位置，以及当前播放位置。
左边显示的数字是小节，右边显示的数字是节拍和击打声。

Tempo
设置乐曲播放的速度。
设置 ：5–300

Loop
将循环播放设置为打开或关闭。
设置为 On 时，将重复播放 Loop Start 和 Loop End 点之间的乐段。
设置 ：Off、On

Loop Start
Loop End
设置循环播放的乐段。左边显示的数字是小节，右边显示的数字是节拍。当 Loop 设置为 Off 时，此参数不可用。

Store Song & Perf Settings (Store Song and Performance Settings)
保存编辑的乐曲和使用的演奏组之间的链接。
注
如果您有已编辑的演奏组参数，则还需要存储演奏组。

Save As .mid File
按此按钮会调出 Save 画面，您可以在这里将乐曲保存为文件。
在下列情况下不可用。
•	 对于新录音（没有乐曲时）
•	 播放期间
•	 启用录制待机时
•	 录制期间

Song Length
显示整个音序的长度。

Track Play Switch
打开或关闭每个音轨的播放。
设置 ：Off、On
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	�录制和录制待机
操作
[SONG/PATTERN] 按钮 → Song → []（录音）按钮
[PERFORMANCE (HOME)] → Play/Rec → Song → []（录音）按钮

新录制

当已经录制某些内容时

Time Signature
显示乐曲的仪表。
设置 ：1/16–16/16, 1/8–16/8, 1/4–8/4

Rec Quantize
量化是一项功能，可将录制的音符校正为节拍的精确分数（以音符值表示）。
设置 ：	� Off、60（三十二分音符）、80（十六分音符三连音）、120（十六分音符）、160（八分音符三连音）、240（八分音符）、

320（四分音符三连音）、480（四分音符）
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Record Type
为已录制的音轨选择录制类型。
此参数不适用于新录制。
设置 ：	 Replace、Overdub、Punch

Replace ：实时覆盖写入录制。现有数据会丢失
Overdub ：实时叠加录制。现有数据不会丢失
Punch ：重新录制乐段并实时录制。这将覆盖指定乐段的现有数据

Punch In
设置 Punch in 点（开始重新录制的特定小节和节拍）。
仅当 Record Type 设置为 Punch 时，此参数才可用。

Punch Out
设置 Punch out 点（结束重新录制的特定小节和节拍）。
仅当 Record Type 设置为 Punch 时，此参数才可用。

Arp Rec
当设置为 On 时，将录制琶音播放的结果。当设置为 Off 时，只录制键盘演奏。
在录制新乐曲时可设置此参数。录制后设置不可更改。
要在 Arp Rec 设置为 Off 时向录制的乐曲添加某些内容，则仅可为 Record Type 使用 Replace。
设置 ：Off、On

注
对于 Arp Rec 设置为 Off 的乐曲，您可以通过更改演奏组中的琶音选择来选择另一个琶音进行播放。

Undo Media Record
取消上一个操作并返回之前的状态。
在录制一个音序后，使用一个或多个作业时，此按钮变得可用。

Redo Media Record
恢复通过 Undo Media Record 按钮取消的录制。使用 Undo Media Record 时启用。
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Put Track to Arpeggio
将所选乐曲转换为用户琶音。
最多可以转换 16 种不同的音符。（所有具有相同音符编号的音符均算作一个音符。）
如果您希望将乐曲转换为用户琶音，请确保仅使用最多 16 个音符，尤其是当您使用多个音轨时。

操作
[SONG/PATTERN] 按钮 → 点击 Play/Rec → Song → Song Name 以打开上下文菜单 → User Arp

Arp (Arpeggio Number)
设置要进行转换的用户琶音的琶音编号。
最初，将设置下一个未使用的编号。
请记住，如果您将其更改为已使用的编号，则会覆盖琶音，这意味着您将丢失该编号的现有用户琶音。
设置 ：1–256

Category (Arpeggio Category)
Sub Category (Arpeggio Sub Category)
设置转换后的琶音的主类别和子类别。
设置 ：请参阅 Data List

Name (Arpeggio Name)
设置琶音名称。您最多可以使用 20 个字母数字字符。

Song Track
为每个琶音音轨设置要转换的乐曲的音轨编号。
设置 ：Off、1–16
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Convert Type
选择如何将乐曲中录制的 MIDI 音序从三种不同的设置转换为琶音。
您可以为每个琶音音轨使用不同的 Convert Type。
设置 ：	 Normal、Fixed、Org Notes

Normal ：以与录制的 MIDI 音序相同的八度音程播放琶音
Fixed ：无论您如何弹奏键盘，都会以相同的方式播放录制的 MIDI 音序。
Org Notes ：与 Fixed 基本相同 ；但 MIDI 音序的播放根据您在键盘上弹奏的和弦而变化。

Org Notes Root (Original Notes Root)
当任何音轨的 Convert Type 设置为 Org Notes 时设置根音音符。
当没有任何音轨设置为 Org Notes 时，此参数不可用。
设置 ：C–2–G8

Start Measure
设置转换的开始小节。
设置 ：1–998

End Measure
设置转换的结束小节。
设置 ：2–999

Store As User Arp
使用此画面上指定的设置将乐曲转换为用户琶音。
当所有音轨均设置为 Off 时，禁用此按钮。
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Audio
在 Audio 画面上，您可以将键盘演奏以 .wav（44.1kHz、24 位立体声）音频文件的形式录制到 USB 闪存中。最长录音时
间为 74 分钟，或最高可达录音设备的容量。

	�播放和播放待机

操作
[SONG/PATTERN] 按钮 → Audio
[PERFORMANCE (HOME)] → Play/Rec → Audio
[]（播放）按钮 → Audio

Audio Name
显示所选音频文件的名称。
点击可显示 Load 的上下文菜单。

Position
设置开始播放的位置，以及当前播放位置。

Audio Volume
设置开始播放的位置。在录制期间，此参数不可用。
设置 ：0–255

Audio Length
显示音频文件的总长度。

电平表
显示音频输入和输出电平。
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	�录制和录制待机

操作
[PERFORMANCE (HOME)] → Play/Rec → Audio → []（录音）按钮

Recordable (Audio Recordable Time)
显示音频的可录制时间。仅在启用录音待机时才显示此参数。

Trigger Level
选择如何开始录制。仅在启用录音待机时才显示此参数。
设置 ：		  manual、1–127

manual ：按 []（播放）按钮开始录制
1–127:按 []（播放）按钮后，当输入的信号超过设定值时，录制会自动开始。此处设置的电平将由电平表中的
蓝色三角形来指示

注
为获得出色效果，请将 Trigger Level 设置得尽可能低，以便捕获整个信号，但也不要太低，以免录制不必要的噪音。
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Smart Morph

Play
点击智能变形图，然后在声部 1 的 FM-X 声音或 AN-X 声音中创建更改。

操作
[PERFORMANCE (HOME)] → Smart Morph → Play
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Edit

操作
[PERFORMANCE (HOME)] → Smart Morph → Edit

未使用的声部
点击可打开 Part Category Search 画面来选择 FM-X 声音或 AN-X 声音。

正在使用的声部
点击可显示 Category Search、Edit、Property 等的上下文菜单。

Display
选择每个声部的 Part Main Category 视图或 Part Name 视图。

Mode
在 FM-X 和 AN-X 之间切换。
设置 ：FM-X、AN-X

Learn
点击按钮开始机器学习（贴图创建）。
当声部 9 至 16 没有 FM-X 声音或 AN-X 声音时，不会显示此按钮。

Undo
Redo
执行 Learn 操作之后，右上角会显示 Undo 按钮。
在使用机器学习之前，使用 Undo 按钮来恢复原始贴图。
执行 Undo 操作后，会出现 Redo 按钮，您可以使用此按钮来恢复在执行 Undo 操作之前的贴图。
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Analyze

操作
[PERFORMANCE (HOME)] → Smart Morph → Analyze

Red
贴图上的每个点都代表参数值，用红色的深浅来表示其程度或电平。

Green
贴图上的每个点都代表参数值，用绿色的深浅来表示其程度或电平。

Blue
贴图上的每个点都代表参数值，用蓝色的深浅来表示其程度或电平。
注
有关可用的 Red、Green 和 Blue 参数的列表，请参阅“可为 Red、Green 和 Blue 设置的参数”。

Coloring
当设置为 Auto 时，将在 Learn 过程中自动重置 Red、Green 和 Blue。
当设置为 Manual 时，不会在 Learn 过程中自动重置 Red、Green 和 Blue。
设置 ：Auto、Manual

Learn
点击按钮开始机器学习（贴图创建）。

Undo
Redo
执行 Learn 操作之后，右上角会显示 Undo 按钮。
在使用机器学习之前，使用 Undo 按钮来恢复原始贴图。
执行 Undo 操作后，会出现 Redo 按钮，您可以使用此按钮来恢复在执行 Undo 操作之前的贴图。
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	�可为Red、Green 和 Blue设置的参数
•	 FM Common

显示名称 参数名称

Random Pan Depth Random Pan Depth
Alternate Pan Alternate Pan Depth
Scaling Pan Depth Scaling Pan Depth
KeyOnDly Time Key On Delay Time Length
KeyOnDly Sync Key On Delay Tempo Sync Switch
KeyOnDly Note Key On Delay Note Length
Pitch/Vel Pitch Velocity Sensitivity
Random Pitch Depth Random Pitch Depth
Pitch/Key Pitch Key Follow Sensitivity
Pitch/Key Center Pitch Key Follow Sensitivity Center Note
PEG Initial Lvl PEG Initial Level
PEG Attack Lvl PEG Attack Level
PEG Decay 1 Lvl PEG Decay 1 Level
PEG Decay 2 Lvl PEG Decay 2 Level
PEG Release Lvl PEG Release Level
PEG Attack Tm PEG Attack Time
PEG Decay 1 Tm PEG Decay 1 Time
PEG Decay 2 Tm PEG Decay 2 Time
PEG Release Tm PEG Release Time
PEG Depth/Vel PEG Depth Velocity Sensitivity
PEG Depth PEG Depth
PEG Time/Key PEG Time Key Follow Sensitivity
2nd LFO Wave 2nd LFO Wave
LFO Speed 2nd LFO Speed
LFO Phase 2nd LFO Phase
LFO Delay 2nd LFO Delay Time
LFO Key On Reset 2nd LFO Key On Reset
LFO Pitch Mod 2nd LFO Pitch Modulation Depth
LFO Amp Mod 2nd LFO Amp Modulation Depth
LFO Filter Mod 2nd LFO Filter Modulation Depth
Algorithm Number Algorithm Number
Feedback Level Feedback Level
LFO Speed Range LFO Speed Range
LFO Ex Speed LFO Extended Speed
Filter Type Filter Type
Cutoff Filter Cutoff Frequency
Cutoff/Vel Filter Cutoff Velocity Sensitivity
Resonance / Width Filter Resonance/Width
Res/Vel Resonance Velocity Sensitivity
HPF Cutoff HPF Cutoff Frequency
Distance Distance
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显示名称 参数名称

Filter Gain Filter Gain
FEG Hold Tm FEG Hold Time
FEG Attack Tm FEG Attack Time
FEG Decay 1 Tm FEG Decay 1 Time
FEG Decay 2 Tm FEG Decay 2 Time
FEG Release Tm FEG Release Time
FEG Hold Lvl FEG Hold Level
FEG Attack Lvl FEG Attack Level
FEG Decay 1 Lvl FEG Decay 1 Level
FEG Decay 2 Lvl FEG Decay 2 Level
FEG Release Lvl FEG Release Level
FEG Depth FEG Depth
FEG Segment FEG Time Velocity Sensitivity Segment
FEG Time/Vel FEG Time Velocity Sensitivity
FEG Depth/Vel FEG Depth Velocity Sensitivity
FEG Curve FEG Depth Velocity Sensitivity Curve
FEG Time/Key FEG Time Key Follow Sensitivity
FEG Center FEG Time Key Follow Sensitivity Center Note
Flt Cutoff/Key Filter Cutoff Key Follow Sensitivity
Flt Break Point 1 Filter Cutoff Scaling Break Point 1
Flt Break Point 2 Filter Cutoff Scaling Break Point 2
Flt Break Point 3 Filter Cutoff Scaling Break Point 3
Flt Break Point 4 Filter Cutoff Scaling Break Point 4
Flt Cutoff Offset 1 Filter Cutoff Scaling Offset 1
Flt Cutoff Offset 2 Filter Cutoff Scaling Offset 2
Flt Cutoff Offset 3 Filter Cutoff Scaling Offset 3
Flt Cutoff Offset 4 Filter Cutoff Scaling Offset 4
HPF Cutoff/Key HPF Cutoff Key Follow Sensitivity

•	Operator

显示名称 参数名称

Key On Reset Oscillator Key On Reset
Freq Mode Oscillator Frequency Mode
Coarse Tune Coarse
Fine Tune Fine
Detune Detune
Pitch/Key Pitch Key Follow Sensitivity
Pitch/Vel Pitch Velocity Sensitivity
Spectral Spectral Form
Skirt Spectral Skirt
Resonance Spectral Resonance
PEG Initial Lvl PEG Initial Level
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显示名称 参数名称

PEG Attack Lvl PEG Attack Level
PEG Attack Tm PEG Attack Time
PEG Decay Tm PEG Decay Time
AEG Attack Lvl AEG Attack Level
AEG Decay 1 Lvl AEG Decay 1 Level
AEG Decay 2 Lvl AEG Decay 2 Level
AEG Release Lvl AEG Release (Hold) Level
AEG Attack Tm AEG Attack Time
AEG Decay 1 Tm AEG Decay 1 Time
AEG Decay 2 Tm AEG Decay 2 Time
AEG Release Tm AEG Release Time
AEG Hold Tm AEG Hold Time
AEG Time/Key AEG Time Key Follow Sensitivity
Level Operator Level
Lvl Break Point Level Scaling Break Point
Lvl/Key Lo Level Scaling Low Depth
Lvl/Key Hi Level Scaling High Depth
Curve Lo Level Scaling Low Curve
Curve Hi Level Scaling High Curve
Level/Vel Level Velocity Sensitivity
LFO PM Depth 2nd LFO Pitch Modulation Depth Offset
LFO AM Depth 2nd LFO Amplitude Modulation Depth Offset
Pitch/Ctrl Pitch Controller Sensitivity
Level/Ctrl Level Controller Sensitivity

•	 AN-X Common

显示名称 参数名称

Random Pan Random Pan Depth
Alternate Pan Alternate Pan Depth
Scaling Pan Scaling Pan Depth
Delay Length Key On Delay Time Length
KeyOnDly Sync Key On Delay Tempo Sync Switch
Delay Length Key On Delay Note Length
Unison Unison
Unison Detune Unison Detune
Unison Spread Unison Spread
OSC Reset OSC Reset
Voltage Drift Voltage Drift
Ageing Ageing
Attack Pitch EG Attack Time
Decay Pitch EG Decay Time
Sustain Pitch EG Sustain Level
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显示名称 参数名称

Release Pitch EG Release Time
Time/Vel Pitch EG Time Velocity Sensitivity
Wave Pitch LFO Wave
Speed Pitch LFO Speed
Key On Reset Pitch LFO Key On Reset
Phase Pitch LFO Phase
Delay Pitch LFO Delay Time
Fade In Pitch LFO Fade In Time
Noise Tone Noise Generator Tone
Connect Noise Generator Out Select
Out Level Noise Generator Out Level
Out Level/Vel Noise Generator Out Level Velocity Sensitivity
Attack Filter Cutoff EG Attack Time
Decay Filter Cutoff EG Decay Time
Sustain Filter Cutoff EG Sustain Level
Release Filter Cutoff EG Release Time
Time/Vel Filter Cutoff EG Time Velocity Sensitivity
Wave Filter Cutoff LFO Wave
Speed Filter Cutoff LFO Speed
Key On Reset Filter Cutoff LFO Key On Reset
Phase Filter Cutoff LFO Phase
Delay Filter Cutoff LFO Delay Time
Fade In Filter Cutoff LFO Fade In Time
Level Amplitude Level
Level/Vel Amplitude Level Velocity Sensitivity
LFO Depth Amplitude Level LFO Depth
Level/Key Amplitude Level Key Follow
Drive Amplitude Saturator Drive
Attack Amplitude EG Attack Time
Decay Amplitude EG Decay Time
Sustain Amplitude EG Sustain Level
Release Amplitude EG Release Time
Time/Vel Amplitude EG Time Velocity Sensitivity
Wave Amplitude LFO Wave
Speed Amplitude LFO Speed
Key On Reset Amplitude LFO Key On Reset
Phase Amplitude LFO Phase
Delay Amplitude LFO Delay Time
Fade In Amplitude LFO Fade In Time
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•	Oscillator

显示名称 参数名称

Wave Oscillator Wave

Octave Oscillator Octave

Pitch Oscillator Pitch

Pitch EG Depth Oscillator Pitch EG Depth

Pitch EG Depth/Vel Oscillator Pitch EG Depth Velocity Sensitivity

Pitch LFO Depth Oscillator Pitch LFO Depth

Sync Pitch Oscillator Self Sync Pitch

Sync Pitch/Vel Oscillator Self Sync Pitch Velocity Sensitivity

Sync Oscillator Self Sync EG Depth

Sync Oscillator Self Sync LFO Depth

Pulse Width Oscillator Pulse Width

PulseWidth/Vel Oscillator Pulse Width Velocity Sensitivity

Pulse Width Oscillator Pulse Width EG Depth

Pulse Width Oscillator Pulse Width LFO Depth

Shaper Oscillator Wave Shaper

Shaper/Vel Oscillator Wave Shaper Velocity Sensitivity

Shaper Oscillator Wave Shaper EG Depth

Shaper Oscillator Wave Shaper LFO Depth

FM Level Oscillator FM Level

FM Level/Vel Oscillator FM Level Velocity Sensitivity

Ring Level Oscillator Ring Level

Ring Level/Vel Oscillator Ring Level Velocity Sensitivity

Connect Oscillator Out Select

Invert Oscillator Out Invert Enable

Out Level Oscillator Out Level

Out Level/Vel Oscillator Out Level Velocity Sensitivity

Attack Oscillator EG Attack Time

Decay Oscillator EG Decay Time

Sustain Oscillator EG Sustain Level

Release Oscillator EG Release Time

Wave Oscillator LFO Wave

Speed Oscillator LFO Speed

Key On Reset Oscillator LFO Key On Reset

Phase Oscillator LFO Phase

Delay Oscillator LFO Delay Time

Fade In Oscillator LFO Fade In Time
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•	 Filter

显示名称 参数名称

Type Filter Type

Cutoff Filter Cutoff

Cutoff/Vel Filter Cutoff Velocity Sensitivity

Filter EG Depth Filter Cutoff EG Depth

Filter EG Depth/Vel Filter Cutoff EG Depth Velocity Sensitivity

Filter LFO Depth Filter Cutoff LFO Depth

Cutoff/Key Filter Cutoff Key Follow

Resonance Filter Resonance

Resonance/Vel Filter Resonance Velocity Sensitivity

Saturator Drive Filter Saturator Drive

Saturator Drive/... Filter Saturator Drive Velocity Sensitivity

Out Level Filter Out Level

•	Modifier

显示名称 参数名称

Wave Folder Modifier Wave Folder

Folder/Vel Modifier Wave Folder Velocity Sensitivity

EG Depth Modifier Wave Folder EG Depth

LFO Depth Modifier Wave Folder LFO Depth

Texture Modifier Wave Folder Texture

Type Modifier Wave Folder Type

Attack Modifier EG Attack Time

Decay Modifier EG Decay Time

Sustain Modifier EG Sustain Level

Release Modifier EG Release Time

Time/Vel Modifier EG Time Velocity Sensitivity

Wave Modifier LFO Wave

Speed Modifier LFO Speed

Key On Reset Modifier LFO Key On Reset

Phase Modifier LFO Phase

Delay Modifier LFO Delay Time

Fade In Modifier LFO Fade In Time
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Super Knob

操作
[PERFORMANCE (HOME)] → Smart Morph → Super Knob

Super Knob Link
设置为 On 时，您可以使用超级旋钮从头到尾沿着贴图上的路径移动，而无需用手指在触摸屏上滑动。
设置 ：Off、On

Start
设置贴图上最小超级旋钮值的位置。
当光标位于 Start 上时，点击贴图来设置开始点的值。

End
设置贴图上最大超级旋钮值的位置。
当光标位于 End 上时，点击贴图来设置结束点的值。

Waypoints
设置开始点和结束点之间散布点（路径点）的数量。
设置 ：0–6

Waypoint 1–Waypoint 6
设置贴图上的位置。



152MODX M 使用说明书

Job

操作
[PERFORMANCE (HOME)] → Smart Morph → Job

Load Smart Morph
打开 Load 画面。
在 Load 画面上，您可以选择另一个演奏组，并将该演奏组中的智能变形设置导入到当前演奏组。

Delete Smart Morph
从所选演奏组中删除智能变形设置。

Delete Part 9–16
一次全部删除声部 9 至 16，使这些声部变为未使用。
声部 9 至 16 用于创建智能变形贴图。
当您调整完参数且不再需要使用贴图时，可以删除声部 9 至 16。
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Common Edit 画面
在 Common Edit 画面上，您可以编辑整个演奏组的参数以及音频声部的参数。

General/Pitch

Perf Settings
在 Perf Settings 画面上，您可以设置演奏组的常规参数。

操作
[PERFORMANCE (HOME)] → Common 选择 → [EDIT/ ] → General/Pitch → Perf Settings

Main Category
Sub Category
设置所选演奏组的主类别和子类别。
设置 ：请参阅 Data List

Performance Name
为当前所选演奏组命名。您最多可以使用 20 个字母数字字符。

Volume (Performance Volume)
显示所选演奏组的音量。
设置 ：0–127

Pan (Performance Pan)
调整当前所选演奏组的声相位置（立体声位置）。
设置 ：L63–C（中央）–R63
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Var Return (Variation Return)
设置变奏效果器处理的信号的输出电平（返回电平）。
设置 ：0–127

Rev Return (Reverb Return)
设置混响效果器处理的信号的输出电平（返回电平）。
设置 ：0–127

MC Flag (Motion Control Flag)
将 MC（动态控制）标记设置为当前所选演奏组。
当设置为 On 时，Performance 画面 (HOME) 上会出现 MC 标记，并且会通过 Performance Category Search 画面上的 MC
属性进行滤波。
设置 ：Off、On

Portamento Master Sw (Portamento Master Switch)
将 Portamento Part Sw 设置为 On，即可为声部设置打开或关闭滑音。
此开关与上方面板的 [PORTAMENTO] 按钮关联。
设置 ：Off、On

Portamento Time
设置声部的滑音音高变化的时间长度（或速度）。
此值指定为声部 Portamento time 的偏移值。
设置 ：–64–+0–+63



155MODX M 使用说明书

USB Monitor
在 USB Monitor 画面上调整从 USB [TO HOST] 端口输入的音频信号的音量。
当您点击 Audio Signal Flow 中的 USB Volume 时，光标会移动到 Audio I/O 画面上的 USB Volume。
注
USB Main Monitor Volume 保存（存储）在演奏组中。

操作
[PERFORMANCE (HOME)] → Common 选择 → [EDIT/ ] → General/Pitch → USB Monitor

Monitor Volume Main
调节从 USB [TO HOST] 端口输入并输出到 OUTPUT 插孔的音频信号的音量。
设置 ：0–127

Audio Settings
点击可打开 Utility Audio I/O 画面。
可以从 [UTILITY] → Settings → Audio I/O 打开相同的画面。



156MODX M 使用说明书

Pitch
在 Pitch 画面上，您可以进行音高设置。

操作
[PERFORMANCE (HOME)] → Common 选择 → [EDIT/ ] → General/Pitch → Pitch
[SHIFT] + [PORTAMENTO]

	� Note Shift / Detune

Part
在声部 1-8 和声部 9-16 之间切换视图。

Detune
以 0.1Hz 增量调整声部的音高。
通过稍微改变音高，您可以微调声音。
设置 ：–12.8Hz–+0.0Hz–+12.7Hz

Shift (Note Shift)
以半音为单位调整声部的音高。
设置 ：–24–+0–+24

Perf Note Shift (Performance Note Shift)
以半音为单位调整所有声部的音高。
设置 ：–24–+0–+24
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	� Pitch Bend / Mono

鼓声部不会显示 Mono / Poly。

Edit Control Assign
Common Edit Control Assign 画面会打开。

Group (Pitch Control Group)
分配到同一组中的声部具有相同的音高。
当您希望将滑音应用于分层声音或同时对多个声部进行相同的微调设置时，这非常方便。

Lower (Pitch Bend Lower)
Upper (Pitch Bend Upper)
设置使用弯音轮创建的变化范围（以半音为单位）。
设置 ：–48–+0–+24

Mono / Poly
设置键盘的音源模式。
Mono 用于演奏单个音符，Poly 用于同时演奏多个音符。
设置 ：Mono、Poly
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	� Portamento

鼓声部不会显示 Sw、Mode、Time 和 Time Mode。

Master Sw (Portamento Master Switch)
将 Sw (Portamento Part Switch) 设置为 On，即可为声部设置打开或关闭滑音。
此开关与上方面板的 [PORTAMENTO] 按钮关联。
设置 ：Off、On

Time (Portamento Time)
设置声部的滑音音高变化的时间长度（或速度）。
此值指定为声部 Portamento time 的偏移值。
设置 ：–64–+0–+63

Sw (Portamento Part Switch)
打开或关闭声部的滑音。
设置 ：Off、On

Portamento Mode
根据您的键盘演奏设置滑音的应用方式。
设置 ：	 Fingered、Full-time

Fingered ：仅当弹奏连奏（在释放前一个音符之前弹奏下一个音符）时才应用滑音。
Full-time ：始终应用滑音。

Time (Portamento Part Time)
设置声部的滑音音高变化的时间长度（或速度）。
设置 ：0–127

Time Mode (Portamento Time Mode)
设置音高如何随时间变化。
设置 ：	 Rate 1、Time 1、Rate 2、Time 2

Rate 1 ：音高以特定速率变化。
Time 1 ：音高在特定时间变化。
Rate 2 ：音高在八度范围内以特定速率变化。
Time 2 ：音高在八度范围内在特定时间变化。
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	� Micro Tuning

鼓声部不会显示 Micro Tuning Name 和 Root。

Edit Global Tuning
在 Utility 画面上打开 Settings → Sound。

Edit User Tuning
打开用户微调设置窗口。

•	 Tuning No. (Micro Tuning Number)
表示所选的用户微调编号。
设置 ：1–8

•	 Tuning Name (Micro Tuning Name)
您可以使用新名称来保存正在编辑的用户微调。您可以使用最多 20 个字母数字字符。

•	 C、C#、D、D#、E、F、F#、G、G#、A、A#、B
您可以调整每个音符的音高（以 cent 为单位）来设置微调。
设置 ：–99–+0–+99

•	 Initialize
初始化所选的用户微调。
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Micro Tuning Name
设置声部的微调（音律）。有关每个设置的说明，请参阅下表。
设置 ：	 Equal Temperament、Pure Major、Pure Minor、Werckmeister、Kirnberger、Vallotti & Young、1/4 shift、1/4 

tone、1/8 tone、Indian、Arabic 1、Arabic 2、Arabic 3
Init Tuning 1–8 （当选定了用户库时）
Library 1–1 – 24–8（加载库文件时）

Equal Temperament 每个八度分为 12 个大小相等的音程。这是音乐中使用最广泛的调音。

Pure Major
Pure Minor

这些调律保留每个音阶的纯数学间隔，特别是对于三和弦（根音、三度音、五度音）。
可以在真正的人声合唱中听到这种律制，如教堂唱诗班或无伴奏清唱。

Werckmeister
Kirnberger
Vallotti & Young

每个音阶都结合了中庸全音律和五度相生律音阶。这些音阶的主要特性是各个琴键皆
具有其独特的特色。
在巴赫和贝多芬时代会使用这些音阶，现在用大键琴这样的乐器演奏那个年代的音乐
时会用到。

1/4 shift 平均律音阶上调了 50 音分。
您可以通过将此设置与平均律混合来在音乐中创造张力。

1/4 tone 每个八度二十四个等距音符。
一个八度由 24 个键组成。

1/8 tone 每个八度四十八个等距音符。
一个八度由 48 个键组成。

Indian 通常出现在印度音乐中。
仅弹奏白键。

Arabic 通常出现在阿拉伯音乐中。

Root (Micro Tuning Root)
设置微调的根音音符。
当 Micro Tuning Name 中选择的类型不需要根音音符时，不会显示此参数。
设置 ：C–B
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Audition
在 Audition 画面上，您可以设置试听乐句。

操作
[PERFORMANCE (HOME)] → Common 选择 → [EDIT/ ] → General/Pitch → Audition

Audition Bank
选择试听乐句的库。

Audition Phrase Number
选择试听乐句。
预置演奏组已分配合适的试听乐句。
通过播放试听乐句，您可以在适当的音乐环境中聆听选定的演奏组。
设置 ：请参阅 Data List

Note Shift (Audition Note Shift)
以半音为单位调整试听乐句中音符的音高。
设置 ：–24 semi 至 +0 semi 至 +24 semi

Velocity Shift (Audition Velocity Shift)
调整试听乐句中音符的力度。
设置 ：–64–+0–+63

Update User Auditions
将保存到内置存储器中的所有乐曲转换为用户试听。
如果任何用户试听已存在，则会覆盖所有先前的用户试听。
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Filter/Amp

Filter EG
在 Filter EG 画面中，您可以设置滤波器包络发生器 (FEG)。
这样您就可以设置截止频率的变化程度（或级别），以及从您按下键盘上的按键到声音衰减的那一刻为止，这些变化如何随
时间演变。

操作
[PERFORMANCE (HOME)] → Common 选择 → [EDIT/ ] → Filter/Amp → Filter EG

FEG Atk (FEG Attack Time)
设置从按下琴键到截止频率达到 Attack Level 中设置的值时声音发生变化所需的时间长度。
此值指定为声部 FEG 的偏移值。
设置 ：–64–+0–+63

FEG Decay (FEG Decay Time)
设置截止频率从起音电平改变所需的时间长度。您可以控制声音的清脆感或衰减速度。
此值指定为声部 FEG 的偏移值。
设置 ：–64–+0–+63

FEG Rel (FEG Release Time)
设置从琴键上松开手指到截止频率达到 Release Level 所需的时间长度。通过此设置，您可以使释放琴键后的声音衰减变慢
或变快。
此值指定为声部 FEG 的偏移值。
设置 ：–64–+0–+63

Cutoff (Cutoff Frequency)
通过设置滤波器的截止频率来改变声音。
选择低通滤波器时，此处的值越大，声音越明亮，值越小，声音越低沉。
此值指定为声部滤波器截止频率的偏移值。
设置 ：–64–+0–+63



163MODX M 使用说明书

Resonance
通过调整接近截止频率的信号电平来为声音增加特殊特性。
此值指定为声部滤波器共鸣的偏移值。
设置 ：–64–+0–+63

FEG Depth
设置 FEG 控制的截止频率变化的深度范围。
此值指定为声部的 FEG 深度的偏移值。
设置 ：–64–+0–+63

Amp EG
在 Amp EG 画面中，您可以设置 AEG（振幅包络发生器）。通过设置 Amp EG，您可以设置从按下键盘上的按键到声音衰减
时音量的变化方式。

操作
[PERFORMANCE (HOME)] → Common 选择 → [EDIT/ ] → Filter/Amp → Amp EG

Amp EG 画面上的设置是所有声部 AEG 的偏移值。

Attack (AEG Attack Time)
设置从按下键盘上的某个键到达到最大音量所需的时间长度。
设置 ：–64–+0–+63

Decay (AEG Decay Time)
设置音量达到最大值后发生变化所需的时间长度。
设置 ：–64–+0–+63

Sustain (AEG Sustain Level)
设置按住琴键时保持的音量。
设置 ：–64–+0–+63

Release (AEG Release Time)
设置释放琴键后声音衰减所需的时间长度。
设置 ：–64–+0–+63
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Effect

Routing
在这个画面上，您可以设置应用于所有声部的系统效果器并查看主控效果器的信号流。

操作
[PERFORMANCE (HOME)] → Common 选择 → [EDIT/ ] → Effect → Routing

Var (Variation Switch)
Rev (Reverb Switch)
MFX (Master Effect Switch)
打开或关闭变奏效果器、混响和主控效果器。
设置 ：Off、On

Var Type (Variation Type)
Rev Type (Reverb Type)
MFX Type (Master Effect Type)
设置变奏效果器、混响和主控效果器的类型。
设置 ：请参阅效果器类型

Var Preset (Variation Preset Number)
Rev Preset (Reverb Preset Number)
MFX Preset (Master Effect Preset Number)
从变奏效果器、混响和主控效果器参数中选择预置。
设置 ：请参阅 Data List

Side Chain (Variation Side Chain Part)
Side Chain (Master Effect Side Chain Part)
Modulator (Variation Modulator Part)
Modulator (Master Effect Modulator Part)
设置变奏效果器和主控效果器的侧链声部（或调制器，具体取决于效果器类型）。
当 Master 设置为调制器声部时，此参数不可用。在这种情况下，参数值将显示在括号中，如“(Master)”。
设置 ：Part 1–16、A/D、Master、Off
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Var Return (Variation Return)
Rev Return (Reverb Return)
设置变奏效果器或混响效果器处理的信号的输出电平（返回电平）。
设置 ：0–127

Var to Rev (Variation To Reverb)
设置变奏效果器处理的信号的发送电平。
设置 ：0–127

Master EQ (Master EQ Switch)
打开或关闭主 EQ。
设置 ：Off、On

Var Pan (Variation Pan)
Rev Pan (Reverb Pan)
设置变奏效果器或混响效果器处理的信号的立体声位置。
设置 ：L63–C（中央）–R63

Envelope Follower
打开包络跟随器的设置画面。

•	 Part (Input Source)
显示所选包络跟随器的输入源。
设置 ：Master、AD、Part 1–16

•	 Gain (Envelope Follower Gain)
设置为 Part 设置的输入源的输入增益。
设置 ：–24.0dB–0.0dB–+24.0dB

•	 Attack (Envelope Follower Attack)
设置包络跟随器的起音时间。
设置 ：1ms–40ms

•	 Release (Envelope Follower Release)
设置包络跟随器的释音时间。
设置 ：10ms–680ms

•	 Input Level
显示从所选 Part 的输入源输入的信号的输入电平。

•	 Envelope Follower Output
显示包络跟随器的输出电平。

•	 Edit
打开所选声部的 Control Assign 画面。
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变化
设置变奏效果器。

操作
[PERFORMANCE (HOME)] → Common 选择 → [EDIT/ ] → Effect → Variation

Variation Switch
打开或关闭变奏效果器。
设置 ：Off、On

Category (Variation Category)
Type (Variation Type)
设置变奏效果器的类别和类型。
设置 ：请参阅效果器类型

Preset (Variation Preset Number)
为每种效果器类型选择预置效果器参数之一。
设置 ：请参阅 Data List

Side Chain (Variation Side Chain Part)
Modulator (Variation Modulator Part)
设置变奏效果器的侧链（或调制器，具体取决于效果器类型）的声部。
当 Master 设置为调制器声部时，此参数不可用。在这种情况下，参数值将显示在括号中，如“(Master)”。
设置 ：Part 1–16、A/D、Master、Off

Effect Parameter
效果器参数因效果器类型而异。
设置 ：请参阅效果器参数
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Reverb
设置混响效果器。

操作
[PERFORMANCE (HOME)] → Common 选择 → [EDIT/ ] → Effect → Reverb

Reverb Switch
打开或关闭混响效果器。
设置 ：Off、On

Category (Reverb Category)
Type (Reverb Type)
设置混响效果器的类别和类型。
设置 ：请参阅效果器类型

Preset (Reverb Preset Number)
为每种效果器类型选择预置效果器参数之一。
设置 ：请参阅 Data List

Effect Parameter
效果器参数因效果器类型而异。
设置 ：请参阅效果器参数
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Master FX
设置主控效果器。

操作
[PERFORMANCE (HOME)] → Common 选择 → [EDIT/ ] → Effect → Master FX

Master Effect Switch
打开或关闭主控效果器。
设置 ：Off、On

Category (Master Effect Category)
Type (Master Effect Type)
设置主控效果器的类别和类型。
设置 ：请参阅效果器参数

Preset (Master Effect Preset Number)
为每种效果器类型选择预置效果器参数之一。
设置 ：请参阅 Data List

Side Chain (Master Effect Side Chain Part)
Modulator (Master Effect Modulator Part)
设置主控效果器的侧链（或调制器，具体取决于效果器类型）。
当 Master 设置为调制器声部时，此参数不可用。在这种情况下，参数值将显示在括号中，如“(Master)”。
设置 ：Part 1–16、A/D、Master、Off

Effect Parameter
效果器参数因效果器类型而异。
设置 ：请参阅效果器参数
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Master EQ
设置 Master EQ。

操作
[PERFORMANCE (HOME)] → Common 选择 → [EDIT/ ] → Effect → Master EQ

Master EQ (Master EQ Switch)
打开或关闭主 EQ。
设置 ：Off、On

Low Gain (Master EQ Low Gain)
设置 Low 频段的信号电平。
设置 ：–12dB – +0dB – +12dB

Lo Mid Gain (Master EQ Low Mid Gain)
设置 Lo Mid 频段的信号电平。
设置 ：–12dB – +0dB – +12dB

Mid Gain (Master EQ Mid Gain)
设置 Mid 频段的信号电平。
设置 ：–12dB – +0dB – +12dB

Hi Mid Gain (Master EQ High Mid Gain)
设置 Hi Mid 频段的信号电平。
设置 ：–12dB – +0dB – +12dB

High Gain (Master EQ High Gain)
设置 High 频段的信号电平。
设置 ：–12dB – +0dB – +12dB

Low Freq (Master EQ Low Frequency)
设置 Low 频段的频率。
设置 ：32Hz – 2.0kHz
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Lo Mid Freq (Master EQ Low Mid Frequency)
设置 Lo Mid 频段的频率。
设置 ：100Hz – 10kHz

Mid Freq (Master EQ Mid Frequency)
设置 Mid 频段的频率。
设置 ：100Hz – 10kHz

Hi Mid Freq (Master EQ High Mid Frequency)
设置 Hi Mid 频段的频率。
设置 ：100Hz – 10kHz

High Freq (Master EQ High Frequency)
设置 High 频段的频率。
设置 ：500Hz – 16kHz

Low Q (Master EQ Low Q)
设置 Low 频段的带宽。
仅当 Low Shape (Master EQ Low Shape) 设置为 Peak 时，此参数才可用。
设置 ：0.1–12.0

Lo Mid Q (Master EQ Low Mid Q)
设置 Lo Mid 频段的带宽。
设置 ：0.1–12.0

Mid Q (Master EQ Mid Q)
设置 Mid 频段的带宽。
设置 ：0.1–12.0

Hi Mid Q (Master EQ High Mid Q)
设置 Hi Mid 频段的带宽。
设置 ：0.1–12.0

High Q (Master EQ High Q)
设置 High 频段的带宽。
仅当 High Shape (Master EQ High Shape) 设置为 Peak 时，此参数才可用。
设置 ：0.1–12.0

Low Shape (Master EQ Low Shape)
High Shape (Master EQ High Shape)
设置是否使用 Low 和 High 作为坡形（一种将信号增强或减弱到特定频率以下或以上的类型）或峰值类型（一种增强或减
弱特定频段中的信号的类型）。
设置 ：Shelf、Peak
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Audio In

Mixing
在 Mixing 画面上，您可以混合 A/D 声部（来自 A/D INPUT 插孔的信号）和数字声部（来自 USB [TO HOST] 端口的信号）。
* 来自 USB [TO HOST] 端口的信号是设备端口中设置为 Digital L/R 的音频。

操作
[PERFORMANCE (HOME)] → Common 选择 → [EDIT/ ] → Audio In → Mixing
[SHIFT] + [A/D INPUT ON/OFF]

Input Mode (A/D Part Input Mode)
Input Mode (Digital Part Input Mode)
确定左右声道输入信号的处理方法。
设置 ：	 L Mono、R Mono、L+R Mono、Stereo

L Mono ：仅使用左声道。
R Mono ：仅使用右声道。
L+R Mono ：混合左右声道并以单声道方式进行处理。
Stereo ：以立体声方式处理立体声输入。

注
如果声音仅从 [L/MONO] 插孔输入，则会以单声道处理。

Volume (A/D Part Volume)
Volume (Digital Part Volume)
设置 A/D 声部或数字声部的音量。
设置 ：0–127

Pan (A/D Part Pan)
Pan (Digital Part Pan)
设置 A/D 声部或数字声部的声像位置（在立体声场中）。
设置 ：L63–C（中央）–R63
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Dry Level (A/D Part Dry Level)
Dry Level (Digital Part Dry Level)
设置 A/D 声部或数字声部的干音音量级别（或未经系统效果器处理的信号电平）。
仅当 Output Select 设置为 MainL&R 时，此参数才可用。
设置 ：0–127

Var Send (A/D Part Variation Send)
Var Send (Digital Part Variation Send)
设置从 A/D 声部或数字声部发送到变奏效果器的信号电平。
仅当 Output Select 设置为 MainL&R 时，此参数才可用。
设置 ：0–127

Rev Send (A/D Part Reverb Send)
Rev Send (Digital Part Reverb Send)
设置从 A/D 声部或数字声部发送到混响效果器的信号电平。
仅当 Output Select 设置为 MainL&R 时，此参数才可用。
设置 ：0–127

Output Select (A/D Part Output Select)
Output Select (Digital Part Output Select)
设置来自 A/D 声部或数字声部的音频信号的输出目的地。
设置 ：	 MainL&R、(AsgnL&R)、USB Stereo、(AsgnL)、(AsgnR)、USB mono、Off

MainL&R：以立体声（两个通道）输出到 OUTPUT [L/MONO] 和 OUTPUT [R] 插孔。
USB Stereo ：以立体声（通道 1 和 2，至通道 7 和 8）输出到 USB [TO HOST] 端口。
USB mono ：以单声道（通道 1 至 8）输出至 USB [TO HOST] 端口
Off：该声部没有音频信号输出。

注
与 MONTAGE M 设备数据兼容的相关设置如下所示。在设置时，这些设置视为 Off。
•	AsgnL&R
•	USB Stereo ：USB9&10 – USB29&30
•	USB mono ：USB9 – USB30
•	AsgnL
•	AsgnR
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Routing
在 Routing 画面上，您可以设置 A/D 声部的效果器路由。

操作
[PERFORMANCE (HOME)] → Common 选择 → [EDIT/ ] → Audio In → Routing

(1)

(2)

(1) A/D Part Insertion FX A Switch

(2) A/D Part Insertion FX B Switch

A/D In
Digital In
在 A/D In 视图和 Digital In 视图之间切换。
选择 Digital In 时，只有 Digital Part Reverb Send、Digital Part Variation Send 和 Digital Part Output Select 可用。

A/D Part Insertion FX A Switch
A/D Part Insertion FX B Switch
打开或关闭插入效果器 A 和插入效果器 B。
设置 ：Off、On

Type (A/D Part Insertion Effect A Type)
Type (A/D Part Insertion Effect B Type)
设置效果器类型。
设置 ：请参阅效果器类型

Preset (A/D Part Insertion Effect A Preset)
Preset (A/D Part Insertion Effect B Preset)
为每种效果器类型选择预置效果器参数之一。
通过选择预置，您可以更改应用效果器的方式。
设置 ：请参阅 Data List
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Side Chain (A/D Part Insertion Effect A Side Chain)
Side Chain (A/D Part Insertion Effect B Side Chain)
Modulator (A/D Part Insertion Effect A Modulator)
Modulator (A/D Part Insertion Effect B Modulator)
设置插入效果器 A 或插入效果器 B 的侧链声部（或调制器，具体取决于效果器类型）。
当声部本身或 Master 设置为 Modulator 时，此参数不可用。在这种情况下，参数值将显示在括号中，如“(Master)”。
设置 ：Part 1–16、A/D、Master、Off

Ins Connect (A/D Part Insertion Effect Connect Type)
设置插入效果器 A 和插入效果器 B 的效果器路由。当设置更改时，图表也会相应变化。
设置 ：Ins A→B、Ins B→A

Dry Level (A/D Part Dry Level)
设置 AD 声部的干音音量级别（或未经系统效果器处理的信号电平）。
仅当 Output Select 设置为 MainL&R 时，此参数才可用。
设置 ：0–127

2-band EQ
打开 A/D 声部的 2-band EQ 画面。

Rev Send (A/D Part Reverb Send)
Rev Send (Digital Part Reverb Send)
设置从插入效果器 A 或插入效果器 B 发送到混响效果器的信号（或旁路信号）的电平。
仅当 Output Select 设置为 MainL&R 时，此参数才可用。
设置 ：0–127

Var Send (A/D Part Variation Send)
Var Send (Digital Part Variation Send)
设置从插入效果器 A 或插入效果器 B 发送到变奏效果器的信号（或旁路信号）的电平。
仅当 Output Select 设置为 MainL&R 时，此参数才可用。
设置 ：0–127

Envelope Follower
打开包络跟随器的设置画面。

Output Select (A/D Part Output Select)
Output Select (Digital Part Output Select)
设置音频信号的输出目的地。
设置 ：	 MainL&R、(AsgnL&R)、USB Stereo、(AsgnL)、(AsgnR)、USB mono、Off

MainL&R：以立体声（两个通道）输出到 OUTPUT [L/MONO] 和 OUTPUT [R] 插孔。
USB Stereo ：以立体声（通道 1 和 2，至通道 7 和 8）输出到 USB [TO HOST] 端口。
USB mono ：以单声道（通道 1 至 8）输出至 USB [TO HOST] 端口。
Off：该声部没有音频信号输出。

注
与 MONTAGE M 设备数据兼容的相关设置如下所示。在设置时，这些设置视为 Off。
•	AsgnL&R
•	USB Stereo ：USB9&10 – USB29&30
•	USB mono ：USB9 – USB30
•	AsgnL
•	AsgnR
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Ins A、Ins B
在 Ins A 和 Ins B 画面上，您可以设置插入效果器。

操作
[PERFORMANCE (HOME)] → Common 选择 → [EDIT/ ] → Audio In → Ins A
[PERFORMANCE (HOME)] → Common 选择 → [EDIT/ ] → Audio In → Ins B

Insertion FX Switch
启用插入效果器。
设置 ：Off、On

Category (Insertion Effect A Category)
Category (Insertion Effect B Category)
Type (Insertion Effect A Type)
Type (Insertion Effect B Type)
设置插入效果器的类别和类型。
设置 ：请参阅效果器类型

Preset (Insertion Effect A Preset)
Preset (Insertion Effect B Preset)
为每种效果器类型选择预置效果器参数之一。通过选择预置，您可以更改应用效果器的方式。
设置 ：请参阅 Data List

Side Chain (Insertion Effect A Side Chain Part)
Side Chain (Insertion Effect B Side Chain Part)
Modulator (Insertion Effect A Modulator Part)
Modulator (Insertion Effect B Modulator Part)
设置插入效果器 A 或插入效果器 B 的侧链声部（或调制器，具体取决于效果器类型）。
当声部本身或 Master 设置为 Modulator 时，此参数不可用。在这种情况下，参数值将显示在括号中，如“(Master)”。
设置 ：Part 1–16、A/D、Master、Off

Effect Parameter
效果器参数因效果器类型而异。
设置 ：请参阅效果器参数
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2-band EQ
在 2-band EQ 画面上，您可以设置声部 EQ。

操作
[PERFORMANCE (HOME)] → Common 选择 → [EDIT/ ] → Audio In → 2-band EQ

EQ1 Type (A/D Part 2-band EQ 1 Type)
EQ2 Type (A/D Part 2-band EQ 2 Type)
选择所需的 EQ 类型。
设置 ：	 Thru、LPF、HPF、Low Shelf、Hi Shelf、Peak/Dip

Thru ：传递信号而不应用任何效果器。
LPF ：减弱高于截止频率的信号。
HPF ：减弱低于截止频率的信号。
Low Shelf ：减弱或增强低于指定频率设置的信号。
Hi Shelf ：减弱或增强高于指定频率设置的信号。
Peak/Dip ：减弱或增强指定频率设置下的信号。

EQ 1 Freq (A/D Part 2-band EQ 1 Frequency)
EQ 2 Freq (A/D Part 2-band EQ 2 Frequency)
设置要减弱或增强的频率。
当 EQ Type 设置为 Thru 时，此参数不可用。
设置 ：63.0Hz–18.0kHz

EQ 1 Gain (A/D Part 2-band EQ 1 Gain)
EQ 2 Gain (A/D Part 2-band EQ 2 Gain)
设置在 EQ1 Freq 或 EQ2 Freq 中设置的频段的信号电平。
当 EQ Type 设置为 Thru、LPF 或 HPF 时，此参数不可用。
设置 ：–12.0dB – +0.0dB – +12.0dB

EQ 1 Q (A/D Part 2-band EQ 1 Q)
EQ 2 Q (A/D Part 2-band EQ 2 Q)
设置带宽，用于减弱或增强使用 EQ1 Freq 或 EQ2 Freq 设置的频率音量。
仅当 EQ Type 设置为 Peak/Dip 时，此参数才可用。
设置 ：0.1–12.0

Output Level (A/D Part 2-band EQ Output Level)
设置 2 频段 EQ 的输出增益。
设置 ：–12.0dB – +0.0dB – +12.0dB
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Arp/MS

Arp Common
在 Arp Common 画面上，您可以设置整个演奏组的琶音参数。

操作
[PERFORMANCE (HOME)] → Common 选择 → [EDIT/ ] → Arp/MS → Arp Common

Arp Master (Arpeggio Master Switch)
打开或关闭演奏组的琶音。此开关与上方面板的 [ARP] 按钮关联。
设置 ：Off、On

Sync Quantize (Arpeggio Sync Quantize Value)
当播放多个声部中的琶音乐句时，调整在播放第一个琶音乐句时开始下一个琶音乐句的时机。如果设置为 Off，则在键盘上
弹奏声部时会播放琶音。
设置 ：	 Off、60（三十二分音符）、80（十六分音符三连音）、120（十六分音符）、160（八分音符三连音）、240（八分音

符）、320（四分音符三连音）、480（四分音符）（此处显示的数字是时钟值）

Swing (Swing Offset)
设置演奏组的琶音和动态音序器的摇摆值。
此值指定为 Part Swing 的偏移值。
设置 ：–120–+ 0–+120

Unit (Common Unit Multiply)
设置整个演奏组的琶音播放时间的拉伸或压缩百分比。
此参数会影响 Part Unit (Arpeggio Unit Multiply) 设置为 Common 的声部。
当您拉伸或压缩播放时间时，节拍和速度的细分会发生变化，因此您可以为最初选择的琶音创造出全新的感觉。
设置 ：	 50%, 66%, 75%, 100%, 133%, 150%, 200%, 266%, 300%, 400%

200%:播放时间加倍，速度减半
100%:播放时间保持不变
50%:播放时间减半，速度加倍
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Qntz Strength (Arpeggio Quantize Strength Offset)
设置应用于演奏组琶音的量化设置的强度。
此值指定为每个声部的 Qntz Strength (Arpeggio Quantize Strength) 的偏移值。
设置 ：–100–+0–+100

Gate Time (Arpeggio Gate Time Rate Offset)
设置演奏组的琶音门限时间率。
此值指定为每个声部的 Gate Time (Arpeggio Gate Time Rate) 的偏移值。
设置 ：–100–+0–+100

Velocity (Arpeggio Velocity Rate Offset)
设置演奏组的琶音力度率。
此值指定为每个声部的 Velocity (Arpeggio Velocity Rate) 的偏移值。
设置 ：–100–+0–+100

Octave Shift (Arpeggio Octave Shift Offset)
以八度为单位改变演奏组的琶音音高。
此值指定为每个声部的 Octave Shift (Arpeggio Octave Shift) 的偏移值。
设置 ：–20–+0–+20

Octave Range (Arpeggio Octave Range Offset)
以八度为单位改变演奏组的琶音范围。
此值指定为每个声部的 Octave Range (Arpeggio Octave Range) 的偏移值。
设置 ：–6–+0–+6

Arp Select (Arpeggio Select)
选择琶音。
设置 ：1–8
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Arp Overview (Arpeggio Overview)
在 Arp Overview 画面上，您可以从所有声部列表中设置琶音类型。

操作
[PERFORMANCE (HOME)] → Common 选择 → [EDIT/ ] → Arp/MS → Arp Overview

（当所选声部为 Common 时）[SHIFT] + [ARP]

Part 1–8
Part 9–16
切换声部的视图。
设置 ：Part 1–8、Part 9–16

Arp Master (Arpeggio Master Switch)
打开或关闭演奏组的琶音。
此开关与上方面板的 [ARP] 按钮关联。
设置 ：Off、On

Group (Arpeggio Group)
设置 Arpeggio Group 以对多个声部使用相同的琶音。在同一 Group 中设置的声部将具有相同的琶音设置。

Arp Select (Arpeggio Select)
选择琶音。
设置 ：1–8

Sw (Part Arpeggio Switch)
打开或关闭每个声部的琶音。
设置 ：Off、On
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	�当 View设置为 Category时
Category (Arpeggio Category)
Sub (Arpeggio Sub Category)
Name (Arpeggio Name)
设置 ：请参阅 Data List

	�当 View设置为Number时
Bank (Arpeggio Bank)
Number (Arpeggio Number)
Name (Arpeggio Name)
设置 ：请参阅 Data List

	�当 View 设置为 Range 时
Name (Arpeggio Name)
设置 ：请参阅 Data List

Velocity Limit (Arpeggio Velocity Limit)
设置琶音播放的力度范围（最低和最高值）。
当设置为较高的值在前，较低的值在后（例如，93 至 34）时，仅以 1 至 34 和 93 至 127 的力度弹奏琶音。
设置 ：1–127

Note Limit (Arpeggio Note Limit)
设置琶音播放的音符范围（最低音符和最高音符）。
当指定的第一个音符高于第二个音符（例如，C5 至 C4）时，将演奏 C–2 至 C4 和 C5 至 G8 范围内的音符。
设置 ：C–2–G8
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MS Common (Motion Sequencer Common)
在 MS Common 画面上，您可以设置用于整个演奏组的动态音序器参数。

操作
[PERFORMANCE (HOME)] → Common 选择 → [EDIT/ ] → Arp/MS → MS Common

（当所选声部为 Common 时）[SHIFT] + [MSEQ]

Common Swing (Swing Offset)
设置演奏组的琶音和动态音序器的摇摆值。
此值指定为 Part Swing 的偏移值。
设置 ：–120–+0–+120

Common Unit (Common Unit Multiply)
设置整个演奏组的动态音序器播放时间的拉伸或压缩百分比。
此参数会影响 Unit 设置为 Common 的通道。
当您拉伸或压缩播放时间时，节拍和速度的细分会发生变化，因此您可以为最初选择的动态音序创造出全新的感觉。
设置 ：	 50%, 66%, 75%, 100%, 133%, 150%, 200%, 266%, 300%, 400%

200%:播放时间加倍，速度减半
100%:播放时间保持不变
50%:播放时间减半，速度加倍

Common Amplitude (Motion Sequencer Amplitude Performance Offset)
设置整个演奏组的动态音序器振幅（或音序变化量）。
如果 MS FX (Lane FX Receive) 设置为 On，则此参数值会使声部内通道的振幅发生偏移。
此值指定为每个声部的 Part Amplitude (Part Motion Sequencer Amplitude) 的偏移值。
设置 ：–127–+0–+127

Common Shape (Motion Sequencer Pulse Shape Performance Offset)
设置演奏组的动态音序器脉冲形状（或步进曲线的形状）。
如果通道的 MS FX (Lane FX Receive) 设置为 On 且 Control 设置为 On，则此参数值会使声部内通道的参数发生偏移。
此值指定为每个声部的 Part Shape (Part Motion Sequencer Pulse Shape) 的偏移值。
设置 ：–100–+0–+100



182MODX M 使用说明书

Common Smooth (Motion Sequencer Smoothness Performance Offset)
设置整个演奏组的动态音序平滑度（或音序随时间变化的平滑度）。
如果通道的 MS FX (Lane FX Receive) 设置为 On，则此参数值会使声部内通道的平滑度发生偏移。
此值指定为每个声部的 Part Motion Seq Smooth (Part Motion Sequencer Smoothness) 的偏移值。
设置 ：–127–+0–+127

Common Random (Motion Sequencer Randomness Performance Offset)
设置整个演奏组的动态音序器随机性（或音序的步进值变化的随机性）。
如果通道的 MS FX (Lane FX Receive) 设置为 On，则此参数值会使演奏组内通道的随机性发生偏移。
此值指定为每个声部的 Part Motion Seq Random (Part Motion Sequencer Randomness) 的偏移值。
设置 ：–127–+0–+127

View Lane (Motion Seq View Lane)
设置当 Home 画面的 View Mode 设置为 Motion Seq 时显示的 Motion Seq Lane。
设置 ：Super Knob、1–4

AD MS Random (A/D Part Motion Sequencer Randomness)
设置 A/D Part Motion Sequencer Step Value 变化的随机性。
设置 ：0–127

MS Select (Motion Sequence Select)
更改动态音序选择。
设置 ：1–8
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MS Overview (Motion Sequencer Overview)
在 MS Overview 画面上，您可以从所有声部列表中设置动态音序器。

操作
[PERFORMANCE (HOME)] → Common 选择 → [EDIT/ ] → Arp/MS → MS Overview

MS Master (Motion Seq Master Switch)
将整个演奏组的动态音序器设置为打开或关闭。
此开关与上方面板的 [MSEQ] 按钮关联。
设置 ：Off、On

Active (Active Motion Sequencer)
显示设置为 On 的通道开关数量。
斜杠 (/) 右侧显示的数字表示您可以同时设置为打开的最大通道数。

MS Select (Motion Sequence Select)
更改动态音序选择。
设置 ：1–8

PartSw (Motion Sequencer Part Switch)
打开或关闭每个声部的动态音序器。
设置 ：Off、On

Lane Switch
打开或关闭每个通道。
您可以在一个声部中使用最多四个动态音序器通道，或者在整个演奏组中使用最多八个通道。
设置 ：Off、On
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Lane
在 Lane 画面上，您可以设置每个动态音序器通道的参数。

操作
[PERFORMANCE (HOME)] → Common 选择 → [EDIT/ ] → Arp/MS → Lane

Motion Seq Master Sw (Motion Sequencer Master Switch)
将整个演奏组的动态音序器设置为打开或关闭。
设置 ：Off、On

Motion Seq Part Sw (Motion Sequencer Part Switch)
打开或关闭声部的动态音序器。
设置 ：Off、On

Lane (Lane Select)
显示所选通道的参数。
设置 ：1–4

LaneSw (Lane Switch)
打开或关闭每个通道。
您可以在一个声部中使用最多四个动态音序器通道，或者在整个演奏组中使用最多八个通道。
当设置为 Off 时，将不会显示该通道的参数。
设置 ：Off、On

MS FX (Lane FX Receive)
设置选定的通道来接收来自旋钮的信号，从而更改动态音序器参数。
设置 ：Off、On

Trigger (Lane Trigger Receive)
设置所选通道来接收来自 [MSEQ TRIGGER] 按钮的信号。
设置为 On 时，除非按 [MSEQ TRIGGER] 按钮，否则不会播放动态音序。
设置 ：Off、On

Sequence Select (Motion Sequence Select)
更改动态音序选择。
设置 ：1–8

Target Sequence
显示选定的通道和音序。
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	� Sync/Speed 选项卡
Sync (Lane Sync)
将动态音序的播放设置为 Control Assign 画面中的目的地，以与演奏组速度或节拍同步。
设置 ：	 Off、Tempo、Beat、Lane1（当选定 Lane2–4 时）

Off：单独播放通道动态音序器
Tempo：以演奏组速度播放通道动态音序器。
Beat ：与节拍同步播放通道动态音序器
Lane1 ：与通道 1 同步播放通道动态音序器

•	当 Sync 设置为Off时

Speed (Lane Speed)
设置动态音序的播放速度。
当 Sync 设置为 Off 时，此参数可用。
设置 ：0–127

Delay Time (A/D Part Motion Seq Lane Key On Delay Time Length)
设置开始播放动态音序的延迟时间。
设置 ：0–127

Fade In Time (A/D Part Motion Seq Lane Fade In Time Length)
设置动态音序达到最大振幅的时间。
设置 ：0–127

•	当 Sync 设置为Off之外的其他设置时

Unit (A/D Part Motion Seq Lane Unit Multiply)
设置所选通道的动态音序器播放时间的拉伸或压缩百分比。
仅当 Sync 设置为 Tempo 或 Beat 时，此参数才可用。
设置 ：	 50%、66%、75%、100%、133%、150%、200%、266%、300%、400%、600%、800%、1200%、1600%、

2400%、3200%、6400%、Common
200%:播放时间加倍，速度减半
100%:播放时间保持不变
50%:播放时间减半，速度加倍
Common：应用在 Unit Multiply 中设置且对所有声部通用的值

Delay Steps (A/D Part Motion Seq Lane Key On Delay Step Length)
设置当 Sync 设置为 Tempo 或 Beat 时开始播放 Motion Sequence 的延迟时间。
设置 ：0–32

Fade In Steps (A/D Part Motion Seq Lane Fade In Step Length)
设置当 Sync 设置为 Tempo、Beat 或 Lane1 时 Motion Sequence 达到最大振幅的时间。
设置 ：0–32

Lane Vel Limit (Lane Velocity Limit)
设置播放所选通道的动态音序的力度范围（最低和最高值）。
仅当 Sync 设置为 Off、Tempo 或 Beat 时，此参数才可用。
当 Velocity Limit 设置为从最高值到最低值的范围时，将仅在两个力度范围内播放动态音序 ：从最大值到最高值，以及从最
低值到最小值。
设置 ：1–127

Edit Sequence
Motion Sequence Edit 画面会打开。

Motion Seq Step n Value
显示所选音序的步级曲线。
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	� Loop/Length 选项卡
Key On Reset (Lane Key On Reset)
当您按键盘上的任意键时重置动态音序播放。
仅当 Sync 设置为 Off、Tempo 或 Beat 时，此参数才可用。当 Trigger 设置为 On 时，此参数不可用。
设置 ：	 Off、Each-On、1st-On

Each-On ：每次演奏任何音符时，音序都会复位，并从头开始播放
1st-On ：从弹奏的第一个音符处开始播放。如果在演奏第一个音符时演奏第二个音符，则音序不会复位。

Loop (Lane Loop)
将动态音序设置为循环播放（重复）或单次播放。
仅当 Sync 设置为 Off、Tempo 或 Beat 时，此参数才可用。
设置 ：Off、On

Loop Start (Lane Loop Start)
指定动态音序循环播放的起点。
设置 ：1–16（应低于 Length 设置）

Length (Motion Seq Length)
设置动态音序的步级数。
设置 ：1–16（应高于 Loop Start 设置）

MS Grid (Motion Sequencer Grid)
设置动态音序中的步级长度。
设置 ：60, 80, 120, 160, 240, 320, 480

	� Motion Sequence Edit
打开动态音序的设置画面。
您可以创建最多 16 个步级的音序。

Loop Start (Lane Loop Start)
指定动态音序循环播放的起点。
设置 ：1–16（应低于 Length 设置）

Length (Motion Sequence Length)
设置动态音序长度。
设置 ：1–16（应高于 Loop Start 设置）
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MS Grid (Motion Sequencer Grid)
设置动态音序中的步级长度。
设置 ：60, 80, 120, 160, 240, 320, 480

Sequence Select (Motion Sequence Select)
更改动态音序类型选择。
设置 ：1–8

Lane Select
更改通道选择。
设置 ：1–4

Polarity (Motion Sequence Polarity)
设置动态音序的极性。
设置 ：	 Unipolar、Bipolar

Unipolar ：参数更改仅使用正值
Bipolar ：参数更改使用正值和负值

Amplitude (Motion Sequence Amplitude)
设置动态音序的变化程度。
设置 ：0–127

Smooth (Motion Sequence Smoothness)
设置动态音序随时间变化的平滑度。
设置 ：0–127

Job
调出作业菜单。

•	 Store Sequence
保存（存储）编辑过的动态音序。

•	 Load Sequence
加载动态音序。

•	 Copy Sequence
复制动态音序。

Motion Sequence Step Value
设置动态音序中每个步级的值。
您可以使用控制滑杆 1 至 8 来更改步级 1 至 8 以及步级 9 至 16 的值，具体取决于光标位置。
设置 ：0–127

Motion Sequence Step Type
设置动态音序中每个步级的类型和方向。
设置 ：A、B、Reverse A、Reverse B

Pulse A (Motion Sequence Step Curve Type A)
Pulse B (Motion Sequence Step Curve Type B)
选择 Pulse A 和 Pulse B 的参数变化曲线。
使用 Motion Sequence Step Type 来选择每个步级要使用的曲线类型。
纵轴表示时间，横轴表示步进值。
设置 ：	 Standard、Sigmoid、Threshold、Bell、Dogleg、FM、AM、M、Discrete Saw、Smooth Saw、Triangle、

Square、Trapezoid、Tilt Sine、Bounce、Resonance、Sequence、Hold、Harmonic、Steps（当选定了预置
库时）
Init Curve 1–32（当选定了用户库时）
Library 1–24 内的 Curve（加载库文件时）



188MODX M 使用说明书

Prm 1 (Motion Sequence Step Curve Parameter 1)
Prm 2 (Motion Sequence Step Curve Parameter 2)
调整动态音序中步进曲线的形状。此外，参数值的范围因 Curve Type 而异。
根据 Curve Type，此设置不可用。

Control (Motion Sequence Step Curve Shape Control Switch)
启用或禁用使用旋钮来控制动态音序的步进曲线形状。
仅当 MS FX (Lane FX Receive) 设置为 On 时显示。根据 Curve Type，此设置不可用。
设置 ：Off、On
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Control

Control Assign
在 Control Assign 画面上，您可以设置声部的控制器。
通过将参数 (Destination) 分配给控制器 (Source)，您可以使用各种各样的方式控制声音。您可以使用物理控制器（例如弯
音轮和旋钮）以及动态音序器和包络跟随器。
最多可以将 32 个控制器同时分配给一个声部。

操作
[PERFORMANCE (HOME)] → Common 选择 → [EDIT/ ] → Control → Control Assign
点击 Motion Control 上的 Edit Super Knob → Super Knob

Auto Select
打开或关闭 Display Filter 的自动选择设置。
设置为 On 时，移动您想要设置为 Source 的控制器会自动将控制器设置为 Display Filter。
设置 ：Off、On

Display Filter
选择在画面上显示设置的控制器。
当您选择 Super Knob 时，将会显示 Super Knob Link 设置为 On 的旋钮 1 至 8 的所有设置。
设置 ：	 PitchBend、ModWheel、Ch.AT、FootCtrl 1、FootCtrl 2、FootSwitch、Ribbon、Breath、AsgnKnob 1–8、

Super Knob、AsgnSw 1、AsgnSw 2、MS Lane 1–4、EnvFollow 1–16、EnvFollowAD、EnvFollowMst、All

Display Name (Assignable Knob Name)
这使您可以输入旋钮 1 至 8 的新名称。当 Source 设置为 AsgnKnob 1–8 以外的其他设置时，不会显示此参数。

Edit Pitch Bend
General/Pitch → Pitch 会打开。当 Source 设置为 PitchBend 以外的其他值时，不会显示此参数。

Edit Motion Sequencer
Opens Arp/MS → Lane。当 Source 设置为 MS Lane 1–4 以外的其他值时，不会显示此参数。

Edit Envelope Follower
打开包络跟随器的设置画面。当 Source 设置为 EnvFollow 1–16、EnvFollowAD 或 EnvFollowMst 以外的其他值时，不会
显示此参数。
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Destination
设置目的地的参数。点击 [+] 可添加 Destination。
当 Source 设置为 AsgnKnob 1–8 时，Part1–16 Assign1–8 会添加到设置中。在这种情况下，Curve Type 和 Curve Ratio
不可用。

Source
设置用于控制 Destination 参数设置的控制器。
当 Destination 设置为 Part1–16 Assign1–8 时，只有 AsgnKnob 1–8 可用。无法使用其他控制器。
设置 ：	 PitchBend、ModWheel、AfterTouch、FootCtrl 1、FootCtrl 2、FootSwitch、Ribbon、Breath、AsgnKnob 1–8、 

AsgnSw 1、AsgnSw 2、MS Lane 1–4、EnvFollow 1–16、EnvFollowAD、EnvFollowMst

Destination to Name
将 Destination 的参数设置复制到 Display Name。
当 Source 设置为 AsgnKnob 1–8 以外的其他值时，不会显示此参数。

Delete
删除选定的 Destination。

Destination (Part Assignable Knob Destination)
设置当您尝试将 Part1–16 Assign1–8 设置为 Destination 且多个目的地已分配给 Part Assign 时要显示的参数。

Parameter (Part Assignable Knob Parameter)
将声部参数设置到 Destination。
设置 ：请参阅 Data List

仅当 Destination 1–32 设置为 Part1–16 Assign1–8 时，才会出现下面显示的参数。此外，当在 Destination 中找不到声部
旋钮 1-8 时，画面上仅显示快捷按钮。

Edit (Part No.) Control Assign
打开所选声部的 Control Assign 画面。

Curve Type
设置 Destination 的参数设置的变化曲线。
横轴表示 Source 中设置的控制器值，纵轴表示参数值。
设置 ：	 Standard、Sigmoid、Threshold、Bell、Dogleg、FM、AM、M、Discrete Saw、Smooth Saw、Triangle、

Square、Trapezoid、Tilt Sine、Bounce、Resonance、Sequence、Hold、Harmonic、Steps （当选定了预置
库时）
Init Curve 1–32（当选定了用户库时）
Library 1–24 内的 Curve （加载库文件时）

Polarity (Curve Polarity)
设置在 Curve Type 中设置的曲线的极性。
设置 ：	 Uni、Bi

Uni ：根据曲线形状，参数变化仅在正范围或负范围内发生。
Bi ：根据曲线形状，参数变化在正范围和负范围内发生。

Ratio (Curve Ratio)
设置参数值的比率。
设置 ：–128–+0–+127

Param 1 (Curve Parameter 1)
Param 2 (Curve Parameter 2)
调整曲线形状。根据 Curve Type，此设置不可用。

Edit User Curve
打开用户曲线的设置画面。
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Ribbon Settings
设置触摸条控制器。

操作
[PERFORMANCE (HOME)] → Common 选择 → [EDIT/ ] → Control → Ribbon Settings

Ribbon Grid Mode
设置触摸条控制器的格栅模式。
设置 ：Continuous、5 step、3 step 

注
如果您希望使用在 Control Assign 画面上设置的 Ribbon Controller 设置，请设置为 Continuous 。

	� Continuous 模式
Ribbon Mode (Ribbon Controller Mode)
设置触摸条控制器的工作方式。
设置 ：	 Hold、Reset

Hold ：保留从触摸条控制器释放手指时的位置值。
Reset ：当您从触摸条控制器上松开手指时，自动将值复位为中间位置。

	� 5 step 模式、3 step 模式
Control Part
选择要使用触摸条控制器控制的声部。
设置 ：Common、Part 1–16

Control Destination
设置 ：请参阅数据列表中的 Control Box Destination

Step Value 1–5
设置 ：取决于 Destination
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Control Number
设置整个演奏组的控制变化编号。
您可以将特定的 MIDI 控制变化编号分配给上方面板上的旋钮和外部设备上的控制器。
注
对于本乐器未包括的控制器，您可以使用外部音序器或外部 MIDI 控制器。

操作
[PERFORMANCE (HOME)] → Common 选择 → [EDIT/ ] → Control → Control Number

Ribbon Ctrl (Ribbon Controller Control Number)
设置由触摸条控制器操作生成的控制变化编号。
当本乐器从外部设备接收到用此参数设置的编号的 MIDI 控制变化信息时，将该信息视为与内置触摸条控制器的操作相同。
设置 ：Off、1–95

Breath Ctrl (Breath Controller Control Number)
设置要从外部设备接收的呼吸控制器的控制变化编号。
当本乐器从外部设备接收到用此参数设置的编号的 MIDI 控制变化信息时，将该信息视为与呼吸控制器的操作相同。
设置 ：Off、1–95

Foot Ctrl 1 (Foot Controller 1 Control Number)
Foot Ctrl 2 (Foot Controller 2 Control Number)
设置通过连接至 FOOT CONTROLLER 插孔的踏板控制器操作生成的控制变化编号。
当本乐器从外部设备接收到用此参数设置的编号的 MIDI 控制变化信息时，将该信息视为与踏板控制器的操作相同。
设置 ：Off、1–95、Super Knob

Assign Sw 1 (Assignable Switch 1 Control Number)
Assign Sw 2 (Assignable Switch 2 Control Number)
设置通过 [ASSIGN 1] 和 [ASSIGN 2] 按钮的操作生成的控制变化编号。
当本乐器从外部设备接收到用此参数设置的编号的 MIDI 控制变化信息时，将该信息视为与 [ASSIGN 1] 和 [ASSIGN 2] 按钮
的操作相同。
设置 ：Off、1–95



193MODX M 使用说明书

MS Trigger (Motion Sequencer Trigger Switch Control Number)
设置由 [MSEQ TRIGGER] 按钮操作生成的控制变化编号。
当本乐器从外部设备接收到用此参数设置的编号的 MIDI 控制变化信息时，将该信息视为与 [MSEQ TRIGGER] 按钮的操作 
相同。
设置 ：Off、1–95

MIDI Settings
打开 MIDI 设置画面。可以从 [UTILITY] → Settings → MIDI I/O 打开相同的画面。

Assign Knob (Assignable Knob Control Number)
设置由旋钮 1 至 8 的操作生成的控制变化编号。
当本乐器从外部设备接收到用此参数设置的编号的 MIDI 控制变化信息时，将该信息视为与旋钮 1 至 8 的操作相同。
设置 ：Off、1–95

FS Assign (Foot Switch Assign Control Number)
显示通过连接至 FOOT SWITCH [ASSIGNABLE] 插孔的脚踏开关操作生成的控制变化编号。当本乐器从外部设备接收到用此
参数设置的编号的 MIDI 控制变化信息时，将该信息视为与脚踏开关的操作相同。

Scene CC (Scene Control Change Number)
显示由 SCENE 按钮操作生成的控制变化编号。当本乐器从外部设备接收到用此参数设置的编号的 MIDI 控制变化信息时， 
将该信息视为与 SCENE 按钮的操作相同。

Super Knob CC (Super Knob Control Change Number)
显示由超级旋钮操作生成的控制变化编号。当本乐器从外部设备接收到用此参数设置的编号的 MIDI 控制变化信息时，将该
信息视为与超级旋钮的操作相同。
注
•	当 Scene CC 和 Super Knob CC 设置为 Off 时，使用系统专有数据 (SysEx) 来处理 MIDI 信息。
•	FS Assign、Scene CC 和 Super Knob CC 用于整个乐器。如果需要，可以从 Utility MIDI I/O 画面更改这些设置。
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Control Settings
设置控制器模式。

操作
[PERFORMANCE (HOME)] → Common 选择 → [EDIT/ ] → Control → Control Settings
[SHIFT] + [ASSIGN 1]
[SHIFT] + [ASSIGN 2]

Slider Direction Part 1–8
当滑杆 Mode 设置为 PART 时，设置控制滑杆 1 至 8 的方向。
设置 ：Normal （从下到上）、Reverse （从上到下）

Assignable Switch 1 Mode
Assignable Switch 2 Mode
设置 [ASSIGN 1] 和 [ASSIGN 2] 按钮的 Latch 或 Momentary 设置。
设置 ：	 Latch、Momentary

Latch ：按下按钮时设置为 On，再次按下按钮时设置为 Off。
Momentary ：按住按钮时设置为 On，释放按钮时设置为 Off。
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Part Edit (AWM2) Part Common Edit 画面
Normal Part (AWM2) 最多包含 128 个音素。
Part Edit (AWM2) 包括 Part Common Edit（用于设置整个声部的参数）和 Element Edit（用于设置声部中每个音素的参数）。

General/Pitch

Part Settings
在 Part Settings 画面上，您可以设置声部的常规参数（例如声部名称和音源系统）。

操作
[PERFORMANCE (HOME)] → Part Common 选择 → [EDIT/ ] → General/Pitch → Part Settings

Main Category (Part Main Category)
Sub Category (Part Sub Category)
设置所选声部的主类别和子类别。
设置 ：请参阅 Data List

Part Name
您可以使用新名称保存正在编辑的声部，您可以使用最多 20 个字母数字字符。

Volume
显示所选声部的音量。
设置 ：0–127

Pan
调整所选声部的声相位置（在立体声场中）。
设置 ：L63–C（中央）–R63



196MODX M 使用说明书

Dry Level
显示所选声部的干音音量级别。仅当 Part Output 设置为 MainL&R 时，此参数才可用。
设置 ：0–127

Var Send (Variation Send)
设置所选声部的变奏发送。仅当 Part Output 设置为 MainL&R 时，此参数才可用。
设置 ：0–127

Rev Send (Reverb Send)
显示所选声部的混响发送。仅当 Part Output 设置为 MainL&R 时，此参数才可用。
设置 ：0–127

Part Output (Part Output Select)
设置所选声部的音频信号的输出目的地。
设置 ：	 MainL&R、(AsgnL&R)、USB Stereo、(AsgnL)、(AsgnR)、USB mono、Off

MainL&R：以立体声（两个通道）输出到 OUTPUT [L/MONO] 和 OUTPUT [R] 插孔。
USB Stereo ：以立体声（通道 1 和 2，至通道 7 和 8）输出到 USB [TO HOST] 端口。
USB mono ：以单声道（通道 1 至 8）输出至 USB [TO HOST] 端口
Off：该声部没有音频信号输出。

注
与 MONTAGE M 设备数据兼容的相关设置如下所示。在设置时，这些设置视为 Off。
•	AsgnL&R
•	USB Stereo ：USB9&10 – USB29&30
•	USB mono ：USB9 – USB30
•	AsgnL
•	AsgnR

Mono/Poly
设置当前声部的音源模式。Mono 用于演奏单个音符，Poly 用于同时演奏多个音符。
在连奏中使用 Mono 设置弹奏键盘时，您可以创建声音从一个音符到另一个音符的平滑过渡。
设置 ：Mono、Poly

Key Assign (Key Assign Mode)
设置当内置音源连续两次（或更多次）收到相同声音的音符打开信息时发出声音的方法。
在大多数情况下，建议使用 Multi 设置。但是，Multi 设置会占用最大复音数中的多个音符，因此如果其他声部中的声音丢
失或无法正常播放，建议更改为 Single。
设置 ：	 Single、Multi

Single ：停止第一个音符，然后再次播放相同的音符。这对于在同一通道上重复相同的音符很方便
Multi ：在第一个音符上重叠演奏第二个音符。Multi 设置使滚奏听起来自然，尤其是会使脆音铜钹或其他打击乐
器具有较长的衰减

Arp Play Only (Arpeggio Play Only)
将声部设置为仅与琶音一起演奏。
任何设置为 On 的声部都将通过从琶音发送的音符打开信息来演奏。
设置 ：Off、On

Element Pan (Element Pan Switch)
从 Element Edit 将 Pan 设置为 On 或 Off。
当设置为 Off 时，Element Edit 中的 Pan 将设置为 C（中央）。
设置 ：Off、On
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TG Note Limit (Note Limit)
设置声部的音符范围（最低音符和最高音符）。
当 Note Limit 的第一个音符设置为高于第二个音符（例如，C5 至 C4）时，将演奏 C–2 至 C4 和 C5 至 G8 范围内的音符。
设置 ：C–2–G8

TG Vel Limit (Velocity Limit)
设置声部的力度范围（最低值和最高值）。
当设置为较高的值在前，较低的值在后（例如，93 至 34）时，仅以 1 至 34 和 93 至 127 的力度演奏音符。
设置 ：1–127

Velocity Offset (Velocity Sensitivity Offset)
增大或减小发送至内部音源的力度值。
设置 ：0–127

当 Velocity Depth = 64
且 Velocity Offset = 32 时

当 Velocity Depth = 64
且 Velocity Offset = 64 时

当 Velocity Depth = 64
且 Velocity Offset = 96 时
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127
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0
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(2)

(1)

(2)
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(1)

(2)

(1)
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(1)

(2)

(1)
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(1) 实际产生的力度（影响音源）
(2) 演奏音符的力度

Velocity Depth (Velocity Sensitivity Depth)
设置如何根据力度或击键的强度来调整（发送到内部音源的）力度值。
设置 ：0–127

当 Velocity Depth = 64 时

 

127

0 12764

(1)
Depth = 127

Depth = 64

Depth = 32

Depth = 0
(2)

(1) 实际产生的力度（影响音源）
(2) 演奏音符的力度
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Zone Settings
在 Zone Settings 画面上，您可以设置区域功能的参数。
此功能使您可以将整个键盘划分为最多八个乐段（区域），并为每个区域独立分配单独的通道。 
这样，您只需要一个键盘即可演奏多个键盘的声音。您可以在外部多音色声音模块上演奏多个声部，或者同时演奏内部音源
和任何连接的外部声音模块。

操作
[PERFORMANCE (HOME)] → Part Common 选择 → [EDIT/ ] → General/Pitch → Zone Settings

Keyboard Sw (Keyboard Control Switch)
您可以通过打开或关闭各个声部的 Keyboard Sw (Keyboard Control Switch)，来设置将同时播放哪些声部。
当您选择 Common 或 Keyboard Sw 设置为 On 的声部并弹奏键盘时，Keyboard Sw 设置为 On 的声部将同时播放。
如果声部的 Keyboard Sw 设置为 Off，则在选定该声部的情况下弹奏键盘时，将会播放这些声音。
设置 ：Off、On

Zone Vel Limit (Zone Velocity Limit)
设置区域的力度范围（最低值和最高值）。
当设置为较高的值在前，较低的值在后（例如，93 至 34）时，仅以 1 至 34 和 93 至 127 的力度演奏音符。
设置 ：1–127

Zone Note Limit
设置区域的音符范围（最低音符和最高音符）。
当 Note Limit 的第一个音符设置为高于第二个音符（例如，C5 至 C4）时，将演奏 C–2 至 C4 和 C5 至 G8 范围内的音符。
设置 ：C–2–G8

Octave Shift
以八度为单位改变区域的音高。
设置 ：–3–+0（标准）–+3
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Transpose
以半音为单位改变区域的音高。
设置 ：–11–+0（标准）–+11

Part Mode
切换声部模式。
设置 ：	 Internal、External

Internal ：该模式使用乐器的内置声音引擎
External：使用外接音源。任何设置为 External 的声部都不会从外接设备接收 MIDI 信息

Tx/Rx Ch (Transmit/Receive Channel)
当 Part Mode 设置为 Internal 时，设置用于发送和接收 MIDI 信息的通道。
设置 ：Ch1–Ch16、Off

Transmit Ch
当 Part Mode 设置为 External 时，设置用于发送和接收区域 MIDI 信息的通道。
设置 ：Ch1–Ch16

MIDI I/O Ch (MIDI Input/Output Channel)
显示用于控制设置为 Common 的声部以及 Keyboard Sw 设置为 On 的声部的通道。
此设置对于整个乐器是通用的。可以在 Utility MIDI Settings 画面上更改设置。
使用 Tx/Rx Ch 和 Transmit Ch 时，请勿使用在 MIDI I/O Ch 中指定的相同通道。如果指定了相同通道，则 MIDI I/O Ch 中的
设置将优先。
设置 ：Ch1–Ch16

MIDI Settings
在 Utility 画面上打开 Settings → MIDI I/O。

MIDI Send
如果此参数设置为 On，则当更改了这些参数时，MIDI Bank MSB/LSB、MIDI Pgm Num、MIDI Volume 和 MIDI Pan 设置
会传输到外接设备。然而，当相应的传输开关设置为 Off 时，不会传输设置。
此设置为所有演奏组通用，不能为每个演奏组单独设置。
仅当 Part Mode 设置为 External 时，此参数才可用。
设置 ：Off、On

Bank Select (Transmit Bank Select)
用于将 MIDI Bank MSB 和 MIDI Bank LSB 发送到外接设备的发送开关。
仅当 Part Mode 设置为 External 时，此参数才可用。
设置 ：Off、On

MIDI Bank MSB
MIDI Bank LSB
选择用于发送演奏组选择的库。当 Bank Select (Transmit Bank Select) 设置为 Off 时，此参数不可用。
仅当 Part Mode 设置为 External 时，此参数才可用。
设置 ：000–127

Pgm Change (Transmit Program Change)
这是用于将程序变更信息发送到外部设备的发送开关。
仅当 Part Mode 设置为 External 时，此参数才可用。
设置 ：Off、On
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MIDI Pgm Num (MIDI Program Number)
选择用于发送演奏组选择的程序变更编号。
当 Pgm Change (Transmit Program Change) 设置为 Off 时，此参数不可用。
仅当 Part Mode 设置为 External 时，此参数才可用。
设置 ：001–128

Vol/Exp (Transmit Volume/Expression)
这是用于将音量设置发送到外部设备的发送开关。
仅当 Part Mode 设置为 External 时，此参数才可用。
设置 ：Off、On

MIDI Volume
设置用于发送演奏组选择的音量。
仅当 Part Mode 设置为 External 时，此参数才可用。
设置 ：0–127

Pan (Transmit Pan)
这是用于将声相设置发送到外接设备的发送开关。
仅当 Part Mode 设置为 External 时，此参数才可用。
设置 ：Off、On

MIDI Pan
设置用于发送演奏组选择的声相。
当 Pan (Transmit Pan) 设置为 Off 时，此参数不可用。
设置 ：L64–C（中央）–R63

Edit Tx/Rx Switch
显示 Mod/Control → Tx/Rx Switch。
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Element Settings
设置要使用的最大音素数。

操作
[PERFORMANCE (HOME)] → Part Common 选择 → [EDIT/ ] → General/Pitch → Element Settings

Ex Elem Sw (Extended Element Switch)
启用音素容量的扩展。
设置为 Off 时，最多只能使用八个音素。
设置 ：Off、On

Element Count
设置要使用的最大音素数。
设置 ：8–128
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Pitch
在 Pitch 画面上，您可以设置声部的音高。

操作
[PERFORMANCE (HOME)] → Part Common 选择 → [EDIT/ ] → General/Pitch → Pitch

Master Sw (Portamento Master Switch)
滑音是一种在两个音符之间创建平滑过渡的功能。
将 Portamento Part Switch 设置为 On，即可为声部设置打开或关闭滑音。
此开关与上方面板的 [PORTAMENTO] 按钮关联。
设置 ：Off、On

Note Shift
以半音为单位调整音高。
设置 ：–48–+0–+48

Detune
以 0.1Hz 增量调整所选声部的音高。
通过稍微改变音高，您可以微调声音。
设置 ：–12.8Hz–+0.0Hz–+12.7Hz

Pitch Control Group
分配到同一组中的声部具有相同的音高。

Mono/Poly
设置当前声部的音源模式。Mono 用于演奏单个音符，Poly 用于同时演奏多个音符。
在连奏中使用 Mono 设置弹奏键盘时，您可以创建声音从一个音符到另一个音符的平滑过渡。
设置 ：Mono、Poly

Pitch Bend (Pitch Bend Range Lower)
Pitch Bend (Pitch Bend Range Upper)
设置使用弯音轮创建的变化范围（以半音为单位）。
设置 ：–48–+0–+24



203MODX M 使用说明书

Edit Control Assign
打开 Control Assign 画面，将 Display Filter 设置为 PitchBend。

Portamento (Portamento Part Switch)
打开或关闭声部的滑音。
设置 ：Off、On

Mode (Portamento Mode)
根据您的键盘演奏设置滑音的应用方式。
设置 ：	 Fingered、Full-time

Fingered：仅当弹奏连奏（在释放前一个音符之前弹奏下一个音符）时才应用滑音。
Full-time：始终应用滑音。

Time (Portamento Time)
设置声部的滑音音高变化的时间长度（或速度）。
设置 ：0–127

Time Mode (Portamento Time Mode)
设置音高如何随时间变化。
设置 ：	 Rate 1、Time 1、Rate 2、Time 2

Rate 1 ：音高以特定速率变化。
Time 1 ：音高在特定时间变化。
Rate 2 ：音高在八度范围内以特定速率变化。
Time 2 ：音高在八度范围内在特定时间变化。

Legato Slope (Portamento Legato Slope)
当 Mono/Poly 设置为 Mono 时调整连奏的起音（在释放前一个音符之前弹奏下一个音符）。
当设置为 Mono 时，根据分配给声部的波形的起音速度，音符的起音可能会听起来不自然。通过将此参数设置为低（对于
起音较短的声音）和高（对于起音较长的声音），您可以调整声音以获得自然的起音。
设置 ：0–7

Micro Tuning Name
设置声部的微调（音律）。
有关每种音律的说明，请参阅 Common Edit 画面上的 General/Pitch → Pitch 。
设置 ：	 Equal Temperament、Pure Major、Pure Minor、Werckmeister、Kirnberger、Vallotti & Young、1/4 shift、1/4 

tone、1/8 tone、Indian、Arabic 1、Arabic 2、Arabic 3
Init Tuning 1–8（当选定了用户库时）
Library 1–1 – 24–8（加载库文件时）

Root (Micro Tuning Root)
设置微调的根音音符。
仅当选择了需要根音音符的 Micro Tuning Name 时才会显示此参数。
设置 ：C–B

Edit User Tuning
打开用户微调设置窗口。
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Filter/Amp

Filter
在 Filter 画面中，您可以设置声部的滤波器包络发生器 (FEG)。
FEG 让您可以设置截止频率的变化程度（或级别），以及从您按下键盘上的按键到声音衰减的那一刻为止，这些变化如何随
时间演变。

操作
[PERFORMANCE (HOME)] → Part Common 选择 → [EDIT/ ] → Filter/Amp → Filter

FEG Atk (FEG Attack Time)
设置从按下琴键到截止频率达到 Attack Level (FEG Attack Level) 中设置的值时声音发生变化所需的时间长度。
此值指定为 Element FEG 的偏移值。
设置 ：–64–+0–+63

FEG Decay (FEG Decay Time)
设置截止频率从 Attack Level (FEG Attack Level) 发生变化所需的时间长度。您可以控制声音的清脆感或衰减速度。
此值指定为 Element FEG 的偏移值。
设置 ：–64–+0–+63

FEG Sus (FEG Sustain Level)
设置 FEG Decay (FEG Decay Time) 结束后的截止频率电平。
此值指定为 Element FEG 的偏移值。
设置 ：–64–+0–+63

FEG Rel (FEG Release Time)
设置将手指从琴键上抬起时截止频率降至 Release Level (FEG Release Level) 所需的时间长度。
此值指定为 Element FEG 的偏移值。
设置 ：–64–+0–+63
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Cutoff (Filter Cutoff Frequency)
通过设置滤波器的截止频率来改变声音。选择低通滤波器时，此处的值越大，声音越明亮，值越小，声音越低沉。
此值指定为音素截止频率的偏移值。
设置 ：–64–+0–+63

Resonance (Filter Resonance)
通过调整接近截止频率的信号电平来为声音增加特殊特性。
此值指定为 Resonance (Filter Resonance) 或 Width (Filter Width) 的偏移值。
设置 ：–64–+0–+63

FEG Depth
调整音素 FEG 控制的截止频率的深度范围。
当此参数设置为 0 时，将不做任何更改地使用音素中的设置。
设置 ：–64–+0–+63
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Amp EG
在 Amp EG 画面中，您可以设置声部的 AEG（振幅包络发生器）。通过设置 Amp EG，您可以设置从按下键盘上的按键到声
音衰减时音量的变化方式。

操作
[PERFORMANCE (HOME)] → Part Common 选择 → [EDIT/ ] → Filter/Amp → Amp EG

AEG Attack (AEG Attack Time)
设置从按下键盘上的某个键到达到最大音量所需的时间长度。
此值指定为 Element AEG 的偏移值。
设置 ：–64–+0–+63

AEG Decay (AEG Decay Time)
设置音量达到最大值后发生变化所需的时间长度。
此值指定为 Element AEG 的偏移值。
设置 ：–64–+0–+63

AEG Sustain (AEG Sustain Level)
调整 AEG Decay (AEG Decay Time) 后保持的音量。
设置 ：–64–+0–+63

AEG Release (AEG Release Time)
设置释放琴键后声音衰减所需的时间长度。
此值指定为 Element AEG 的偏移值。
设置 ：–64–+0–+63
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Effect

Routing
在 Routing 画面上，您可以设置声部的效果器路由。

操作
[PERFORMANCE (HOME)] → Part Common 选择 → [EDIT/ ] → Effect → Routing

(1)

(1) VCM Rotary Speaker Switch

Element (Element Select)
显示所选音素的名称。
当 Ex Elem Sw (General/Pitch → Element Settings) 设置为 Off 时，或者当音素少于八个时，显示数字 1 至 8。
设置 ：1–128（最多可达到 Element Count 设置）

Connect (Element Connection Switch)
设置要输出到插入效果器 A 或插入效果器 B 的音素。
将此项设置为 Thru 可绕过插入效果器。
设置 ：Thru、InsA、InsB

3-band EQ
打开 3-band EQ 的设置画面。
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Expression (Expression Type)
设置使用 Expression 踏板时在信号流中的位置。
设置 ：	 Normal、Pre FX

Normal ：在 2-band EQ 之后应用
Pre FX ：在插入效果器之前应用。当与 Distortion 等非线性（声音随输入电平显著变化）效果器一起使用时， 
此设置有效

Exp.Curve (Expression Curve)
设置在以下时候通过 Exp.Curve 来应用表情效果器的方式 ：Expression Type 设置为 Pre FX 时。
设置 ：	 Normal、Organ

Normal ：具有正常特征的音量曲线
Organ ：模拟复古风琴特性的音量曲线

VCM Rotary Speaker Switch
设置 VCM Rotary Speaker 效果器，利用 VCM 技术模拟旋转扬声器的特性。
仅当 VCM Rotary Speaker Switch 设置为 Part 1 时，此参数才可用。
设置 ：Off、On

Ins Connect (Insertion Connection Type)
设置插入效果器 A 和插入效果器 B 的效果器路由。当设置更改时，图表也会相应变化。
设置 ：	 Parallel、Ins A→B、Ins B→A

Parallel ：（对于标准声部 (AWM2) 和鼓声部）：插入效果器 A 和插入效果器 B 的输出分别发送到主控效果器、 
主 EQ、混响、变奏和包络跟随器
Ins A→B：插入效果器 A 的输出发送到插入效果器 B，插入效果器 B 的输出发送到主控效果器、主 EQ、混响、 
变奏和包络跟随器。
Ins B→A ：插入效果器 B 的输出发送到插入效果器 A，插入效果器 A 的输出发送到主控效果器、主 EQ、混响、 
变奏和包络跟随器。

Parallel Ins A→B Ins B→A

A

B

A

B

A

B

A (Insertion Effect A Switch)
B (Insertion Effect B Switch)
打开或关闭插入效果器 A 或 B。
设置 ：Off、On

Type (Insertion Effect Type)
设置效果器类型。
设置 ：请参阅效果器类型

Preset (Insertion Effect Preset)
为每种效果器类型选择预置效果器参数之一。
通过选择预置，您可以更改应用效果器的方式。
设置 ：请参阅 Data List
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Side Chain (Insertion Side Chain Part)
Modulator (Insertion Modulator Part)
设置插入效果器 A 或插入效果器 B 的侧链声部（或调制器，具体取决于效果器类型）。
当声部本身或 Master 设置为 Modulator 时，此参数不可用。在这种情况下，参数值将显示在括号中，如“(Master)”。
设置 ：Part 1–16、A/D、Master、Off

Dry Level
设置所选声部的干音音量级别（或未经系统效果器处理的信号电平）。
仅当 Part Output (Part Output Select) 设置为 MainL&R 时，此参数才可用。
设置 ：0–127

2-band EQ
打开 2-band EQ 的设置画面。

Rev Send (Reverb Send)
设置从插入效果器 A 或插入效果器 B 发送到混响效果器的信号（或旁路信号）的电平。仅当 Part Output (Part Output 
Select) 设置为 MainL&R 时，此参数才可用。
设置 ：0–127

Var Send (Variation Send)
设置从插入效果器 A 或插入效果器 B 发送到变奏效果器的信号（或旁路信号）的电平。仅当 Part Output (Part Output 
Select) 设置为 MainL&R 时，此参数才可用。
设置 ：0–127

Envelope Follower
打开包络跟随器的设置画面。

Part Output (Part Output Select)
设置音频信号的输出目的地。
设置 ：	 MainL&R、(AsgnL&R)、USB Stereo、(AsgnL)、(AsgnR)、USB mono、Off

MainL&R：以立体声（两个通道）输出到 OUTPUT [L/MONO] 和 OUTPUT [R] 插孔。
USB Stereo ：以立体声（通道 1 和 2，至通道 7 和 8）输出到 USB [TO HOST] 端口。
USB mono ：以单声道（通道 1 至 8）输出至 USB [TO HOST] 端口。
Off：该声部没有音频信号输出。

注
与 MONTAGE M 设备数据兼容的相关设置如下所示。在设置时，这些设置视为 Off。
•	AsgnL&R
•	USB Stereo ：USB9&10 – USB29&30
•	USB mono ：USB9 – USB30
•	AsgnL
•	AsgnR
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Ins A、Ins B
在 Ins A 和 Ins B 画面上，您可以设置插入效果器。

操作
[PERFORMANCE (HOME)] → Part Common 选择 → [EDIT/ ] → Effect → Ins A
[PERFORMANCE (HOME)] → Part Common 选择 → [EDIT/ ] → Effect → Ins B

与 Common Edit 画面上的 Audio In → Ins A 和 Ins B 相同。
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3-band EQ
在 3-band EQ 画面上，您可以设置声部 EQ。EQ 可以在插入效果器之前设置。

Part EQ Part EQ
3-band EQ

Insertion A

Insertion B 2-band EQ

Part

操作
PERFORMANCE (HOME)] → Part Common 选择 → [EDIT/ ] → Effect → 3-band EQ

EQ Low Gain (3band EQ Low Gain)
设置 Low 频段的信号电平。
设置 ：–12.00dB – +0.00dB – +12.00dB

EQ Low Freq (3band EQ Low Frequency)
设置 Low 频段的频率。
设置 ：50.1Hz–2.00kHz

EQ Mid Gain (3band EQ Mid Gain)
设置 Mid 频段的信号电平。
设置 ：–12.00dB – +0.00dB – +12.00dB

EQ Mid Freq (3band EQ Mid Frequency)
设置 Mid 频段的频率。
设置 ：139.7Hz–10.1kHz

EQ Mid Q (3band EQ Mid Q)
设置 Mid 频段的带宽。
设置 ：0.7–10.3

EQ Hi Gain (3band EQ High Gain)
设置 High 频段的信号电平。
设置 ：–12.00dB – +0.00dB – +12.00dB

EQ Hi Freq (3band EQ High Frequency)
设置 High 频段的频率。
设置 ：503.8Hz–14.0kHz
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2-band EQ
在 2-band EQ 画面上，您可以设置声部 EQ。EQ 可以在插入效果器之后设置。

Part EQ Part EQ
3-band EQ

Insertion A

Insertion B 2-band EQ

Part

操作
[PERFORMANCE (HOME)] → Part Common 选择 → [EDIT/ ] → Effect → 2-band EQ

EQ1 Type (2band EQ 1 Type)
EQ2 Type (2band EQ 2 Type)
选择所需的 EQ 类型。
设置 ：	 Thru、LPF、HPF、Low Shelf、Hi Shelf、Peak/Dip

Thru ：传递信号而不应用任何效果器。
LPF ：减弱高于截止频率的信号。
HPF ：减弱低于截止频率的信号。
Low Shelf ：减弱或增强低于指定频率设置的信号。
Hi Shelf ：减弱或增强高于指定频率设置的信号。
Peak/Dip ：减弱或增强指定频率设置下的信号。

EQ 1 Gain (2band EQ 1 Gain)
EQ 2 Gain (2band EQ 2 Gain)
设置在 EQ1 Type (2band EQ 1 Type) 或 EQ2 Type (2band EQ 2 Type) 中设置的频段的信号电平。当 EQ Type 设置为 Thru、
LPF 或 HPF 时，此参数不可用。
设置 ：–12.0dB – +0.0dB – +12.0dB

EQ 1 Freq (2band EQ 1 Frequency)
EQ 2 Freq (2band EQ 2 Frequency)
设置要减弱或增强的频率。当 EQ Type 设置为 Thru 时，此参数不可用。
设置 ：63.0Hz–18.0Hz
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EQ 1 Q (2band EQ 1 Q)
EQ 2 Q (2band EQ 2 Q)
设置带宽，用于减弱或增强使用 EQ1 Type (2band EQ 1 Type) 或 EQ2 Type (2band EQ 2 Type) 设置的频率音量。仅当 EQ 
Type 设置为 Peak/Dip 时，此参数才可用。
设置 ：0.1–12.0

Output Level (2band EQ Output Level)
设置 2 频段 EQ 的输出增益。
设置 ：–12.0dB – +0.0dB – +12.0dB

Ins Assign
在 Ins Assign 画面上，您可以启用 Part 9 至 16 插入效果器。

操作
[PERFORMANCE (HOME)] → Part Common 选择 → [EDIT/ ] → Effect → Ins Assign

Active (Active Part)
这显示了插入效果器开关设置为 On 的声部数量。斜杠 (/) 右侧的数字是可以同时打开的最大插入效果器数。

Part 9–16
启用声部 9 至 16 的插入效果器。
设置 ：Off、On

注
始终为声部 1 至 8 启用插入效果器。



214MODX M 使用说明书

Arpeggio

Common
在 Common 画面上，您可以设置整个声部的琶音。

操作
[PERFORMANCE (HOME)] → Part Common 选择 → [EDIT/ ] → Arpeggio → Common

Arp Part (Part Arpeggio Switch)
打开或关闭声部的琶音。
设置 ：Off、On

Arp Master (Arpeggio Master Switch)
打开或关闭演奏组的琶音。
设置 ：Off、On

Sync Quantize (Arpeggio Sync Quantize Value)
当播放多个声部中的琶音乐句时，调整在播放第一个琶音乐句时开始下一个琶音乐句的时机。
如果设置为 Off，则在键盘上弹奏声部时会播放琶音。
此处显示的值以时钟数为单位。
设置 ：	 Off、60（三十二分音符）、80（十六分音符三连音）、120（十六分音符）、160（八分音符三连音）、240（八分音

符）、320（四分音符三连音）、480（四分音符）

Arpeggio Group
设置 Arpeggio Group 以对多个声部使用相同的琶音。

Indicator
对于与所选声部位于同一 Arpeggio Group 中的声部，此指示灯设置为 On。
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Hold (Arpeggio Hold)
启用或禁用保持功能，即使在抬起手指后，仍会继续重复播放琶音。
设置 ：	 Sync-Off、Off、On

Sync-Off：在手指松开琴键时在后台重复进行琶音播放，并在按下键盘上的任意键时恢复播放。
Off：仅在按住任意键时播放琶音
On：当您按下琴键时，将会重复播放琶音，即使在抬起手指后，也会继续播放

Change Timing (Arpeggio Change Timing)
设置在另一个琶音乐句仍在播放时改变琶音类型的时机。您可以选择 Real-time 来立即切换到新的琶音乐句，或选择
Measure 来切换到下一小节顶部的新琶音乐句。
设置 ：Real-time、Measure

Key Mode (Arpeggio Key Mode)
设置琶音的播放方式。
设置 ：	 Sort、Thru、Direct、Sort+Drct、Thru+Drct

Sort ：无论弹奏琴键的顺序如何，都播放相同的琶音
Thru ：根据弹奏琴键的顺序以不同方式播放琶音
Direct：不播放琶音。仅播放您的键盘演奏。但是，如果琶音数据包括控制变化 (CC) 数据（例如声相或亮度），则
会反映这些效果。当琶音类型包含控制变化数据或选择了控制类别中的琶音时，此设置有效
Sort+Drct ：根据 Sort 设置以及键盘上弹奏的音符来播放琶音
Thru+Drct ：根据 Thru 设置以及键盘上弹奏的音符来播放琶音

Loop (Arpeggio Loop)
选择按住键盘上的琴键时循环（重复）播放，或每次按下琴键时单次播放琶音。
设置 ：Off、On

Arp Play Only (Arpeggio Play Only)
将声部设置为仅与琶音一起演奏。
设置为打开的声部将通过为琶音发送的音符打开信息来演奏。
设置 ：Off、On

Swing
更改根据中 Quantize Value 指定的值计数的偶数节拍（后拍）的时间，为琶音播放添加摇摆感。此设置对于创造以摇摆、
随机播放和弹跳感觉演奏所需的节奏非常有用。
设置 ：	 –120–+0–+120

+1 及更高：跟在节拍后面
-1 及更低：走在节拍前面
0:不改变偶数节拍或添加任何摇摆感

Unit (Arpeggio Unit Multiply)
设置琶音播放时间的拉伸或压缩百分比。
当您拉伸或压缩播放时间时，节拍和速度的细分会发生变化，因此您可以为最初选择的琶音创造出全新的感觉。
设置 ：	 50%、66%、75%、100%、133%、150%、200%、266%、300%、400%、Common

200%:播放时间加倍，速度减半
100%:播放时间保持不变
50%:播放时间减半，速度加倍
Common：应用在 Unit 中设置且对所有声部通用的值
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Quantize Value (Arpeggio Quantize Value)
设置使用量化和摇摆的参考音符。此处显示的值以时钟数为单位。
设置 ：	 Off、60（三十二分音符）、80（十六分音符三连音）、120（十六分音符）、160（八分音符三连音）、240（八分音

符）、320（四分音符三连音）、480（四分音符）

Qntz Strength (Arpeggio Quantize Strength)
设置 Quantize Value (Arpeggio Quantize Value) 设置的强度（或音符与 Quantize Value 中设置的参考音符的接近程度）。
设置为 100% 会将时序完全移调为 Quantize Value 中设置的时序，而设置为 0% 则不会进行量化。
设置 ：0%–100%

Gate Time Rate (Arpeggio Gate Time Rate)
设置琶音播放的门限时间（或演奏音符的时间长度）。如果门限时间设置为值 0，则该设置将更改为值 1。
设置 ：0%–200%

Velocity Rate (Arpeggio Velocity Rate)
设置琶音播放的力度率。如果将 Velocity 设置为值 0，则设置将更改为值 1。当设置为大于 128 的值时，设置将更改为 
值 127。
设置 ：0%–200%

Arp Vel Limit (Arpeggio Velocity Limit)
设置琶音播放的力度范围（最低和最高值）。
当设置为较高的值在前，较低的值在后（例如，93 至 34）时，仅以 1 至 34 和 93 至 127 的力度弹奏琶音。
设置 ：1–127

Arp Note Limit (Arpeggio Note Limit)
设置琶音播放的音符范围（最低音符和最高音符）。
当指定的第一个音符高于第二个音符（例如，C5 至 C4）时，将演奏 C–2 至 C4 和 C5 至 G8 范围内的音符。
设置 ：C–2–G8

Octave Shift (Arpeggio Output Octave Shift)
以八度为单位改变区域琶音的音高。
设置 ：–10–+0–+10

Octave Range (Arpeggio Octave Range)
以八度为单位改变区域琶音的范围。
设置 ：–3–+0–+3

Arp Select (Arpeggio Select)
选择琶音。
设置 ：1–8
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Individual
在 Individual 画面上，您可以设置 Arp Select (Arpeggio Select) 1–8 的琶音类型参数。
点击琶音类型设置可调出上下文菜单。选择 Category Search 打开 Arpeggio Category Search 画面。选择 Number 让您可
以通过数字指定琶音类型。

操作
[PERFORMANCE (HOME)] → Part Common 选择 → [EDIT/ ] → Arpeggio → Individual

（当所选声部不是 Common 时）[SHIFT] + [ARP]

Arp Part (Part Arpeggio Switch)
Arp Master (Arpeggio Master Switch)
Sync Quantize (Arpeggio Sync Quantize Value)
Arpeggio Group
Indicator
与 Common 画面相同。

Arp (Arpeggio Select)
切换 Arpeggio Select。
设置 ：1–8

Category (Arpeggio Category)
显示所选琶音的类别。
设置 ：请参阅 Data List

Sub (Arpeggio Sub Category)
显示所选琶音的子类别。
设置 ：请参阅 Data List

Name (Arpeggio Name)
显示所选琶音的名称。
设置 ：请参阅 Data List
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Velocity (Arpeggio Velocity Rate)
设置琶音播放的力度率。
如果将 Velocity 设置为值 0，则设置将更改为值 1。当设置为大于 128 的值时，设置将更改为值 127。
设置 ：–100%–+0%–+100%

Gate Time (Arpeggio Gate Time Rate)
设置琶音播放的门限时间（或演奏音符的时间长度）。
如果门限时间设置为值 0，则该设置将更改为值 1。
设置 ：–100%–+0%–+100%

Advanced
在 Advanced 画面上，您可以设置琶音参数。

操作
[PERFORMANCE (HOME)] → Part Common 选择 → [EDIT/ ] → Arpeggio → Advanced

Arp Part (Part Arpeggio Switch)
Arp Master (Arpeggio Master Switch)
Sync Quantize (Arpeggio Sync Quantize Value)
Arpeggio Group
Indicator
与 Common 画面相同。

Accent Vel Threshold (Arpeggio Accent Velocity Threshold)
设置触发重音乐句的力度电平。重音乐句是已编程为仅在快速弹奏琴键时才播放某些类型琶音模式的音序乐句。
当您以大于设定值的力度按下琴键时，将播放重音乐句。如果您按下琴键，但重音乐句没有播放，请尝试将其设置得稍微低
一些，然后再次按下琴键。
设置 ：Off、1–127

注
有关支持重音乐句的琶音类型的更多信息，请参阅 Data List。
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Accent Start Quantize (Arpeggio Accent Start Quantize)
设置当以大于 Accent Vel Threshold (Arpeggio Accent Velocity Threshold) 的力度值按下琴键时触发重音乐句（设置为
On），或在所选琶音类型中设置的时间触发重音乐句（设置为 Off）。
设置 ：Off、On

Random SFX (Arpeggio Random SFX)
启用随机 SFX 功能。
随机 SFX 功能会触发某些琶音类型中包括的特殊声音。您可以根据琶音类型使用各种类型的特殊声音。例如，当您将手指
从琴键上松开时，您可以使用此功能来添加吉他按弦杂音。
设置 ：Off、On

注
有关支持此功能的琶音类型的更多信息，请参阅 Data List。

Random SFX Velocity Offset (Arpeggio Random SFX Velocity Offset)
设置触发随机 SFX 功能特殊声音的力度值。
设置 ：–64–+0–+63

Random SFX Key On Ctrl (Arpeggio Random SFX Key On Control)
设置由按键力度电平或自动设置的力度电平触发的特殊声音。
设置 ：Off、On

Velocity Mode (Arpeggio Velocity Mode)
设置播放琶音的力度。
设置 ：	 Original、Thru

Original ：跟随琶音类型中设置的力度电平。
Thru ：跟随击键的力度电平

Trigger Mode (Arpeggio Trigger Mode)
切换琶音播放方法。
设置 ：	 Gate、Toggle

Gate：通过按下琴键开始琶音播放，通过松开琴键来停止播放
Toggle ：通过按下琴键来交替开始和停止琶音播放

Arp Select (Arpeggio Select)
切换 Arpeggio Select。
设置 ：1–8
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Motion Seq

Common
在 Common 画面上，您可以设置整个声部的动态音序器参数。

操作
[PERFORMANCE (HOME)] → Part Common 选择 → [EDIT/ ] → Motion Seq → Common

（当所选声部不是 Common 时）[SHIFT] + [MSEQ]

Common Swing (Common Swing Offset)
设置演奏组的琶音和动态音序器的摇摆值。
此值指定为 Part Swing 的偏移值。
设置 ：–120–+0–+120

Common Unit (Common Unit Multiply)
设置整个演奏组的琶音和动态音序器播放时间的拉伸或压缩百分比。
此参数会影响 Unit (Lane Unit Multiply) 设置为 Common 的通道。
当您拉伸或压缩播放时间时，节拍和速度的细分会发生变化，因此您可以为最初选择的动态音序创造出全新的感觉。
设置 ：	 50%–400%

200%:播放时间加倍，速度减半
100%:播放时间保持不变
50%:播放时间减半，速度加倍

Common Amplitude (Common Motion Sequencer Amplitude Performance Offset)
设置整个演奏组的动态音序器振幅（或音序变化量）。
如果 MS FX (Lane FX Receive) 设置为 On，则此参数值会使声部内通道的振幅发生偏移。
此值指定为每个声部的 Part Amplitude (Part Motion Sequencer Amplitude) 的偏移值。
设置 ：–127–+0–+127
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Common Shape (Common Motion Sequencer Pulse Shape Performance Offset)
设置演奏组的动态音序器脉冲形状（或步进曲线的形状）。
如果通道的 MS FX (Lane FX Receive) 设置为 On 且 Control (Motion Sequence Step Curve Shape Control Switch) 设置为
On，则此参数值会使声部内通道的参数发生偏移。
此值指定为每个声部的 Part Shape (Part Motion Sequencer Pulse Shape) 的偏移值。
设置 ：–100–+0–+100

Common Smooth (Common Motion Sequencer Smoothness Performance Offset)
设置整个演奏组的动态音序平滑度（或音序随时间变化的平滑度）。
如果通道的 MS FX (Lane FX Receive) 设置为 On，则此参数值会使声部内通道的平滑度发生偏移。
此值指定为每个声部的 Part Motion Seq Smooth (Part Motion Sequencer Smoothness) 的偏移值。
设置 ：–127–+0–+127

Common Random (Common Motion Sequencer Randomness Performance Offset)
设置整个演奏组的动态音序器随机性（或音序的步进值变化的随机性）。
如果通道的 MS FX (Lane FX Receive) 设置为 On，则此参数值会使演奏组内通道的随机性发生偏移。
此值指定为每个声部的 Part Motion Seq Random (Part Motion Sequencer Randomness) 的偏移值。
设置 ：–127–+0–+127

Part Swing (Part Swing)
更改根据 MS Grid 中指定的值计数的偶数节拍（后拍）的时间，为动态音序器播放添加摇摆感。此设置对于创造以摇摆、随
机播放和弹跳感觉演奏所需的节奏非常有用。
设置 ：	 –120–+0–+120

+1 及更高：跟在节拍后面
0:不改变偶数节拍或添加任何摇摆感
-1 及更低：走在节拍前面

Part Unit (Arpeggio Unit Multiply)
设置声部的琶音播放时间的拉伸或压缩百分比。
在每个通道的 Unit (Lane Unit Multiply) 设置为 Arp 时，该参数设置才有效。
设置 ：	 50%–400%，Common

200%:播放时间加倍，速度减半
100%:播放时间保持不变
50%:播放时间减半，速度加倍
Common：应用在 Unit 中设置且对所有声部通用的值

Part Amplitude (Part Motion Sequencer Amplitude)
设置声部的动态音序器振幅（或音序变化量）。如果通道的 MS FX (Lane FX Receive) 设置为 On，则此参数值会使声部内通
道的振幅发生偏移。
此值指定为每个通道的 Amplitude (Motion Sequence Amplitude) 的偏移值。
设置 ：–127–+0–+127

Part Shape (Part Motion Sequencer Pulse Shape)
设置声部的动态音序器脉冲形状（或步进曲线的形状）。如果通道的 MS FX (Lane FX Receive) 设置为 On 且 Control (Motion 
Sequence Step Curve Shape Control Switch) 设置为 On，则此参数值会使声部内通道的参数发生偏移。
此值指定为每个通道的 Prm (Motion Sequence Step Curve Parameter) 的偏移值。
设置 ：–100–+0–+100
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Part Smooth (Part Motion Sequencer Smoothness)
设置声部的动态音序器平滑度。如果通道的 MS FX (Lane FX Receive) 设置为 On，则此参数值会使声部内通道的平滑度发
生偏移。
此值指定为每个通道的 Smooth (Motion Sequence Smoothness) 的偏移值。
设置 ：–127–+0–+127

Part Random (Part Motion Sequencer Randomness)
设置声部的动态音序器随机性。
设置音序步进值变化的随机性。
设置 ：0–127

View Lane
设置当 Home 画面的 View Mode 设置为 Motion Seq View 时要显示的 Lane。

MS Select (Motion Sequence Select)
选择要播放的动态音序。
设置 ：1–8
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Lane
在 Lane 画面上，您可以设置每个动态音序器通道的参数。

操作
[PERFORMANCE (HOME)] → Part Common 选择 → [EDIT/ ] → Motion Seq → Lane

Motion Seq Master Sw (Motion Sequencer Master Switch)
将整个演奏组的动态音序器设置为打开或关闭。
设置 ：Off、On

Motion Seq Part Sw (Motion Sequencer Part Switch)
打开或关闭声部的动态音序器。
设置 ：Off、On

Lane Select
选择一个通道。
设置 ：1–4

LaneSw (Lane Switch)
打开或关闭每个通道。
您可以在一个声部中使用最多四个动态音序器通道，或者在整个演奏组中使用最多八个通道。
当设置为 Off 时，将不会显示该通道的参数。
设置 ：Off、On

MS FX (Lane FX Receive)
设置选定的通道来接收来自旋钮的信号，从而更改动态音序器参数。
设置 ：Off、On

Trigger (Lane Trigger Receive)
设置所选通道来接收来自 [MSEQ TRIGGER] 按钮的信号。
设置为 On 时，除非按 [MSEQ TRIGGER] 按钮，否则不会播放动态音序。
设置 ：Off、On
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Sequence Select (Motion Sequence Select)
更改动态音序选择。
设置 ：1–8

Target Sequence
指示通道和音序。

Edit Sequence
Motion Sequence Edit 画面会打开。
您可以创建最多 16 个步级的音序。

Motion Seq Step Value
设置动态音序中每个步级的值。
您可以使用控制滑杆 1 至 8 来更改步级 1 至 8 以及步级 9 至 16 的值，具体取决于光标位置。
设置 ：0–127

	� Sync/Speed 选项卡
Sync (Lane Sync)
将动态音序的播放设置为 Control Assign 画面中的 Destination，以与演奏组速度、节拍或琶音同步。
设置 ：	 Off、Tempo、Beat、Arp、Lane1（当选定 Lane2–4 时）

Off：单独播放通道动态音序器
Tempo：以演奏组速度播放通道动态音序器。
Beat ：与节拍同步播放。
Arp ：与琶音播放的顶部同步播放通道动态音序器。
Lane1 ：与通道 1 同步播放通道动态音序器

•	当 Sync 设置为Off时

Speed (Lane Speed)
设置动态音序的播放速度。
当 Sync (Lane Sync) 设置为 Off 时，此参数可用。
设置 ：0–127

Delay Time (Lane Key On Delay Time Length)
设置开始播放动态音序的延迟时间。
设置 ：0–127

Fade In Time (Lane Fade In Time Length)
设置动态音序达到最大振幅的时间。
设置 ：0–127
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•	当 Sync 设置为Off之外的其他设置时

Unit (Lane Unit Multiply)
设置所选通道的动态音序器播放时间的拉伸或压缩百分比。
仅当 Sync (Lane Sync) 设置为 Tempo、Beat 或 Arp 时，此参数才可用。
设置 ：	 50%–6400%、Common、Arp

200%:播放时间加倍，速度减半
100%:播放时间保持不变
50%:播放时间减半，速度加倍
Common：应用在 Unit 中设置且对所有声部通用的值
Arp ：应用在声部琶音的 Unit 中设置的值

Delay Steps (Lane Key On Delay Step)
设置当 Sync (Lane Sync) 设置为 Tempo、Beat 或 Arp 时开始播放动态序列的延迟时间。
设置 ：0–32

Fade In Steps (Lane Fade In Step Length)
设置当 Sync (Lane Sync) 设置为 Tempo、Beat、Arp 或 Lane1 时动态音序达到最大振幅的时间。
设置 ：0–32

Lane Vel Limit (Lane Velocity Limit)
设置播放所选通道的动态音序的力度范围（最低和最高值）。
仅当 Sync (Lane Sync) 设置为 Off、Tempo、Beat 或 Arp 时，此参数才可用。
当 Velocity Limit 设置为从最高值到最低值的范围时，将仅在两个力度范围内播放动态音序 ：从最大值到最高值，以及从最
低值到最小值。
设置 ：1–127

	� Loop/Length 选项卡
Key On Reset (Lane Key On Reset)
当您按键盘上的任意键时重置动态音序播放。
仅当 Sync (Lane Sync) 设置为 Off、Tempo 或 Beat 时，此参数才可用。当 Trigger 设置为 On 时，此参数不可用。
设置 ：	 Off、Each-On、1st-On

Each-On:每次演奏任何音符时，音序都会复位，并从头开始播放
1st-On ：从弹奏的第一个音符处开始播放。如果在保持第一个音符时演奏第二个音符，则播放不会复位

Loop (Lane Loop)
将动态音序设置为循环播放（重复）或单次播放。
仅当 Sync (Lane Sync) 设置为 Off、Tempo、Beat 或 Arp 时，此参数才可用。
设置 ：Off、On

Loop Start (Motion Sequence Loop Start)
设置重复动态音序播放时第二次或更晚开始播放的步级。
设置 ：1–Length (Motion Sequence Length)

Length (Motion Sequence Length)
设置动态音序的步级数。
设置 ：Loop Start (Motion Sequence Loop Start)–16

MS Grid (Motion Sequencer Grid)
设置动态音序中的步级长度。
设置 ：60, 80, 120, 160, 240, 320, 480
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Mod/Control

Control Assign
在 Control Assign 画面上，您可以设置声部的控制器。
通过将参数 (Destination) 分配给控制器 (Source)，您可以使用各种各样的方式控制声音。您可以使用物理控制器（例如弯
音轮和旋钮）以及动态音序器和包络跟随器。
最多可以将 32 个控制器同时分配给一个声部。

操作
[PERFORMANCE (HOME)] → Part Common 选择 → [EDIT/ ] → Mod/Control → Control Assign

当 Display Filter 设置为 Super Knob 时，点击 [+] 会在画面的上部区域显示信息，并自动添加 Common Edit 的 Control 
Assign 设置。
注
当没有可用的可指定旋钮时，将不会显示 [+]。

Auto Select
打开或关闭 Display Filter 的自动选择设置。
设置为 On 时，移动您想要设置为 Source 的控制器会自动将控制器设置为 Display Filter。
设置 ：Off、On

Display Filter
选择在画面上显示设置的控制器。
当您选择 Super Knob 时，将会显示 Super Knob Link 设置为 On 的所有设置。
设置 ：	 PitchBend、ModWheel、Ch.AT、FootCtrl 1、FootCtrl 2、FootSwitch、Ribbon、Breath、AsgnKnob 1–8、

Super Knob、AsgnSw 1、AsgnSw 2、MS Lane 1–4、EnvFollow 1–16、EnvFollowAD、EnvFollowMst、All

注
如果其他声部使用了设置为 Display Filter 的控制器，则相应的 PART 按钮会闪烁。
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Edit Pitch Bend
调出 Pitch Settings 画面。General/Pitch → Pitch 会打开。
当 Source 设置为 PitchBend 以外的其他值时，不会显示此参数。

Display Name (Assignable Knob Name)
这使您可以输入旋钮 1 至 8 的新名称，以便显示在副画面上。
当 Source 设置为 AsgnKnob 1–8 以外的其他值时，不会显示此参数。

Edit Motion Sequencer
打开所选声部的 Motion Seq → Lane。
您可以创建最多 16 个步级的音序。
当 Source 设置为 MS Lane 1–4 以外的其他值时，不会显示此参数。

Edit Envelope Follower
打开包络跟随器的设置画面。
当 Source 设置为 EnvFollow 1–16、EnvFollowAD 或 EnvFollowMst 以外的其他值时，不会显示此参数。

Page
当 Destination 超过四个时选择下一页。当 Destination 为四个或更少时，不会出现下一页。
设置 ：1–8

Destination
设置目的地的参数。点击 [+] 可添加 Destination。

Source
设置用于控制 Destination 参数设置的控制器。
设置 ：	 PitchBend、ModWheel、Ch.AT、FootCtrl 1、FootCtrl 2、FootSwitch、Ribbon、Breath、AsgnKnob 1–8、

AsgnSw 1、AsgnSw 2、MS Lane 1–4、EnvFollow 1–16、EnvFollowAD、EnvFollowMst

Element Sw (Element Switch) 1–128
仅当所选 Destination 与音素相关时才会显示此参数。
您可以打开或关闭每个音素的控制器设置。
当 General/Pitch → Element Settings Ex Elem Sw 设置为 On 时，您可以选择另一组显示的八个开关编号。 
但您可以在开关中使用的实际数字范围取决于在 General/Pitch → Element Settings 画面上的 Element Count 中设置的值 

（示例 ：如果 Element Count 设置为 30，则可选择的组为 25–32）。
设置 ：（每个开关）Off、On（显示的开关编号发生变化）1–8、9–16、...、121–128
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Curve Type
设置 Destination 的参数设置的变化曲线。
横轴表示 Source 中设置的控制器值，纵轴表示 Destination 中设置的参数值。
设置 ：	 Standard、Sigmoid、Threshold、Bell、Dogleg、FM、AM、M、Discrete Saw、Smooth Saw、Triangle、

Square、Trapezoid、Tilt Sine、Bounce、Resonance、Sequence、Hold、Harmonic、Steps（当选定了预置
库时）
Init Curve 1–32（当选定了用户库时）
Library 1–24 内的 Curve（加载库文件时）

Standard

Sigmoid

Threshold

Bell

Dogleg

FM

AM

M

Discrete Saw

Smooth Saw

Triangle

Square

Trapezoid

Tilt Sine

Bounce

Harmonic

Steps

Resonance

Sequence

Hold

Polarity (Curve Polarity)
设置在 Curve Type 中设置的曲线的极性。
设置 ：	 Uni、Bi

Uni ：根据曲线形状，参数变化仅在正范围或负范围内发生。
Bi ：根据曲线形状，参数变化在正范围和负范围内发生。

Ratio (Curve Ratio)
设置参数值的比率。
设置 ：–128–+0–+127

Param 1 (Curve Parameter 1)
Param 2 (Curve Parameter 2)
调整曲线形状。
根据 Curve Type，此设置不可用。

Destination to Name
将 Destination 的参数设置复制到 Display Name。
当 Source 设置为 AsgnKnob 1–8 以外的其他值时，不会显示此参数。

Edit User Curve
User Curve Edit 画面会打开。

Edit Common Control Assign
在 Common Edit 画面上打开 Control → Control Assign。

Delete
删除选定的 Destination。
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After Touch

操作
[PERFORMANCE (HOME)] → Part Common 选择 → [EDIT/ ] → Mod/Control → After Touch

Destination
将目的地的参数。点击 [+] 可添加 Destination。

Source
无法从这个画面进行更改。此参数固定为 Poly AT。

Element Sw (Element Switch) 1–128
Curve Type
Polarity (Curve Polarity)
Ratio (Curve Ratio)
Edit User Curve
Delete
与 Mod/Control → Control Assign 相同。
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Tx/Rx Switch
在 Tx/Rx Switch 画面上，您可以打开或关闭用于发送或接收 MIDI 信息（例如控制变化）的开关。
注
当 CC (Control Change) 设置为 Off 时，无法设置与控制变化信息相关的参数。

操作
[PERFORMANCE (HOME)] → Part Common 选择 → [EDIT/ ] → Mod/Control → Tx/Rx Switch

Transmit Sw (Transmit Switch)
显示发送开关。
仅当 Part Mode 设置为 External 或当 Keyboard Sw 设置为 Off 时，此参数才可用。

Receive Sw (Receive Switch)
显示接收开关。

Keyboard Sw (Keyboard Control Switch)
设置要同时播放的声部。
当您选择 Common 或 Keyboard Sw 设置为 On 的声部并弹奏键盘时，Keyboard Sw 设置为 On 的声部将同时播放。
如果声部的 Keyboard Sw 设置为 Off，则在选定该声部的情况下弹奏键盘时，将会播放这些声音。
设置 ：Off、On

Tx/Rx Ch (Transmit/Receive Channel)
当 Part Mode 设置为 Internal 时，设置用于发送和接收 MIDI 信息的通道。
设置 ：Ch1–Ch16、Off

Transmit Ch.
当 Part Mode 设置为 External 时，设置用于发送 MIDI 信息的通道。
设置 ：Ch1–Ch16

MIDI I/O Ch.(MIDI In-Out Channel)
显示用于发送和接收 MIDI 信息的通道。
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Zone Settings
调出 Zone Settings 画面。
与 General/Pitch → Zone Settings 相同。

PC (Program Change)
打开或关闭程序变更信息的发送和接收。
设置 ：Off、On

BankSelect (Bank Select)
打开或关闭音色库选择 MSB 和 LSB 信息的发送和接收。当 CC (Control Change) 设置为 Off 时，此参数不可用。
设置 ：Off、On

Pitch Bend
打开或关闭 MIDI 弯音信息的发送和接收。
设置 ：Off、On

CAT (Channel After Touch)
打开或关闭通道触后的发送和接收。
设置 ：Off、On

PAT (Polyphonic After Touch)
打开或关闭复音触后的发送和接收。
设置 ：Off、On

CC (Control Change)
打开或关闭控制变化信息的发送和接收。
设置 ：Off、On

Vol/Exp (Volume/Expression)
打开或关闭音量设置的发送和接收。当 CC (Control Change) 设置为 Off 时，此参数不可用。
设置 ：Off、On

Pan
打开或关闭声像设置的发送和接收。当 CC (Control Change) 设置为 Off 时，此参数不可用。
设置 ：Off、On

MW (Modulation Wheel)
打开或关闭 MIDI 调制轮信息的发送和接收。当 CC (Control Change) 设置为 Off 时，此参数不可用。
设置 ：Off、On

Sustain
打开或关闭 MIDI 延音和选择性延音信息的发送和接收。当 CC (Control Change) 设置为 Off 时，此参数不可用。
设置 ：Off、On

FC1 (Foot Controller 1)
FC2 (Foot Controller 2)
打开或关闭单独出售的踏板控制器的 MIDI 信息的发送和接收。当 CC (Control Change) 设置为 Off 时，此参数不可用。
设置 ：Off、On
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FS (Foot Switch)
打开或关闭单独出售的脚踏开关的 MIDI 信息的发送和接收。当 CC (Control Change) 设置为 Off 时，此参数不可用。
设置 ：Off、On

A. Sw 1 (Assignable Function Switch 1)
A. Sw 2 (Assignable Function Switch 2)
打开或关闭 [ASSIGN 1] 和 [ASSIGN 2] 按钮的 MIDI 信息的发送和接收。当 CC (Control Change) 设置为 Off 时，此参数 
不可用。
设置 ：Off、On

MS Trigger (Motion Sequencer Trigger)
打开或关闭 [MSEQ TRIGGER] 按钮的 MIDI 信息发送和接收。当 CC (Control Change) 设置为 Off 时，此参数不可用。
设置 ：Off、On

RB (Ribbon Controller)
打开或关闭 MIDI 触摸条控制器信息的发送和接收。当 CC (Control Change) 设置为 Off 时，此参数不可用。
设置 ：Off、On

BC (Breath Controller)
打开或关闭 MIDI 呼吸控制器信息的发送和接收。当 CC (Control Change) 设置为 Off 时，此参数不可用。
设置 ：Off、On

Porta Sw (Portamento Switch)
打开或关闭 [PORTAMENTO] 按钮的 MIDI 信息发送和接收。当 CC (Control Change) 设置为 Off 时，此参数不可用。
设置 ：Off、On

Porta Time (Portamento Time)
打开或关闭 PORTAMENTO [TIME] 旋钮的 MIDI 信息发送和接收。当 CC (Control Change) 设置为 Off 时，此参数不可用。
设置 ：Off、On

A. Knob 1–8 (Assignable Knob)
打开或关闭旋钮 1 至 8 的 MIDI 信息的发送和接收。当 CC (Control Change) 设置为 Off 时，此参数不可用。
设置 ：Off、On
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Control Settings

操作
[PERFORMANCE (HOME)] → Part Common 选择 → [EDIT/ ] → Mod/Control → Control Settings

Slider Direction
当滑杆 Mode 设置为“ELEM/OP/OSC”时，设置此声部的控制滑杆 1 至 8 的方向。
当设置为 Reverse 时，画面上的音量控制将更改为风琴滑块。当您选择一个声部并将 View Mode 设置为 Part Info 时，将
显示风琴滑杆。
设置 ：Normal （从下到上）、Reverse （从上到下）
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Part LFO
在 Part LFO 画面上，您可以设置声部 LFO。

操作
[PERFORMANCE (HOME)] → Part Common 选择 → [EDIT/ ] → Mod/Control → Part LFO

LFO Wave
选择 LFO 波形并设置 LFO 的循环变化类型。
设置 ：	 Triangle、Triangle+、Saw Up、Saw Down、Squ1/4、Squ1/3、Square、Squ2/3、Squ3/4、Trapezoid、 

S/H1、S/H2、User

Edit User LFO
User LFO Edit 画面会打开。
您可以创建拥有最多 16 个步级的 LFO 波形。

•	 Cycle
设置 LFO 步级数。
设置 ：2 steps、3 steps、4 steps、6 steps、8 steps、12 steps、16 steps

•	 Slope
设置画面上当前显示的波形斜率的变化。
设置 ：Off （无斜率）、Up、Down、Up&Down
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•	 User LFO Step Value
设置每个步级的值。
设置 ：–64–+0–+63

•	 Template
为 LFO 波形选择模板。

Tempo Sync (LFO Tempo Sync)
设置 LFO Wave 设置变化同步到琶音或乐曲播放的速度。
设置 ：Off（不同步）、On（同步）

•	当设置为Off时

Speed (LFO Speed)
设置 LFO Wave 变化的速度。
当 Tempo Sync (LFO Tempo Sync) 设置为 On 时，此参数不可用。
设置 ：0–63

Random Speed (Part LFO Random Speed Depth)
随机更改 LFO Speed。
当 Tempo Sync (LFO Tempo Sync) 设置为 On 时，此参数不可用。
设置 ：0–127

•	当设置为On时

Tempo Speed (LFO Tempo Speed)
您可以使用音符值设置 LFO Wave 变化的速度。
设置 ：	 1/16（十六分音符）、1/8 Tri.（八分音符三连音）、1/16 Dot.（附点十六分音符）、1/8（八分音符）、1/4 Tri.（四

分音符三连音）、1/8 Dot.（附点八分音符）、1/4（四分音符）、1/2 Tri.（二分音符三连音）、1/4 Dot.（附点四分音
符）、1/2（二分音符）、Whole Tri.（全音符三连音）、1/2 Dot.（附点二分音符）、1/4 × 4（四分音符四连音 ；四
个四分音符节拍）、1/4 × 5（四分音符五连音；五个四分音符节拍）、1/4 × 6（四分音符六连音；六个四分音符节
拍）、1/4 × 7（四分音符七连音 ；七个四分音符节拍）、1/4 × 8（四分音符八连音 ；八个四分音符节拍）、1/4 × 
16（十六个四分音符节拍）、1/4 × 32（三十二个四分音符节拍）、1/4 × 64（六十四个四分音符节拍）

Delay (LFO Delay Time)
设置从按下键盘上的琴键到 LFO 生效之间的延迟时间。
该值越大，LFO 生效的延迟时间就越长。
设置 ：0–127



236MODX M 使用说明书

Fade In (LFO Fade In Time)
设置在松开琴键且经过 Delay (LFO Delay Time) 中设置的延迟时间后，LFO 效果器淡入的时间长度。该值越大，LFO 效果
器达到最大值所花的时间就越长。
设置 ：0–127

0:在没有任何淡入的情况下 LFO 变化为最大值。

当值较小时
Fade In

Maximum

Delay

Key On

Time

当值较大时
Fade In

Maximum

Delay

Key On

Time

Hold (LFO Hold Time)
设置达到最大电平后保持 LFO 效果器的时间。
设置 ：0–126、Hold

Hold ：不淡出

Hold
Maximum

Key On

Time
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Fade Out (LFO Fade Out time)
设置在经过 Hold (LFO Hold Time) 中设置的保持时间后 LFO 效果器淡出的时间量。该值越大，LFO 效果器淡出所花的时间
就越长。
设置 ：0–127

当值较小时
Fade-Out

Maximum
Hold

Key On

Time

当值较大时
Fade-Out

Maximum
Hold

Key On

Time

Key On Reset (LFO Key On Reset)
按下琴键时使 LFO 的振荡复位。
设置 ：	 Off、Each-on、1st-on

当设置为Off时
不复位 LFO 的振荡。无论 LFO 当时处于哪个相位，按下琴键都会启动 LFO 波形。

Key On

Time

当设置为 Each-on 时
每次按下按键时都会复位 LFO 的振荡，并以 Phase 参数指定的相位启动波形。

Key On
(first note)

Key On
(second note)

Time

当设置为 1st-on 时
每次按下按键时都会复位 LFO 的振荡，并以 Phase 参数指定的相位启动波形。
如果在保持第一个音符时演奏第二个音符，则播放不会复位。

Key On
(first note)

Key On
(second note)

Time
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Loop (LFO Loop Switch)
将 LFO Wave 设置为循环（重复）播放或单次播放。
设置 ：Off、On

Phase (LFO Phase)
您可以设置复位 LFO Wave 时的初始相位。
设置 ：0° , 90° , 120° , 180° , 240° , 270°

Phase

Time

Level

0° 90°
120° 240°

180° 270°

Element Phase Offset (LFO Element Phrase Offset)
设置每个音素的 Phase (LFO Phase) 的偏移值。
设置 ：0° , 90° , 120° , 180° , 240° , 270°

Element (Display Element)
当 General/Pitch → Element Settings Ex Elem Sw 设置为 On 时，您可以为与 Element Phase Offset 和 Element Depth 
Ratio 对应的四个音素的组选择不同的数字。但您可以在开关中使用的实际数字范围取决于在 General/Pitch → Element 
Settings 画面上的 Element Count 中设置的值（示例 ：如果 Element Count 设置为 30，则可选择的组为 29–32）。
设置 ：1–4, 5–8, ..., 125–128

Element Phase Offset (LFO Element Phase Offset)
设置每个音素的 Phase (LFO Phase) 的偏移值。
您可以设置复位 LFO Wave 时每个音素的初始相位。
当 General/Pitch → Element Settings 画面上的 Ex Elem Sw 设置为 On 时，您可以通过更改 Element (Display Element)
来更改音素编号。最多显示 General/Pitch → Element Settings Element Count 中设置的值。

Element Depth Ratio (LFO Element Depth Ratio)
调整每个音素的 Depth。将此参数设置为 Off 可关闭 LFO。
仅当所选 Destination 与音素相关时才会显示此参数。
当 General/Pitch → Element Settings Ex Elem Sw 设置为 On 时，可以通过 Element (Display Element) 更改 Depth 音素
编号。
最多显示 General/Pitch → Element Settings Element Count 中设置的值。
设置 ：Off、0–127

Destination (LFO Destination)
设置由 LFO Wave 控制的功能。
设置 ：	 Insertion Effect A Parameter 1–24、Insertion Effect B Parameter 1–24、Level、Pitch、Cutoff、Resonance、

Pan、E.LFO Speed

Depth (LFO Depth)
设置每个 Destination 的 LFO Wave 控制的深度。
设置 ：0–127
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Part Edit (AWM2) Element Edit 画面
Normal Part (AWM2) 最多包含 128 个音素。
Part Edit (AWM2) 包括 Part Common Edit（用于设置整个声部的参数）和 Element Edit（用于设置声部中每个音素的 
参数）。

Osc/Tune

在 Osc/Tune 画面上，您可以设置音素的振荡器。
在这里，您可以选择用作声音基础的波形，并设置音素的键区域和力度范围。

操作
[PERFORMANCE (HOME)] → [EDIT/ ] → Part 选择 → Element 选择 → Osc/Tune

Element Switch
打开或关闭选定的音素。
设置 ：Off、On

Bank (Waveform Bank)
Number (Waveform Number)
Category (Waveform Category)
Sub Category (Waveform Sub Category)
Waveform Name
显示为音素选择的波形的名称。
Bank 指示分配给音素的波形类型（Preset、User 和 Library）。
设置 ：请参阅 Data List
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XA Control
XA (Expanded Articulation) 是一种创建逼真声音（如原声乐器上的声音）以及创建新合成声音的功能。
您可以通过设置 XA Control 来指定音素的播放方式，从而创造这样的声音。
设置 ：	 Normal、Legato、Key Off、Cycle、Random、A.Sw Off、A.Sw1 On、A.Sw2 On

Normal ：作为标准音素来弹奏。
Legato：当 Mono/Poly 设置为 Mono 时弹奏。当您用连奏来弹奏时，将会弹奏设置为 Legato 的音素，而不是弹奏
设置为 Normal 的音素
Key Off ：当手指离开琴键时弹奏
Cycle ：当在 Cycle 中设置了一系列音素时弹奏
Random：当多个音素设置为 Random 时，随机弹奏音素
A.Sw Off：当 [ASSIGN 1] 和 [ASSIGN 2] 按钮均设置为 Off 时弹奏。
A.Sw1 On ：当 [ASSIGN 1] 按钮设置为 On 时弹奏。
A.Sw2 On ：当 [ASSIGN 2] 按钮设置为 On 时弹奏。

XA Control 设置的示例
•	 创建平滑的连奏

在 XA Control 设置为 Normal 的一个音素与 XA Control 设置为 Legato 的另一个音素之间交替切换音素。
•	 创建在松开琴键时产生的声音

创建一个音素，并将 XA Control 设置为 Key Off。
•	 为同一个音符创建随机性

将一个音素的 XA Control 设置为 Cycle，并将另一个音素的 XA Control 设置为 Random。
•	 发出原声乐器特有的声音，例如吉他上的泛音和拨弦掌闷音、长笛上的花舌以及萨克斯管上的低鸣声

设置一个音素，将 XA Control 设置为 A.Sw Off、A.Sw1 On 或 A.Sw2 On，并通过上方面板的 [ASSIGN 1] 和 [ASSIGN 2] 按
钮进行控制。
注
通过从外接设备发送在 Common Edit 画面的 Control → Control Number 中设置的控制变化编号，可以将 [ASSIGN 1] 和 [ASSIGN 2]
按钮设置为 On 或 Off。

Elem Group (Element Group Number)
此参数用于将具有相同 XA Control 设置的音素分类到组中。
当所有音素的 XA Control 均设置为 Normal 时，此设置无效。
设置 ：1–8

Elem Connect (Element Connection Switch)
设置插入效果器 A 或插入效果器 B 的音素输出。
将此项设置为 Thru 可绕过插入效果器。
设置 ：Thru、InsA、InsB

New Waveform
将保存在 USB 闪存上的音频文件加载为波形。
加载波形时会出现 Edit Waveform。

Edit Waveform
Waveform Edit 画面会打开。
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Coarse (Coarse Tune)
以半音为单位改变音素的音高。
设置 ：–48–+0–+48

Fine (Fine Tune)
精细调整音素的音高。
设置 ：–64–+0–+63

Pitch/Vel (Pitch Velocity Sensitivity)
设置如何根据力度或击键的强度进行音高变化。
设置 ：	 –64–+0–63

正值：力度越快，音高越高
0:保持不变
负值：力度越快，音高越低

Fine/Key (Fine Tune Key Follow Sensitivity)
设置如何根据琴键的位置来微调音高变化。
设置 ：	 –64–+0–63

正值：当按下低音部分的按键时音高降低，当按下高音部分的按键时音高上升
负值：当按下低音部分的按键时音高上升，当按下高音部分的按键时音高降低

Random (Random Pitch Depth)
每次按下琴键时随机更改音素的音高。
将参数设置为较大的值可产生更多的音高变化。当该值设置为 0 时，音高保持不变。
设置 ：0–127

Vel Cross Fade (Velocity Cross Fade)
随着超出 Velocity Limit 的击键力度值与 Velocity Limit 中设置的值之间的差异变得更大，将振荡器的输出电平设置为更低。
该值越大，振荡器的输出电平下降的幅度就越缓慢。设置为 0 时，如果力度超出 Velocity Limit 设置，则不会发出声音。
设置 ：	 0–127

当 Level/Vel 设置为 +0时

Output

Velocity
Velocity Limit Low

(1)

(2)

Output

Velocity
Velocity Limit Low

Vel Cross Fade = 0

(1) 当使用较大的值时，斜率将向左移动。
(2) 设置为 0 时，如果力度超出 Velocity Limit 设置，则不会发出声音。
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Key On Delay Tempo Sync (Key On Delay Tempo Sync Switch)
设置 Key On Delay 的时间以与速度同步。
设置 ：Off、On

Key On Delay Length (Key On Delay Time Length)
设置从按下琴键那一刻到发出声音的延迟时间。
当 Key On Delay Tempo Sync (Key On Delay Tempo Sync Switch) 设置为 On 时，此参数不可用。
设置 ：0–127

Length (Key On Delay Note Length)
您可以使用音符值来设置 Key On Delay 的时间。
当 Key On Delay Tempo Sync (Key On Delay Tempo Sync Switch) 设置为 On 时，此参数可用。
设置 ：	� 1/16（十六分音符）、1/8 Tri.（八分音符三连音）、1/16 Dot.（附点十六分音符）、1/8（八分音符）、1/4 Tri.（四分

音符三连音）、1/8 Dot.（附点八分音符）、1/4（四分音符）、1/2 Tri.（二分音符三连音）、1/4 Dot.（附点四分音符）、
1/2（二分音符）、Whole Tri.（全音符三连音）、1/2 Dot.（附点二分音符）、1/4 × 4（四分音符四连音；四个四分音
符节拍）、1/4 × 5（四分音符五连音 ；五个四分音符节拍）、1/4 × 6（四分音符六连音 ；六个四分音符节拍）、1/4 
× 7（四分音符七连音 ；七个四分音符节拍）、1/4 × 8（四分音符八连音 ；八个四分音符节拍）

Velocity Limit
设置弹奏因素波形的力度范围（最低和最高值）。
当设置为较高的值在前，较低的值在后（例如，93 至 34）时，仅以 1 至 34 和 93 至 127 的力度播放音素声音。
设置 ：1–127

Note Limit
设置音素的音符范围（最低音符和最高音符）。
当指定的第一个音符高于第二个音符（例如，C5 至 C4）时，将以 C2 至 C4 和 C5 至 G8 范围演奏音素。
设置 ：C–2–G8

Center Key (Pitch Key Follow Sensitivity Center Key)
设置 Pitch/Key (Pitch Key Follow Sensitivity) 的参考键（音符）。
无论 Pitch/Key 设置如何，此处使用音符编号设置的键都会以标准音高演奏。
设置 ：C–2–G8
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Pitch/Key (Pitch Key Follow Sensitivity)
设置两个相邻键之间的音高差异。参考音符由 Center Key (Pitch Key Follow Sensitivity Center Key) 指定。
此参数对于播放无音高的声音（例如特殊效果器）或将打击乐器作为普通声部演奏，或者音高差异并不一定是半音的任何其
他情况下非常有用。
设置 ：	 –200%–+0%–+200%

+100%（正常设置）：相邻两个键之间的音高差异设置为半音
0%:两个相邻键之间没有音高差异，且所有键均按 Center Key 中设置的音高演奏。
负值：设置相反的音高响应，使得较低的音符产生较高的音高，而较高的音符产生较低的音高。

Pitch/Key 和 Center Key
(2)

(1)

(3)

(4)

(5)

+

–

High

+100%

+150%

+50%

Low

(1) 键
(2) 音高的变化量
(3) Center Key
(4) 相邻键之间的音高差异变得更大
(5) 相邻键之间的音高差异变得更小
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Waveform Edit
打开 Waveform Edit 画面。
在这里，您可以设置构成波形的各种键库。

	�键库
键库是由加载到乐器中的短音频段（例如人声或其他声音）组成的数字数据。它具有与 .wav 文件相同的特性 ；但为了避免
混淆，使用了不同的名称来将它与波形区分开来。

	�键库和波形
键库始终保存为波形的一部分。
一个波形可以包含多个键库，让您可以在单个波形中保存几十个键库。
然而，如果所有键库同时发声，就会变得难以管理，因此您可以设置每个键库发声的琴键范围 (Note Limit) 和力度范围
(Velocity Limit)。通过设置多个键库，您可以根据所用的键盘部分和击键强度来弹奏各种键库声音。

键库和波形设置示例
Velocity

Waveform
Key

Bank 1

Key Number
(Note Number)

40

127

D♯2 A♯2 G♯3 F4

Key Bank 2 Key Bank 4

Key Bank 3 Key Bank 5

	�声部和波形
波形可以合并到声部中并在键盘上演奏。
您可以使用 Part Edit (AWM2)、Element Edit、Drum Part Edit (AWM2) 和 Key Edit 为每个音素分配一个波形到声部。
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Waveform
显示所选波形的名称。

Category (Waveform Category)
Sub Category (Waveform Sub Category)
设置所选波形的主类别和子类别。
设置 ：请参阅 Data List

Name (Waveform Name)
您可以使用最多 20 个字母数字字符的新名称来保存正在编辑的波形。

Total
显示波形中的键库数以及数据容量的总大小。

Keybank (Keybank Number)
显示键库编号。

Size (Keybank Size)
显示数据容量的总大小。

Channel (Keybank Channel)
显示键库是立体声还是单声道。

Velocity Limit
设置弹奏键库的力度范围（最低和最高值）。
设置 ：1–127

Note Limit
设置弹奏键库的音符范围（最低和最高音符）。
设置 ：1–127

Center Note
设置原始波形数据的键（音高）。
设置 ：C–2–G8

Volume
设置键库的音量。
设置 ：0–255

Pan
设置键库的声像位置（在立体声场中）。
设置 ：L63–C（中央）–R63

Tune Coarse (Coarse Tune)
以半音为单位改变键库的音高。
设置 ：–64–+63

Tune Fine (Fine Tune)
用于微调键库的音高。
设置 ：–64–+63

Delete Keybank
删除键库。

Add Keybank
将键库添加到波形。
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Pitch EG

在 Pitch EG 画面中，您可以设置振荡器的包络发生器。
通过设置 PEG（音高包络发生器）时间和电平（音高变化量），您可以设置从按下键盘上的琴键到声音衰减到静音的过程中
声音如何变化。

操作
[PERFORMANCE (HOME)] → [EDIT/ ] → Part 选择 → Element 选择 → Pitch EG

Hold Time (PEG Hold Time)
设置从按下键盘上的琴键的那一刻起，直至将音高保持在 Hold Level (PEG Hold Level) 所需的时间长度。
设置 ：0–127

Attack Time (PEG Attack Time)
设置音高从 Hold Time (PEG Hold Time) 结束变化到 Attack Level (PEG Attack Level) 所需的时间长度。
设置 ：0–127

Decay1 Time (PEG Decay 1 Time)
设置音高从 Attack Level (PEG Attack Level) 变化到 Decay1 Level (PEG Decay 1 Level) 所需的时间长度。
设置 ：0–127

Decay2 Time (PEG Decay 2 Time)
设置音高从 Decay1 Level (PEG Decay 1 Level) 变化到 Decay2 Level (PEG Decay 2 Level) 所需的时间长度。
设置 ：0–127

Release Time (PEG Release Time)
设置从松开琴键变化至音高达到 Release Level (PEG Release Level) 所需的时间长度。
设置 ：0–127
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Hold Level (PEG Hold Level)
设置按下琴键那一刻的音高。
设置 ：–128–+0–+127

Attack Level (PEG Attack Level)
设置从保持电平或按下琴键的那一刻开始音高发生的变化。
设置 ：–128–+0–+127

Decay1 Level (PEG Decay 1 Level)
设置要从 Attack Level (PEG Attack Level) 变化的下一个音高值。
设置 ：–128–+0–+127

Decay2 Level (PEG Decay 2 Level)
设置要从 Decay1 Level (PEG Decay 1 Level) 变化的下一个音高值。
设置 ：–128–+0–+127

Release Level (PEG Release Level)
设置松开琴键后要达到的最终音高。
设置 ：–128–+0–+127

Center Key (PEG Time Key Follow Sensitivity Center Key)
设置 Time/Key (PEG Time Key Follow Sensitivity) 的参考键（音符）。
通过此处设置的音符（键），将播放 PEG 中设置的音高变化产生的最终声音。
设置 ：C–2–G8

Time/Key (PEG Time Key Follow Sensitivity)
设置 PEG 中音高变化的速度如何根据键位置而变化。
PEG 中的变化速度用于 Center Key (PEG Time Key Follow Sensitivity Center Key) 中的指定键。
设置 ：	 –64–+0–+63

正值：弹奏的琴键越低，PEG 中的变化越慢 ；弹奏的琴键越高，PEG 中的变化越快。
0:无论键位置如何，PEG 都不会变化
负值：按下的键越高，PEG 的音高变化越慢。

Center Key 和 Time/key

(2)

(1)

(3)

High

Fast

Slow

+63

+30

−40

Low

Time

(6)

Time

(6)

Time

(6)

Time

(6)

(4)

(5)

Low key High key

(1) 键
(2) PEG 中音高变化的速度
(3) Center Key
(4) 当 Time/Key 为正数时
(5) 当 Time/Key 为负数时
(6) 音高
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Time/Vel (PEG Time Velocity Sensitivity)
Segment (PEG Time Velocity Sensitivity Segment)
设置如何根据力度或击键的强度调整 PEG 音高变化的时间。
首先在 Segment 中设置时间值，然后在 Time/Vel 中设置力度灵敏度值。
设置 ：	 Time/Vel ：–64–+0–+63

正值：力度越快，PEG 的音高变化越快
0:无论力度设置如何，PEG 都不会变化。
负值：力度越快，PEG 的音高变化越慢
当值为正数时
快速的力度（音高变化快）		  慢速的力度（音高变化慢）

Time

(1)

Time

(1)

(1) 音高
设置 ：	 Segment ：Attack、Atk+Dcy、Decay、Atk+Rls、All

Attack ：Time/Vel 值会影响 Attack Time
Atk+Dcy ：Time/Vel 值会影响 Attack Time 和 Decay1Time
Decay ：Time/Vel 值会影响 Decay Time
Atk+Rls ：Time/Vel 值会影响 Attack Time 和 Release Time
All ：Time/Vel 值会影响 PEG 中与时间相关的设置

PEG Depth
设置由 PEG 控制的音高变化量。深度距离值 0 越远，音高变化就越大。
设置 ：	 –64–+0–+63

0:保持不变
负值：音高变化反转。

Depth/Vel (PEG Depth Velocity Sensitivity)
Curve (PEG Depth Velocity Sensitivity Curve)
设置 PEG 如何根据力度或击键的强度控制音高变化的深度范围。
此外，通过 Curve 设置，您可以设置 PEG Depth 如何根据力度而变化。纵轴表示力度，横轴表示音高变化的深度范围。
设置 ：	 Depth/Vel ：–64–+0–+63

正值：较快的力度值会拓宽 PEG 控制的音高变化的深度范围，而较慢的值会缩窄深度范围
0:无论力度设置如何，PEG 都不会变化。
负值：较快的力度值会缩窄 PEG 控制的音高变化的深度范围，而较慢的值会拓宽深度范围
当值为正数时
快速的力度（音高变化的深度范围更广）	 慢速的力度（音高变化的深度范围更窄）

Time

(1)

Time

(1)

(1) 音高深度

设置 ：	 Curve ：0–4
0 31 42
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Filter

Type
在 Type 画面上，您可以为音素选择滤波器类型。可用参数根据您在此处选择的滤波器类型而有所不同。

操作
[PERFORMANCE (HOME)] → [EDIT/ ] → Part 选择 → Element 选择 → Filter → Type

Filter Type
设置音素的滤波器。此乐器上可用的滤波器分为四种类型 ：LPF、HPF、BPF 和 BEF。
设置 ：	� LPF24D、LPF24A、LPF18、LPF18s、LPF12+HPF12、LPF6+HPF12、HPF24D、HPF12、BPF12D、BPFw、BPF6、

BEF12、BEF6、DualLPF、DualHPF、DualBPF、DualBEF、LPF12+BPF6、Thru

•	 LPF（低通滤波器）
减弱高于截止频率中设置的值的信号。这种类型非常受欢迎，对于产生经典的合成器声音非常有用。当您提高截止
频率时，因为更多的信号会通过滤波器，所以声音会变得更明亮。当您降低截止频率时，因为滤波器会减弱或阻止
信号，所以声音会变得更低沉。
您可以通过提高 Resonance 或提高接近截止频率的信号电平来产生独特的“尖峰”声音。

Frequencies that are
“passed” by the filter

Cutoff Frequency

Resonance

FrequencyCutoff FrequencyFrequency

Gain
Gain

LPF24D ：具有特征数字声音的动态 4 极 (–24dB/oct) LPF。与 LPF24A 类型相比，此滤波器可以产生更明显的共
鸣效果
LPF24A ：数字动态 LPF，其特性类似于 4 极 (–24dB/oct) 模拟合成器滤波器
LPF18 ：3 极 (–18dB/oct) LPF
LPF18s ：3 极 (–18dB/oct) LPF。频率曲线比 LPF18 更平缓
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•	 HPF（高通滤波器）
这种滤波器类型仅传递高于截止频率的信号。
您可以通过提高 Resonance 或提高接近截止频率的信号电平来产生独特的“尖峰”声音。

Resonance

Frequencies that are
“passed” by the filter

Frequency
Cutoff Frequency

Gain

LPF12+HPF12：2 极 (–12dB/oct) LPF 和 HPF 的串联组合。选择此滤波器类型后，可以设置 HPF Cutoff (HPF Cutoff 
Frequency) 和 HPF Cutoff /Key (HPF Cutoff Key Follow Sensitivity)
LPF6+HPF12：–6dB/oct LPF 和 –12dB/oct 的串联组合。选择此滤波器类型后，可以设置 H PF Cutoff (HPF Cutoff 
Frequency) 和 HPF Cutoff /Key (HPF Cutoff Key Follow Sensitivity)
HPF24D ：具有特征数字声音的动态 –24dB/oct HPF。此滤波器可以产生明显的共鸣效果。
HPF12 ：动态 –12dB/oct HPF

•	 BPF（带通滤波器）
这种滤波器类型仅允许具有设定截止频率频段的信号通过，并切断所有其他信号。

Frequencies that are “passed” by the filter

FrequencyCenter Frequency

Gain

BPF12D ：具有特征数字声音的 –12dB/oct HPF 和 LPF 的组合
BPFw：–12dB/oct HPF 和 LPF 的组合。允许更宽的带宽设置
BPF6 ：–6dB/oct HPF 和 LPF 的组合

BPF12D	 BPFw

Width

Frequencies that are 
“passed” by the filter

Frequencies that are 
“passed” by the filter

Frequencies that are 
“passed” by the filter

Frequency Frequency

Frequency

Resonance

Resonance

Gain

Gain

Gain

BPF6
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•	 BEF（带阻滤波器）
与 BPF（带通滤波器）相比，对声音有相反的影响。这种滤波器类型会切断所设定截止频率附近的信号，而让其他
频段的信号通过。

Frequencies that are 
“passed” by the filter

Frequency
Center Frequency

Gain

BEF12 ：–12dB/oct BEF
BEF6 ：–6dB/oct BEF
DualLPF：两个并联的 –12dB/oct LPF。使用 Distance 设置两个滤波器的截止频率之间的距离。下限频率在画面上
设定，而上限频率则自动与之配合确定
DualHPF ：两个并联的 –12dB/oct HPF
DualBPF ：两个并联的 –6dB/oct BPF
DualBEF ：两个串联的 –6dB/oct BEF
LPF12+BPF6：–12dB/oct LPF 和 –6dB/oct BPF 的并联组合。使用 Distance 设置两个滤波器的截止频率之间的距
离。下限频率在画面上设定，而上限频率则自动与之配合确定

DualLPF	 DualBEF

Frequency Frequency

Frequency

Distance

Distance

Distance
Gain

Gain

Gain

Cutoff (Filter Cutoff Frequency)
设置截止频率。
此处设置的频率由 Type 中设置的滤波器使用。
设置 ：0–1023

Cutoff/Vel (Filter Cutoff Velocity Sensitivity)
设置如何根据力度或击键的强度调整截止频率。
设置 ：	 –64–+0–+63

正值：力度越快，截止频率值就越高
0:截止频率不随力度而变化。
负值：力度越慢，截止频率值就越高

LPF12+BPF6
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Resonance (Filter Resonance)
Width (Filter Width)
此处显示的参数根据 Filter Type 设置而变化。对于 LPF、HPF、BPF（不包括 BPFw）或 BEF，显示 Resonance，对于
BPFw，显示 Width。
对于 Resonance，此参数表示共鸣的强度。这可以与 Cutoff 参数结合使用，为声音添加更多特征。
对于 BPFw，Width 用于调整滤波器允许通过的频率的宽度。
设置 ：0–127

Res/Vel (Filter Resonance Velocity Sensitivity)
设置如何根据力度或击键的强度调整共鸣电平。
根据 Filter Type，此参数可能不可用。
设置 ：	 –64–+0–+63

正值：力度越高，共鸣变得越大
0:共鸣值不随力度而改变。
负值：力度越低，共鸣变得越大

Cutoff/Key (Filter Cutoff Key Follow Sensitivity)
设置滤波器的截止频率电平如何随着键位置而变化。
参考点是 Center Key (FEG Time Key Follow Sensitivity Center Key) 中设置的键的截止频率。
设置 ：	 –200%–0%–+200%

正值：弹奏的琴键越低，截止频率就越低 ；弹奏的琴键越高，截止频率就越高。
负值：弹奏的琴键越低，截止频率就越高 ；弹奏的琴键越高，截止频率就越低。

Distance
设置双滤波器类型和 LPF12+BPF6 滤波器的截止频率之间的距离。
根据 Filter Type，此参数可能不可用。
设置 ：–128–+0–+127

HPF Cutoff (HPF Cutoff Frequency)
设置控制滤波器截止功能的中心频率以及 FEG 根据 HPF 的按键连奏设置变化的速度有多快。
增大该值会产生更高的截止频率，低频信号会减弱或阻挡，使声音更明亮。减小该值会产生更低的截止频率，允许更多的低
音成分通过，从而使声音更丰富、更深沉。
当 Filter Type 设置为 LPF12+HPF12 或 LPF6+HPF12 时，此参数不可用。
设置 ：0–1023

HPF Cutoff/Key (HPF Cutoff Key Follow Sensitivity)
根据琴键的位置设置 HPF 的截止频率电平。
当 Filter Type 设置为 LPF12+HPF12 或 LPF6+HPF12 时，此参数不可用。
设置 ：	 –200%–+0–+200%

正值：弹奏的琴键越低，截止频率就越低 ；弹奏的琴键越高，截止频率就越高。
负值：弹奏的琴键越低，截止频率就越高 ；弹奏的琴键越高，截止频率就越低。

Gain (Filter Gain)
设置增益（发送到滤波器单元的信号）。
降低该值会减小音素的音量。
设置 ：0–255
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Filter EG
在 Filter EG 画面中，您可以设置音素的滤波器包络发生器 (FEG)。
FEG 让您可以设置截止频率的变化程度（或级别），以及从您按下键盘上的按键到声音衰减的那一刻为止，这些变化如何随
时间演变。

操作
[PERFORMANCE (HOME)] → [EDIT/ ] → Part 选择 → Element 选择 → Filter → Filter EG

Hold Time (FEG Hold Time)
设置从按下键盘上的琴键的那一刻起，直至将截止频率保持在 Hold Level (FEG Hold Level) 所需的时间长度。
设置 ：0–127

Attack Time (FEG Attack Time)
设置截止频率从 Hold Time (FEG Hold Time) 结束变化到 Attack Level (FEG Attack Level) 所需的时间长度。
设置 ：0–127

Decay 1 Time (FEG Decay 1 Time)
设置截止频率从 Attack Level (FEG Attack Level) 变化到 Decay1 Level (FEG Decay 1 Level) 所需的时间长度。
设置 ：0–127

Decay 2 Time (FEG Decay 2 Time)
设置截止频率从 Decay 1 Level (FEG Decay 1 Level) 变化到 Decay 2 Level (FEG Decay 2 Level) 所需的时间长度。
设置 ：0–127

Release Time (FEG Release Time)
设置从琴键上松开手指到截止频率达到 Release Level (FEG Release Level) 所需的时间长度。
设置 ：0–127
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Hold Level (FEG Hold Level)
设置按下琴键时的截止频率。
设置 ：–128–+0–+127

Attack Level (FEG Attack Level)
设置按下琴键后要更改的截止频率值。
设置 ：–128–+0–+127

Decay 1 Level (FEG Decay 1 Level)
设置要从 Attack Level (FEG Attack Level) 更改的下一个截止频率值。
设置 ：–128–+0–+127

Decay 2 Level (FEG Decay 2 Level)
设置按住琴键时保持的截止频率。
设置 ：–128–+0–+127

Release Level (FEG Release Level)
设置从琴键上松开手指后的下一个截止频率值。
设置 ：–128–+0–+127

Center Key (FEG Time Key Follow Sensitivity Center Key)
设置 Time/Key 的参考键（音符）。
通过此处设置的键（音符），按原样使用 FEG 中设置的截止频率的变化速度。
设置 ：C–2–G8

Time/Key (FEG Time Key Follow Sensitivity)
设置由 FEG 引起的截止频率变化速度根据琴键的音高增加或减少的程度。
FEG 中的变化速度用于 Center Key 中的指定键。
设置 ：	 –64–+63

正值：弹奏的琴键越低，FEG 控制的截止频率变化越慢 ；弹奏的琴键越高，变化变得越快
0:无论键位置如何，FEG 都不会变化
负值：弹奏的琴键越低，FEG 控制的截止频率变化越快 ；弹奏的琴键越高，变化变得越慢

Center Key 和 Time/key

(2)

(1)

(3)

High

Fast

Slow

+63

+30

−40

Low

Time

(6)

Time

(6)

Time

(6)

Time

(6)

(4)

(5)

Low key High key

(1) 键
(2) FEG 控制的截止频率的速度
(3) Center Key
(4) 当 Time/Key 为正数时
(5) 当 Time/Key 为负数时
(6) 截止频率
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Time/Vel (FEG Time Velocity Sensitivity)
Segment (FEG Time Velocity Sensitivity Segment)
设置如何根据力度或击键的强度调整截止频率。
首先在 Segment 中设置时间值，然后在 Time/Vel 中设置力度灵敏度值。
设置 ：	 Time/Vel ：–64–+0–+63

正值：力度越快，FEG 控制的截止频率变化越快 ；力度越慢，变化越慢
0:无论力度设置如何，都不会变化。
负值：力度越快，FEG 控制的截止频率变化越慢 ；力度越慢，变化越快
当值为正数时
快速的力度（截止频率快速变化）	 慢速的力度（截止频率慢速变化）

Time

(1)

Time

(1)

(1) 截止频率
设置 ：	 Segment ：Attack、Atk+Dcy、Decay、Atk+Rls、All

	 Attack ：Time/Vel 值会影响 Attack Time
	 Atk+Dcy ：Time/Vel 值会影响 Attack Time 和 Decay1Time
	 Decay ：Time/Vel 值会影响 Decay Time
	 Atk+Rls ：Time/Vel 值会影响 Attack Time 和 Release Time
	 All ：Time/Vel 值会影响 FEG 中与时间相关的设置

FEG Depth
设置 FEG 控制的截止频率变化的深度范围。设置距离 0 值越远，截止频率变化的深度范围就越宽。
设置 ：	 –64–+0–+63

0:FEG 不会导致截止频率发生变化。
负值：截止频率的变化相反。

Depth/Vel (FEG Depth Velocity Sensitivity)
Curve (FEG Depth Velocity Sensitivity Curve)
Depth/Vel (FEG Depth Velocity Sensitivity) 设置 FEG 如何根据力度或击键的强度控制截止频率变化的深度范围。
通过 Curve (FEG Depth Velocity Sensitivity Curve) 设置，您可以设置 FEG Depth 如何根据力度而变化。纵轴表示力度，横
轴表示截止频率变化的深度范围。
设置 ：	 Depth/Vel:–64–+0–+63

正值：力度越快，FEG 导致截止频率变化的深度范围就越宽 ；力度越慢，深度范围越窄
0:截止频率不随力度而变化。
负值：力度越快，FEG 导致截止频率变化的深度范围就越窄 ；力度越慢，深度范围越宽
当值为正数时
快速的力度（截止频率变化深度范围更广）	 慢速的力度（截止频率变化深度范围缩窄）

Time

(1)

Time

(1)

(1) 截止频率变化深度范围
设置 ：	 Curve ：0–4

0 31 42
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Scale
在 Scale 画面上，您可以设置音素的滤波器范围。
滤波器范围功能让您可以根据音高更改滤波器的截止频率。

操作
[PERFORMANCE (HOME)] → [EDIT/ ] → Part 选择 → Element 选择 → Filter → Scale

Break Point (Filter Cutoff Scaling Break Point) 1–4
为要设置为 Cutoff Offset 的四个点设置音符编号。
设置 ：C–2–G8

注
Break Point 1 至 4 的音符编号将自动按升序排列。

Cutoff Offset (Filter Cutoff Scaling Offset) 1–4
设置在 Break Point (Filter Cutoff Scaling Break Point) 1–4 上增大或减小 Cutoff 的值。
设置 ：–128–+0–+127

注
•	当偏移值设置高于或低于 Cutoff 值时，截止频率绝不会超出设置。
•	对于任何低于 Break Point 1 的音符，将设置值为 1 的截止频率。对于任何高于 Break Point 4 的音符，将设置值为 4 的截止频率。
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Amplitude

Level/Pan
在 Level/Pan 画面上，您可以为每个音素设置电平和声相（立体声场中的位置）。

操作
[PERFORMANCE (HOME)] → [EDIT/ ] → Part 选择 → Element 选择 → Amplitude → Level/Pan

Level/Key (Level Key Follow Sensitivity)
设置每个音素的音量如何根据键位置而改变。
参考点是在 Center Key (AEG Time Key Follow Center Key) 中指定的音量。
设置 ：	 –64–+0–+63

正值：弹奏的琴键越低，音量越柔和 ；弹奏的琴键越高，音量就越大。
负值：弹奏的琴键越低，音量越大 ；弹奏的琴键越高，音量越柔和。

Level (Element Level)
设置每个音素的输出电平（音量）。
设置 ：0–127
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Level/Vel (Level Velocity Sensitivity)
Offset (Level Velocity Offset)
Curve (Level Sensitivity Key Curve)
Level/Vel (Level Velocity Sensitivity) 设置如何根据力度或击键的强度调整每个音素的音量。
Offset (Level Velocity Offset) 调整 Level/Vel 中指定的所有设置。当值超过 127 时，力度设置为 127。
通过 Curve (Level Sensitivity Key Curve) 设置，您可以设置音量如何根据力度而变化。纵轴表示力度，横轴表示音量变化
的范围。

设置 ：	 Level/Vel:–64–+0–+63
正值：力度越快，音量越大
负值：力度越慢，音量越大
0:无论力度设置如何，都不会变化。

设置 ：	 Offset ：0–127

Offset = 0 Offset = 64 Offset = 96

0 64 127

127 A

B

X

Y

C

0 64 127

127 A

B

X

Y

C

0 64 127

127 A
B

X

Y

C

A ：Level/Vel = 0
B ：Level/Vel = 32
C ：Level/Vel = 64
X ：演奏音符的力度
Y ：力度值发送至内置音源

设置 ：	 Curve: 0–4
0 31 42

Pan (Element Pan)
设置音素的声像位置（在立体声场中）。
当声部内的音素有左右声像设置时，可能很难听到声相设置的结果。
设置 ：L63–C（中央）–R63



259MODX M 使用说明书

Alternate Pan (Alternate Pan Depth)
为弹奏的每个键设置声音如何左右交替平移。
Pan (Element Pan) 中设置的值是声相左右移动的中心位置。
设置 ：L63–C（中央）–R63

Random Pan (Random Pan Depth)
为弹奏的每个键设置声音如何左右随机平移。
Pan (Element Pan) 中设置的值是立体声场中的中心位置。
设置 ：0–127

Scaling Pan (Scaling Pan Depth)
设置按键位置如何影响声像位置设置。
Pan (Element Pan) 中设置的值是 C3 的位置。
设置 ：	 –64–+0–+63

正值：对于较低的调，声相位置偏向左侧，对于较高的调，则偏向右侧。
负值：对于较低的调，声相位置偏向右侧，对于较高的调，则偏向左侧。
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Amp EG
在 Amp EG 画面中，您可以设置音素的 AEG（振幅包络发生器）。通过设置 Amp EG，您可以设置从按下键盘上的按键到声
音衰减时音量的变化方式。

操作
[PERFORMANCE (HOME)] → [EDIT/ ] → Part 选择 → Element 选择 → Amplitude → Amp EG

Attack Time (AEG Attack Time)
设置从按下键盘上的琴键到音量变化为达到 Attack Level (AEG Attack Level) 中设置的值所需的时间长度。
设置 ：0–127

Decay 1 Time (AEG Decay 1 Time)
设置音量从 Attack Level (AEG Attack Level) 变化到 Decay 1 Level (AEG Decay 1 Level) 所需的时间长度。
设置 ：0–127

Decay 2 Time (AEG Decay 2 Time)
设置音量从 Decay 1 Level (AEG Decay 1 Level) 变化到 Decay 2 Level (AEG Decay 2 Level) 所需的时间长度。
设置 ：0–127

Release Time (AEG Release Time)
设置释放琴键后声音衰减所需的时间长度。
设置 ：0–127

Initial Level (AEG Initial Level)
设置按下琴键那一刻的音量。
设置 ：0–127

Attack Level (AEG Attack Level)
设置按键后变化的音量。
设置 ：0–127
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Decay 1 Level (AEG Decay 1 Level)
设置要从 Attack Level (AEG Attack Level) 更改的下一个音量值。
设置 ：0–127

Decay 2 Level (AEG Decay 2 Level)
设置按住琴键时保持的音量。
设置 ：0–127

Center Key (AEG Time Key Follow Center Key)
设置 Time/Key (AEG Time Key Follow Sensitivity) 的参考键（音符）。
通过此处设置的音符（键），将播放 Time/Key (AEG Time Key Follow Sensitivity) 中设置的音高变化产生的最终声音。
设置 ：C–2–G8

Time/Key (AEG Time Key Follow Sensitivity)
设置 AEG 中音量变化的速度如何根据键位置而变化。
AEG 中的变化速度用于 Center Key (AEG Time Key Follow Center Key) 中的指定键。
设置 ：	 –64–+0–+63

正值：弹奏的琴键越低，AEG 音量变化越慢 ；弹奏的琴键越高，AEG 音量变化越快。
0:无论键位置如何，AEG 音量都不会变化
负值：弹奏的琴键越低，AEG 音量变化越快 ；弹奏的琴键越高，AEG 音量变化越慢。

Center Key 和 Time/key

(2)

(1)

(3)

High

Fast

Slow

+63

+30

−40

Low

Time

(6)

Time

(6)

Time

(6)

Time

(6)

(4)

(5)

Low key High key

(1) 键
(2) AEG 中音量变化的速度
(3) Center Key
(4) 当 Time/Key 为正数时
(5) 当 Time/Key 为负数时
(6) AEG 音量

Release Adj (AEG Time Key Follow Sensitivity Release Adjustment)
将 Time/Key (AEG Time Key Follow Sensitivity) 的灵敏度调整为 AEG Release。
值越低，灵敏度越低。
设置 ：	 0–127

127:Time/Key 与 Decay 1 和 Decay 2 相同
0:Time/Key 不会影响 AEG Release
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Time/Vel (AEG Time Velocity Sensitivity)
Segment (AEG Time Velocity Segment)
设置 AEG 中的音量根据力度或击键的强度发生变化所花的时间长度。
首先在 Segment 中设置时间值，然后在 Time/Vel 中设置力度灵敏度值。
设置 ：	 Time/Vel ：–64–+0–+63

正值：力度越快，AEG 音量变化越快。
0:无论力度设置如何，都不会变化。
负值：快速的力度值会导致 AEG 音量变化较慢，而较慢的力度值会导致 AEG 音量变化较快。

当值为正数时
快速的力度（音量变化快）		  慢速的力度（音量变化慢）

Time

(1)

Time

(1)

(1) 音量

设置 ：	 Segment ：Attack、Atk+Dcy、Decay、Atk+Rls、All
Attack ：Time/Vel 值会影响 Attack Time
Atk+Dcy ：Time/Vel 值会影响 Attack Time 和 Decay1Time
Decay ：Time/Vel 值会影响 Decay Time
Atk+Rls ：Time/Vel 值会影响 Attack Time 和 Release Time
All ：Time/Vel 值会影响 AEG 中与时间相关的设置

Half Damper (Half Damper Switch)
通过将此开关设置为打开，您可以将另售的踏板控制器 FC3A 连接到后面板上的 [SUSTAIN] 插孔，并使用半制音功能进行键
盘演奏。
半制音功能使您能够更好地控制声音衰减，让您像在原声钢琴上一样连续地使用制音踏板操作，而不仅仅是作为开关。
设置 ：Off、On

Time (Half Damper Time)
设置从完全按下踏板控制器 FC3A 时松开按键那一刻起，一直到 Half Damper (Half Damper Switch) 设置为 On 时声音衰
减为止的时间。当设置为 Off 时，不会显示此参数。
您可以通过更改踩下踏板的量，将衰减时间从 Half Damper Time 调整为 Release Time (AEG Release Time)。
松开踏板时，使用 Release Time (AEG Release Time) 来使声音衰减。通过将 Release Time 设置为较小的值，并将 Half 
Damper Time 设置为较大的值，您可以演奏自然衰减的声音，就像原声钢琴上的声音一样。
设置 ：0–127
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Scale
在 Scale 画面上，您可以设置音素的振幅缩放。
这会根据键盘上的键位置来改变音量。

操作
[PERFORMANCE (HOME)] → [EDIT/ ] → Part 选择 → Element 选择 → Amplitude → Scale

Break Point (Level Scaling Break Point) 1–4
设置 Level Offset (Level Scaling Offset) 1–4 的音符编号。
设置 ：C–2–G8

注
Break Point 1 至 4 的音符编号将自动按升序排列。

Level Offset (Level Scaling Offset) 1–4
设置在 Break Point (Level Scaling Break Point) 1–4 上增大或减小 Level 的值。
设置 ：–128–+0–+127
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Element EQ

在 Element EQ 画面上，您可以设置音素的均衡器。

操作
[PERFORMANCE (HOME)] → [EDIT/ ] → Part 选择 → Element 选择 → Element EQ

EQ Type (Element EQ Type)
选择所需的 EQ 类型。
设置 ：	 2-band、P.EQ、Boost6、Boost12、Boost18、Thru

2-band ：将 EQ 设置为坡形，增强或减弱高于或低于特定频率的信号频段 (Low Freq 或 High Freq))。
P.EQ ：参数 EQ，增强或减弱接近中心频率 (Freq) 的信号电平 (Gain))。
Boost6 ：将电平提高 6dB。
Boost12 ：将电平提高 12dB。
Boost18 ：将电平提高 18dB。
Thru ：传递信号而不应用任何效果器

	�当 EQ Type 设置为 2-band时

–

+

0

Gain

Low Gain High Gain

Low Freq High Freq

Frequency

EQ Low Gain (Element EQ Low Gain)
设置 Low 频段的信号电平。
设置 ：–12.00dB – +0.00dB – +12.00dB

EQ Low Freq (Element EQ Low Frequency)
设置 Low 频段的频率。
设置 ：50.1Hz–2.00kHz
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EQ Hi Gain (Element EQ High Gain)
设置 High 频段的信号电平。
设置 ：–12.00dB – +0.00dB – +12.00dB

EQ Hi Freq (Element EQ High Frequency)
设置 High 频段的频率。
设置 ：503.8Hz–10.1kHz

	�当 EQ Type 设置为 P.EQ时

–

+

0

Gain

Gain
Freq

Q

Frequency

EQ Gain (Element EQ Gain)
设置在 EQ Freq (Element EQ Frequency) 中设置的频率范围的信号电平。
设置 ：–12.00dB – +0.00dB – +12.00dB

EQ Freq (Element EQ Frequency)
设置要减弱或增强的频率。
设置 ：139.7Hz–12.9kHz

EQ Q (Element EQ Q)
通过增强或减弱 EQ Freq (Element EQ Frequency) 中设置的频率的信号电平，您可以创建各种频率响应曲线。
设置 ：0.7–10.3
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Element LFO

在 Element LFO 画面上，您可以设置音素的 LFO（低频振荡器）。
音素的 LFO（低频振荡器）生成低频段信号，您可以用它来调制音高、滤波器和振幅（循环变奏）。

操作
[PERFORMANCE (HOME)] → [EDIT/ ] → Part 选择 → Element 选择 → Element LFO

LFO Wave
选择 LFO 波形，通过使用您在此处选择的波形，您可以创建各种类型的调制。
设置 ：Saw、Triangle、Square

Saw （锯齿波） Triangle （三角形波） Square （方波）

Extended LFO
对于 Speed (LFO Speed)，在旧的 Speed (LFO Speed) 设置（关闭：0–63）和一组具有更高分辨率的新设置（打开：0–415）
之间切换。
要保持与使用旧设置创建的数据的兼容性，请将此参数设置为关闭。
设置 ：Off、On

Speed (LFO Speed)
设置 LFO Wave 变化的速度。此参数的值越大，速度越快。
设置 ：0–63（Extended LFO 设置为关闭）、0–415（Extended LFO 设置为打开）

Delay (LFO Delay Time)
设置从按下键盘上的琴键到 LFO 生效之间的延迟时间。
设置 ：0–127
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Fade In (LFO Fade In Time)
设置在松开琴键且经过 Delay (LFO Delay Time) 中设置的延迟时间后，LFO 效果器淡入的时间长度。该值越大，LFO 效果
器达到最大值所花的时间就越长。
设置 ：	 0–127

0:在没有任何淡入的情况下 LFO 变化为最大值。

当值较小时
Fade In

Maximum

Delay

Key On

Time

当值较大时
Fade In

Maximum

Delay

Key On

Time

Key On Reset (LFO Key On Reset)
按下琴键时使 LFO 的振荡复位。
设置 ：Off、On

Pitch Mod (LFO Pitch Modulation Depth)
此参数使用 LFO 波形创建颤音效果（音高的循环变化）。
将该参数设置为较大的值会导致音量发生较大的变化。
设置 ：0–127

Filter Mod (LFO Filter Modulation Depth)
此参数使用 LFO 波形来创建哇音效果（滤波器截止频率的循环变化）。
值越大，截止频率变化的范围就越大。
设置 ：0–127

Amp Mod (LFO Amplitude Modulation Depth)
此参数使用 LFO 波形来创建震音效果（音量的循环变化）。
将该参数设置为较大的值会导致音量发生较大的变化。
设置 ：0–127



268MODX M 使用说明书

Drum Part Edit (AWM2) Part Common Edit 画面
鼓声部 (AWM2) 由 73 个鼓键组成。
Drum Part Edit (AWM2) 包括 Part Common Edit（用于设置整个声部的参数）和 Key Edit（用于设置单个鼓键的参数）。

General/Pitch

Part Settings

操作
[PERFORMANCE (HOME)] → Part Common 选择 → [EDIT/ ] → General/Pitch → Part Settings

Main Category (Part Main Category)
Sub Category (Part Sub Category)
设置所选声部的主类别和子类别。
设置 ：请参阅 Data List

Part Name
您可以使用新名称保存正在编辑的声部，您可以使用最多 20 个字母数字字符。

Volume
显示所选声部的音量。
设置 ：0–127

Pan
调整所选声部的声相位置（在立体声场中）。
设置 ：L63–C（中央）–R63
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Dry Level
显示所选声部的干音音量级别。
仅当 Part Output (Part Output Select) 设置为 MainL&R 或 Drum 时，此参数才可用。
设置 ：0–127

Var Send (Variation Send)
设置所选声部的变奏发送。
仅当 Part Output (Part Output Select) 设置为 MainL&R 或 Drum 时，此参数才可用。
设置 ：0–127

Rev Send (Reverb Send)
显示所选声部的混响发送。
仅当 Part Output (Part Output Select) 设置为 MainL&R 或 Drum 时，此参数才可用。
设置 ：0–127

Part Output (Part Output Select)
设置所选声部的音频信号的输出目的地。
设置 ：	 MainL&R、(AsgnL&R)、USB Stereo、(AsgnL)、(AsgnR)、USB mono、Off、Drum

MainL&R：以立体声（两个通道）输出到 OUTPUT [L/MONO] 和 OUTPUT [R] 插孔。
USB Stereo ：以立体声（通道 1 和 2，至通道 7 和 8）输出到 USB [TO HOST] 端口。
USB mono ：以单声道（通道 1 至 8）输出至 USB [TO HOST] 端口。
Off：该声部没有音频信号输出。
Drum：您可以设置每个鼓键的输出。

注
与 MONTAGE M 设备数据兼容的相关设置如下所示。在设置时，这些设置视为 Off。
•	AsgnL&R
•	USB Stereo ：USB9&10 – USB29&30
•	USB mono ：USB9 – USB30
•	AsgnL
•	AsgnR

Arp Play Only (Arpeggio Play Only)
将声部设置为仅与琶音一起演奏。
任何设置为 On 的声部都将通过从琶音发送的音符打开信息来演奏。
设置 ：Off、On

Element Pan (Element Pan Switch)
从 Key Edit 将 Pan 设置为 On 或 Off。
当设置为 Off 时，Key Edit 中的声相将设置为 C（中央）。
设置 ：Off、On

Velocity Limit
设置声部的力度范围（最低值和最高值）。
设置 ：1–127

Note Limit
设置声部的音符范围（最低音符和最高音符）。
设置 ：C–2–G8
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Velocity Offset (Velocity Sensitivity Offset)
增大或减小发送至内部音源的力度值。
设置 ：0–127

当 Velocity Depth  = 64
且 Velocity Offset = 32 时

当 Velocity Depth = 64
且 Velocity Offset = 64 时

当 Velocity Depth = 64
且 Velocity Offset = 96 时

127

0 12764 12764

127

012764

127

0

(1)

(2)

(1)

(2)

(1)

(2)

127

0 12764 12764

127

012764

127

0

(1)

(2)

(1)

(2)

(1)

(2)

127

0 12764 12764

127

012764

127

0

(1)

(2)

(1)

(2)

(1)

(2)

(1) 实际产生的力度（影响音源）
(2) 演奏音符的力度

Velocity Depth (Velocity Sensitivity Depth)
设置如何根据力度或击键的强度来调整（发送到内部音源的）力度值。
设置 ：0–127

当 Velocity Depth = 64

 

127

0 12764

(1)
Depth = 127

Depth = 64

Depth = 32

Depth = 0
(2)

(1) 实际产生的力度（影响音源）
(2) 演奏音符的力度
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Zone Settings
与 Part Edit (AWM2) Part Common Edit 画面上的 General/Pitch → Zone Settings 相同。

Pitch
在 Pitch 画面上，您可以设置声部的音高。

操作
[PERFORMANCE (HOME)] → Part Common 选择 → [EDIT/ ] → General/Pitch → Pitch

Note Shift
以半音为单位调整音高。
设置 ：–48–+0–+48

Detune
以 0.1Hz 增量调整所选声部的音高。
通过稍微改变音高，您可以微调声音。
设置 ：–12.8Hz–+0.0Hz–+12.7Hz

Pitch Control Group
分配到同一组中的声部具有相同的音高。
但是，Portamento、Mono/Poly 和 Micro Tuning 不适用于鼓声部。

Pitch Bend (Pitch Bend Range Lower)
Pitch Bend (Pitch Bend Range Upper)
设置使用弯音轮创建的变化范围（以半音为单位）。
设置 ：–48–+0–+24
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Filter/Amp

Filter
与 Part Edit (AWM2) Part Common Edit 画面上的 Filter/Amp → Filter 相同。

Amp EG
与 Part Edit (AWM2) Part Common Edit 画面上的 Filter/Amp → Amp EG 相同。
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Effect

Routing
在 Routing 画面上，您可以设置声部的效果器路由。

操作
[PERFORMANCE (HOME)] → Part Common 选择 → [EDIT/ ] → Effect → Routing

此处的画面与从 Part Edit (AWM2) Part Common Edit 画面上的 Effect → Routing 打开的画面基本相同 ；但是，添加到
Drum Part Edit (AWM2) 的参数如下所示。

Drum Key (Drum Key Select)
显示所选鼓键的名称。
设置 ：C0–C6

Keyboard Select
打开或关闭键盘选择设置。
当此参数设置为打开时，您可以通过按键盘上的键来选择所需的鼓键进行编辑。
设置 ：Off、On

Connect (Drum Key Connection Switch)
设置要输出到插入效果器 A(InsA) 或插入效果器 B(InsB) 的键，或绕过插入效果器 (Thru)。
设置 ：Thru、InsA、InsB
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InsRev (Insertion to Reverb Send Level)
InsVar (Insertion to Variation Send Level)
设置从插入效果器 A 或插入效果器 B 发送到混响效果器或变奏效果器的鼓键信号的电平。
此设置应用于整个鼓声部（所有鼓键）。
仅当 Connect (Drum Key Connection Switch) 设置为 InsA 或 InsB，且 Part Output (Part Output Select) 设置为 MainL&R
或 Drum 时，此参数才可用。
设置 ：0–127

KeyRev (Drum Key Reverb Send Level)
KeyVar (Drum Key Variation Send Level)
设置通过插入效果器 A 或插入效果器 B 发送到混响效果器或变奏效果器的鼓键信号的电平。
可为每个鼓键设置此参数。
仅当 Connect (Drum Key Connection Switch) 设置为 Thru 且 Part Output (Part Output Select) 设置为 MainL&R，或当
Part Output 设置为 Drum 且 Drum Key Out 设置为 MainL&R 时，此参数才可用。
设置 ：0–127

Drum Key Out (Drum Key Output Select)
设置每个鼓键的输出目的地。
仅当 Part Output (Part Output Select) 设置为 Drum 时，才显示此参数。
设置 ：	 MainL&R、(AsgnL&R)、USB Stereo、(AsgnL)、(AsgnR)、USB mono

MainL&R：以立体声（两个通道）输出到 OUTPUT [L/MONO] 和 OUTPUT [R] 插孔。
USB Stereo ：以立体声（通道 1 和 2，至通道 7 和 8）输出到 USB [TO HOST] 端口。
USB mono ：以单声道（通道 1 至 8）输出至 USB [TO HOST] 端口

注
•	与 MONTAGE M 设备数据兼容的相关设置如下所示。在设置时，这些设置视为 Off。

•	AsgnL&R
•	USB Stereo ：USB9&10 – USB29&30
•	USB mono ：USB9 – USB30
•	AsgnL
•	AsgnR

•	Connect (Drum Key Connection Switch) 设置为 InsA/InsB，此参数固定为 MainL&R。
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Ins A、Ins B
在 Ins A 和 Ins B 画面上，您可以设置插入效果器。

操作
[PERFORMANCE (HOME)] → Part Common 选择 → [EDIT/ ] → Effect → Ins A
[PERFORMANCE (HOME)] → Part Common 选择 → [EDIT/ ] → Effect → Ins B

与 Common Edit 画面上的 Audio In → Ins A 和 Ins B 相同。

3-band EQ
与 Part Edit (AWM2) Part Common Edit 画面上的 Effect → 3-band EQ 相同。

2-band EQ
与 Part Edit (AWM2) Part Common Edit 画面上的 Effect → 2-band EQ 相同。

Ins Assign
与 Part Edit (AWM2) Part Common Edit 画面上的 Effect → Ins Assign 相同。
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Arpeggio

Common
与 Part Edit (AWM2) Part Common Edit 画面上的 Arpeggio → Common 相同。

Individual
与 Part Edit (AWM2) Part Common Edit 画面上的 Arpeggio → Individual 相同。

Advanced
这里的画面与从 Part Edit (AWM2) Part Common Edit 画面上的 Arpeggio → Advanced 打开的画面基本相同 ；但增加了如
下所示的参数。

Fixed SD/BD (Arpeggio Fixed SD/BD)
当此参数设置为打开时，琶音播放使用 C1 作为低音鼓，使用 D1 作为军鼓。
大多数打击乐器组都将低音鼓分配给 C1，将军鼓分配给 D1，但有些打击乐器组可能会分配不同的音符。因此，根据所选打
击乐器组和琶音类型的组合，声音可能听起来不自然。打开此参数可能会解决这种不自然的声音。
设置 ：Off、On
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Motion Seq

Common
与 Part Edit (AWM2) Part Common Edit 画面上的 Motion Seq → Common 相同。

Lane
与 Part Edit (AWM2) Part Common Edit 画面上的 Motion Seq → Lane 相同。
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Mod/Control

Control Assign
除了 Destination 设置之外，其他设置与 Control Assign 画面上的 Mod/Control → Part Edit (AWM2) Part Common Edit
相同。
有关 Destination 设置列表，请参见 Data List 上的 Control List。

Tx/Rx Switch
与 Part Edit (AWM2) Part Common Edit 画面上的 Mod/Control → Tx/Rx Switch 相同。

Control Settings
与 Part Edit (AWM2) Part Common Edit 画面上的 Mod/Control → Control Settings 相同。
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Drum Part Edit (AWM2) Key Edit 画面
鼓声部 (AWM2) 由 73 个鼓键组成。
Drum Part Edit (AWM2) 包括 Part Common Edit（用于设置整个声部的参数）和 Key Edit（用于设置单个鼓键的参数）。

Osc/Tune

在 Osc/Tune 画面上，您可以为鼓声部中的每个键设置振荡器。

操作
[PERFORMANCE (HOME)] → [EDIT/ ] → Part 选择 → Key 选择 → Osc/Tune

Drum Key Switch
设置要使用的选定鼓键。
设置 ：Off、On

Bank (Waveform Bank)
Number (Waveform Number)
Category (Waveform Category)
Sub Category (Waveform Sub Category)
Waveform Name
显示为鼓键选择的波形的名称。
Bank 指示分配给音素的波形类型（Preset、User 和 Library）。
设置 ：请参阅 Data List
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Assign Mode (Key Assign Mode)
设置当内置音源连续两次（或更多次）收到相同声音的音符打开信息时发出声音的方法。Multi 设置使滚奏听起来自然，尤
其是会使脆音铜钹或其他打击乐器具有较长的衰减。
设置 ：	 Single、Multi

Single ：停止第一个音符，然后再次播放相同的音符。
Multi ：在第一个音符上重叠演奏第二个音符

Connect (Drum Key Connection)
设置要输出到插入效果器 A(InsA) 或插入效果器 B(InsB) 的键，或绕过插入效果器 (Thru)。
此参数与 Drum Part Edit (AWM2) Part Common Edit 画面上的 Effect → Routing Connect (Drum Key Connection Switch)
相同。
设置 ：Thru、InsA、InsB

New Waveform
将保存在 USB 闪存上的音频文件加载为波形。
加载波形时会出现 Edit Waveform。

Edit Waveform
Waveform Edit 画面会打开。

Coarse (Coarse Tune)
改变分配给鼓键的波形的音高。
设置 ：–48–+0–+48

Fine (Fine Tune)
精细调整分配给鼓键的波形的音高。
设置 ：–64–+0–+63

Pitch/Vel (Pitch Velocity Sensitivity)
设置如何根据力度或击键的强度进行音高变化。
设置 ：	 –64–+0–63

正值：力度越快，音高越高
0:保持不变
负值：力度越快，音高越低

Rcv Note Off (Receive Note Off)
设置鼓键来接收 MIDI 音符关闭信息。对于打击乐器音色，将此项设置为 On 可使其持续而不衰减。
设置 ：	 Off、On

On：松开按键时声音停止
Off：松开按键后声音减弱

Group (Alternate Group)
此设置可帮助您防止一起演奏鼓键的不适当或不自然的组合。
例如，您可以将打开和关闭的踩镲分配到同一个组，这样就可以避免它们一起演奏。
对于可以通过任意组合自然演奏的鼓键，请将此参数设置为 Off。
设置 ：Off、1–127
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KeyRev (Drum Key Reverb Send Level)
KeyVar (Drum Key Variation Send Level)
设置通过插入效果器 A 或插入效果器 B 发送到混响效果器或变奏效果器的鼓键信号的电平。可为每个鼓键设置此参数。
根据 Connect (Drum Key Connection Switch)、Part Output (Part Output Select) 和 Drum Key Out (Drum Key Output 
Select) 设置，此参数可能不可用。
设置 ：0–127

Drum Key Out (Drum Key Output Select)
设置鼓键的输出目的地。
根据 Connect (Drum Key Connection Switch) 和 Part Output (Part Output Select) 设置，此参数可能不可用。
设置 ：	 MainL&R、(AsgnL&R)、USB Stereo、(AsgnL)、(AsgnR)、USB Mono

MainL&R：以立体声（两个通道）输出到 OUTPUT [L/MONO] 和 OUTPUT [R] 插孔。
USB Stereo ：以立体声（通道 1 和 2，至通道 7 和 8）输出到 USB [TO HOST] 端口。
USB Mono ：以单声道（通道 1 至 8）输出至 USB [TO HOST] 端口。

注
与 MONTAGE M 设备数据兼容的相关设置如下所示。在设置时，这些设置视为 Off。
•	AsgnL&R
•	USB Stereo ：USB9&10 – USB29&30
•	USB mono ：USB9 – USB30
•	AsgnL
•	AsgnR

Keyboard Select
打开或关闭键盘选择设置。
当此参数设置为打开时，您可以通过按键盘上的键来选择所需的鼓键进行编辑。
设置 ：Off、On
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Filter

设置鼓声部的滤波器。您可以通过在每个鼓键上使用低通滤波器和高通滤波器来更改音质。

操作
[PERFORMANCE (HOME)] → [EDIT/ ] → Part 选择 → Key 选择 → Filter 

Cutoff (LPF Cutoff Frequency)
设置低通滤波器的截止频率。
设置 ：0–1023

Cutoff/Vel (LPF Cutoff Velocity Sensitivity)
设置低通滤波器截止频率的力度灵敏度。
对于此参数的正值，弹奏琴键的力度越强（力度越高），截止频率就越高。
对于此参数的负值，弹奏琴键的力度越强，截止频率就越低。
设置 ：–64–+0–+63

Resonance (LPF Resonance)
设置低通滤波器上的共鸣效果水平。
设置 ：0–127

HPF Cutoff (HPF Cutoff Frequency)
设置高通滤波器的截止频率。
设置 ：0–1023
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Level/Pan

设置每个鼓键的电平和声像（立体声场中的位置）。

操作
[PERFORMANCE (HOME)] → [EDIT/ ] → Part 选择 → Key 选择 → Level/Pan

Attack Time (AEG Attack Time)
设置从按下键盘上的琴键到音量变化为达到 Level (Drum Key Level) 中设置的值所需的时间长度。
设置 ：0–127

Decay 1 Time (AEG Decay 1 Time)
设置音量从 Level (Drum Key Level) 变化到 Decay 1 Level (AEG Decay 1 Level) 所需的时间长度。
设置 ：0–127

Decay 2 Time (AEG Decay 2 Time)
设置音量在达到 Decay 1 Level (AEG Decay 1 Level) 中设置的音量后衰减所需的时间长度。
设置 ：0–126、Hold

Decay 1 Level (AEG Decay 1 Level)
设置要从 Level (Drum Key Level) 更改的下一个音量值。
设置 ：0–127

Level (Drum Key Level)
设置鼓键的输出电平。您可以使用此参数调整鼓键之间的电平平衡。
设置 ：	 0–127

当 Decay2 Time = 0–126 时	 当 Decay2 Time = hold 时

Time

Level Drum Key Level

Attack
Time

Decay 1
Time

Decay 2
Time

Decay 1 Level

Key on

Time

Level Drum Key Level

Attack
Time

Decay 1
Time

Decay 2
Time

Decay 1 Level

Key on
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Level/Vel (Level Velocity Sensitivity)
设置如何根据力度或击键的强度调整电平（音量）。
设置 ：	 –64– +0–+63

正值：力度越快，音量越大
0:无论力度设置如何，都不会变化。
负值：力度越慢，音量越大

Pan
设置鼓键的声相（声场中的位置）。您可以调整鼓声部（打击乐器组）在立体声场中的位置。
设置 ：L63–C（中央）–R63

Alternate Pan (Alternate Pan Depth)
为弹奏的每个键设置声音如何左右交替平移。
Pan 中设置的值是声相左右移动的中心位置。
设置 ：L63–C（中央）–R63

Random Pan (Random Pan Depth)
为弹奏的每个键设置声音如何左右随机平移。
Pan 中设置的值是立体声场中的中心位置。
设置 ：0–127
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Element EQ

与 Part Edit (AWM2) Element Edit 画面上的 Element EQ 相同。
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Part Edit (FM-X) Part Common Edit 画面
Normal Part (FM-X) 由八个操作器组成。
Part Edit (FM-X) 包括 Part Common Edit（用于设置整个声部的参数）和 Operator Edit（用于设置单个操作器的参数）。

General/Pitch

Part Settings
在 Part Settings 画面上，您可以设置声部的常规参数（例如声部名称和音源系统）。

操作
[PERFORMANCE (HOME)] → Part Common 选择 → [EDIT/ ] → General/Pitch → Part Settings

这里的画面与从 Part Edit (AWM2) Part Common Edit 画面上的 General/Pitch → Part Settings 打开的画面基本相同 ；但
增加了如下所示的参数。

Random Pan (Random Pan Depth)
为弹奏的每个键设置声音如何左右随机平移。
Pan 中设置的值是立体声场中的中心位置。
设置 ：0–127

Alternate Pan (Alternate Pan Depth)
为弹奏的每个键设置声音如何左右交替平移。
Pan 中设置的值是声相左右移动的中心位置。
设置 ：L63–C（中央）–R63

Scaling Pan (Scaling Pan Depth)
设置按键位置如何影响声像位置设置。音符编号 C3 是声相的参考点，此时的位置是在 Pan 中设置的值。
如果将此参数设置为正值，对于较低的键，Pan 设置到左侧，对于较高的键，Pan 设置到右侧。
当此参数设置为 0 时，Pan 设置不会发生变化。如果将此参数设置为负值，对于较低的键，Pan 设置到左侧，对于较高的
键，Pan 设置到右侧。
设置 ：–64–+0–+63
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KeyOnDly Sync (Key On Delay Tempo Sync)
设置 Key On Delay 的时间以与速度同步。
设置 ：Off、On

Delay Length (Key On Delay Time Length)
设置从按下琴键那一刻到发出声音的延迟时间。
当 KeyOnDly Sync 设置为 On 时，此参数不可用。
设置 ：0–127

Delay Length (Key On Delay Note Length)
当 KeyOnDly Sync (Key On Delay Tempo Sync) 设置为 On 时，此参数可用。您可以使用音符值来设置 Key On Delay 的 
时间。
设置 ：	� 1/16（十六分音符）、1/8 Tri.（八分音符三连音）、1/16 Dot.（附点十六分音符）、1/8（八分音符）、1/4 Tri.（四分

音符三连音）、1/8 Dot.（附点八分音符）、1/4（四分音符）、1/2 Tri.（二分音符三连音）、1/4 Dot.（附点四分音符）、
1/2（二分音符）、Whole Tri.（全音符三连音）、1/2 Dot.（附点二分音符）、1/4 × 4（四分音符四连音 ；四个四分
音符节拍）、1/4 × 5（四分音符五连音 ；五个四分音符节拍）、1/4 × 6（四分音符六连音 ；六个四分音符节拍）、 
1/4 × 7（四分音符七连音 ；七个四分音符节拍）、1/4 × 8（四分音符八连音 ；八个四分音符节拍）
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Zone Settings
与 Part Edit (AWM2) Part Common Edit 画面上的 General/Pitch → Zone Settings 相同。

FM-X Settings
在 FM-X Settings 画面上，您可以设置作为 FM-X 声音的便捷编辑工具提供的 FM Color 参数，还可以设置算法（或操作器
的排列方式）。

操作
[PERFORMANCE (HOME)] → Part Common 选择 → [EDIT/ ] → General/Pitch → FM-X Settings

FM Attack
控制 EG 的起音时间，从而随时间改变频率调制的深度。
设置 ：–99–+0–+99

FM Decay
控制 EG 的衰减时间，从而随时间改变频率调制的深度。
设置 ：–99–+0–+99

FM Sustain
控制 EG 的延音电平，从而随时间改变频率调制的深度。
设置 ：–99–+0–+99

FM Release
控制 EG 的释音时间，从而随时间改变频率调制的深度。
设置 ：–99–+0–+99

Algorithm (Algorithm Number)
更改算法。
设置 ：请参阅 Data List

Feedback (Feedback Level)
反馈使操作器通过发回一些输出信号来对自身进行调制。
通过此参数，您可以设置此类调制的程度。
设置 ：0–7
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FM Depth
更改频率调制的深度。
设置 ：–99–+0–+99

FM Harmonics
更改 FM 合成的谐波泛音的频率。
设置 ：–99–+0–+99

FM 质感
更改 FM 合成的质地。
设置 ：–99–+0–+99

Algorithm Search
打开 Algorithm Search 画面。

•	 Chain
根据串联操作器的最大长度来筛选可用的算法。

•	 Carrier
根据载波器数量来筛选可用的算法。

Filter Offset Cutoff (Filter Cutoff Frequency)
通过设置滤波器的截止频率来改变声音。选择低通滤波器时，此处的值越大，声音越明亮，值越小，声音越低沉。
此参数指定为滤波器截止频率的偏移值。
设置 ：–64–+0–+63

Filter Offset Resonance (Filter Offset Resonance/Width)
通过调整接近截止频率的信号电平来为声音增加特殊特性。
此值指定为滤波器共鸣的偏移值。
设置 ：–64–+0–+63

Filter Offset FEG Depth
设置 FEG 控制的截止频率变化的深度范围。
设置 ：–64–+0–+63

Filter Type
Filter Type 画面会打开。

Filter EG
Filter EG 画面会打开。
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Pitch
此处的画面与从 Part Edit (AWM2) Part Common Edit 画面上的 General/Pitch → Pitch 打开的画面相同，但禁用了 Legato 
Slope (Portamento Legato Slope)。

PEG/Scale
在 PEG/Scale 画面上，您可以设置声部的音高包络发生器和音阶。

操作
[PERFORMANCE (HOME)]  → Part Common 选择 → [EDIT/ ] → General/Pitch → PEG/Scale

Attack Time (PEG Attack Time)
设置从按下键盘上的琴键到音高变化为达到 Attack Level (PEG Attack Level) 中设置的值所需的时间长度。
设置 ：0–99

Decay1 Time (PEG Decay 1 Time)
设置音高从 Attack Level (PEG Attack Level) 变化到 Decay1 Level (PEG Decay 1 Level) 所需的时间长度。
设置 ：0–99

Decay2 Time (PEG Decay 2 Time)
设置音高从 Decay1 Level (PEG Decay 1 Level) 变化到 Decay2 Level (PEG Decay 2 Level) 所需的时间长度。
设置 ：0–99

Release Time (PEG Release Time)
设置从松开琴键变化至音高达到 Release Level (PEG Release Level) 所需的时间长度。
设置 ：0–99

Center Key (Pitch Key Follow Sensitivity Center Key)
设置 Pitch/Key (Pitch Key Follow Sensitivity) 的参考键。
设置 ：C–2–G8
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Pitch/Key (Pitch Key Follow Sensitivity)
设置两个相邻键之间的音高差异。在 Center Key (Pitch Key Follow Sensitivity Center Key) 中设置的音符用作参考。
设置 ：	 –200%–+0%–+200%

+100%（默认值）：相邻两个键之间的音高差异设置为半音
0%：两个键之间没有音高差异，所有键均按 Center Key (Pitch Key Follow Sensitivity Center Key) 中设置的音高 
演奏。
负值：设置相反的音高响应，使得较低的音符产生较高的音高，而较高的音符产生较低的音高。

Initial Level (PEG Initial Level)
设置按下琴键那一刻的音高。
设置 ：–50–+0–+50

Attack Level (PEG Attack Level)
设置在按下某个键后要从 Initial Level (PEG Initial Level) 更改的音高。
设置 ：–50–+0–+50

Decay1 Level (PEG Decay 1 Level)
设置要从 Attack Level (PEG Attack Level) 变化的下一个音高值。
设置 ：–50–+0–+50

Decay2 Level (PEG Decay 2 Level)
设置要从 Decay1 Level (PEG Decay 1 Level) 变化的下一个音高值。
设置 ：–50–+0–+50

Release Level (PEG Release Level)
设置松开琴键后要达到的最终音高。
设置 ：–50–+0–+50

PEG Depth
设置由 PEG 控制的音高变化量。
设置 ：8 oct、2 oct、1 oct、0.5 oct

注
当此参数设置为 8 oct 时，您可以通过将音高值 0 发送到内部音源来指定音高 EG 电平的最小值，以创建 –4 八度的音高变化，以及通过指
定最大值来创建 +4 八度的音高变化。

Depth/Vel (PEG Depth Velocity Sensitivity)
设置如何根据力度或击键的强度调整 PEG 音高变化的时间。
设置 ：0–7

Time/Key (PEG Time Key Follow Sensitivity)
设置 PEG 中音高变化的速度如何根据键位置而变化。
Center Key (Pitch Key Follow Sensitivity Center Key) ：PEG 中的速度变化用于指定键（固定为 C3）。
设置 ：	 0–7

正值：弹奏的琴键越低，PEG 中的变化越慢 ；弹奏的琴键越高，PEG 中的变化越快。
0:无论键位置如何，PEG 都不会变化

Random Pitch (Random Pitch Depth)
每次按下琴键时随机更改音素的音高。
设置 ：0–127

Pitch/Vel (Pitch Velocity Sensitivity)
设置如何根据力度或击键的强度调整音高。
设置 ：	 –64–+0–+63

正值：力度越快，音高越高
0:保持不变
负值：力度越快，音高越低
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Filter/Amp

Filter Type
与 Part Edit (AWM2) Element Edit 画面上的 Filter → Type 相同。

Filter EG
与 Part Edit (AWM2) Element Edit 画面上的 Filter → Filter EG 相同。

Filter Scale
与 Part Edit (AWM2) Element Edit 画面上的 Filter → Scale 相同。

Amp EG
与 Part Edit (AWM2) Part Common Edit 画面上的 Filter/Amp → Amp EG 相同。
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Effect

Routing
此处的画面与从 Part Edit (AWM2) Part Common Edit 画面上的 Effect → Routing 打开的画面几乎相同，唯一的不同是下
面列出的例外情况。
•	 没有针对每个 Element 的输出设置
•	 无法为 Ins Connect 选择 Parallel

Ins A、Ins B
与 Part Edit (AWM2) Part Common Edit 画面上的 Effect → InsA 和 InsB 相同。

3-band EQ
与 Part Edit (AWM2) Part Common Edit 画面上的 Effect → 3-band EQ 相同。

2-band EQ
与 Part Edit (AWM2) Part Common Edit 画面上的 Effect → 2-band EQ 相同。

Ins Assign
与 Part Edit (AWM2) Part Common Edit 画面上的 Effect → Ins Assign 相同。
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Arpeggio

Common
与 Part Edit (AWM2) Part Common Edit 画面上的 Arpeggio → Common 相同。

Individual
与 Part Edit (AWM2) Part Common Edit 画面上的 Arpeggio → Individual 相同。

Advanced
与 Part Edit (AWM2) Part Common Edit 画面上的 Arpeggio → Advanced 相同。
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Motion Seq

Common
与 Part Edit (AWM2) Part Common Edit 画面上的 Motion Seq → Common 相同。

Lane
与 Part Edit (AWM2) Part Common Edit 画面上的 Motion Seq → Lane 相同。
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Mod/Control

Control Assign

操作
[PERFORMANCE (HOME)] → Part Common 选择 → [EDIT/ ] → Mod/Control → Control Assign

除了 Destination 设置之外，其他设置与 Control Assign 画面上的 Mod/Control → Part Edit (AWM2) Part Common Edit
相同。
有关设置列表，请参见 Data List。
使用下面显示的参数，而不是使用 ElementSw 及其他参数。

Operator Sw 1–8 (Operator Switch)
您可以打开或关闭每个操作器的控制器设置。仅当所选 Destination 与操作器相关时才会显示此参数。
设置 ：Off、On

Sw/Rate
在 Operator Sw 视图和 Operator Rate 视图之间切换。
仅当 Destination 设置为 OP Freq 或 OP AEG Offset 时，才会显示此参数。
设置 ：Off、On

Operator Rate 1–8
设置为 Destination 选择的控制器的灵敏度。
仅当 Destination 设置为 OP Freq 或 OP AEG Offset 时，才会显示此参数。
设置 ：–7–+0–+7
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After Touch
除了 Destination 设置之外，其他设置与 After Touch 画面上的 Mod/Control → Part Edit (AWM2) Part Common Edit 
相同。

Tx/Rx Switch
与 Part Edit (AWM2) Part Common Edit 画面上的 Mod/Control → Tx/Rx Switch 相同。

Control Settings
与 Part Edit (AWM2) Part Common Edit 画面上的 Mod/Control → Control Settings 相同。

Part LFO
在 Part LFO 画面上，您可以设置声部 LFO。

操作
[PERFORMANCE (HOME)] → Part Common 选择 → [EDIT/ ] → Mod/Control → Part LFO

LFO Wave
选择 LFO 波形并设置 LFO 的循环变化类型。
设置 ：Triangle、Triangle+、Saw Up、Saw Down、Squ1/4、Squ1/3、Square、Squ2/3、Squ3/4、Trapezoid、S/H1、

S/H2、User

Edit User LFO
User LFO Edit 画面会打开。
您可以创建拥有最多 16 个步级的 LFO 波形。
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Tempo Sync (LFO Tempo Sync)
设置 LFO Wave 设置变化同步到琶音或乐曲播放的速度。
设置 ：Off（不同步）、On（同步）

•	当设置为Off时

Speed (LFO Speed)
设置 LFO Wave 变化的速度。
当 Tempo Sync (LFO Tempo Sync) 设置为 On 时，此参数不可用。
设置 ：0–63

Random Speed (Part LFO Random Speed Depth)
随机更改 LFO Speed。
当 Tempo Sync (LFO Tempo Sync) 设置为 On 时，此参数不可用。
设置 ：0–127

•	当设置为On时

Tempo Speed (LFO Tempo Speed)
您可以使用音符值设置 LFO Wave 变化的速度。
设置 ：	 �1/16（十六分音符）、1/8 Tri.（八分音符三连音）、1/16 Dot.（附点十六分音符）、1/8（八分音符）、1/4 Tri.（四分

音符三连音）、1/8 Dot.（附点八分音符）、1/4（四分音符）、1/2 Tri.（二分音符三连音）、1/4 Dot.（附点四分音符）、
1/2（二分音符）、Whole Tri.（全音符三连音）、1/2 Dot.（附点二分音符）、1/4 × 4（四分音符四连音；四个四分音
符节拍）、1/4 × 5（四分音符五连音 ；五个四分音符节拍）、1/4 × 6（四分音符六连音 ；六个四分音符节拍）、1/4 
× 7（四分音符七连音 ；七个四分音符节拍）、1/4 × 8（四分音符八连音 ；八个四分音符节拍）、1/4 × 16（十六个
四分音符节拍）、1/4 × 32（三十二个四分音符节拍）、1/4 × 64（六十四个四分音符节拍）

Delay (LFO Delay Time)
设置从按下键盘上的琴键到 LFO 生效之间的延迟时间。
该值越大，LFO 生效的延迟时间就越长。
设置 ：0–127

Fade In (LFO Fade In Time)
设置在松开琴键且经过 Delay (LFO Delay Time) 中设置的延迟时间后，LFO 效果器淡入的时间长度。该值越大，LFO 效果
器达到最大值所花的时间就越长。
设置 ：	 0–127

0:在没有任何淡入的情况下 LFO 变化为最大值。

当值较小时
Fade In

Maximum

Delay

Key On

Time

当值较大时
Fade In

Maximum

Delay

Key On

Time
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Hold (LFO Hold Time)
设置达到最大电平后保持 LFO 效果器的时间。
设置 ：	 0–126、Hold

Hold ：不淡出

Hold
Maximum

Key On

Time

Fade Out (LFO Fade Out time)
设置在经过 Hold (LFO Hold Time) 中设置的保持时间后 LFO 效果器淡出的时间量。该值越大，LFO 效果器淡出所花的时间
就越长。
设置 ：	 0–127

当值较小时
Fade-Out

Maximum
Hold

Key On

Time

当值较大时
Fade-Out

Maximum
Hold

Key On

Time
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Key On Reset (LFO Key On Reset)
按下琴键时使 LFO 的振荡复位。
设置 ：	 Off、Each-on、1st-on

当设置为Off时
不复位 LFO 的振荡。无论 LFO 当时处于哪个相位，按下琴键都会启动 LFO 波形。

Key On

Time

当设置为 Each-on 时
每次按下按键时都会复位 LFO 的振荡，并以 Phase 参数指定的相位启动波形。

Key On
(first note)

Key On
(second note)

Time

当设置为 1st-on 时
每次按下按键时都会复位 LFO 的振荡，并以 Phase 参数指定的相位启动波形。
如果在保持第一个音符时演奏第二个音符，则播放不会复位。

Key On
(first note)

Key On
(second note)

Time

Loop (LFO Loop Switch)
将 LFO Wave 设置为循环（重复）播放或单次播放。
设置 ：Off、On

Phase (LFO Phase)
您可以设置复位 LFO Wave 时的初始相位。
设置 ：0° , 90° , 120° , 180° , 240° , 270°

Phase

Time

Level

0° 90°
120° 240°

180° 270°

Destination (LFO Destination)
设置由 LFO Wave 控制的功能。
设置 ：Insertion Effect A Parameter1–24、Insertion Effect B Parameter1–24（取决于插入效果器）

Depth (LFO Depth)
设置每个 Destination 的 LFO Wave 控制的深度。
设置 ：0–127
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2nd LFO

操作
[PERFORMANCE (HOME)] → Part Common 选择 → [EDIT/ ] → Mod/Control → 2nd LFO

LFO Wave (2nd LFO Wave)
选择 2nd LFO。
设置 ：Triangle、Saw Down、Saw Up、Square、Sine、S/H

注
对于 Sine，Amplitude Modulation 相位会偏移。

Extended LFO (2nd LFO Extended LFO)
对于 Speed (LFO Speed)，在旧的 Speed (2nd LFO Speed) 设置（关闭 ：0–99）和一组具有更高分辨率的新设置（打开 ：
0–415）之间切换。
要保持与使用旧设置创建的数据的兼容性，请将此参数设置为关闭。
设置 ：Off、On

Speed (2nd LFO Speed)
设置 LFO Wave (2nd LFO Wave) 变化的速度。
设置 ：0–99（当 Extended LFO 设置为 Off 时）、0–415（当 Extended LFO 设置为 On 时）

Phase (2nd LFO Phase)
您可以设置复位 LFO Wave (2nd LFO Wave) 时的初始相位。
设置 ：0° , 90° , 180° , 270°

Delay (2nd LFO Delay Time)
设置在松开琴键且经过 Delay 中设置的延迟时间后，2nd LFO 效果器淡入的时间长度。
设置 ：0–99

Key On Reset (2nd LFO Key On Reset)
按下琴键时使 2nd LFO 的振荡复位。
设置 ：Off、On
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Pitch Modulation Depth (2nd LFO Pitch Modulation Depth)
此参数通过使用 LFO Wave (2nd LFO Wave) 创建颤音效果（音高的循环变化），并让您可以指定 LFO 的滤波器调制深度。
设置 ：0–99

Pitch Modulation Operator Depth Ratio 1~8 (2nd LFO Pitch Modulation Depth Offset)
通过 Pitch Modulation Depth (2nd LFO Pitch Modulation Depth) 中设置的 LFO 信号来设置调制深度。
设置 ：0–7

Amplitude Modulation Depth (2nd LFO Amplitude Modulation Depth)
此参数通过使用 LFO Wave (2nd LFO Wave) 创建音量的循环变化，并让您可以指定 LFO 的滤波器调制深度。
设置 ：0–99

Amplitude Modulation Operator Depth Ratio 1~8 (2nd LFO Amplitude Modulation Depth Offset)
通过 Amplitude Modulation Depth (2nd LFO Amplitude Modulation Depth) 中设置的 LFO 信号来设置调制深度。
设置 ：0–7

Filter Modulation Depth (2nd LFO Filter Modulation Depth)
此参数通过使用 LFO Wave (2nd LFO Wave) 创建滤波器截止频率的循环变化，并让您可以指定 LFO 的滤波器调制深度。
设置 ：0–99
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Part Edit (FM-X) Operator Edit 画面
Normal Part (FM-X) 由八个操作器组成。
Part Edit (FM-X) 包括 Part Common Edit（用于设置整个声部的参数）和 Operator Edit（用于设置单个操作器的参数）。

Form/Freq

在 Form/Freq 画面上，您可以设置操作器的波形和频率。

操作
[PERFORMANCE (HOME)] → [EDIT/ ] → Part 选择 → Operator 选择 → Form/Freq

Attack Time (PEG Attack Time)
设置从按下键盘上的琴键到音高变化为达到 Attack Level (PEG Attack Level) 中设置的值所需的时间长度。
设置 ：0–99

Decay Time (PEG Decay Time)
设置音高从 Attack Level (PEG Attack Level) 中设置的值变化到 PEG 值为 0 时所需的时间长度。
设置 ：0–99

Initial Level (PEG Initial Level)
设置按下琴键那一刻的音高。
设置 ：–50–+0–+50
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Attack Level (PEG Attack Level)
设置在按下某个键后要从 Initial Level (PEG Initial Level) 更改的音高。
设置 ：–50–+0–+50

Time

Level
+50

−50

Attack
Time

Decay
Time

Attack Level

Initial Level

Spectral (Spectral Form)
设置所选操作器的波形。
设置 ：	 Sine、All 1、All 2、Odd 1、Odd 2、Res 1、Res 2

Sine ：没有谐波泛音的正弦波
All 1 ：具有宽 Spectral 范围内谐波泛音的波形
All 2 ：具有窄 Spectral 范围内谐波泛音的波形
Odd 1 ：包含宽 Spectral 范围内奇次谐波的波形
Odd 2 ：包含窄 Spectral 范围内奇次谐波的波形
Res 1 ：在宽 Spectral 范围内具有特定谐波峰值的波形
Res 2 ：在窄 Spectral 范围内具有特定谐波峰值的波形

Skirt (Spectral Skirt)
设置过渡带（频谱裙）的宽度。该值越小，频谱裙变得越窄，从而可增强特定的泛音。
当 Spectral (Spectral Form) 设置为 Sine 时，此参数不可用。
设置 ：0–7
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Resonance (Spectral Resonance)
设置 Spectral 中共鸣效应的灵敏度。
中心频率将转移到高阶谐波，因此您可以创建共鸣效果或为声音添加特殊特性。
仅当 Spectral (Spectral Form) 设置为 Res 1 或 Res 2 时，此参数才可用。
设置 ：0–99

Sine 是一种简单的波形，仅包含基波，不含谐波，而其他波形则包含谐波泛音。因此，当您将波形设置为 Sine 之外的其他
波形时，与谐波及其“峰值”（共振峰）相关的参数将可用。
下面是 Spectral 中说明的用于控制每个波形的一些具体参数。

Level

Level

Level

Level

Skirt Skirt

Skirt Skirt

Center Frequency
(F.Coarse & Freq Fine)

Center Frequency
(F.Coarse & Freq Fine)

Center Frequency
(F.Coarse & Freq Fine)

Center Frequency
(F.Coarse & Freq Fine)

Frequency
(Hz)

Frequency
(Hz)

Frequency
(Hz)

Frequency
(Hz)

您可以通过设置较大的 Skirt 值来增加谐波泛音数量，从而扩大频谱范围。

Level Level

Skirt

Resonance of
Center Frequency

Resonance of
Center Frequency

Skirt

Center Frequency
(F.Coarse & Freq Fine)

Center Frequency
(F.Coarse & Freq Fine)

Frequency (Hz) Frequency (Hz)

设置较大的 Resonance 值会将中心频率移至高阶谐波。
Resonance 设置为 0 ：移至一次谐波。

Resonance 设置为 99 ：移至 100 次谐波。
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Key On Reset (Oscillator Key On Reset)
按下琴键时使振荡器的振荡复位。
设置 ：	 Off、On

Off：如果您弹奏琴键而不重置振荡器，则无论当时处于哪个相位，信号波形都会启动

Pitch/Vel (Pitch Velocity Sensitivity)
设置如何根据力度或击键的强度调整音高。
仅当 Freq Mode (Oscillator Frequency Mode) 设置为 Fixed 时，此参数才可用。
设置 ：	 –7–+0–+7

正值：力度越快，音高越高
0 ：保持不变
负值：力度越快，音高越低

Freq Mode (Oscillator Frequency Mode)
设置操作器的输出音高。
设置 ：	 Ratio、Fixed

Ratio ：根据琴键设置输出音高
Fixed ：无论所按下按键的音高如何，都将音高设置为 Coarse 或 Fine 设置

Coarse (Coarse Tune)
调整每个操作器的输出音高。
设置 ：当 Freq Mode 设置为 Ratio 时 ：0–31，当 Freq Mode 设置为 Fixed 时 ：0–21

Fine (Fine Tune)
精细调整每个操作器的输出音高。
设置 ：当 Freq Mode 设置为 Ratio 时 ：0–99，当 Freq Mode 设置为 Fixed 时 ：0–127

Detune
将每个操作器的输出音高设置为略高或略低。
当为 Coarse (Coarse Tune) 或 Fine (Fine Tune) 设置相同的值时，具有 Detune 设置的操作器会有轻微的音高差异。因此，
您可以创建更温暖的声音或合唱效果。
设置 ：–15–+0–+15

Pitch/Key (Pitch Key Follow Sensitivity)
设置两个相邻键之间的音高差异。仅当 Freq Mode (Oscillator Frequency Mode) 设置为 Fixed 时，此参数才可用。
设置 ：	 0–99

0:两个相邻键之间没有音高差异，且所有键均按 Coarse 或 Fine 中设置的音高演奏
99:相邻两个键之间的音高差异设置为半音
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Level

在 Level 画面上，您可以设置操作器的常规参数。

操作
[PERFORMANCE (HOME)] → [EDIT/ ] → Part 选择 → Operator 选择 → Level

Hold Time (AEG Hold Time)
设置从按下键盘上的琴键到值变化为达到 Rel (Hold) Level (AEG Release (Hold) Level) 值时所需的时间长度。
设置 ：0–99

Attack Time (AEG Attack Time)
设置从按下键盘上的琴键到值变化为达到 Attack Level (AEG Attack Level) 值时所需的时间长度。
设置 ：0–99

Decay 1 Time (AEG Decay 1 Time)
设置值从 Attack Level (AEG Attack Level) 变化到 Decay 1 Level (AEG Decay 1 Level) 所需的时间长度。
设置 ：0–99

Decay 2 Time (AEG Decay 2 Time)
设置值从 Decay 1 Level (AEG Decay 1 Level) 变化到 Decay 2 Level (AEG Decay 2 Level) 所需的时间长度。
设置 ：0–99

Release Time (AEG Release Time)
设置从松开琴键到值变化为达到 Rel (Hold) Level (AEG Release (Hold) Level) 值时所需的时间长度。
设置 ：0–99

Attack Level (AEG Attack Level)
设置按键后要更改的值。
设置 ：0–99
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Decay 1 Level (AEG Decay 1 Level)
设置要从 Attack Level (AEG Attack Level) 更改的下一个值。
设置 ：0–99

Decay 2 Level (AEG Decay 2 Level)
设置按住琴键时保持的值。
设置 ：0–99

Rel (Hold) Level (AEG Release (Hold) Level)
设置松开琴键后要达到的最终值。
设置 ：0–99

Level

Hold
Time

Attack
Time

Decay 1
Time

Decay 2
Time

Release
Time

Time

Rel (Hold)
Level

Rel (Hold)
Level

Decay 1 Level

Decay 2 Level

Key On Key Off

Attack Level

Level (Operator Level)
设置操作器的输出电平。
设置 ：0–99

Level/Vel (Level Velocity Sensitivity)
设置如何根据力度或击键的强度调整电平。
设置 ：	 –7–+0–+7

正值：力度越快，音量越大
0:无论力度设置如何，都不会变化。
负值：力度越慢，音量越大

Time/Key (AEG Time Key Follow Sensitivity)
设置 AEG 中电平变化的速度如何根据键位置而变化。
设置 ：	 0–7

正值：弹奏的琴键越低，AEG 音量变化越慢 ；弹奏的琴键越高，AEG 音量变化越快。
0:无论键位置如何，AEG 音量都不会变化

Break Point (Level Scaling Break Point)
设置振幅缩放分割点的音符编号。
设置 ：A–1–C8

Lvl/Key Lo (Level Scaling Low Depth)
Lvl/Key Hi (Level Scaling High Depth)
设置变化曲线的陡度。
设置 ：0–99
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Curve Lo (Level Scaling Low Curve)
Curve Hi (Level Scaling High Curve)
设置振幅缩放的变化曲线。
设置 ：–Linear、–Exp、+Exp、+Linear

键盘在 Break Point 处一分为二。为左侧的曲线陡度设置 Curve Lo，为右侧的曲线陡度设置 Lvl/Key Lo。同样，设置 Curve 
Hi 来选择右侧的曲线，并设置 Lvl/Key Hi 来选择曲线的陡度。

Low Depth

Break Point Output Level

Low Curve High Curve

Key
High Depth

Output Level

−

+

+exp +exp+linear +linear

−exp −exp−linear −linear

Break Point 处的按键与 Level (Operator Level) 中设置的输出电平相同。
使用 Break Point 左侧的按键，将输出电平校正为 Curve Lo 和 Lvl/Key Lo 中设置的曲线。使用 Break Point 右侧的按键，
将输出电平校正为 Curve Hi 和 Lvl/Key Hi 中设置的曲线。
Exp 曲线的输出电平呈指数变化，而 Linear 曲线的输出电平呈线性变化。无论哪种情况，距离 Break Point 越远，输出电
平的变化就越大。



310MODX M 使用说明书

Part Edit (AN-X) Part Common Edit 画面
Normal Part (AN-X) 由三个振荡器和噪声组成。
Part Edit (AN-X) 包括 Part Common Edit（用于设置整个声部的参数）、Oscillator Edit（用于设置每个振荡器的参数）和
Noise Edit（用于编辑噪声）。

General/Pitch

Part Settings
与 Part Edit (AWM2) Part Common Edit 画面上的 General/Pitch → Part Settings 相同。

Zone Settings
与 Part Edit (AWM2) Part Common Edit 画面上的 General/Pitch → Zone Settings 相同。

AN-X Settings
在 AN-X Settings 画面上，您可以设置特定于 AN-X 声音引擎的参数。

操作
[PERFORMANCE (HOME)] → Part Common 选择 → [EDIT/ ] → General/Pitch → AN-X Settings

Unison
通过叠加多个声音来创造厚度。
设置 ：Off、2、4

Unison Detune
设置如何改变叠加声音的音高。
设置 ：0–15

Unison Spread
设置叠加声音在立体声场中的传播方式。
设置 ：0–15
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OSC Reset
指定如何复位振荡器。
设置 ：	 Off、Phase、Tune、Full

Off：不复位。
Phase ：在触键时复位 OSC 1–3 的相位。
Tune ：使 OSC 1-3 的音高一致。
Full ：同时启用 Phase 和 Tune

Amplitude

Osc 1

Osc 2

Osc 3

Key On

OSC Reset = Off or Tune

OSC Reset = Off or Phase

Amplitude

Osc 1

Osc 2

Osc 3

Key On

OSC Reset = Phase or Full

OSC Reset = Tune or Full

Osc 1

Osc 3

Osc 2

Pitch

t

Osc 1, 2, 3
Pitch

t

Voltage Drift
指定振荡器的音高和 Filter Cutoff 的变化。这些变化也受 Ageing 影响。
设置 ：	 0–127

0:无变化
64: Standard
127:最大变化

Ageing
根据乐器模型的虚拟年龄来调整频率响应以及 OSC Pitch、Filter Cutoff 和 EG Time。
设置 ：–100（旧）– +100（新）

	� Voltage Drift 和 Ageing
(1)

210 43 64 85 107 128
Voltage Drift

Ageing = −100 (Retro)

Ageing = 0 (Default)

Ageing = 100 (Modern)

(1) Cutoff 或 Pitch 中的变化
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Filter Offset Cutoff (Filter Cutoff Frequency)
通过设置滤波器的截止频率来改变声音。选择低通滤波器时，此处的值越大，声音越明亮，值越小，声音越低沉。
此参数指定为滤波器截止频率的偏移值。
设置 ：–64–+0–+63

Filter Offset Resonance (Filter Offset Resonance/Width)
通过调整接近截止频率的信号电平来为声音增加特殊特性。
此值指定为滤波器共鸣的偏移值。
设置 ：–64–+0–+63

Filter Offset FEG Depth
设置 FEG 控制的截止频率变化的深度范围。
设置 ：–64–+0–+63

Filter Type
Filter Type 画面会打开。

Filter EG
Filter EG 画面会打开。

AEG Offset Attack (AEG Attack Time)
设置从按下键盘上的某个键到达到最大音量所需的时间长度。
设置 Attack (Amplitude EG Attack Time) 的偏移值。
设置 ：–64–+0–+63

AEG Offset Decay (AEG Decay Time)
设置音量达到最大值后发生变化所需的时间长度。
设置 Decay (Amplitude EG Decay Time) 的偏移值。
设置 ：–64–+0–+63

AEG Offset Sustain (AEG Sustain Level)
设置衰减时间后保持的音量。
设置 Sustain (Amplitude EG Sustain Level) 的偏移值。
设置 ：–64–+0–+63

AEG Offset Release (AEG Release Time)
设置释放琴键后声音衰减所需的时间长度。
设置 Release (Amplitude EG Release Time) 的偏移值。
设置 ：–64–+0–+63

Amp EG
Amp EG 画面会打开。
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Pitch
此处的画面与从 Part Edit (AWM2) Part Common Edit 画面上的 General/Pitch → Pitch 打开的画面相同，但禁用了 Legato 
Slope (Portamento Legato Slope)。

Pitch EG
在 Pitch EG 画面中，您可以设置音高包络发生器。
您可以使用它来设置声音如何随时间变化，从按下键盘上的按键开始，一直到声音衰减。

操作
[PERFORMANCE (HOME)] → Part Common 选择 → [EDIT/ ] → General/Pitch → Pitch EG

Attack (Pitch EG Attack Time)
设置从按下键盘上的某个键到 EG 达到最大值所需的时间长度。
设置 ：0–255

Decay (Pitch EG Decay Time)
设置 EG 从最大电平变化到 Sustain (Pitch EG Sustain Level) 所需的时间长度。
设置 ：0–255

Sustain (Pitch EG Sustain Level)
设置延音电平。
设置 ：0–511

Release (Pitch EG Release Time)
设置松开琴键后 EG 达到 0 值所需的时间长度。
设置 ：0–255

Time/Vel (Pitch EG Time Velocity Sensitivity)
设置力度如何随时间改变 EG。
该值越大，当以较快的力度弹奏琴键时，EG 随时间变化的速度越快。
设置 ：–255–+0–+255
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PEG Depth - Osc 1–3 (Oscillator 1–3 Pitch EG Depth)
设置 EG 的最大音高变化量（以 cent 为单位）。深度距离值 0 越远，音高变化就越大。
设置 ：	 –4800 cent – +0 – +4800 cent

0:保持不变
负值：音高变化反转。

PEG Depth/Vel - Osc 1–3 (Oscillator 1–3 Pitch EG Depth Velocity Sensitivity)
设置 PEG 如何根据力度或击键的强度控制音高变化的深度范围。
设置 ：	 –255–+0–+255

正值：较快的力度值会拓宽 PEG 控制的音高变化的深度范围，而较慢的值会缩窄深度范围
0:无论力度设置如何，PEG 都不会变化。
负值：较快的力度值会缩窄 PEG 控制的音高变化的深度范围，而较慢的值会拓宽深度范围

当值为正数时
快速的力度（音高变化的深度范围更广）	 慢速的力度（音高变化的深度范围更窄）

Time

(1)

Time

(1)

(1) 音高深度
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Pitch LFO
在 Pitch LFO 画面上，您可以设置音高 LFO。

操作
[PERFORMANCE (HOME)] → Part Common 选择 → [EDIT/ ] → General/Pitch → Pitch LFO

Wave (Pitch LFO Wave)
选择 LFO 波形并设置 LFO 的循环变化类型。
设置 ：Saw、Square、Triangle、Sine、Random

Key On Reset (Pitch LFO Key On Reset)
按下琴键时使 LFO 的相位复位。
设置 ：Off、On

Time

Key on

Time

Key on

OnOff

Speed (Pitch LFO Speed)
设置 LFO Wave 变化的速度。
设置 ：0–415

Delay (Pitch LFO Decay Time)
设置从按下键盘上的琴键到 LFO 生效之间的延迟时间。
设置 ：0–127
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Fade In (Pitch LFO Fade In Time)
设置在松开琴键且经过 Delay 中设置的延迟时间后，LFO 效果器淡入的时间长度。该值越大，LFO 效果器达到最大值所花
的时间就越长。
设置 ：	 0–214

0:在没有任何淡入的情况下 LFO 变化为最大值。

当值较小时
Fade In

Maximum

Delay

Key On

Time

当值较大时
Fade In

Maximum

Delay

Key On

Time

Phase (Pitch LFO Phase)
设置按下按键时复位波形的相位。
设置 ：	 0, 30, 45, 60, 90, 120, 135, 150, 180, 210, 225, 240, 270, 300, 315, 330(° )

波形的相位

Phase

Time

Level

0° 90°
120° 240°

180° 270°

Pitch LFO Depth - Osc 1–3 (Oscillator 1–3 Pitch LFO Depth)
设置由 LFO 控制的音高变化的深度范围。深度距离值 0 越远，音高变化就越大。
设置 ：	 –4800 cent – +0 – +4800 cent

0:保持不变
负值：音高变化反转。
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Modifier

Modifier 是用于为 OSC 模块输出的信号添加失真以及为声音添加泛音的功能块。

Amp Effects

Motion Sequencer
Envelope Follower

Pitch EG
Pitch LFO

OSC EG
OSC LFO

Modifier EG
Modifier LFO

Filter EG
Filter LFO

Amp EG
Amp LFO Part LFO

Oscillators Modifier Filters
Output

Wave Folder
Wave Folder 是根据指定值对波形进行折叠处理而产生的效果。通过此效果，您可以实现从轻微失真到极端失真的平滑变
化。使用 AN-X 声音引擎，您可以独立地对每个音符使用此效果。
可以使用各种控制器（包括 EG、LFO、力度和复音触后力度）来实时控制此效果。

操作
[PERFORMANCE (HOME)] → Part Common 选择 → [EDIT/ ] → Modifier → Wave Folder
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Wave Folder (Modifier Wave Folder)
指定波形折叠的程度。
设置 ：0–255

Folder/Vel (Modifier Wave Folder Velocity Sensitivity)
设置 Wave Folder 如何根据力度而变化。
设置 ：–255–+0–+255

Texture (Modifier Wave Folder Texture)
更改 Wave Folder 的质感。
设置 ：0–255

Folder Type (Modifier Wave Folder Type)
更改 Wave Folder 类型。
设置 ：Soft、Hard

Modifier EG Settings
Modifier EG 画面会打开。

Modifier LFO Settings
Modifier LFO 画面会打开。
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Modifier EG
在 Modifier EG 画面中，您可以设置 Modifier 的包络发生器。

操作
[PERFORMANCE (HOME)] → Part Common 选择 → [EDIT/ ] → Modifier → Modifier EG

Attack (Modifier EG Attack Time)
设置从按下键盘上的某个键到 EG 达到最大值所需的时间长度。
设置 ：0–255

Decay (Modifier EG Decay Time)
设置 EG 从最大电平变化到 Sustain (Modifier EG Sustain Level) 所需的时间长度。
设置 ：0–255

Sustain (Modifier EG Sustain Level)
设置延音电平。
设置 ：0–511

Release (Modifier EG Release Time)
设置松开琴键后 EG 达到 0 值所需的时间长度。
设置 ：0–255

Time/Vel (Modifier EG Velocity Sensitivity)
设置力度如何随时间改变 EG。
该值越大，当以较快的力度弹奏琴键时，EG 随时间变化的速度越快。
设置 ：–255–+0–+255

EG Depth (Modifier Wave Folder EG Depth)
设置 Wave Folder 如何根据 Modifier EG 而变化。
设置 ：–127–+0–+127
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Modifier LFO
在 Modifier LFO 画面上，您可以设置 Modifier LFO。

操作
[PERFORMANCE (HOME)] → Part Common 选择 → [EDIT/ ] → Modifier → Modifier LFO

Wave (Modifier LFO Wave)
选择 LFO 波形并设置 LFO 的循环变化类型。
设置 ：Saw、Square、Triangle、Sine、Random

Key On Reset (Modifier LFO Key On Reset)
按下琴键时使 LFO 的相位复位。
设置 ：Off、On

Time

Key on

Time

Key on

OnOff

Speed (Modifier LFO Speed)
设置 LFO Wave 变化的速度。
设置 ：0–415

Delay (Modifier LFO Decay Time)
设置从按下键盘上的琴键到 LFO 生效之间的延迟时间。
设置 ：0–127
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Fade In (Modifier LFO Fade In Time)
设置在松开琴键且经过 Delay 中设置的延迟时间后，LFO 效果器淡入的时间长度。该值越大，LFO 效果器达到最大值所花
的时间就越长。
设置 ：	 0–214

0:在没有任何淡入的情况下 LFO 变化为最大值。

当值较小时
Fade In

Maximum

Delay

Key On

Time

当值较大时
Fade In

Maximum

Delay

Key On

Time

Phase (Modifier LFO Phase)
设置按下按键时复位波形的相位。
设置 ：	 0, 30, 45, 60, 90, 120, 135, 150, 180, 210, 225, 240, 270, 300, 315, 330(° )

波形的相位

Phase

Time

Level

0° 90°
120° 240°

180° 270°

LFO Depth (Modifier Wave Folder LFO Depth) 
设置 Wave Folder 如何根据 Modifier LFO 而变化。深度距离值 0 越远，音高变化就越大。
设置 ：	 –127–+0–+127

0:保持不变
负值：音高变化反转。
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Filter/Amp

Mixing
在 Mixing 画面上，您可以在检查 AN-X 声部的信号流程图的同时设置每个振荡器的输出。

操作
[PERFORMANCE (HOME)] → Part Common 选择 → [EDIT/ ] → Filter/Amp → Mixing

FM 3 → 1 (Oscillator 1 FM Level)
FM 3 → 2 (Oscillator 2 FM Level)
设置 OSC3 如何使用频率调制 (FM) 来调制 OSC1 和 OSC2。
设置 ：0–255

Osc 1 (Oscillator 1)
Osc 2 (Oscillator 2)
Osc 3 (Oscillator 3)
打开 Oscillator Edit 的 OSC/Tune 画面。

Noise
此时显示 Noise 画面。
可用于通过对噪声信号使用 VCF 和 HPF 等滤波器来创建各种 SFX 声音。

Ring 3 → 1 (Oscillator 1 Ring Level)
Ring 3 → 2 (Oscillator 2 Ring Level)
设置 OSC3 如何使用环形调制来调制 OSC1 和 OSC2。
设置 ：0–255

1 (Oscillator 1 Out Level)
2 (Oscillator 2 Out Level)
3 (Oscillator 3 Out Level)
Noise (Noise Out Level)
1、2 和 3 用于设置振荡器音量。
Noise 用于调整噪声单元输出的信号电平。您可以使用其他信号（例如 OSC 1、OSC 2 和环形调制器）控制电平平衡。
设置 ：0–511
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Connect 1 (Oscillator 1 Out Select)
Connect 2 (Oscillator 2 Out Select)
Connect 3 (Oscillator 3 Out Select)
Noise Connect (Noise Out Select)
设置振荡器和噪声的输出目的地。
设置 ：Filter、Amp

Modifier
显示 Modifier → Wave Folder。

Filter 1
Filter 2
显示 Filter/Amp → Filter Type。

Amplifier
显示 Filter/Amp → Amp EG。

Filter Type
在 Filter Type 画面上，您可以选择滤波器类型。
可用参数根据您在此处选择的滤波器类型而有所不同。

操作
[PERFORMANCE (HOME)] → Part Common 选择 → [EDIT/ ] → Filter/Amp → Filter Type

Filter 1 Type
Filter 2 Type
设置滤波器。
AN-X 可用的滤波器分为三种类型 ：LPF、HPF 和 BPF。
设置 ：Thru、LPF24、LPF18、LPF12、LPF6、HPF24、HPF18、HPF12、HPF6、BPF12、BPF6
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•	 LPF 
减弱高于截止频率中设置的值的信号。这种类型非常受欢迎，对于产生经典的合成器声音非常有用。
当您提高截止频率时，因为更多的信号会通过滤波器，所以声音会变得更明亮。
当您降低截止频率时，因为滤波器会减弱或阻止信号，所以声音会变得更低沉。
您可以通过提高 Resonance 或提高接近截止频率的信号电平来产生独特的“尖峰”声音。

Frequencies that are
“passed” by the filter

Cutoff Frequency

Resonance

FrequencyCutoff FrequencyFrequency

Gain
Gain

LPF24 ：–24 dB/oct
LPF18 ：–18 dB/oc
LPF12 ：–12 dB/oct
LPF6 ：–6 dB/oct

•	 HPF 
这种滤波器类型仅传递高于截止频率的信号。
您可以通过提高 Resonance 或提高接近截止频率的信号电平来产生独特的“尖峰”声音。

Resonance

Frequencies that are
“passed” by the filter

Frequency
Cutoff Frequency

Gain

HPF24 ：–24 dB/oct
HPF18 ：–18 dB/oct
HPF12 ：–12 dB/oct
HPF6 ：–6dB/oct

•	 BPF 
这种滤波器类型仅允许特定频段（截止频率）的信号通过并切断所有其他信号。

Frequencies that are “passed” by the filter

FrequencyCenter Frequency

Gain

BPF12 ：–12dB/oct
BPF6 ：–6dB/oct
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Cutoff (Filter Cutoff)
设置截止频率。此处设置的频率由 Filter Type 中设置的滤波器使用。
设置 ：0–1023

Resonance (Filter Resonance)
设置共鸣的大小。根据 Filter Type，此参数可能不可用。
设置 ：0–255

Cutoff/Vel (Filter Cutoff Velocity Sensitivity)
设置如何根据力度或击键的强度调整截止频率。
设置 ：	 –255–+0–+255

正值：力度越快，截止频率值就越高
0:截止频率不随力度而变化。
负值：力度越慢，截止频率值就越高

Resonance/Vel (Filter Resonance Velocity Sensitivity)
设置如何根据力度或击键的强度调整共鸣电平。根据 Filter Type，此参数可能不可用。
设置 ：	 –255–+0–+255

正值：力度越高，共鸣变得越大
负值：力度越低，共鸣变得越大
0:共鸣值不随力度而改变。

Cutoff/Key (Filter Cutoff Key Follow)
设置滤波器的截止频率电平如何随着键位置而变化。当该值设置为 1oct 时，音高和截止频率以相同的速率变化。
设置 ：Off、1/3oct、1/2oct、2/3oct、1oct、2oct

Filter 1 Drive (Filter 1 Saturator Drive)
Filter 2 Drive (Filter 2 Saturator Drive)
设置由滤波器的饱和器部分控制的失真量。
设置 ：0.0dB–60.0dB（以 0.75dB 为增量）

Filter 1 Drive/Vel (Filter 1 Saturator Drive Velocity Sensitivity)
Filter 2 Drive/Vel (Filter 2 Saturator Drive Velocity Sensitivity)
设置 Drive 如何根据力度而变化。
设置 ：–255–+0–+255

F1 Out Level (Filter 1 Out Level)
F2 Out Level (Filter 2 Out Level)
设置滤波器的输出电平。
设置 ：–12.000 – +0.000 – +12.000 (dB)（以 0.375dB 为增量）
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Filter EG
在 Filter EG 画面中，您可以设置滤波器包络发生器 (FEG)。
FEG 让您可以设置截止频率的变化程度（或级别），以及从您按下键盘上的按键到声音衰减的那一刻为止，这些变化如何随
时间演变。

操作
[PERFORMANCE (HOME)] → Part Common 选择 → [EDIT/ ] → Filter/Amp → Filter EG

Attack (Filter Cutoff EG Attack Time)
设置从按下键盘上的某个键到 EG 达到最大值所需的时间长度。
设置 ：0–255

Decay (Filter Cutoff EG Decay Time)
设置 EG 从最大电平变化到 Sustain (Filter Cutoff EG Sustain Level) 所需的时间长度。
设置 ：0–255

Sustain (Filter Cutoff EG Sustain Level)
设置延音电平。
设置 ：0–511

Release (Filter Cutoff EG Release Time)
设置松开琴键后 EG 达到 0 值所需的时间长度。
设置 ：0–255

Time/Vel (Filter Cutoff EG Time Velocity Sensitivity)
设置如何根据力度或击键的强度调整截止频率。
设置 ：	 –255–+0–+255

正值：力度越快，FEG 变化越快
0:无论力度设置如何，都不会变化。
负值：快速的力度值会导致 FEG 变化较慢，而较慢的力度值会导致 FEG 变化较快。
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FEG Depth - Filter 1–2 (Filter 1–2 Cutoff EG Depth)
设置 FEG 控制的截止频率变化的深度范围，以 50cent 为增量。设置距离 0 值越远，截止频率变化的深度范围就越宽。
设置 ：	 –9600 – +0 – +9600 (cent)

0: FEG 不会导致截止频率发生变化。
负值：截止频率的变化相反。

FEG Depth/Vel - Filter 1–2 (Filter 1–2 Cutoff EG Depth Velocity Sensitivity)
设置 FEG 控制的截止频率如何根据力度或击键的强度而变化。
设置 ：	 –255–+0–+255

正值：力度越快，FEG 导致截止频率变化的深度范围就越宽 ；力度越慢，深度范围越窄
0:截止频率不随力度而变化。
负值：力度越快，FEG 导致截止频率变化的深度范围就越窄 ；力度越慢，深度范围越宽

Filter LFO
在 Filter LFO 画面上，您可以设置滤波器 LFO。

操作
[PERFORMANCE (HOME)] → Part Common 选择 → [EDIT/ ] → Filter/Amp → Filter LFO

Wave (Filter Common Cutoff LFO Wave)
选择 LFO 波形。通过使用您在此处选择的波形，您可以创建各种类型的调制。
设置 ：Saw、Square、Triangle、Sine、Random
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Key On Reset (Filter Common Cutoff LFO Key On Reset)
按下琴键时使 LFO 的振荡复位。
设置 ：Off、On

Time

Key on

Time

Key on

OnOff

Speed (Filter Common Cutoff LFO Speed)
设置 LFO Wave 变化的速度。
设置 ：0–415

Delay (Filter Common Cutoff LFO Decay Time)
设置从按下键盘上的琴键到 LFO 生效之间的延迟时间。该值越大，LFO 生效的延迟时间就越长。
设置 ：0–127

Fade In (Filter Common Cutoff LFO Fade In Time)
设置在松开琴键且经过 Delay 中设置的延迟时间后，LFO 效果器淡入的时间长度。该值越大，LFO 效果器达到最大值所花
的时间就越长。
设置 ：	 0–214

0:在没有任何淡入的情况下 LFO 变化为最大值。

当值较小时
Fade In

Maximum

Delay

Key On

Time

当值较大时
Fade In

Maximum

Delay

Key On

Time
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Phase (Modifier LFO Phase)
您可以设置复位 LFO Wave 时的初始相位。
设置 ：	 0, 30, 45, 60, 90, 120, 135, 150, 180, 210, 225, 240, 270, 300, 315, 330(° )

波形的相位

Phase

Time

Level

0° 90°
120° 240°

180° 270°

Filter LFO Depth - Filter 1–2 (Filter Cutoff LFO Depth) 
设置 Filter 1 和 Filter 2 的 LFO Wave 控制的深度，以 50 cent 为增量。
设置 ：–9600 – +0 – +9600 (cent)

Amp EG
在 Amp EG 画面中，您可以设置 AEG（振幅包络发生器）。
通过设置 Amp EG，您可以设置从按下键盘上的按键到声音衰减时音量的变化方式。

操作
[PERFORMANCE (HOME)] → Part Common 选择 → [EDIT/ ] → Filter/Amp → Amp EG

Attack (Amplitude EG Attack Time)
设置从按下键盘上的按键至达到 Level (Amplitude Level) 所需的时间长度。
设置 ：0–255
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Decay (Amplitude EG Decay Time)
设置音量从 Level (Amplitude Level) 变化到 Sustain (Amplitude EG Sustain Level) 所需的时间长度。
设置 ：0–255

Sustain (Amplitude EG Sustain Level)
设置按住琴键时保持的音量。
设置 ：0–511

Release (Amplitude EG Release Time)
设置释放琴键到声音衰减所需的时间长度。
设置 ：0–255

Time/Vel (Amplitude EG Time Velocity Sensitivity)
设置 AEG 中的音量根据力度或击键的强度发生变化所花的时间长度。
设置 ：	 –255–+0–+255

正值：力度越快，AEG 音量变化越快。
0:无论力度设置如何，都不会变化。
负值：快速的力度值会导致 AEG 音量变化较慢，而较慢的力度值会导致 AEG 音量变化较快。

Level (Amplitude Level)
设置振幅的音量电平。
设置 ：0–511

Level/Vel (Amplitude Level Velocity Sensitivity)
设置如何根据力度来调整振幅电平。
设置 ：–255–+0–+255

Level/Key (Amplitude Level Key Follow)
设置 Amp Level 如何根据音高而变化。
当 Amplitude Level Key 设置为 127 时，Amp Level 随着音高升高 1 个八度而下降 6dB。
设置 ：0–127

Drive (Amplitude Saturator Drive)
设置由振幅部分的饱和器控制的失真量。
设置 ：0.0dB–60.0dB（以 0.75dB 为增量）
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Amp LFO
在 Amp LFO 画面上，您可以设置振幅 LFO。

操作
[PERFORMANCE (HOME)] → Part Common 选择 → [EDIT/ ] → Filter/Amp → Amp LFO

Wave (Amplitude LFO Wave)
选择 LFO 波形。通过使用您在此处选择的波形，您可以创建各种类型的调制。
设置 ：Saw、Square、Triangle、Sine、Random

Key On Reset (Amplitude LFO Key On Reset)
按下琴键时使 LFO 的振荡复位。
设置 ：Off、On

Time

Key on

Time

Key on

OnOff

Speed (Amplitude LFO Speed)
设置 LFO Wave 变化的速度。
设置 ：0–415

Delay (Amplitude LFO Decay Time)
设置从按下键盘上的琴键到 LFO 生效之间的延迟时间。该值越大，LFO 生效的延迟时间就越长。
设置 ：0–127
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Fade In (Amplitude LFO Fade In Time)
设置在松开琴键且经过 Delay 中设置的延迟时间后，LFO 效果器淡入的时间长度。该值越大，LFO 效果器达到最大值所花
的时间就越长。
设置 ：	 0–214

0:在没有任何淡入的情况下 LFO 变化为最大值。

	 当值较小时
Fade In

Maximum

Delay

Key On

Time

	 当值较大时
Fade In

Maximum

Delay

Key On

Time

Phase (Amplitude LFO Phase)
您可以设置复位 LFO Wave 时的初始相位。
设置 ：	 0, 30, 45, 60, 90, 120, 135, 150, 180, 210, 225, 240, 270, 300, 315, 330(° )

	 波形的相位

Phase

Time

Level

0° 90°
120° 240°

180° 270°

Depth (Amplitude Level LFO Depth)
设置由 LFO 控制的音量变化的深度范围。
设置 ：–127–+0–+127
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Effect

Routing
此处的画面与从 Part Edit (AWM2) Part Common Edit 画面上的 Effect → Routing 打开的画面几乎相同，唯一的不同是下
面列出的例外情况。
•	 没有针对每个 Element 的输出设置
•	 无法为 Ins Connect 选择 Parallel

Ins A、Ins B
与 Part Edit (AWM2) Part Common Edit 画面上的 Effect → Ins A 和 Ins B 相同。

3-band EQ
与 Part Edit (AWM2) Part Common Edit 画面上的 Effect → 3-band EQ 相同。

2-band EQ
在 2-band EQ 画面上，您可以设置声部 EQ。EQ 可以在插入效果器之后设置。

Ins Assign
与 Part Edit (AWM2) Part Common Edit 画面上的 Effect → Ins Assign 相同。
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Arp/MS

Arp Common
与 Part Edit (AWM2) Part Common Edit 画面上的 Arpeggio → Common 相同。

Individual
与 Part Edit (AWM2) Part Common Edit 画面上的 Arpeggio → Individual 相同。

Advanced
与 Part Edit (AWM2) Part Common Edit 画面上的 Arpeggio → Advanced 相同。

MS Common
与 Part Edit (AWM2) Part Common Edit 画面上的 Motion Seq → Common 相同。

Lane
与 Part Edit (AWM2) Part Common Edit 画面上的 Motion Seq → Lane 相同。
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Mod/Control

Control Assign
除了 Destination 设置之外，其他设置与 Control Assign 画面上的 Mod/Control → Part Edit (AWM2) Part Common Edit
相同。
使用下面显示的参数，而不是使用 ElementSw 及其他参数。

Oscillator Sw (Oscillator Switch)
您可以打开或关闭每个振荡器的控制器设置。仅当所选 Destination 与振荡器相关时才会显示此参数。
通常会显示三个开关，但当 Destination 设置为 OSC FM 或 OSC Ring 时，仅显示其中两个开关。
设置 ：Off、On

Filter Sw
您可以打开或关闭每个滤波器的控制器设置。
仅当所选 Destination 与滤波器相关时才会显示此参数。
设置 ：Off、On

After Touch
除了 Destination 设置之外，其他设置与 After Touch 画面上的 Mod/Control → Part Edit (AWM2) Part Common Edit 
相同。

Tx/Rx Switch
与 Part Edit (AWM2) Part Common Edit 画面上的 Mod/Control → Tx/Rx Switch 相同。

Control Settings
与 Part Edit (AWM2) Part Common Edit 画面上的 Mod/Control → Control Settings 相同。

Part LFO
此处的画面与从 Part Edit (AWM2) Part Common Edit 画面上的 Mod/Control → Part LFO 打开的画面相同，但唯一可用 
的 Destination 设置是 Ins。



336MODX M 使用说明书

Part Edit (AN-X) Oscillator Edit 画面
Normal Part (AN-X) 由三个振荡器和噪声组成。
Part Edit (AN-X) 包括 Part Common Edit（用于设置整个声部的参数）、Oscillator Edit（用于设置每个振荡器的参数）和
Noise Edit（用于编辑噪声）。

Osc/Tune

在 Osc/Tune 画面上，您可以设置振荡器的常规参数。
此画面上提供的调制和波形整形功能包括 FM（频率调制）、环形调制、振荡器同步、Pulse Width 和 Wave Shaper。

操作
[PERFORMANCE (HOME)] → Part 选择 → Oscillator 选择 → Osc/Tune

Wave (Oscillator Wave)
设置振荡器的波形。
设置 ：Saw1、Saw2（具有更厚实声音的 Saw1 变体）、Square、Triangle、Sine

Out Level (Oscillator Out Level)
设置振荡器的音量。
设置 ：0–511

Out Level/Vel (Oscillator Out Level Velocity Sensitivity)
设置如何根据力度来调整振荡器音量。
设置 ：–255–+0–+255
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Invert (Oscillator Out Invert Enable)
执行振荡器输出的负 / 正转位。
设置 ：Off、On

Connect (Oscillator Out Select)
设置振荡器的输出目的地。
设置 ：Filter、Amp

Octave (Oscillator Octave)
以八度为单位设置振荡器的音高。
设置 ：64’, 32’, 16’, 8’, 4’, 2’, 1’

Pitch (Oscillator Pitch)
精细调整振荡器的音高。
设置 ：–1200 – +0 – +1200(cent)

	� FM (Frequency Modulation)
使用另一个振荡器调制振荡器的频率。

FM Level (Oscillator FM Level)
设置频率调制的电平。
设置 ：0–255

FM Level/Vel (Oscillator FM Level Velocity Sensitivity)
设置频率调制如何根据力度而变化。
设置 ：–255–+0–+255

	�环形调制
通过混合两个振荡器信号，您可以创建金属材质的非谐波声音。

Ring Level (Oscillator Ring Level)
设置环形调制的电平。
设置 ：0–255

Ring Level/Vel (Oscillator Ring Level Velocity Sensitivity)
设置环形调制如何根据力度而变化。
设置 ：–255–+0–+255

	�振荡器同步
振荡器同步是一个通过强制两个振荡器同步来创建复杂波形的系统。
AN-X 声音引擎让每个振荡器可以设置其同步时序，因此您可以使用单个振荡器来创建复杂的波形。

Sync Pitch (Oscillator Self Sync Pitch)
设置振荡器同步的电平，以 25cent 为增量。
设置 ：0–4800 (cent)

Sync Pitch/Vel (Oscillator Self Sync Pitch Velocity Sensitivity)
设置 Sync Pitch 如何根据力度而变化。
设置 ：–255–+0–+255
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	� Pulse Width
Pulse Width 是 Square 波的负部分和正部分的比率。

当 Pulse Width 设置为较小值时 当 Pulse Width 设置为 50% 时 当 Pulse Width 设置为较大值时

借助 AN-X 声音引擎，您不仅可以对 Square 波使用 Pulse Width，也可以对其他波形使用。

使用 Pulse Width 对 LFO 进行调制称为 Pulse Width Modulation (PWM)，从而让您可以创建独特的环绕声音。
借助 AN-X 声音引擎，您可以通过 Osc EG 和 Osc LFO 来使用 PWM。您可以在 Osc EG 画面和 Osc LFO 画面上指定 PWM 的
电平。

Pulse Width (Oscillator Pulse Width)
设置波形的 Pulse Width。
设置 ：1.0%–50.0%–99.0%

PulseWidth/Vel (Oscillator Pulse Width Velocity Sensitivity)
设置 Pulse Width 如何根据力度而变化。
设置 ：–255–+0–+255

	� Wave Shaper
通过改变波形的形状来创建特征失真并改变谐波内容。

Shaper (Oscillator Wave Shaper)
设置 Wave Shaper 的电平。通过使用 Wave Shaper，波形会动态变化。
设置 ：0–255

Shaper/Vel (Oscillator Wave Shaper Velocity Sensitivity)
设置 Wave Shaper 如何根据力度而变化。
设置 ：–255–+0–+255

Pitch EG Settings
Part Edit (AN-X) Part Common Edit 画面上会显示 General/Pitch → Pitch EG。

Pitch LFO Settings
Part Edit (AN-X) Part Common Edit 画面上会显示 General/Pitch → Pitch LFO。

Osc 1–3 EG Settings
此时显示 Osc EG 画面。

Osc 1–3 LFO Settings
此时显示 Osc LFO 画面。
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Osc EG

在 Osc EG 画面中，您可以设置振荡器的包络发生器。
您可以设置 Sync、Pulse Width 和 Wave Shaper 如何随时间变化，从按下键盘上的按键开始，一直到声音衰减。

操作
[PERFORMANCE (HOME)] → Part 选择 → Oscillator 选择 → Osc EG

Attack (Oscillator EG Attack Time)
设置从按下键盘上的琴键到 EG 变化为达到在 Attack Level 中设置的值时所需的时间长度。
设置 ：0–255

Decay (Oscillator EG Decay Time)
设置从按下键盘上的琴键到 EG 变化为达到在 Decay Level 中设置的值时所需的时间长度。
设置 ：0–255

Sustain (Oscillator EG Sustain Level)
设置延音电平。
设置 ：0–511

Release (Oscillator EG Release Time)
设置松开琴键后 EG 达到 0 值所需的时间长度。
设置 ：0–255

Osc EG Depth Sync (Oscillator Self Sync EG Depth)
设置 Sync 如何根据 Osc EG 而变化。
设置 ：–4800 – +0 – +4800 (cent)

Osc EG Depth Pulse Width (Oscillator Pulse Width EG Depth)
设置 Pulse Width 如何根据 Osc EG 而变化。
设置 ：–127–+0–+127

Osc EG Depth Shaper (Oscillator Wave Shaper EG Depth)
设置 Shaper 如何根据 Osc EG 而变化。
设置 ：–127–+0–+127
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Osc LFO

在 Osc LFO 画面上，您可以设置振荡器 LFO。

操作
[PERFORMANCE (HOME)] → Part 选择 → Oscillator 选择 → Osc LFO

LFO Wave (Oscillator LFO Wave)
选择 LFO 波形。通过使用您在此处选择的波形，您可以创建各种类型的调制。
设置 ：Saw、Square、Triangle、Sine、Random

Key On Reset (Oscillator LFO Key On Reset)
按下琴键时使 LFO 的振荡复位。
设置 ：Off、On

Time

Key on

Time

Key on

OnOff

Speed (Oscillator LFO Speed)
设置 LFO Wave 变化的速度。
设置 ：0–415



341MODX M 使用说明书

Delay (Oscillator LFO Delay Time)
设置从按下键盘上的琴键到 LFO 生效之间的延迟时间。
设置 ：0–127

Fade In (Oscillator LFO Fade In Time)
设置在松开琴键且经过 Delay 中设置的延迟时间后，LFO 效果器淡入的时间长度。
设置 ：0–214

Oscillator LFO Phase
设置按下按键时复位波形的 LFO 相位。
设置 ：0, 30, 45, 60, 90, 120, 135, 150, 180, 210, 225, 240, 270, 300, 315, 330(° )

Osc LFO Depth Sync (Oscillator Self Sync LFO Depth)
设置 Sync 如何根据 Osc LFO 而变化。
设置 ：–4800 – +0 – +4800 (cent)

Osc LFO Depth Pulse Width (Oscillator Pulse Width LFO Depth)
设置 Pulse Width 如何根据 Osc LFO 而变化。
设置 ：–127–+0–+127

Osc LFO Depth Shaper (Oscillator Wave Shaper LFO Depth)
设置 Shaper 如何根据 Osc LFO 而变化。
设置 ：–127–+0–+127
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Part Edit (AN-X) Noise Edit 画面
Normal Part (AN-X) 由三个振荡器和噪声组成。
Part Edit (AN-X) 包括 Part Common Edit（用于设置整个声部的参数）、Oscillator Edit（用于设置每个振荡器的参数）和
Noise Edit（用于编辑噪声）。

Noise

在 Noise 画面上，您可以设置 Noise Generator。

操作
[PERFORMANCE (HOME)] → Part 选择 → Oscillator 选择 → Noise

Noise Tone (Noise Generator Tone)
设置 Noise 的频率响应。
设置 ：	 0–64–127

0–63:减弱高音
64:白噪声
65–127:减弱低音

Out Level (Noise Generator Out Level)
设置 Noise 的音量。
设置 ：0–511

Out Level/Vel (Noise Generator Out Level Velocity Sensitivity)
设置如何根据 Velocity 来调整 Noise 音量。
设置 ：–255–+0–+255

Connect (Noise Generator Out Select)
设置 Noise 的输出目的地。
设置 ：Filter、Amp
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Category Search 画面
分类查找是一项方便的功能，让您可以从指定类别中快速找到您想要使用的特定演奏组、声部、琶音或波形。

Performance Category Search

在 Performance Category Search 画面上，您可以搜索并选择演奏组。
显示 Category Search 画面时，您可以使用上方面板的按钮更改声部选择或静音设置。

操作
按 [CATEGORY] 按钮。
点击演奏组名称并从上下文菜单中选择 Category Search

Filter
选择要在搜索中使用的筛选条件。
设置 ：Category、Attribute

Main (Main Category)
Sub (Sub Category)
按类别筛选。
取消选中 Main 或 Sub 复选框，您可以取消按类别筛选。
设置 ：请参阅 Data List

Attribute
按属性筛选。
取消选中 Attribute 复选框，您可以取消按属性筛选。
设置 ：AWM2、FM-X、AN-X、MC、SSS、Smart Morph、Single、Multi、MOTIF XF、MONTAGE、MODX M OS V1.0
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Bank/Favorite (Bank/Favorite Select)
按库或喜好来筛选。
当选择 Favorite 时，只有带有喜好标记的演奏组才会出现在列表中。
显示 Category Search 画面时，您可以按 [CATEGORY] 按钮，以便按 All → Favorite → Preset → User → 库名称（加载了
库文件时）的顺序来切换库。
按住 [CATEGORY] 按钮时，选择将复位为 All。
设置 ：All、Favorite、Preset、User、库名称（加载了库文件时）

Name Search
让您可以输入名称中包括的某些字符以便于搜索。您最多可以使用 20 个字母数字字符。

Job
调出作业菜单。

•	 Delete
删除选定的内容。
仅当选择用户库中的演奏组时，此参数才可用。

•	 Rename
更改所选内容的名称。
仅当选择用户库中的演奏组时，此参数才可用。

•	 Favorite All Clear
清除演奏组中的所有喜好标记。
当没有带有喜好标记的演奏组时，此参数不可用。

Sort
设置演奏组列表的排序顺序。
设置 ：	 Default、Name、Date

Name：按名称排序。向下箭头表示列表按升序排列（A 至 Z）。向上箭头表示列表按降序排列。
Date ：按设置的存储日期排序。向下箭头表示列表按降序排列（从新到旧）。向上箭头表示列表按升序排列。

Audition
打开或关闭试听乐句播放。
当 Audition Lock 设置为 On 时，此参数不可用，设置路径为 ：[UTILITY] → Settings → Advanced。
设置 ：Off、On

演奏组列表
显示演奏组名称及其活动声部、属性和喜好标记。
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Performance Merge

您可以在 Performance Merge 画面中将所选演奏组的多个声部分配给另一个演奏组的空声部。例如，您可以将四声部钢琴
演奏组和两声部弦乐演奏组分层，从而创造丰富的六声部演奏组。

操作
[PERFORMANCE (HOME)] → 声部选择（如果所选声部和所有后续声部为空时） → 点击 [+]

Source
选择演奏组时，此处指定的声部的声音会分配到当前选定的声部。
设置 ：	 All、Part 1–16

All ：所选演奏组中的所有声部都分配给其他选定演奏组的空声部（尽可能多地分配）。
Part 1–16 ：仅将指定声部的声音分配给另一个选定声部

Mute Org (Original Part Mute)
当此选项设置为 Off 时，在打开 Performance Merge 画面之前显示的声部将会静音。
设置 ：Off、On

Mute Add (Additional Part Mute)
当此选项设置为 Off 时，在 Performance Merge 画面上添加的声部将会静音。
设置 ：Off、On
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Part Category Search

在 Part Category Search 画面上，您可以搜索并选择声部。

操作
[SHIFT] + [CATEGORY] 

（当选择已分配声音的声部时）点击演奏组名称并从上下文菜单中选择 Category Search
（当选择已分配声音的空声部时）点击 [+]

Source (Source Part)
选择演奏组时，此处指定的声部的声音会分配到当前选定的声部。
初始设置为 Part 1。
设置 ：Part 1–16

Solo
打开 / 关闭独奏功能。
打开此开关时，所选声部会设置为独奏。
设置 ：Off、On

Param. with Part (Parameter with Part)
选择演奏组时加载一组参数值。
参数组设置为 Off 时，即使选择了新的演奏组，也会保留其当前设置。
参数组 ：Mixing、Arp/MS、Scene、Zone
设置 ：Off、On
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Rhythm Pattern

在 Rhythm Pattern 画面上，您可以搜索并选择节奏模板。
节奏模板功能让您可以立即将节奏声部添加至当前演奏组。此外，通过将节奏模板与包络跟随器效果器相结合，可以进一步
改变声音。

操作
[SHIFT] + [SONG/PATTERN]

Arp (Arpeggio)
Envelope Follower
选择琶音画面或包络跟随器画面。

Bank/Favorite (Bank/Favorite Select)
按库或喜好来筛选。
当选择了 Favorite 时，只有带有喜好标记的节奏模板才会出现在列表中。
设置 ：All、Favorite、Preset、User、库名称（加载了库文件时）

Name Search
让您可以输入名称中包括的某些字符以便于搜索。您最多可以使用 20 个字母数字字符。

Sort
设置节奏模板列表的排序顺序。
设置 ：	 Default、Name、Date

Name：按名称排序。向下箭头表示列表按升序排列（A 至 Z）。向上箭头表示列表按降序排列。
Date ：按设置的存储日期排序。向下箭头表示列表按降序排列（从新到旧）。向上箭头表示列表按升序排列。

Mute Org (Original Part Mute)
当此选项设置为 Off 时，在打开 Rhythm Pattern 画面之前显示的声部将会静音。
设置 ：Off、On

Mute Add (Additional Part Mute)
当此选项设置为 Off 时，在 Rhythm Pattern 画面上添加的声部将会静音。
设置 ：Off、On

节奏模板列表
显示节奏模板列表。

Cancel
取消操作。



348MODX M 使用说明书

	�当 Arp 设置为On时
琶音设置的常用参数显示在画面左侧。

Tempo
设置速度。
设置 ：5–300

Volume
设置节奏模板的音量。
设置 ：0–127

Category (Arpeggio Main Category)
Sub Category (Arpeggio Sub Category)
Name
显示当前所选的琶音类别、子类别和名称。
通过点击名称，您将看到 Arpeggio Category Search 上下文菜单并输入数字。
设置 ：请参阅 Data List

Arp Select (Arpeggio Select)
选择琶音。
设置 ：1–8



349MODX M 使用说明书

	�当 Envelope Follower 设置为On时
Envelope Follower 设置的常用参数显示在画面左侧。
这样就可以快速编辑节奏模板常用的参数。
当您想更改其他参数时，请使用 Edit 打开 Envelope Follower Edit 画面。

Quick Assign
启用包络跟随器
设置 ：Off、On

Gain (Envelop Follower Gain)
设置输入源的输入增益。
设置 ：-24.0dB – 0.0dB – 24.0dB

Destination
设置包络跟随器的目的地。
设置 ：	 Volume、Cutoff、Resonance、Pitch、Pan、Reverb Send、Variation Send、LFO Speed、LFO Depth 1、LFO 

Depth 2、LFO Depth 3

Curve Type
Polarity (Curve Polarity)
Ratio (Curve Ratio)
Param1 (Curve Parameter 1)
Param2 (Curve Parameter 2)
与 Control Assign 画面相同。

Edit
此时显示 Envelope Follower Edit 画面。
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如何使用Rhythm Pattern 功能
在这里，我们将展示一个示例，说明如何将节奏模板 8Z Trance Basics 1 添加至演奏组 Supertrance 中，然后通过包络跟
随器修改声音。

首先，添加节奏声部。

1.	 选择您想要添加节奏声部的演奏组。
选择 Supertrance。

2.	 按 [SHIFT]+[SONG/PATTERN] 打开 Rhythm Pattern 画面。
当使用声部 1 至 8 中的所有声部时，将显示 PartFull 且无法添加节奏模板。

3.	 点击节奏模板列表中您想要使用的节奏模板组。
点击 8Z Trance Basics 1。

此时已添加了节奏声部。

4.	 按下琴键来播放节奏。

5.	 按 [PERFORMANCE (HOME)] 按钮或 [EXIT] 按钮来确认节奏模板。
Rhythm Pattern 画面将关闭。
注
您还可以通过点击 HOME 图标 ( ) 来确认选择。

6.	 若要停止节奏模板，请按 [ARP] 按钮或 []（停止）按钮。

接下来，设置包络跟随器。有关包络跟随器的信息，请参阅“使用包络跟随器”。

7.	 按 [SHIFT]+[SONG/PATTERN] 打开 Rhythm Pattern 画面，然后点击 Envelope Follower。

8.	 将Quick Assign 设置为On。
您可以弹奏键盘，试听启用包络跟随器后的声音。
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9.	 可以根据需要调整设置。
在本示例中，将 Polarity 设置为 Bi，将 Ratio 设置为 –64，并将 Gain 设置为 –12.0dB。

如需进行更精细的调整，请从画面上的 Edit 打开 Envelope Follower Edit。

当想要更改节奏模板组或琶音类型时，按 [SHIFT]+[SONG/PATTERN] 返回 Rhythm Pattern 画面。即便已更改节奏模
板组或琶音类型，Envelope Follower 设置仍将保留。
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Arp Category Search (Arpeggio Category Search)

在 Arp Category Search 画面上，您可以搜索并选择琶音类型。

操作
[PERFORMANCE (HOME)] → Part Common 选择 → [EDIT/ ] → Arpeggio → Individual → [CATEGORY]
[PERFORMANCE (HOME)] → Common 选择 → [EDIT/ ] → Arp / MS → Arp Overview → Part 选择 → [CATEGORY]

Classic (Classic Switch)
打开或关闭 Classic 视图。
在 Classic 视图中，仅列出常见的琶音，并且没有可供搜索的筛选条件。
设置 ：Off、On

Main (Main Category)
Sub (Sub Category)
按类别筛选。
取消选中 Main 或 Sub 复选框，您可以取消按类别筛选。
设置 ：请参阅 Data List

Attribute
按属性筛选。
取消选中 Attribute 复选框，您可以取消按属性筛选。
设置 ：Note、Chord、Other、Intro、Main、Fill、Ending、AF、Accent、Random SFX、Mg、小节数、拍号、tempo

Bank/Favorite (Bank/Favorite Select)
按库或喜好来筛选。
当选择了 Favorite 时，只有带有喜好标记的琶音类型才会出现在列表中。
设置 ：All、Favorite、Preset、User、库名称（加载了库文件时）
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Name Search
让您可以输入名称中包括的某些字符以便于搜索。您最多可以使用 20 个字母数字字符。

Job
调出作业菜单。

•	 Delete
删除选定的内容。
仅当选择用户库中的琶音时，此参数才可用。

•	 Rename
更改所选内容的名称。
仅当选择用户库中的琶音时，此参数才可用。

•	 Favorite All Clear
清除琶音中的所有喜好标记。
当没有带有喜好标记的琶音类型时，此参数不可用。

Sort
设置琶音类型列表的排序顺序。
设置 ：		  Default、Name、Date

Name：按名称排序。向下箭头表示列表按升序排列（A 至 Z）。向上箭头表示列表按降序排列。
Date ：按设置的加载日期排序。向下箭头表示列表按降序排列（从新到旧）。向上箭头表示列表按升序排列。

琶音列表
显示琶音名称、小节数、拍号、推荐速度、属性和喜好标记状态。
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Waveform Search (Waveform Category Search)

在 Waveform Search 画面上，您可以搜索并选择波形。

操作
波形相关画面 → 声部选择 → 波形选择 → [CATEGORY]

Bank/Favorite (Bank/Favorite Select)
按库或喜好来筛选。
当选择 Favorite 时，只有带有喜好标记的波形才会出现在列表中。
设置 ：All、Favorite、Preset、User、库名称（加载了库文件时）

Name Search
让您可以输入名称中包括的某些字符以便于搜索。您最多可以使用 20 个字母数字字符。

Main (Main Category)
Sub (Sub Category)
按类别筛选。取消选中 Main 或 Sub 复选框，您可以取消按类别筛选。
设置 ：请参阅 Data List

Job
调出作业菜单。

•	 Delete
删除选定的内容。
仅当选择用户库中的波形时，此参数才可用。

•	 Rename
更改所选内容的名称。
仅当选择用户库中的波形时，此参数才可用。

•	 Favorite All Clear
清除波形中的所有喜好标记。
当没有带有喜好标记的波形时，此参数不可用。
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Sort
设置波形列表的排序顺序。
设置 ：	 Default、Name、Date

Name：按名称排序。向下箭头表示列表按升序排列（A 至 Z）。向上箭头表示列表按降序排列。
Date ：按设置的存储日期排序。向下箭头表示列表按降序排列（从新到旧）。向上箭头表示列表按升序排列。

波形列表
显示波形列表。
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Live Set 画面
例如，当您播放歌单中的歌曲时，Live Set 功能能够非常方便地立即在不同演奏组之间进行切换。

Live Set

在 Live Set 画面上，您可以调出演奏组。
如果在选定 User Bank 时按 [SHIFT] + [EDIT/ ]，则会显示一个对话框，然后您可以复制或交换页面或库。

操作
按 [LIVE SET] 按钮
点击 LIVE SET 图标 ( )

Bank (Bank Name)
选择 Live Set 库。
设置 ：Preset、User 1–8（出厂默认设置）、库名称（加载了库文件时）

Page
选择 Live Set 页面。

Edit
此时显示 Live Set Edit 画面。
仅当选择 User Bank 时 Edit 才会出现。

Live Set Slot 1–16
显示在所选 Live Set 页面上注册的演奏组列表。

Category Search
Performance Category Search 画面会打开。
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Current Performance Name
显示所选插槽中注册的演奏组名称。

Current Slot Name
显示所选插槽的名称。
当将模板、乐曲或音频分配到插槽时，将显示模板或乐曲的名称或音频文件。

Performance Attribute
显示所选插槽中注册的演奏组的属性。

在 Live Set 画面上，当已启用链的模板分配给插槽时，PTN 图标变为 PTN CHAIN。
PTN：为分配了模板的插槽显示。
PTN CHAIN ：为分配了模板（已启用链）的插槽显示。
SONG：为分配了乐曲的插槽显示。
AUDIO ：为分配了音频的插槽显示。
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Live Set Register

在 Live Set Register 画面上，您可以将演奏组注册到 Live Set 插槽。

操作
[SHIFT] + [LIVE SET]
按住 [SHIFT] 按钮时点击导航栏上的 LIVE SET 图标

Store as New Perf. and Register (Store as New Performance and Register)
将当前演奏组存储为新演奏组并将其注册到所选插槽。

Jump to Data Utility
此时显示 Data Utility 画面。

Overwrite Current Perf. and Register (Overwrite Current Performance and Register)
在现有演奏组上存储新演奏组并将其注册到所选插槽。

Register
注册演奏组。
按住 [SHIFT] 按钮时，按 Register，通过将演奏组插入插槽之间来注册演奏组。
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Live Set Edit

在 Live Set Edit 画面上，您可以编辑 Live Set。
只能编辑用户库中的 Live Set。

操作
[LIVE SET] → [EDIT/ ]

Bank (Bank Name)
以新名称保存选定的 Live Set 库。名称中最多可以使用 20 个字母数字字符。

Page (Page Name)
以新名称保存选定的 Live Set 页面。名称中最多可以使用 20 个字母数字字符。

Done
点击可关闭 Live Set Edit 并显示 Live Set 画面。

Live Set Slot 1–16
显示为所选 Live Set 注册的演奏组列表。

[+] (Add)
点击可将所选演奏组注册到该插槽。

Job
调出作业菜单。

•	 Copy
打开复制功能。
您可以通过以下方式复制设置 ：选择要从中复制的插槽，点击 Copy，然后选择要复制到的插槽。
设置 ：Off、On

•	 Exchange
打开交换功能。
您可以通过以下方式交换设置 ：选择第一个插槽，点击 Exchange，然后选择第二个插槽。
设置 ：Off、On

•	 Delete
选择插槽，然后点击 Delete 从插槽中删除所有已注册的演奏组和其他设置。

•	 Delete & Move
选择插槽，然后点击 Delete & Move 从插槽中删除所有已注册的演奏组并将后面的插槽向上移动。
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Slot Type
选择插槽类型。
设置 ：	 Perform、Song、Audio、Pattern

Perform：仅将演奏组注册到插槽
Song ：将演奏组和乐曲注册到插槽
Audio ：将演奏组和音频文件注册到插槽
Pattern ：将演奏组和模板注册到插槽

Slot Name
Song Name
Audio Name
Pattern Name
当 Slot Type 为 Perform 时，显示 Slot Name。
点击名称会调出屏幕键盘，让您可以输入当前插槽的名称。您最多可以使用 20 个字母数字字符。
当 Slot Type 为 Pattern 时，显示 Pattern Name ；当它为 Song 时，显示 Song Name ；当它为 Audio 时，显示 Audio 
Name。此时会显示注册的模板、乐曲或音频。当您点击名称时，会出现 Utility Load 画面。然后您可以选择要注册的模板、
乐曲或音频。

Performance (Performance Name)
显示向所选插槽注册的演奏组名称。
点击可显示 Performance Category Search 画面。

Color
设置所选插槽的颜色。
设置 ：	 Black、Red、Yellow、Green、Blue、Azure、Pink、Orange、Purple、Sakura、Cream、Lime、Aqua、Beige、

Mint、Lilac

Volume
设置所选插槽中注册的演奏组的音量。

SSS Time
调整所选插槽的 SSS Time。如果设置了 SSS Time，即使在演奏时更改演奏组，如果在演奏时声音设置为 Note Off，则在设
置的时间之后声音仍会淡出。
设置 ：0.0sec – 30sec、Hold、System

从 Live Set 画面播放模板、乐曲或音频文件

操作
[LIVE SET]（或点击上方面板中的 LIVE SET） → User Bank 选择 → Slot 选择 → []（播放）按钮

注
•	当模板或乐曲正在播放时，无法更改演奏组和插槽。如果您尝试更改它们，会出现错误消息。
•	当您在播放模板、乐曲或音频文件时按 []（播放）按钮，将打开模板、乐曲或音频文件播放画面。
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Utility 画面
Utility 画面用于设置整个乐器的常用项目。

Settings

Sound
Sound 画面用于设置乐器的声音输出。

操作
[UTILITY] → Settings → Sound

Tone Generator Volume
设置乐器声音输出的总体音量。
设置 ：0–127

Tone Generator Note Shift
以半音为单位调整乐器的音源模块产生的总体音色的音高。
设置 ：–24–+0–+24

Tone Generator Tune
以半音为单位调整乐器的音源模块产生的总体音色的调音。您可以以音分为单位微调音高。
设置 ：–102.4–+0.0–+102.3

SSS Time
调整乐器的音源模块产生的总体音色的 SSS Time。选择后，将应用 Live Set Slot 的 SSS Time。
设置 ：0.0sec – 30sec、Hold、System
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Keyboard Octave Shift
以八度为单位变换键盘的音高。这与上方面板的 [OCTAVE] 按钮关联。
设置 ：–3–+0–+3

注
下次启动程序时，Keyboard Octave Shift 设置会设置为 0。

Keyboard Transpose
以半音为单位改变键盘的音高。
设置 ：–11semi 至 +0semi 至 +11semi

注
•	如果音高超出了设备的声音来源部分可以播放的范围（C-2 到 G8），则会输出高一个（或低一个）八度的音符。
•	下次启动程序时，Keyboard Transpose 设置会设置为 +0semi。

Keyboard Velocity Curve
设置力度曲线，用于确定弹奏琴键的力量与力度值之间的关系。
乐器画面上显示的图表的横轴表示弹奏琴键的力量，纵轴表示从琴键输出的力度。
设置 ：	 Normal、Soft 1、Soft 2、Hard 1、Hard 2、Wide、Fixed

Normal ：最常见的曲线，其中击键的力量与力度成正比
Soft 1 ：提供更快的响应
Soft 2 ：Soft 1 和 Normal之间的曲线
Hard 1 ：提供更慢的响应
Hard 2 ：Hard 1 和 Normal之间的曲线
Wide ：一种在轻触按键时抑制力度响应，而在用力按键时增强力度表现的曲线。该曲线提供了更宽动态范围的 
感觉。
Fixed ：如果您希望创建一个声音来源，无论按键力量强弱，输出的力度都保持恒定，使用此设置。 Keyboard 
Fixed Velocity 中设置的值用作力度值

Keyboard Fixed Velocity
无论您弹奏键盘的力度如何，都会向音源发送固定力度。
仅当您将 Keyboard Velocity Curve 参数设置为 Fixed 时，这才有效。
设置 ：1–127

Sustain Pedal (Sustain Pedal Select)
选择连接到后面板上 FOOT SWITCH [SUSTAIN] 插孔的脚踏开关类型。

•	 FC3、FC3A（启用半制音功能）
选择 FC3A (Half On)。如果不需要使用半制音功能，请选择 FC3A (Half Off)。

•	 FC4、FC4A、FC5
选择 FC4A 或 FC5。FC4、FC4A 和 FC5 不提供半制音功能。

•	反极性踏板
选择 Reverse Polarity。半制音功能不可用。

设置 ：FC3A (Half On)、FC3A (Half Off)、FC4A/FC5、Reverse Polarity

注
如果您使用来自外接 MIDI 设备的控制变化来播放半制音，不需要 Sustain Pedal (Sustain Pedal Select) 设置。
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Global Tuning (Global Micro Tuning Switch)
当此参数设置为 On 时，全局设置中的微调设置优先于演奏组每个声部的微调设置。这适用于除鼓声部之外的所有声部。
设置 ：Off、On

注
下次启动程序时，Global Tuning (Global Micro Tuning Switch) 设置会设置为 Off。

Micro Tuning Name (Global Micro Tuning Name)
显示所选微调的名称。点击名称即可调出用于选择微调的菜单。
设置 ：	 Preset：Equal Temperament、Pure Major、Pure Minor、Werckmeister、Kirnberger、Vallotti & Young、1/4 

shift、1/4 tone、1/8 tone、Indian、Arabic1、Arabic2、Arabic3  
User ：Init Tuning1–8  
Library ：库名称（加载了库文件时）

Root (Global Micro Tuning Root)
设置微调的根音音符。如果 Micro Tuning Name 中选择的类型不需要根音音符，不会显示此参数。
设置 ：C–B

Edit User Tuning
打开用户微调设置窗口。
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Quick Setup
通过此功能，您只需选择一组设置即可将连接外接设备所需的所有设置设定为最佳值。
可以一次性将几个设置画面的参数都设置为适合预期用途。

操作
[QUICK SETUP]
[UTILITY] → Settings → Quick Setup

Audio Signal Flow
显示当前音频信号流程图。
所描绘的信号流根据 USB [TO HOST] 端口上的连接以及乐器的其他设置而变化。

MIDI Signal Flow
显示当前 MIDI 信号流程图。
信号流程图根据乐器的设置而变化。

Quick Setup (Quick Setup Select)
选择 Quick Setup。
设置 ：	 Standalone、MIDI Rec on DAW (Setup No.1)、Audio Rec on DAW (Setup No.1)、With Plugin Host App (Setup 

No.3)
每个快速设置中存储的参数如下 ：

音频设置 Direct Monitor

MIDI 设置 Local Control

演奏组设置 Part 1–16 Output Select
A/D In Output Select
Digital In Output Select
Part 1–8 Keyboard Control Switch
Part 1–16 Part Mode
Part 1–16 Transmit Channel

请参阅 Audio I/O，了解音频设置参数，并参阅 MIDI I/O，了解 MIDI 设置参数。
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Quick Setup 初始设置

•	 Standalone
单独使用乐器的设置和从乐器操作外接设备的设置

Direct Monitor Local Control Output Select Keyboard Sw Part Mode Transmit Ch

On On Main L&R Part 1–8 ：On Part 1–16 ：Int Part 1–16 ： 
Ch 1–16

•	MIDI Rec on DAW
在 DAW 软件上以 MIDI 形式录制演奏组的设置

Direct Monitor Local Control Output Select Keyboard Sw Part Mode Transmit Ch

On Off Main L&R Part 1–8 ：On Part 1–16 ：Int Part 1–16 ： 
Ch 1–16

•	 Audio Rec on DAW
用于将内部音源上的每个声部作为单独音轨录制到 DAW 软件的设置

Direct Monitor Local Control Output Select Keyboard Sw Part Mode Transmit Ch

Off On Different for each 
Part

Part 1–8 ：On Part 1–16 ：Int Part 1–16 ： 
Ch 1–16

•	With Plugin Host App
将内置音源与计算机上的音源插件一起使用的设置

Direct Monitor Local Control Output Select Keyboard Sw Part Mode Transmit Ch

On On Main L&R Part 1–5 ：On
Part 6–8 ：Off

Part 1–4 ：Int
Part 5–16 ：Ext

Part 1–4 ：Ch 1–4
Part 5–8 ：Ch 1–4
Part 9–16 ： 
Ch 9–16

Store Current Settings
您可以将当前设置保存到 Quick Setup 的 Setup No.1–3 中的任意一项。
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Audio I/O
在 Audio I/O 画面上，您可以设置音频信号输入和输出。

操作
[UTILITY] → Settings → Audio I/O

Audio Signal Flow
显示当前音频信号流程图。
所描绘的信号流根据 USB [TO HOST] 端口上的连接以及乐器的其他设置而变化。

A/D Input (A/D Input Gain)
将 A/D INPUT 插孔的输入增益设置为 Mic 或 Line。
设置 ：	 Mic、Line

Mic ：适用于具有低输出电平的设备，例如麦克风。
Line ：适用于具有高输出电平的设备，例如合成器或音频设备。

注
可直接连接具备有源拾音器的吉他或贝司。另一方面，当使用无源拾音器时，通过效果器或引导盒连接乐器。

USB Volume (USB Input Volume)
调整从 USB [TO HOST] 端口输入的音频信号的音量。
设置 ：0–127

注
USB 输入音量作为系统范围的设置来存储，而不是作为各个演奏组的设置来存储。

Direct Monitor
设置从 Main L&R、USB Main 或 USB 1–8 通道输出到外接设备（例如计算机）的音频信号也会从本乐器播放（直接监听）。
当此选项设置为 On 时，输出到 Main L&R、USB Main 和 USB 1–8 通道的音频信号也会发送到乐器的 OUTPUT [L/MONO]
和 [R] 插孔以及 [PHONES] 插孔。当没有 USB 连接时，此功能会自动打开。
设置 ：Off、On
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Main L&R (Analog Output L&R Output Gain)
设置 OUTPUT [L/MONO] 和 [R] 端口的输出增益。
设置 ：–6dB、+0dB、+6dB、+12dB

USB Main (USB Main L&R Output Gain)
设置 USB [TO HOST] 端口的主 L&R 通道的输出增益。
设置 ：–6dB、+0dB、+6dB、+12dB

USB 1-8 (USB Individual Output Gain)
设置 USB [TO HOST] 端口的通道 1–8 的输出增益。
设置 ：–6dB、+0dB、+6dB、+12dB

Monitor Volume
此时显示 Monitor Volume 画面。
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MIDI I/O
在 MIDI I/O 画面上设置 MIDI 输入和输出。

操作
[UTILITY] → Settings → MIDI I/O
点击 Quick Setup 图标

MIDI Signal Flow
显示当前 MIDI 信号流程图。流程图根据乐器的设置而变化。
通过在 MIDI Signal Flow 中的 Local Control 开关附近点击，您可以打开或关闭 Local Control。

MIDI IN/OUT
选择用于发送和接收 MIDI 信息的端口。
设置 ：MIDI、USB

MIDI Thru
指定 MIDI [OUT] 端口是否用作 MIDI Thru 端口。
设置 ：Off、On

Local Control
打开或关闭本地控制。
当 Local Control 设置为 Off 时，乐器的控制器模块和音源模块会断开连接，弹奏键盘时不会发出声音。
但是，无论此设置如何，乐器上的键盘演奏数据都会作为 MIDI 消息传输。此外，音源模块会处理 MIDI 输入消息。
设置 ：Off、On

MIDI I/O Channel
为 Common 声部和 Keyboard Control Switch 设置为 On 的声部的输入和输出设置 MIDI 通道。
设置 ：Ch1–Ch16
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MIDI Sync
设置与连接的外接设备同步相关的参数。
选择本乐器的内部时钟、计算机或外接 MIDI 设备上 DAW 软件的外部 MIDI 时钟，或从 A/D INPUT 插孔输入的音频信号，用
于播放琶音、动态音序器、乐曲和模板。
设置 ：	 Internal、MIDI、A/D In (ABS)

Internal ：同步到内置时钟。用于单独使用本乐器或作为要同步到的其他设备的主时钟源。
MIDI ：同步到从外接 MIDI 设备接收的 MIDI 时钟。用于使用外接设备作为主时钟源。
A/D In (ABS) ：操作方法是使用 Audio Beat Sync 功能从 A/D INPUT 端口输入的音频信号提取速度。

Clock Out (MIDI Clock Out)
设置要传输的 MIDI 时钟信息。
设置 ：Off、On

Receive (Receive Sequencer Control)
接收用于开始和停止乐曲的 MIDI 消息。
设置 ：Off、On

Transmit (Transmit Sequencer Control)
发送用于开始和停止乐曲的 MIDI 消息。
设置 ：Off、On

Controller Hold/Reset
当您在演奏组之间切换时，设置是使用调制轮、触后力度、踏板控制器和呼吸控制器等控制器的当前设置 (Hold)，还是复
位为其初始设置 (Reset)。
设置 ：	 Hold、Reset

如果设置为 Reset，则当您在演奏组之间切换时，控制器会复位，如下所示 ：

弯音 中央

调制轮 最小值

触后 最小值

踏板控制器 最大值

脚踏开关 关闭

触摸条控制器 中央

呼吸控制器 最大值

表情 最大值

可指定开关 1 和 2 关闭

[KEYBOARD HOLD] 按钮 关闭

动态音序器的每个通道 当通道的 Motion Seq Polarity 设置为 Unipolar 时 ：值为 0（最小值）
当通道的 Motion Seq Polarity 设置为 Bipolar 时 ：值为 64（中央）

FS Assign (FootSwitch Assign Control Number)
设置通过连接至 FOOT SWITCH [ASSIGNABLE] 插孔的脚踏开关操作生成的控制变化编号。当此乐器从外接 MIDI 设备接收
到具有此处指定的相同控制变化编号的 MIDI 信息时，乐器会像已踩下脚踏开关一样工作。
设置 ：Off、1–95、Arp Sw、MS Sw、Play/Stop、Live Set+、Live Set–、Oct Reset、Tap Tempo
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Super Knob CC (Super Knob Control Change Number)
设置由超级旋钮操作生成的控制变化编号。
当此乐器从外接设备接收到具有此处指定的相同控制变化编号的 MIDI 信息时，乐器会像已按下超级旋钮一样工作。
设置 ：Off、1–95

注
当此参数设置为 Off 时，系统专用 (SysEx) 用于处理 MIDI 信息。

Scene CC (Scene Control Change Number)
设置在场景之间切换时生成的控制变化编号。
此外，当从外接 MIDI 设备接收到具有此处设置的相同控制变化编号的 MIDI 信息时，场景也会发生变化。
设置 ：Off、1–95

注
•	根据控制变化编号，将选择场景 1-8 之一。 

0–15: 场景 1、16–31 ：场景 2、32–47 ：场景 3、48–63 ：场景 4、64–79 ：场景 5、80–95 ：场景 6、96–111 ：场景 7、112–127 ：场景 8
•	如果 Super Knob CC 编号与 Scene CC 编号设置为相同的值，则编号前面会出现感叹号。在这种情况下，场景控制变化优先，禁用超级

旋钮控制变化。

Control Number
在 Common Edit 画面上打开 Control → Control Number。
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Advanced
在 Advanced 画面上，您可以对乐器进行详细设置。

操作
[UTILITY] → Settings → Advanced

Audition Lock
打开或关闭试听锁定。当设置为 On 时，禁用试听功能。
设置 ：Off、On

Audition Loop
当此项设置为 On 时，将循环播放试听乐句。
当此项设置为 Off 时，试听乐句的播放将在播放至结尾后自动停止。
设置 ：Off、On

Kbd Hold Lock (Keyboard Hold Lock)
打开或关闭 Keyboard Hold 功能。设置为 On 时，将禁用 Keyboard Hold 功能。
此功能与 [KEYBOARD HOLD] 按钮协同工作。
设置 ：Off、On

Auto Power Off (Auto Power Off Time)
为避免因不小心让乐器开启而产生不必要的电力消耗，自动关机功能会在乐器处于不操作状态一段时间后，自动关闭乐器的
电源。
在这里，可以设置一段时间，在这段时间之后乐器会自动关闭。
设置 ：Off （禁用自动关机）、5min、10min、15min、30min、60min、120min

Device Number
设置 MIDI 设备编号。为了向外接 MIDI 设备发送和从外接设备接收系统专用信息（例如批量转储和参数更改），您需要设置
此编号来匹配另一台设备的设备编号。
设置 ：1–16、All、Off
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Bank Select (Receive/Transmit Bank Select)
设置乐器和外接 MIDI 设备之间的库选择信息的接收和发送。
当此参数设置为 On 时，乐器将接收或识别从外接 MIDI 设备发送的库选择信息。
设置 ：Off、On

Pgm Change (Receive/Transmit Program Change)
设置乐器和外接 MIDI 设备之间的程序变更信息的接收和发送。
当此参数设置为 On 时，乐器将接收或识别从外接 MIDI 设备发送的程序变更信息。
设置 ：Off、On

Receive Bulk
设置批量转储信息的接收。
设置 ：Protect （不接收）、On （接收）

Bulk Interval
设置当本仪器从外接设备接收到批量请求信息时发送批量数据的间隔时间。
设置 ：0–900ms

Sequencer Event Chase (Song Event Chase)
此选项可确保在从中间播放乐曲或执行前进（快进）和后退（快倒）操作时可正确识别指定事件。
设置了 MIDI Event Chase 的事件可在执行前进和后退操作时正常运行。
设置 ：Off、PC (Program Change)、PC+PB+Ctrl (Program Change+Pitch Bend+Control Change)

Init On Boot (Initialize User Data on Boot-up)
设置启动时是初始化用户数据 (On) 还是不初始化用户数据 (Off)。
设置 ：Off、On

Audio I/O Mode
切换从 USB [TO HOST] 端口输出音频信号的输出模式。
必须重新启动乐器才能使此设置生效。
设置 ：	 5 Stereo/44.1kHz、1 Stereo/44.1–192kHz

5 Stereo/44.1kHz ：最多 10 个通道（5 个立体声通道），采样频率为 44.1kHz
1 Stereo/44.1-192kHz ：最多 2 个通道（1 个立体声通道），采样频率为 44.1kHz 至 192kHz

注
当设置为 1 Stereo/44.1-192kHz 时，可用频率为 ：44.1/48/96/192kHz。

Legacy Mode
如果您想使用 MIDI 1.0 而不是 MIDI 2.0，请将此项设置为 On。
必须重新启动乐器才能使此设置生效。
设置 ：Off、On

Initialize Advanced Settings
初始化 Advanced 画面上的设置。
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System
在 System 画面上，您可以设置整个乐器的相关参数。

操作
[UTILITY] → Settings → System
[UTILITY] + [DAW REMOTE]（→ Calibrate Touch Panel 设置）

Power on Mode
设置打开乐器时画面上显示的屏幕。
设置 ：Perform、Live Set

Calibrate Touch Panel
打开触摸屏校准画面。当触摸屏未正确响应时使用此选项。

Initial Live Set Bank (Initial Live Set Bank)
Initial Live Set Page (Initial Live Set Page)
Initial Live Set Slot (Initial Live Set Slot)
当 Power on Mode 设置为 Live Set 时，可以确定在启动后要立即选择的 Live Set 插槽。
注
您还可以通过以下方式设置插槽 ：在 Live Set 画面上选择演奏组，打开此画面，然后点击 Set Current Slot 按钮。

Set Current Slot (Set Current Slot to Initial Live Set)
将当前演奏组设置为启动后选择的 Live Set 插槽。

Initialize All Settings
初始化所有 Utility 画面设置。

Animation
设置在画面切换时动画是开启还是关闭。
设置 ：Off、On
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Beep
打开或关闭触摸屏操作声音。
设置 ：Off、On

Part Display
设置 Part Name 以显示类别和声部类型或仅显示声部名称。
设置 ：Type、Name

Live Set Font
确定 Live Set 画面和 Category Search 画面上内容名称和类别名称的字体大小。
设置 ：Normal、Large

Initialize User Data
初始化用户存储器中的所有用户区域数据（演奏组、动态音序、Live Set 等）以及 Utility 画面上的所有设置。

Knob Flash (Super Knob LED Blink)
打开或关闭超级旋钮的闪烁。
设置 ：Off、On

KnobBrightness
设置超级旋钮的发光亮度。
设置 ：0–128

Half Glow (LED Half Glow Brightness)
控制按钮灯的调光。
设置 ：Off、1/4、1/2

Perf Inc/Dec
设置在 Home 画面上切换演奏组的方式。
设置 ：	 Default、Live Set

Default ：按照 Performance Category Search 画面上的演奏组列表的顺序切换
Live Set ：按照 Live Set 插槽的顺序切换。

Initialize All Data
初始化用户存储器中的所有数据和 Utility 画面设置。

Product Info
显示乐器的固件版本。

须知
初始化会覆盖写入所有目标数据并将系统设置恢复为出厂设置。
小心不要丢失重要数据。我们还建议提前将必要的设置保存到USB闪存。
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Contents

Load
使用 Load 画面加载文件和内部数据。

操作
[UTILITY] → Contents → Load
[SHIFT] + [STORE]

Content Type
从 USB 闪存上保存的单个文件或乐器上存储的设置加载所有数据或一组特定数据。在这里，您可以选择要加载文件中的哪
一组数据。
可用的设置根据您打开画面所遵循的路径而有所不同。
设置 ：可以加载的文件类型如下。

内容类型 设备类型 文件扩展名 说明

User File 文件 .Y2U
(.Y2W)
.X7U
.X8U

•	保存在 USB 驱动器上的用户文件加载到用户存储器的用户区
域中。

•	如果分割了用户文件，.Y2U 和 .Y2W 都必须存储在 USB 驱动 
器上。

•	用户文件中包括以下设置。 
演奏组、琶音、动态音序、曲线、Live Set、微调、波形、 
试听、工具设置（仅限 .Y2U）、快速设置（仅限 .Y2U）

Library File 文件 .Y2L
(.Y2M)
.X7L
.X8L

•	保存在 USB 驱动器上的库文件加载到用户存储器的库区域中。
•	如果分割了库文件，.Y2L 和 .Y2M 都必须保存在 USB 驱动器上。
•	库文件中包括以下设置。 

演奏组、琶音、动态音序、曲线、Live Set（仅限 1 个库）、 
微调、波形、试听
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内容类型 设备类型 文件扩展名 说明

Backup File 文件 .Y2A
(.Y2B)
.X7A
.X8A

•	USB 驱动器上保存的备份文件加载到用户存储器中。
•	备份文件包括用户和库区域中的所有内容，以及乐曲和模板。
•	如果分割了备份文件，.Y2A 和 .Y2B 都必须保存在 USB 驱动 

器上。

Song&Perf
(Song & Performance)

内部数据 •	仅从用户存储器的用户区域存储的乐曲中加载指定的乐曲。
•	MIDI 音序和演奏组都可以加载。

Song 内部数据 •	仅从用户存储器的用户区域存储的乐曲中加载指定的乐曲。
•	仅可加载 MIDI 音序。

.mid File 文件 .MID 加载保存在 USB 驱动器上的标准 MIDI 文件 (SMF)（格式 0 或 
格式 1）。

.wav File 文件 .WAV 加载保存在 USB 驱动器上的音频文件。

Pattern&Perf
(Pattern & 
Performance)

内部数据 •	仅从用户存储器的用户区域存储的模板中加载指定的模板。
•	MIDI 音序和演奏组都可以加载。

Pattern 内部数据 •	仅从用户存储器的用户区域存储的模板中加载指定的模板。
•	仅可加载 MIDI 音序。

Audio File* 文件 .WAV
.AIF

保存在 USB 驱动器上的音频文件加载为波形。
示例：[PERFORMANCE (HOME)] → [EDIT/ ] → Part 选择 → 
Element 选择 → Osc/Tune

Motion Seq
(Motion Sequence)*

内部数据 仅从用户存储器的用户区域保存（存储）的动态音序中加载指定
的音序。

Smart Morph* 内部数据 仅从用户存储器的用户区域中保存（存储）的演奏组中加载智能
变形数据。

注
从 Utility 画面打开此画面时，不会显示标有星号 (*) 的内容类型。

Parent Folder Name
Current Folder Name
指示父文件夹的名称和当前文件夹的名称。
点击父文件夹名称后，它就是当前文件夹。

Job
设置作业功能是启用（亮起）还是禁用（熄灭）。
开启此参数后，点击当前文件、文件夹或内容会调出 Rename 或 Delete 上下文菜单。
点击连接的 USB 闪存时，会调出 Format 上下文菜单。
设置 ：Off、On



377MODX M 使用说明书

Free Storage
指示所选存储的已用容量和总容量。
指示因内容类型而异。

文件夹和文件选择
指示当前文件夹内的文件夹和文件。

Sort
设置文件选择中的文件的排序顺序。
设置 ：	 Name、Size、Date、Default （取决于内容类型）

Name：按名称排序。向下箭头表示列表按升序排列（A 至 Z）。向上箭头表示列表按降序排列。
Size：按照数据大小顺序排序。向下箭头表示列表按升序排列（从小到大）。向上箭头表示列表按降序排列。内容
类型无效 Motion Seq、Song、Song&Perf、Pattern、Pattern&Perf、Performance、Smart Morph
Date：按设置的存储日期排序。向下箭头表示列表按降序排列（从新到旧）。向上箭头表示列表按升序排列。仅当
内容类型为 Motion Seq、Song、Song&Perf、Pattern、Pattern&Perf、Performance、Smart Morph 时，此参
数才可用。
Default ：按内容编号升序排序。仅当内容类型为 Song、Song&Perf、Pattern、Pattern&Perf、Performance、
Motion Seq、Smart Morph 时，此参数才可用。

Mode
选择加载模式。
仅为 User File 或 Library File 显示此项。
设置 ：	 Default、1 Perf

Default ：加载所有演奏组
1 Perf ：仅加载指定的演奏组

Key (Center Key)
选择要为其分配已加载的 WAV 或 AIFF 的键位。
仅为音频文件显示此选项。
设置 ：Keyboard Select (C–2 –G8)、All

Keyboard Select
设置是否通过键盘操作更新 Center Key。
仅为音频文件显示此选项。

Page
如果文件选择中出现的文件无法容纳在单个页面上时，会出现一个滚动按钮，让您可以选择页面。您也可以使用显示旋钮选
择页面。
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Save
在 Save 画面上，您可以保存文件和内部数据。
此画面与 Load 画面基本相同。

操作
[UTILITY] → Contents → Save

Content Type
可以检索存储在 USB 驱动器或主机上的文件中的所有数据或指定的部分数据，并将其加载到乐器中。
在这里，您可以设置要存储或保存的数据。
可用的设置根据您打开画面所遵循的路径而有所不同。
设置 ：下表显示了可以存储或保存的内容类型。

内容类型 设备类型 文件扩展名 说明

Performance 内部数据 将演奏组保存（存储）到用户存储器的用户区域。

User File 文件 .Y2U
(.Y2W)

•	保存（存储）在用户存储器的用户区域中的设置将作为用户文
件保存到 USB 驱动器中。

•	用户文件中包括以下设置。 
演奏组、琶音、动态音序、曲线、Live Set、微调、波形、试
听、工具设置、快速设置

•	当文件大小超过 2GB 且文件已分割时，.Y2U 和 .Y2W 必须作为
一组进行处理。

Library File 文件 .Y2L
(.Y2M)

•	保存（存储）在用户存储器的库区域中的设置将作为库文件保
存到 USB 驱动器中。

•	库文件中包含的设置如下（除工具设置外，与用户文件相同）： 
演奏组、琶音、动态音序、曲线、Live Set（仅限 1 个库）、微
调、波形、试听

•	当文件大小超过 2GB 且文件已分割时，.Y2L 和 .Y2M 必须作为
一组进行处理。

Backup File 文件 .Y2A
(.Y2B)

•	存储在用户存储器中的设置将作为备份文件保存到 USB 驱动
器中。

•	备份文件包括用户和库区域中的所有内容，以及乐曲和模板。
•	当文件大小超过 2GB 且文件已分割时，.Y2A 和 .Y2B 必须作为

一组进行处理。
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内容类型 设备类型 文件扩展名 说明

.mid File 文件 .MID 存储在用户存储器的乐曲和模板区域中的 MIDI 数据将作为标准
MIDI 文件（SMF ；仅格式 1）保存到 USB 驱动器。

Motion Seq
(Motion Sequence)*

内部数据 将正在编辑的动态音序存储（保存）到用户区域。

注
从 Utility 画面打开此画面时，不会显示标有星号 (*) 的内容类型。
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Data Utility
在 Data Utility 画面上，您可以管理用户存储器中的文件和数据。
此画面与 Load 画面基本相同。

操作
[UTILITY] → Contents → Data Utility

Folder select
将用户存储器中的内容类型显示为文件夹。点击要打开的文件夹。
内容类型：�Arp、Audition、Curve、Library、Live Set、Micro Tuning、Motion Seq、Pattern、Performance、Song、

Waveform

Content Select
点击内容会调出 Rename、Delete 上下文菜单。
当 Job 设置为 On 时，会显示以下三项。

Select All
选择文件夹中的所有内容。
未选择任何内容时显示。

Unselect All
取消选择文件夹中的所有内容。
选择了任何内容时显示。

Delete
删除所有选定的内容。
选择了任何内容时显示



381MODX M 使用说明书

Library Import
此功能从库中选择特定的演奏组并将其复制到用户库。
此画面与 Load 画面基本相同。

操作
[UTILITY] → Contents → Library Import

Select All
选择当前库文件夹中的所有演奏组。
仅当未选择任何演奏组时才显示。

Unselect All
取消选择当前库文件夹中的所有演奏组。
仅当选择了任何演奏组时才显示。

Import to User Bank
将所选演奏组复制到用户库。
执行此操作时，所选演奏组中使用的用户波形和用户琶音、用户曲线、用户微调和用户试听也会复制到用户库中。
仅当选择了任何演奏组时才显示。



382MODX M 使用说明书

Tempo Settings

在 Tempo Settings 画面上，您可以设置与速度和同步相关的参数。

操作
[TEMPO/TAP]
[UTILITY] + Tempo Settings
点击 TEMPO SETTING 图标

Tempo
设置演奏组速度。
如果 MIDI Sync 设置为 MIDI 或 A/D In (ABS)，且已与外接设备同步，则会显示 Ex.Tempo，而不是显示设置值。
设置 ：5–300

Knob Flash (Super Knob LED Blink)
打开或关闭超级旋钮的闪烁。
设置 ：Off、On

Global Tempo
当此参数设置为 Off 时，将为每个演奏组使用速度设置。
设置为 On 时，即使更改演奏组也会保留当前速度。
设置 ：Off、On

Tap Tempo
通过点击此区域或当存在光标时按下（点击）[ENTER] 按钮，您可以将速度设置为击拍速度或按压速度。
您也可以使用 [TEMPO/TAP] 按钮以相同的方式设置速度。
但是，当 MIDI Sync 设置为 MIDI 且乐器设置为与外接设备同步时，此参数不可用。
注
如果将 MIDI Sync 设置为“A/D In (ABS)”，则速度将发生变化，以击拍作为节拍的开始。
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MIDI Sync
设置与连接的外接设备同步相关的参数。
您可以选择是使用乐器的内置时钟、使用已连接到本乐器的 DAW 软件或 MIDI 设备的时钟（外部时钟），还是使用从 A/D 
INPUT 端口输入的音频信号来播放琶音、动态音序器和乐曲。
设置 ：	 Internal、MIDI、A/D In (ABS)

Internal ：同步到内置时钟。用于单独使用本乐器或作为其他设备的主时钟源。
MIDI ：同步到从外接 MIDI 设备接收的 MIDI 时钟。用于使用外接设备作为主时钟源。
A/D In (ABS) ：操作方法是使用 Audio Beat Sync 功能从 A/D INPUT 端口输入的音频信号提取速度。

Clock Out (MIDI Clock Out)
设置要传输的 MIDI 时钟信息。
设置 ：Off、On

Sync Quantize (Arpeggio Synchro Quantize Value)
调节在播放多个声部的琶音时开始下一个琶音的时机。如果设置为 Off，则在键盘上弹奏声部时会播放琶音。
设置 ：	 Off、60（三十二分音符）、80（十六分音符三连音）、120（十六分音符）、160（八分音符三连音）、240（八分音

符）、320（四分音符三连音）、480（四分音符）

Mode (Click Mode)
设置播放节拍声（节拍器声音）的时间。
设置 ：	 Off、Rec、Rec/Play、Always

Off：不弹奏节拍声。
Rec ：在乐曲或模板录制期间弹奏节拍声。
Rec/Play ：在乐曲或模板录制和播放期间弹奏节拍声。
Always ：始终弹奏节拍声。

注
使用内置音源弹奏节拍声，因此会使用部分同时发声输出。

Precount (Click Precount)
设置在录制乐曲或模板时，从按 []（播放）按钮到实际开始录音为止的预备拍小节数。
设置 ：Off（按 []（播放）按钮时开始录音）、1meas–8meas

Volume (Click Volume)
设置节拍声的音量。
设置 ：0–127

Beat (Click Beat)
设置播放节拍声时的节拍。
设置 ：1/16（十六分音符）、1/8（八分音符）、1/4（四分音符）、1/2（二分音符）、Whole（全音符）

Type (Click Type)
选择节拍声的类型。
设置 ：1–10

Click Out (Click Output Select)
设置节拍声的输出目的地。
设置 ：	 MainL&R、(AsgnL&R)、USB Stereo、(AsgnL)、(AsgnR)、USB mono

MainL&R：以立体声（两个通道）输出到 OUTPUT [L/MONO] 和 OUTPUT [R] 插孔。
USB Stereo ：以立体声（通道 1 和 2，至通道 7 和 8）输出到 USB [TO HOST] 端口。
USB mono ：以单声道（通道 1 至 8）输出至 USB [TO HOST] 端口。

注
与 MONTAGE M 设备数据兼容的相关设置如下所示。在设置时，这些设置视为 Off。
•	AsgnL&R
•	USB Stereo ：USB9&10 – USB29&30
•	USB mono ：USB9 – USB30
•	AsgnL
•	AsgnR
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Effect Switch

在 Effect Switch 画面上，您可以设置与效果器绕过相关的参数。
此画面上的设置不会保存（存储），因此当乐器重新启动时，设置会复位为默认值。

操作
[UTILITY] → Effect Switch
点击 EFFECT 图标 ( FX )
[SHIFT] + [QUICK SETUP]

Insertion FX (Insertion Effect)
打开或关闭插入效果器。
设置 ：Off、On

System FX (System Effect)
打开或关闭系统效果器。
设置 ：Off、On

Master FX (Master Effect)
打开或关闭主控效果器。
设置 ：Off、On

Master EQ
打开或关闭主 EQ。
设置 ：Off、On

Arp Bypass (Arpeggio Bypass)
打开或关闭琶音绕过。当此参数设置为 On 时，禁用所有琶音操作。
设置 ：Off、On

注
•	当 Arp Bypass 设置为 On 时，[ARP] 按钮会闪烁。
•	当 Arp Bypass 设置为 On 时，如果更改每个声部的琶音开关，Arp Bypass 将设置为 Off。
•	使用琶音功能录制的乐曲将在数据中包括琶音音序。如果您继续在 DAW 软件中编辑乐曲数据，将 Arp Bypass 设置为 On 可防止琶音器

产生双重效果。
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Kbd Ctrl Lock (Keyboard Control Lock)
打开或关闭键盘控制的锁定。
设置为 On 时，会激活锁定，并且会禁用所有声部的 Keyboard Control。将其关闭可解锁键盘控制。
对于单独创建或编辑每个 MIDI 音轨（例如，当使用 DAW 软件将乐器用作 16 声部多音色声音模块时），此选项非常有用。
设置 ：Off、On

注
当 Kbd Ctrl Lock 设置为 On 时，如果您更改每个声部的 Keyboard Control SW，Kbd Ctrl Lock 将设置为 Off。

Global A/D
当此参数设置为 On 时，如果在演奏组之间切换，A/D 声部的音量不会改变，并且与 A/D 声部相关的其他参数也不会改变。
当此参数设置为 Off 时，如果在演奏组之间切换，音量会更改为演奏组特定的设置，并且与 A/D 声部相关的其他参数会改变。
Master FX 和 Master EQ 同时打开和关闭。
设置 ：Off、On
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Other Info

Other Info 画面上显示了其他信息。

Shift Function
显示同时按 [SHIFT] 按钮和其他按钮时的快捷操作列表。

Legal Notices
显示版权等内容。
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按特定按钮时显示的画面

面板锁定

使用面板锁定功能可防止现场演奏期间出现意外操作。

操作
显示 Home 画面或 Live Set 画面时，按 [SHIFT]+[TEMPO/TAP]

	�有效操作
键盘、踏板、主音量、超级旋钮、弯音轮、调制轮、触摸条控制器和面板锁定解除

	�无效操作
所有其他操作，包括触摸屏操作

如何解除面板锁定
要解锁面板，请再次按住 [SHIFT] 按钮，同时点击 [TEMPO/TAP] 按钮以解锁面板。
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Split Job

设置分割。

操作
按 [SPLIT] 按钮。

Split Points
指定分割点的数量。
设置 ：Off、1–3

Split Point 1–3
指定用于分割点的键位。
当 Keyboard 设置为 On 时，您还可以使用键盘指定分割点位置。
设置 ：C#–2 – G8

Part Name
点击声部名称会调出 Category Search 和 Delete 的上下文菜单。

[+](Add)
点击可显示 Part Category Search 画面或 Performance Merge 画面，让您可以添加声部。

Group A–D
按组按钮将声部分配到组中。
按住 [SHIFT] 按钮的同时点击组按钮，将单个声部分配到多个组。

× (Cancel)
取消组分配。

Done
确认设置并关闭画面。
注
点击左上角的 ×（关闭），可以在不确认其他设置的情况下关闭画面，但添加、删除或更改声部的操作除外。
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Note Range

操作
[SHIFT] + [SPLIT]

Home 画面上会显示 Part - Note 视图。
光标将移动到所选声部的 TG Note Limit Low，并且您可以在键盘上输入音符范围的下限。

Navigation

操作
按 [NAVIGATION] 按钮

（在 Home 画面的 View Mode 设置为 Default 的情况下）点击画面上显示的 Navigation

点击图标调出相应的设置画面。
此外，在编辑过程中按 [NAVIGATION] 按钮会调出当前位置图标 ( )。

从 Navigation 画面，您不仅可以跳转到音素，还可以跳转到 Part Common 的 Filter 和 Amp EG。
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FX Overview

在 FX OVERVIEW 画面上，您可以检查效果器设置的状态并轻松访问高级设置画面。

操作
[SHIFT] + [NAVIGATION]

（在 Home 画面的 View Mode 设置为 Default 的情况下）点击画面上显示的 Fx Overview

切换显示的声部
切换要显示的声部。
设置 ：1–4、5–8、9–12、13–16、A/D In

All Ins
打开或关闭所有插入效果器（A 和 B）。
设置 ：Off、On

Var + Rev
打开或关闭变奏效果器和混响效果器。
设置 ：Off、On

Ins A、Ins B、Var、Rev、MFX、MEQ
显示相应的详细设置画面。

Effect switch
打开或关闭各个效果器。
设置 ：Off、On

Type
设置每个效果器的类型。
设置 ：请参阅效果器类型

Preset
设置每个效果器的预置。
设置 ：请参阅 Data List
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Store

这是在用户区域中保存（存储）当前演奏组时的确认画面。

Store As New Performance
注册为新演奏组。

Update Current Live Set Slot
当选择用户 Live Set 库中的某个插槽时，将出现一条消息来确认 Live Set 插槽更新。要继续更新，请选中该框并选择 Store 
As New Performance。

Overwrite Current Perf.
保存您正在编辑的演奏组，覆盖画面上显示的现有设置（Bank、MSB、LSB 和程序变更编号）。

Jump to Data Utility
由于 Performance full 等错误而无法保存时显示。
使用 [UTILITY] → Contents → Data Utility 来显示该画面。
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DAW Remote

按 [DAW REMOTE] 按钮启用 DAW 远程功能，让您可以使用乐器上的控制器方便地控制您喜欢的 DAW。

操作
[DAW REMOTE]

Mode (Remote Control Mode)
从三种操作模式中选择 DAW 远程功能。
设置 ：	 Track、Plugin、Transport

Track ：同时控制 DAW 上多个音轨的模式。旋钮和控制滑杆操作作为 Mackie Control 兼容协议从端口 2 发送。
Plugin：该模式用于控制 DAW 上的特定插件。对于来自端口 1 的 Remote 功能，旋钮和控制滑杆操作作为消息发
送，采用 CC Number 格式。
Transport ：该模式在播放 DAW 上录制的数据时弹奏键盘，或在 DAW 上录制键盘演奏。您可以使用音序器传送
按钮在 DAW 上开始或停止播放。除音序器传送按钮外的所有控制器均按正常方式操作。

切换画面
打开每个控制器和远程功能的设置画面。
设置 ：Knob/Slider、Scene Sw、Display Knob、AS、Pedal、Settings

Local Control
打开或关闭本地控制。
这与可在 [UTILITY] → Settings → MIDI I/O 中设置的内容相同。

Use for Remote Cursor / Dial
设置是否使用上方面板中的数据轮和光标按钮来控制 DAW。
On：用于控制 DAW。
Off：用于控制上方面板上的主画面。

Track (Track Select)
输出音轨组选择（一次八个音轨）。
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用于使用控制器

	� Track 模式

控制器

(1) (2)

(3) (4) (5)

(6)

(7)

(4)

控制器 DAW操作

(1) [ASSIGN] 按钮 声相像选择 (1 – 4 / 5 – 8)

(2) 旋钮 1 – 4 (5 – 8) 音轨声相从 Port2 输出

(3) 控制滑杆 1–8 音轨音量从 Port2 输出

(4) PART 按钮，[PART SELECT] 按钮 选择音轨，以及打开或关闭所选音轨的静音和独奏。

(5) 场景按钮 功能 1–8 从 Port2 输出

(6) 数据轮、光标按钮 移动光标位置或乐曲位置。

(7) 音序器传送按钮。 
[SONG/PATTERN] 按钮

控制走带操作（录制和播放）。

其他控制器设置为发送在远程模式下设置的控制变化信息。
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	� Plugin 模式

控制器

(1) (2)

控制器 DAW操作

(1) [ASSIGN] 按钮 旋钮选择 (1 – 4 / 5 – 8)

(2) 旋钮 1 – 4 (5 – 8)，控制滑杆 1–8，SCENE 按
钮，显示旋钮

您选择的任何控制变化。
（将会输出在 DAW Remote 画面上的 Edit 中设置的 CC 编号。）

PART 按钮、[PART SELECT] 按钮、[KEYBOARD CONTROL] 按钮、数据轮、光标按钮、音序器传送按钮、BANK 按钮和
PAGE 按钮的操作方式与 Track 模式相同。



395MODX M 使用说明书

	� Transport 模式

控制器

(1)

(2)

控制器 DAW操作

(1) 数据轮、光标按钮 移动光标位置或乐曲位置。

(2) 音序器传送按钮。 
[SONG/PATTERN] 按钮

控制走带操作（录制和播放）。

其他控制器按正常方式操作。
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在 Edit期间

Edit
设置从端口 1 输出的控制变化信息，例如控制编号和通道模式。
每个选项卡上的设置如下 ：

	� Common
Local (Local Control)
打开或关闭本地控制。
这与可在 [UTILITY] → Settings → MIDI I/O 中设置的内容相同。

Use for Remote Cursor / Dial
设置是否使用上方面板中的数据轮和光标按钮来控制 DAW。
On：用于控制 DAW。
Off：用于控制上方面板上的主画面。

	� Knob / Slider
CC Num. (Control Change Number)
设置旋钮和控制滑杆的控制编号。
设置 ：1–95

	� Scene SW
Scene1–8CC# (Scene 1–8 Control Number)
设置场景按钮的控制编号。
设置 ：1–95

Latch/Momentary (Scene 1–8 Switch Mode)
切换场景按钮的操作模式。
设置 ：Momentary、Latch

	� Display Knob
DispKnob 1–6CC# (Display Knob 1–6 Control Number)
设置显示旋钮的控制编号。
设置 ：1–95

AS 
Porta Sw CC# (Portamento Switch Control Number)
设置 [PORTAMENTO] 按钮的控制编号。
设置 ：1–95

Latch/Momentary (Portamento Switch Mode)
切换 [PORTAMENTO] 按钮的操作模式。
设置 ：Momentary、Latch

Porta Knob CC# (Portamento Knob Control Number)
设置 PORTAMENTO [TIME] 旋钮的控制编号。
设置 ：1–95
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AssignSw 1 CC# (Assignable Switch 1 Control Number)
AssignSw 2 CC# (Assignable Switch 2 Control Number)
MS Trigger CC# (Motion Seq Trigger Switch Control Number)
设置 [ASSIGN 1] 按钮、[ASSIGN 2] 按钮和 [MSEQ TRIGGER] 按钮的控制编号。
设置 ：1–95

Assign SW 1 Latch/Momentary (Assignable Switch 1 Mode)
Assign SW 2 Latch/Momentary (Assignable Switch 2 Mode)
MS Trigger Latch/Momentary (Motion Seq Trigger Switch Mode)
切换 [ASSIGN 1] 按钮、[ASSIGN 2] 按钮和 [MSEQ TRIGGER] 按钮的操作模式。
设置 ：Momentary、Latch

	� Pedal
FC 1 CC# (Foot Controller 1 Control Number)
FC 2 CC# (Foot Controller 2 Control Number)
设置踏板控制器 1 和踏板控制器 2 的控制编号。
设置 ：1–95

FS CC# (Foot Switch Control Number)
显示脚踏开关的控制编号。
设置 ：1–95

Latch/Momentary (Foot Switch Mode)
切换脚踏开关的操作模式。
设置 ：Momentary、Latch

	� Settings
DAW
选择与本乐器配合使用的特定 DAW。
设置 ：Cubase、Logic Pro、Pro Tools、Live

MIDI I/O Ch.
为 Common 声部和 Keyboard Control Switch 设置为 On 的声部的输入和输出设置 MIDI 通道。
此处设置的 MIDI 通道还用于从 DAW Remote 发送控制变化信息。
这与可在 [UTILITY] → Settings → MIDI I/O 中设置的内容相同。
设置 ：Ch1–Ch16
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Control Assign

在 Controller Set 中注册 Source 和 Destination 的组合。

操作
当在画面上选择可分配给控制器的参数时，按下 [CONTROL ASSIGN] 按钮。

操作用于调整目标参数的控制器，或在画面上选择 Motion Sequencer Lane、Envelope Follower 或 Ribbon。
注
•	当您移动超级旋钮但没有任何未使用的可指定旋钮来继续设置时，会出现错误消息。
•	当选定 Part 参数时，按住 [COMMON] 按钮的同时操作可指定旋钮以选择 Common 的可指定旋钮。
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Control View

您可以检查正在操作的控制器的设置。

操作
[SHIFT] + [CONTROL ASSIGN]

（在 Home 画面的 View Mode 设置为 Default 的情况下）点击画面上显示的 Control View。

操作您想要检查的控制器，或在画面上选择 Motion Sequencer Lane、Envelope Follower 或 Ribbon。Control Assign 画
面会打开，您可以在这里查看设置信息。
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7.	 其他信息

效果类型
No Effect 禁用效果。不输出声音。

Thru 将效果设置为 Thru。在不应用任何效果的情况下输出输入声。

Reverb
HD Hall 模拟音乐厅的自然声学效果。

REV-X Hall 使用 REV-X 混响算法的音乐厅混响

R3 Hall 使用 ProR3 数字混响处理器混响算法的音乐厅混响

SPX Hall 来自经典 SPX1000 的音乐厅混响

HD Room 模拟房间的自然声学效果。

REV-X Room 使用 REV-X 混响算法的房间混响

R3 Room 使用 ProR3 数字混响处理器混响算法的房间混响

SPX Room 来自经典 SPX1000 的房间混响

HD Plate 模拟板式混响。

R3 Plate 使用 ProR3 数字混响处理器混响算法的板式混响

SPX Stage 来自经典 SPX1000 的舞台混响。

Space Simulator 让您可以指定房间大小的宽度、高度和深度。

Gated Reverb 产生门控混响。

Reverse Reverb 产生门控混响的反向播放。

Shimmer Reverb 通过添加有音高变化的混响声音来创造神秘的闪烁效果。

Delay
Cross Delay 两个通道中的每一个通道的延迟声的反馈路由到对面的通道。

在右侧和左侧产生交替的延迟声。

Tempo Cross Delay 速度同步交叉延迟

Tempo Delay Mono 速度同步单声道延迟

Tempo Delay Stereo 速度同步立体声延迟

Control Delay 这种延迟可通过实时更改延迟时长来创建刮擦声音。

Delay LR 在左侧和右侧产生两个延迟声，并具有两个反馈延迟。

Delay LCR 在左侧、中央和右侧产生三个延迟声。

Analog Delay Retro 模拟水桶接力式模拟延迟，设置为长延迟，
设置为短延迟。

Analog Delay Modern 模拟水桶接力式模拟延迟，设置为长延迟，
设置为长延迟。
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Chorus
G Chorus 通过复杂的调制发出深沉的声音。
2 Modulator 让您可以设置音高调制和振幅调制。自然地传播声音。
SPX Chorus 使用三相 LFO 为声音添加调制和空间感的叠奏效果。
Symphonic 通过多重调制来创造更宽敞的音效。
Ensemble Detune 通过添加稍微变调的声音来营造无调制叠奏效果。

Flanger
VCM Flanger 采用 VCM 技术的镶边
Classic Flanger 具有典型环绕声音的镶边
Tempo Flanger 具有速度同步 LFO 的镶边
Dynamic Flanger 根据输入声音的电平实时控制延迟调制的镶边。
Control Flanger 允许手动操作而不是使用 LFO。

Phaser
VCM Phaser Mono 采用 VCM 技术的单声道移相器
VCM Phaser Stereo 采用 VCM 技术的立体声移相器
Tempo Phaser 具有速度同步 LFO 的移相器
Dynamic Phaser 根据输入声音的电平实时控制相位的效果。
Control Phaser 允许手动操作而不是使用 LFO。

Trem/Rtr (Tremolo & Rotary)
Auto Pan 左右移动声像。
Tremolo 使音量产生周期性变化。
Rotary Speaker 1 模拟旋转扬声器。
Rotary Speaker 2 模拟包括放大器的旋转扬声器。
VCM Rotary Speaker 
Classic

采用 VCM 技术的标准旋转扬声器效果。适合风琴。

VCM Rotary Speaker 
Overdrive

采用 VCM 技术的旋转扬声器效果。模拟连接了晶体管前置放大器的旋转扬声器的失真声音。

VCM Rotary Speaker 
Studio

采用 VCM 技术的旋转扬声器效果，具有三维旋转功能。

Dist (Distortion)
Amp Simulator 1 模拟吉他放大器。
Amp Simulator 2 模拟吉他放大器。
Comp Distortion 结合压缩器和失真。
Comp Distortion 
Delay

结合压缩器、失真和延迟。

U.S. Combo 美式组合功放模拟器
Jazz Combo 爵士乐组合功放模拟器
U.S. High Gain 美式高增益功放模拟器

British Lead 英式堆栈功放模拟器
Multi FX 吉他的复合音色效果处理器
Small Stereo 吉他声音的立体声失真
British Combo 英式组合功放模拟器
British Legend 英式堆栈功放模拟器
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Comp (Compressor)
VCM Compressor 376 采用 VCM 技术的压缩器

Classic Compressor 简单、易于使用的压缩器。适合独奏乐器。

Multi-band Comp 将声音分成三个频段，并在这些频段上单独应用压缩器。

Uni Comp Down 采用向下算法来抑制响亮声音的压缩器。

Uni Comp Up 采用向上算法来放大柔和声音的压缩器。

Parallel Comp 应用压缩声音和干声并行处理的压缩器。

Wah
VCM Auto Wah 采用 VCM 技术的自动哇音。让滤波器中心频率产生周期性变化。

VCM Touch Wah 采用 VCM 技术的碰触哇音。根据输入声音的电平更改滤波器的中心频率。

VCM Pedal Wah 采用 VCM 技术的踏板哇音。通过操作踏板等控制器来改变滤波器的中心频率。

Lo-Fi
Lo-Fi 降低音频输入的质量来获得 Lo-Fi 声音。

Noisy 为声音添加噪音。

Digital Turntable 为声音添加唱片机噪音。

Bit Crusher 通过降低数字声音的分辨率或带宽来产生失真。

Tech
Ring Modulator 将输入更改为金属声。

Dynamic Ring 
Modulator

根据输入声音的电平实时控制环形调制器的 OSC Freq 参数。

Dynamic Filter 根据输入声音的电平实时控制滤波器截止频率。

Auto Synth 使用延迟和调制重新合成输入信号。

Spiralizer P 基于特殊移相器的滤波器，能够实现似乎无尽的上升或下降音高变化。

Tempo Spiralizer P 具有速度同步 LFO 的 Spiralizer

Spiralizer F 基于特殊镶边的滤波器，能够实现似乎无尽的上升或下降音高变化。

Tempo Spiralizer F 具有速度同步 LFO 的 Spiralizer

Isolator 使用强大的滤波器控制每个频段的音量。

Slice 对输入声音的振幅 EG 进行分割。

Tech Modulation 应用特殊调制。

Control Filter 允许手动操作截止频率的滤波器。

Vinyl Break 使音高逐渐下降，从而产生用手停止唱片机或关闭设备的声音效果。

Beat Repeat (even) 通过重复播放采样声音来产生机械节拍。重复的长度指定为节拍的分数，分母为偶数，例如 1/2、
1/4、1/8、1/16 等。

Beat Repeat (triplet) 通过重复播放采样声音来产生机械节拍。重复的长度指定为节拍的分数，分母为三的倍数，例如
1/3、1/6、1/12 等。

Beat Repeat 
(even+tri.)

通过重复播放采样声音来产生机械节拍。
包含偶数和三重设置。

Beat Repeat (free) 通过重复播放采样声音来产生机械节拍。重复的长度指定为小数。
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Misc
VCM EQ 501 采用 VCM 技术的 5 频段 EQ

Presence 为输入声音提供更大的声音临场感。

Harmonic Enhancer 添加谐波泛音来使输入声音突出。

Stereophonic 
Optimizer

调整声场中的立体声位置。

Talking Modulator 重新合成输入声音来产生元音共振峰。

Wave Folder 控制谐波泛音来产生随时间变化的丰富声音。

VCM Mini Filter 增加声音厚度和深度的滤波器。对模拟合成器电路进行模拟。

VCM Mini Booster 具有鲜明特征的助推器。对模拟合成器电路进行模拟。

Damper Resonance 模拟原声钢琴的空弦音符的共鸣。

Pitch Change 更改输入声音的音高。

Early Reflection 通过隔离混响的早期反射而产生的效果。

Vocoder 提取麦克声音中的特点并将其应用到键盘弹奏的声部。乐器的声音变得像机器人的声音。

NoiseGate+Comp+Eq 包含噪声门限、压缩器和 3 频段 EQ。
主要适合人声。
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效果参数

A
显示名称 参数名称 使用该参数的效果类型 说明

AEG Phase AEG Phase Slice 改变振幅包络发生器的相位。

AM Depth AM Depth 2 Modulator, Tremolo, 
Noisy, Auto Synth, Shimmer 
Reverb

设置振幅调制的深度。

AM Freq AM Frequency Shimmer Reverb 设置振幅调制速度。

AM Inverse R AM Inverse R Auto Synth 设置右通道振幅调制的相位。

AM LR Phase AM LR Phase Shimmer Reverb 设置左和右通道之间振幅调制的相位。

AM Speed AM Speed Noisy, Auto Synth 设置振幅调制速度。

AM Wave AM Wave Auto Synth 选择用于调制振幅的波形。

AM Waveform AM Waveforms Shimmer Reverb 选择用于调制振幅的波形。

Amp Type Amp Type Amp Simulator 2 选择要模拟的放大器类型。

Analog Feel Analog Feel Classic Flanger 在声音中添加模拟镶边的特点。

Attack Attack Comp Distortion, VCM 
Compressor 376, Classic 
Compressor, Downward 
Compressor, Upward 
Compressor

设置压缩器达到最大值所需的时间长度。

Attack Offset Attack Offset VCM Touch Wah 设置应用哇音效果所需的时间长度。

Attack Time Attack Time Dynamic Flanger, Dynamic 
Phaser, Dynamic Ring 
Modulator, Dynamic Filter

设置包络跟随器的起音时间。

Beat Repeat 设置应用于整个声音的 Gate 的 Attack 时间

B
显示名称 参数名称 使用该参数的效果类型 说明

Balance Balance U.S. Combo 调整低音和高音之间的平衡。

Bass Bass British Combo, British Lead, 
British Legend, Jazz Combo, 
U.S. High Gain

调整低音的音质。

Bit Bit Bit Crusher 降低位精度。

Bit Assign Bit Assign Lo-Fi 设置如何将 Word Length 应用于声音

Bit Link Bit Link Bit Crusher 设置当 M/S 打开时，与 Mid 值匹配的 Side 设
置的级别

BPF 1–10 Gain BPF1–10 Gain Vocoder 设置声码器效果的 BPF 1–10 的 Gain

Break Break Vinyl Break 将 Break 设置为 On

Brilliant Brilliant British Combo 调整切掉低音后的声音的音量。
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C
显示名称 参数名称 使用该参数的效果类型 说明

Chorus Chorus Jazz Combo 选择叠奏类型。

Click Density Click Density Digital Turntable 设置要重复的节拍声的频率。

Click Level Click Level Digital Turntable 设置节拍电平。

Clipper Clipper Upward Compressor, 
Downward Compressor

设置削波器的失真电平，该电平确定用于限制
波形的最大电平。

Clipper Source Clipper Source Upward Compressor, 
Downward Compressor

选择应用削波器效果的信号。

Color Color Control Phaser, VCM Phaser 
Mono, VCM Phaser Stereo

设置固定相位调制。

Com Release Common Release Multi Band Comp 设置在三个频段上通常使用的释音时间（压缩
器效果消失所需的时间）。

Comp Attack Comp Attack NoiseGate+Comp+Eq 设置要应用压缩器的时长。

Comp Level Comp Level Small Stereo 调整压缩器的输出电平。

Comp Out Lvl Comp Output 
Level

NoiseGate+Comp+Eq 设置压缩器的输出电平。

Comp Ratio Comp Ratio NoiseGate+Comp+Eq 设置压缩器的比率。

Comp Release Comp Release NoiseGate+Comp+Eq 设置压缩器效果消失所需的时长。

Comp Sustain Comp Sustain Multi FX, Small Stereo 调整压缩器维持的时长。

Comp Sw Comp SW Small Stereo 打开或关闭压缩器。

Comp Threshold Comp Threshold NoiseGate+Comp+Eq 设置要应用的效果的输入电平。

Compress Compress Comp Distortion Delay 设置要应用的压缩器的阈值（或最小输入电
平）。

Compression Compression Parallel Compressor 设置应用压缩器的程度。

Control Type Control Type Control Delay 当设置为 Normal 时，延迟效果始终应用于声
音。当设置为 Scratch 时，如果为 Delay Time
设置控制器值 0，则不会应用延迟效果。对其
他情况应用延迟。

Cross-Feedback Cross-Feedback Shimmer Reverb 设置第一条路径上的音高变化声音与第二条
路径的音高变化声音的平衡，以便将其发送到
相对的路径以获得音高变化声音的反馈

Crush Type Crush Type Bit Crusher 设置如何降低位精度。

Cut Cut British Combo 将力度曲线设置到声音的末尾

Cutoff Cutoff Frequency Beat Repeat 减弱高频。

VCM Mini Filter 设置效果声音滤波器的截止频率。

Cutoff Frequency 
Control

Control Filter 设置滤波器截止频率。
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D
显示名称 参数名称 使用该参数的效果类型 说明

Damper Control Damper Control Damper Resonance 设置钢琴制音器的共振量。

Decay Decay REV-X Hall, REV-X Room 控制混响声音的衰减方式。

Delay Control Delay Control Multi FX 调整设置为 Delay Sw 的效果的深度或程度。

Delay Input Lvl Delay Input Level Analog Delay Retro, Analog 
Delay Modern

设置延迟的输入电平。

Delay Level Delay Level Auto Synth 设置延迟声的电平。

Delay Level C Delay Level C Delay LCR 设置中央通道的延迟声电平。

Delay Mix Delay Mix Comp Distortion Delay 设置延迟声的混音电平。

Delay Offset Delay Offset G Chorus, 2 Modulator, SPX 
Chorus, Symphonic, Classic 
Flanger, Tempo Flanger, 
Dynamic Flanger

设置延迟调制的偏移值。

Delay Sw Delay SW Multi FX 设置延迟类型或调制类型。

Delay Time Delay Time Tempo Delay Mono, Tempo 
Delay Stereo

指定音符持续时间的延迟时长。

Comp Ratio Comp Ratio Control Delay, Auto Synth, 
Tech Modulation, Multi FX, 
Analog Delay Retro, Analog 
Delay Modern

设置延迟时长。

Delay Time C Delay Time C Delay LCR 设置中央通道的延迟时长。

Delay Time L Delay Time L Delay LR, Delay LCR, Comp 
Distortion Delay

设置左侧通道的延迟时长。

Delay Time L>R Delay Time L>R Cross Delay, Tempo Cross 
Delay

设置从右侧输出从左侧输入的声音的延迟 
时间。

Delay Time R Delay Time R Delay LR, Delay LCR, Comp 
Distortion Delay

设置右侧通道的延迟时长。

Delay Time R>L Delay Time R>L Cross Delay, Tempo Cross 
Delay

设置从左侧输出从右侧输入的声音的延迟 
时间。

Delay Tm Ofs R Delay Time Offset R Auto Synth, Tech 
Modulation

设置右侧通道的延迟时长的偏移值。

Density Density R3 Hall, R3 Room, R3 Plate, 
SPX Hall, SPX Room, SPX 
Stage, Space Simulator

设置混响的密度。

Early Reflection, Gated 
Reverb, Reverse Reverb

设置反射的密度。

Depth Depth Space Simulator 设置模拟房间的深度。

VCM Flanger 设置控制延迟调制循环变化的 LFO 波形的 
振幅。

VCM Phaser Mono, VCM 
Phaser Stereo

设置控制相位调制循环变化的 LFO 波形的振
幅值。

Jazz Combo 设置叠奏 / 振音的深度。

Device Device Amp Simulator 1, Comp 
Distortion Delay

设置用于创建失真声音的设备
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显示名称 参数名称 使用该参数的效果类型 说明

Diffusion Diffusion REV-X Hall, REV-X Room, R3 
Hall, R3 Room, R3 Plate, SPX 
Hall, SPX Room, SPX Stage, 
Space Simulator, Gated 
Reverb, Reverse Reverb, 
Shimmer Reverb

设置混响的扩散。

Tempo Phaser, Early 
Reflection

设置所选效果的扩散。

Direction Direction Dynamic Flanger, Dynamic 
Phaser, VCM Touch Wah, VCN 
Pedal Wah, Dynamic Ring 
Modulator, Dynamic Filter

设置由包络跟随器控制的调制方向。

Tempo Spiralizer P, Tempo 
Spiralizer F

设置音高变化的方向。

Dist Drive Dist Drive Multi FX, Small Stereo 控制失真量。

Dist EQ Dist EQ Multi FX, Small Stereo 切换 EQ 类型来调整失真的音质。

Dist Presence Dist Presence Multi FX, Small Stereo 调整每种失真类型的音质。

Dist Sw Dist SW Multi FX 设置失真类型。

Dist Tone Dist Tone Multi FX, Small Stereo 调整失真的音质。

Dist Type Dist Type Small Stereo 设置失真类型。

Distortion Distortion Jazz Combo 设置失真的电平。

Divide Freq Hi Divide Freq High Multi Band Comp 设置 Mid/High 频率来分为三个频段。

Divide Freq Low Divide Freq Low Multi Band Comp 设置 Low/Mid 频率来分为三个频段。

Divide Min Lvl Divide Min Level Slice 设置分割乐段的最小电平。

Divide Type Divide Type Slice 指定按音符时长分割的时间。

Drive Drive Noisy, Slice, Rotary Speaker 
2, VCM Rotary Speaker 
Classic, VCM Rotary Speaker 
Overdrive, VCM Rotary 
Speaker Studio

设置失真的电平。

Harmonic Enhancer, Talking 
Modulator

设置效果的电平。

Drive Horn Drive Horn Rotary Speaker 1 设置通过喇叭（高音）旋转生成的调制深度。

Drive Rotor Drive Rotor Rotary Speaker 1 设置通过喇叭（低音）旋转生成的调制深度。

Dry Level Dry Level Digital Turntable 设置干音的电平。

Dry LPF Cutoff Dry LPF Cutoff 
Frequency

Digital Turntable 设置通过使用应用于干音的低通滤波器来减
弱的频率。

Dry Mix Level Dry Mix Level Auto Synth 设置干音的电平。

Dry/Wet Dry/Wet Balance All 设置干音和效果音的平衡。
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E
显示名称 参数名称 使用该参数的效果类型 说明

Edge Edge Comp Distortion 设置用于确定声音失真方式的曲线。

Emphasis Emphasis Lo-Fi 设置高频特性的变化。

EQ 1 Freq EQ1(LSH) Frequency VCM EQ 501 设置 EQ1 (Low Shelving) 的截止频率

EQ 1 Gain EQ1(LSH) Gain VCM EQ 501 设置 EQ1 (Low Shelving) 的增益

EQ 2 Freq EQ2 Frequency VCM EQ 501 设置 EQ2 的中心频率。

EQ 2 Gain EQ2 Gain VCM EQ 501 设置 EQ2 的增益。

EQ 2 Q EQ2 Q VCM EQ 501 设置 EQ2 的 Q。

EQ 3 Freq EQ3 Frequency VCM EQ 501 设置 EQ3 的中心频率

EQ 3 Gain EQ3 Gain VCM EQ 501 设置 EQ3 的增益

EQ 3 Q EQ3 Q VCM EQ 501 设置 EQ3 的 Q

EQ 4 Freq EQ4 Frequency VCM EQ 501 设置 EQ4 的中心频率

EQ 4 Gain EQ4 Gain VCM EQ 501 设置 EQ4 的增益

EQ 4 Q EQ4 Q VCM EQ 501 设置 EQ4 的 Q

EQ 5 Freq EQ5(HSH) Frequency VCM EQ 501 设置 EQ5 (High Shelving) 的截止频率

EQ 5 Gain EQ5(HSH) Gain VCM EQ 501 设置 EQ5 (High Shelving) 的增益

EQ Frequency EQ Frequency Noisy 设置要使用 EQ 来增强或减弱的频率。

VCM Mini Booster 将 EQ 的频率设置为 Type

EQ Gain EQ Gain Noisy 设置要使用 EQ 来增强或减弱的增益。

EQ High Freq EQ High Frequency Cross Delay, Tempo Cross 
Delay, Tempo Delay Mono, 
Tempo Delay Stereo, Control 
Delay, Delay LR, Delay LCR, 
G Chorus, 2 Modulator, 
SPX Chorus, Symphonic, 
Ensemble Detune, Classic 
Flanger, Tempo Flanger, 
Dynamic Flanger, Tempo 
Phaser, Dynamic Phaser, 
Auto Pan, Tremolo, Rotary 
Speaker 1, Ring Modulator, 
Dynamic Ring Modulator, 
Dynamic Filter, Slice, HD 
Hall, HD Room, HD Plate, 
NoiseGate+Comp+Eq

设置要使用 EQ 来增强或减弱的高频段 
频率。

EQ High Gain EQ High Gain Cross Delay, Tempo Cross 
Delay, Tempo Delay Mono, 
Tempo Delay Stereo, Control 
Delay, Delay LR, Delay LCR, 
G Chorus, 2 Modulator, 
SPX, Chorus, Symphonic, 
Ensemble Detune, Classic 
Flanger, Tempo Flanger, 
Dynamic Flanger, Tempo 
Phaser, Dynamic Phaser, 
Auto Pan, Tremolo, Rotary 
Speaker 1, Ring Modulator, 
Dynamic Ring Modulator, 
Dynamic Filter, Slice, HD 
Hall, HD Room, HD Plate, 
NoiseGate+Comp+Eq

设置要使用 EQ 来增强或减弱的高频段 
增益。
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显示名称 参数名称 使用该参数的效果类型 说明

EQ Low Freq EQ Low Frequency Cross Delay, Tempo Cross 
Delay, Tempo Delay Mono, 
Tempo Delay Stereo, Control 
Delay, Delay LR, Delay LCR, 
G Chorus, 2 Modulator, 
SPX Chorus, Symphonic, 
Ensemble Detune, Classic 
Flanger, Tempo Flanger, 
Dynamic Flanger, Tempo 
Phaser, Dynamic Phaser, 
Auto Pan, Tremolo, Rotary 
Speaker 1, Ring Modulator, 
Dynamic Ring Modulator, 
Dynamic Filter, Slice, Comp 
Distortion, HD Hall, HD 
Room, HD Plate

设置要使用 EQ 来增强或减弱的低频段 
频率。

EQ Low Gain EQ Low Gain Cross Delay, Tempo Cross 
Delay, Tempo Delay Mono, 
Tempo Delay Stereo, Control 
Delay, Delay LR, Delay LCR, 
G Chorus, 2 Modulator, 
SPX Chorus, Symphonic, 
Ensemble Detune, Classic 
Flanger, Tempo Flanger, 
Dynamic Flanger, Tempo 
Phaser, Dynamic Phaser, 
Auto Pan, Tremolo, Rotary 
Speaker 1, Ring Modulator, 
Dynamic Ring Modulator, 
Dynamic Filter, Slice, Comp 
Distortion, HD Hall, HD 
Room, HD Plate

设置要使用 EQ 来增强或减弱的低频段 
增益。

EQ Mid Freq EQ Mid Frequency G Chorus, 2 Modulator, 
SPX Chorus, Symphonic, 
Classic Flanger, Tempo 
Flanger, Auto Pan, 
Tremolo, Comp Distortion, 
NoiseGate+Comp+EQ

设置要使用 EQ 来增强或减弱的中频段 
频率。

EQ Mid Gain EQ Mid Gain G Chorus, 2 Modulator, 
SPX Chorus, Symphonic, 
Classic Flanger, Tempo 
Flanger, Auto Pan, 
Tremolo, Comp Distortion, 
NoiseGate+Comp+EQ

设置要使用 EQ 来增强或减弱的中频段 
增益。

EQ Mid Width EQ Mid Width G Chorus, 2 Modulator, 
SPX Chorus, Symphonic, 
Classic Flanger, Tempo 
Flanger, Auto Pan, 
Tremolo, Comp Distortion, 
NoiseGate+Comp+EQ

设置要使用 EQ 来增强或减弱的中频段 
宽度。

EQ Width EQ Width Noisy 设置要使用 EQ 来增强或减弱的宽度。

ER/Rev Balance ER/Rev Balance R3 Hall, R3 Room, R3 Plate, 
SPX Hall, SPX Room, SPX 
Stage, Space Simulator

设置早期反射和混响声音的电平平衡。
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F
显示名称 参数名称 使用该参数的效果类型 说明

F/R Depth F/R Depth Auto Pan 设置前后声像的深度（当 PAN Direction
设置为 L Turn 或 R Turn 时可用）

FB Hi Dmp Ofs R FB Hi Damp Offset R Tech Modulation 设置右侧通道高音衰减的偏移值

FB High Damp Feedback High Damp R3 Hall, R3 Room, R3 Plate, 
SPX Hall, SPX Room, SPX 
Stage, Space Simulator, Cross 
Delay, Tempo Cross Delay, 
Tempo Delay Mono, Tempo 
Delay Stereo, Control Delay, 
Delay LR, Delay LCR, Classic 
Flanger, Early Reflection, 
Gated Reverb, Reverse 
Reverb, Comp Distortion 
Delay, Tech Modulation

利用反馈声音调整高频声音的衰减。值越
小，高频声音衰减越快。

FB Level Ofs R FB Level Offset R Auto Synth, Tech 
Modulation

设置右侧通道反馈量的偏移值

FB Time L Feedback Time L Delay LR 设置左延迟的反馈时长

FB Time R Feedback Time R Delay LR 设置右延迟的反馈时长

Feedback Feedback VCM Flanger, VCM Phaser 
Mono, VCM Phaser Stereo, 
Control Flanger, Control 
Phaser
Spiralizer P, Spiralizer F, 
Tempo Spiralizer P, Tempo 
Spiralizer F

设置输出信号返回到效果模块的电平。

Feedback Feedback Level R3 Hall, R3 Room, R3 Plate, 
SPX Hall, SPX Room, SPX 
Stage, Space Simulator, 
Early Reflection, Gated 
Reverb, Reverse Reverb

设置初始延迟的反馈电平。

Cross Delay, Tempo Cross 
Delay, Tempo Delay Mono, 
Tempo Delay Stereo, Control 
Delay, Delay LR, Delay LCR, 
G Chorus, 2 Modulator, SPX 
Chorus, Classic Flanger, 
Tempo Flanger, Dynamic 
Flanger, Comp Distortion 
Delay, Auto Synth, Teck 
Modulation

设置发送回输入的延迟声音的电平（负值
时相位反转）

Analog Delay Retro, Analog 
Delay Modern

设置延迟声的反馈电平。

Tempo Phaser, Dynamic 
Phaser

设置从移相器输出和返回到输入的信号
电平（负值时相位反转）

Feedback Lvl 1 Feedback Level 1 Pitch Change 设置延迟声音在第一条路径上的反馈 
电平

Feedback Lvl 2 Feedback Level 2 Pitch Change 设置延迟声音在第二条路径上的反馈 
电平

Feedback Time Feedback Time Delay LCR, Comp Distortion 
Delay

设置反馈的延迟时长。

Filter Type Filter Type Lo-Fi 选择效果类型。

Dynamic Filter, Control Filter 设置滤波器类型。

Beat Repeat 设置效果声的滤波器类型。
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显示名称 参数名称 使用该参数的效果类型 说明

Fine 1 Fine 1 Pitch Change, Shimmer 
Reverb

微调第一条路径的音高。

Fine 2 Fine 2 Pitch Change, Shimmer 
Reverb

微调第二条路径的音高。

Flanger Control Flanger Control Control Flanger 设置延迟值（延迟调制的 Comb Filter 
的值）

Fold Fold Wave Folder 使声音失真。

Fold Type Fold Type Wave Folder 选择失真的电平。

Formant Offset Formant Offset Vocoder 将偏移值添加到 BPF 的截止频率上，以用
于处理乐器声音输入。

Formant Shift Formant Shift Vocoder 改变每个 BPF 的截止频率，以用于处理乐
器声音输入。

Freeze Freeze Beat Repeat 当此参数设置为 On 时，节拍会重复。

G
显示名称 参数名称 使用该参数的效果类型 说明

Gain Gain U.S. High Gain 设置前置放大器的增益。

VCM Mini Booster 调整 ShelfEQ 的 Gain

Gain Boost Gain Boost U.S. Combo 切换功率放大器的增益。

Gain Limit Gain Limit Upward Compressor 设置最大 Gain 电平

Gate Time Gate Time Slice 设置分割的门限时间。

Beat Repeat 设置整个声音的 Gate 时间

H
显示名称 参数名称 使用该参数的效果类型 说明

Height Height Space Simulator 设置模拟房间的高度。

Hi Damp Freq High Damp 
Frequency

HD Hall, HD Room, HD Plate 调整高频段的衰减。

High Attack High Attack Multi Band Comp 设置要应用到高频段的压缩器的时长

High Cut High Cut U.S. Combo 减弱高频段。

High Gain High Gain Multi Band Comp 设置高频段的输出电平

High Gain L High Subband Gain 
Lch

Stereophonic Optimizer 设置调整立体声（L 通道）后 High 频段的
最终增益

High Gain R High Subband Gain 
Rch

Stereophonic Optimizer 设置调整立体声（R 通道）后 High 频段
的最终增益

High Level High Level Isolator 设置高频段的电平。

High Mute High Mute Isolator 切换高频段的静音。

High Ratio High Ratio REV-X Hall, REV-X Room, HD 
Hall, HD Room, HD Plate

调整高频的比率。

Multi Band Comp 设置高频段的压缩比

High Threshold High Threshold Multi Band Comp 设置要应用到高频段的效果的最小输入
电平

High Treble High Treble Jazz Combo 调整高于 Treble 设置的频率下的音质
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显示名称 参数名称 使用该参数的效果类型 说明

Horn Accel Horn Acceleration Rotary Speaker 2, VCM 
Rotary Speaker Classic, VCM 
Rotary Speaker Overdrive, 
VCM Rotary Speaker Studio

设置喇叭（高音）的旋转如何从 Slow 变
为 Fast

Horn Decel Horn Deceleration Rotary Speaker 2, VCM 
Rotary Speaker Classic, VCM 
Rotary Speaker Overdrive, 
VCM Rotary Speaker Studio

设置喇叭（高音）的旋转如何从 Fast 变为
Slow

Horn Fast Horn Speed Fast Rotary Speaker 1, Rotary 
Speaker 2, VCM Rotary 
Speaker Classic, VCM Rotary 
Speaker Overdrive, VCM 
Rotary Speaker Studio

将喇叭（高音）的旋转速度设置为 Fast 
设置

Horn Level Horn Level VCM Rotary Speaker Classic, 
VCM Rotary Speaker 
Overdrive, VCM Rotary 
Speaker Studio

设置喇叭（高音）的音量。

Horn Slow Horn Speed Slow Rotary Speaker 1, Rotary 
Speaker 2, VCM Rotary 
Speaker Classic, VCM Rotary 
Speaker Overdrive, VCM 
Rotary Speaker Studio

将喇叭（高音）的旋转速度设置为 Slow
设置

Horn Slow/Fast Horn Slow/Fast Time Rotary Speaker 1 设置喇叭（高音）旋转速度从 Slow 变为
Fast 的转换时间

HPF Cutoff HPF Cutoff Frequency REV-X Hall, REV-X Room, 
R3 Hall, R3 Room, R3 Plate, 
SPX Hall, SPX Room, SPX 
Stage, Space Simulator, 
Ring Modulator, Dynamic 
Ring Modulator, Auto Synth, 
Harmonic Enhancer, Early 
Reflection, Gated Reverb, 
Reverse Reverb

使用 HPF 设置要减弱的低频

Vocoder 设置应用于麦克风声音输入的高通滤波
器的截止频率。

HPF Output Lvl HPF Output Level Vocoder 设置高通滤波器的输出与声码器的输出
混合的程度。
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I
显示名称 参数名称 使用该参数的效果类型 说明

Initial Delay Initial Delay REV-X Hall, REV-X Room, 
R3 Hall, R3 Room, R3 Plate, 
SPX Hall, SPX Room, SPX 
Stage, Space Simulator, 
Early Reflection, HD Hall, 
HD Room, HD Plate, Gated 
Reverb, Reverse Reverb

设置早期反射的延迟时间。

Initial Delay 1 Initial Delay 1 Pitch Change 设置第一组效果的延迟时长。

Initial Delay 2 Initial Delay 2 Pitch Change 设置第二组效果的延迟时长。

Initial Delay L Initial Delay Lch Ensemble Detune 设置左侧通道延迟的时长。

Initial Delay R Initial Delay Rch Ensemble Detune 设置右侧通道延迟的时长。

Input Level Input Level Bit Crusher, VCM 
Compressor 376, Rotary 
Speaker 2, Parallel 
Compressor, Wave Folder, 
VCM Mini Filter, VCM Mini 
Booster

设置输入电平。

Input Mode Input Mode G Chorus, 2 Modulator, SPX 
Chorus, Auto Pan, Tremolo, 
Lo-Fi

选择输入声是单声道还是立体声。

Input Select Input Select Cross Delay, Tempo Cross 
Delay

选择输入。

Inst Level Inst Level Vocoder 设置乐器声音的输入电平。

K
显示名称 参数名称 使用该参数的效果类型 说明

Knee Knee Upward Compressor, 
Downward Compressor

设置 Threshold 周围的曲线。数值越高，
则曲线越浅。

L
显示名称 参数名称 使用该参数的效果类型 说明

L/R Depth L/R Depth Auto Pan 设置左右声像的深度。

L/R Diffusion L/R Diffusion Tempo Delay Mono, Tempo 
Delay Stereo

设置左右延迟的差异来创造空间感。

Lag Lag Tempo Cross Delay, Tempo 
Delay Mono, Tempo Delay 
Stereo

设置应用于由音符时长指定的延迟声音
的额外延迟时长。

Length Length Beat Repeat 设置重复的时长。

Level Offset Dyna Level Offset Dynamic Flanger, Dynamic 
Phaser, Dynamic Ring 
Modulator, Dynamic Filter

设置添加到包络跟随器输出的偏移值。

LFO Depth LFO Depth SPX Chorus, Symphonic, 
Classic Flanger, Tempo 
Flanger, Ring Modulator

设置调制的深度。

Tempo Phaser 设置相位调制的深度。

Wave Folder 调整 LFO 效果的深度。

LFO Shape LFO Shape Wave Folder 调整 LFO 的形状。
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显示名称 参数名称 使用该参数的效果类型 说明

LFO Speed LFO Speed G Chorus, 2 Modulator, SPX 
Chorus, Symphonic, Classic 
Flanger, Tremolo, Ring 
Modulator, Multi FX

设置调制的频率。

Tempo Flanger, Tempo 
Phaser

按音符时长指定调制速度。

Auto Pan 设置自动声像的频率。

Wave Folder 调整 LFO 速度。

LFO Wave LFO Wave Classic Flanger, Ring 
Modulator

选择调制的波形。

Auto Pan 设置声像曲线。

VCM Auto Wah 选择波形 ：正弦波或方波。

Liveness Liveness Gated Reverb, Reverse 
Reverb, Early Reflection

设置早期反射的衰减。

Ln Chg Quantz Length Change 
Quantize

Beat Repeat 量化更改长度参数的时间。

Low Attack Low Attack Multi Band Comp 设置要应用到低频段的压缩器的时长

Low Cut Low Cut U.S. Combo 减弱低频段。

Low Gain Low Gain Multi Band Comp 设置低频段的输出电平

Low Gain L Low Subband Gain 
Lch

Stereophonic Optimizer 设置调整立体声（L 通道）后 Low 频段的
最终增益

Low Gain R Low Subband Gain 
Rch

Stereophonic Optimizer 设置调整立体声（R 通道）后 Low 频段的
最终增益

Low Level Low Level Isolator 设置低频段的电平。

Low Mute Low Mute Isolator 切换低频段的静音。

Low Ratio Low Ratio REV-X Hall, REV-X Room 设置低频的调整。

Multi Band Comp 设置低频段的压缩比

Low Threshold Low Threshold Multi Band Comp 设置要应用到低频段的效果的最小输入
电平

Lower Range Lower Range VCM Auto Wah, VCM Touch 
Wah, VCM Pedal Wah

设置哇音滤波器可变范围的最大值。

Control Flanger 设置 Flanger Control 可变范围的最大值

Control Phaser 设置 Phase Control 可变范围的最大值

LPF Cutoff LPF Cutoff Frequency REV-X Hall, REV-X Room, 
R3 Hall, R3 Room, R3 Plate, 
SPX Hall, SPX Room, SPX 
Stage, Space Simulator, 
Amp Simulator 2, Comp 
Distortion, Noisy, Ring 
Modulator, Dynamic Ring 
Modulator, Auto Synth, Early 
Reflection, Gated Reverb, 
Reverse Reverb, Auto Synth, 
Noisy

设置要使用低通滤波器减弱的高频范围。

LPF Resonance LPF Resonance Noisy 向低通滤波器的输入添加特性。
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M
显示名称 参数名称 使用该参数的效果类型 说明

M/S M/S Bit Crusher 当此参数打开时，位于中央、左侧和右侧
的每个声音都会单独变化。

Make Up Gain Make Up Gain Upward Compressor, 
Downward Compressor

调整从压缩器输出的信号电平。

Manual Manual VCM Flanger 设置延迟调制的偏移值。

VCM Phaser Mono, VCM 
Phaser Stereo

设置相位调制的偏移值。

Master Volume Master Volume U.S. High Gain, British Lead, 
British Legend

调整功率放大器的增益。

Mic Input Level Mic Input Level Vocoder 设置麦克风的输入电平

Mic L-R Angle Mic L-R Angle Rotary Speaker 1, Rotary 
Speaker 2, VCM Rotary 
Speaker Classic, VCM Rotary 
Speaker Overdrive, VCM 
Rotary Speaker Studio

设置麦克风的左 / 右角度以从输出中提取
声音

Mic Out Gate Mic Output Gate 
Switch

Vocoder 关 ：始终让 HPF 输出和 Noise Generator
输出通过
打开 ：当有乐器声音的音频输入时让 HPF
输出和 Noise Generator 输出通过

Mic Position Mic Position U.S. Combo, Jazz Combo, 
U.S. High Gain, British Lead, 
British Combo, British 
Legend, Rotary Speaker 2

设置麦克风与扬声器的相对位置。

Mid Middle British Lead, British Legend, 
Jazz Combo, U.S. High Gain

设置中频段的音质。

Mid 1 Gain L Mid1 Subband Gain 
Lch

Stereophonic Optimizer 设置调整立体声（L 通道）后 Mid1 频段
的最终增益

Mid 1 Gain R Mid1 Subband Gain 
Rch

Stereophonic Optimizer 设置调整立体声（R 通道）后 Mid1 频段
的最终增益

Mid 2 Gain L Mid2 Subband Gain 
Lch

Stereophonic Optimizer 设置调整立体声（L 通道）后 Mid2 频段
的最终增益

Mid 2 Gain R Mid2 Subband Gain 
Rch

Stereophonic Optimizer 设置调整立体声（R 通道）后 Mid2 频段
的最终增益

Mid 3 Gain L Mid3 Subband Gain 
Lch

Stereophonic Optimizer 设置调整立体声（L 通道）后 Mid3 频段
的最终增益

Mid 3 Gain R Mid3 Subband Gain 
Rch

Stereophonic Optimizer 设置调整立体声（R 通道）后 Mid3 频段
的最终增益

Mid Attack Mid Attack Multi Band Comp 设置要应用到中频段的压缩器的时长

Mid Cut Mid Cut U.S. Combo 减弱中频。

Mid Gain Mid Gain Multi Band Comp 设置中频段的输出电平

Mid Level Mid Level Isolator 设置中频的电平。

Mid Mute Mid Mute Isolator 切换中频的静音。

Mid Ratio Mid Ratio Multi Band Comp 设置中频段的压缩比
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显示名称 参数名称 使用该参数的效果类型 说明

Mid Sweep Mid Sweep U.S. Combo 调整减弱了中频的频率范围。

Mid Threshold Mid Threshold Multi Band Comp 设置要应用到中频段的效果的最小输入
电平

Mid Width Mid Width U.S. Combo 设置要减弱中频的带宽。

Mix Mix VCM Flanger, Control 
Flanger

设置效果声的音量。

Mix Level Mix Level Harmonic Enhancer 设置效果声音与干音混合的电平。

Mod Depth Mod Depth Noisy, Auto Synth, Tech 
Modulation, Shimmer 
Reverb

设置调制的深度。

Modulation Depth Rotary Speaker 2 设置音量循环变化的深度。

Mod Dpt Ofs R Mod Depth Offset R Auto Synth 设置 R 通道调制深度的偏移。

Mod Feedback Mod Feedback Noisy 设置调制反馈的电平。

Mod Gain Mod Gain Tech Modulation 设置调制的增益电平。

Mod LPF Cutoff Mod LPF Cutoff 
Frequency

Tech Modulation 设置应用于已调制声音的低通滤波器的
截止频率。

Mod LPF Res Mod LPF Resonance Tech Modulation 使用低通滤波器为调制声音添加特性。

Mod Mix Mod Mix Balance Noisy, Tech Modulation 设置调制声音的混音平衡。

Mod Phase Modulation Phase Classic Flanger 设置调制波的 L/R 相位差。

Mod Speed Mod Speed Noisy, Auto Synth, Tech 
Modulation, Shimmer 
Reverb

设置调制速度。

Mod Wave Type Mod Wave Type Auto Synth 选择调制的波形类型。

Mode Mode VCM Phaser Mono, VCM 
Phaser Stereo, Control 
Phaser

设置用于更改移相器类型的元素，或更具
体地说，设置用于形成移相器效果的因素。

British Combo 切换前置放大器。

Modulator Lvl Modulator Input 
Level

Ring Modulator 设置调制器电平。

Move Speed Move Speed Talking Modulator 设置更改为 Vowel 参数指定的声音所需
的时间

N
显示名称 参数名称 使用该参数的效果类型 说明

Noise Level Background Noise 
Level

VCM Rotary Speaker Classic, 
VCM Rotary Speaker 
Overdrive, VCM Rotary 
Speaker Studio

设置背景噪音量。

Noise Level Vocoder 设置噪音输入的电平。

Digital Turntable 设置噪声电平。

Noise LPF Q Noise LPF Q Digital Turntable 设置应用于噪音的低通滤波器的共鸣。

Noise Switch Background Noise 
Off/On

VCM Rotary Speaker Classic, 
VCM Rotary Speaker 
Overdrive, VCM Rotary 
Speaker Studio

打开或关闭背景噪音。

Noise Tone Noise Tone Digital Turntable 设置噪音的音质。
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显示名称 参数名称 使用该参数的效果类型 说明

Normal Normal British Combo 调整具有平坦 EQ 响应的声音的音量。

Ns Gate Atk Noise Gate Attack NoiseGate+Comp+Eq 设置要应用噪音门限的时长。

Ns Gate Rls Noise Gate Release NoiseGate+Comp+Eq 设置让噪音门限保持不活动的时长。

Ns Gate Thrs Noise Gate Threshold NoiseGate+Comp+Eq 设置要应用的噪音门限的最小输入电平。

Ns LPF Cutoff Noise LPF Cutoff 
Frequency

Digital Turntable 设置通过使用应用于噪音的低通滤波器
来减弱的频率。

Ns Mod Depth Noise Mod Depth Digital Turntable 设置噪音调制的深度。

Ns Mod Speed Noise Mod Speed Digital Turntable 设置噪音调制的速度。

O
显示名称 参数名称 使用该参数的效果类型 说明

Offset Filter Offset Spiralizer P, Spiralizer F, 
Tempo Spiralizer P, Tempo 
Spiralizer F

设置初始音高值（以半音为单位）。

Ofs Transition Offset Transition Rate Spiralizer P, Spiralizer F, 
Tempo Spiralizer P, Tempo 
Spiralizer F

设置偏移值变化为新值的转换时间。

On/Off Switch On/Off Switch Isolator 打开或关闭隔离器。

Stereophonic Optimizer 打开或关闭效果。

Osc Freq OSC Frequency 
Coarse

Ring Modulator 设置用于调制输入波形的频率。

Osc Freq Fine OSC Frequency Fine Ring Modulator 精细调整用于调制输入波形的频率。

Output Output VCM Auto Wah, VCM Touch 
Wah, VCM Pedal Wah

设置输出电平。

Output Level Filter Output Level Control Filter 设置滤波器的输出电平。

Output Level Amp Simulator 1, Amp 
Simulator 2, Comp 
Distortion, Comp Distortion 
Delay, U.S. Combo, Jazz 
Combo, U.S. High Gain, 
British Combo, British 
Lead, British Legend, Multi 
FX, Small Stereo, VCM 
Compressor 376, Classic 
Compressor, VCM EQ 501, 
Talking Modulator, Lo-Fi, Bit 
Crusher, Vinyl Break, Beat 
Repeat, Rotary Speaker 2, 
Downward Compressor, 
Upward Compressor, 
Parallel Compressor, 
Presence, Wave Folder, VCM 
Mini Filter, VCM Mini Booster

设置输出电平。

Vocoder 设置声码器的输出电平。

Output Level 1 Output Level1 Pitch Change 设置第一条路径的输出电平。

Output Level 2 Output Level2 Pitch Change 设置第二条路径的输出电平。

Overdrive Overdrive Amp Simulator 1, Amp 
Simulator 2, Comp 
Distortion, Comp Distortion 
Delay, VCM Auto Wah, VCM 
Touch Wah, VCN Pedal Wah

设置失真的电平。
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P
显示名称 参数名称 使用该参数的效果类型 说明

Pan 1 Pan 1 Pitch Change 设置第一条路径上的声像。
Pan 2 Pan 2 Pitch Change 设置第二条路径上的声像。
Pan AEG Min Lvl Pan AEG Min Level Slice 设置应用于声像声音的振幅包络发生器

的最小电平。
Pan AEG Type Pan AEG Type Slice 设置应用于声像声音的振幅包络发生器

的类型。
Pan Depth Pan Depth Slice 设置声像的深度。
Pan Direction Pan Direction Auto Pan 设置自动声像类型。
Pan Type Pan Type Slice 设置声像类型。
Panning Panning Jazz Combo 设置叠奏 / 振音的扩散。
Pedal Control Pedal Control VCM Pedal Wah 控制哇音滤波器的截止频率。
Phase Control Phase Control Control Phaser 设置相位调制的深度。
Phase Differ LFO Phase Difference Tempo Flanger, Tremolo 设置调制波的 L/R 相位差。（0 度或值为

64 时没有相位差。）
Phase Reset LFO Phase Reset Tempo Flanger, Tempo 

Phaser, Slice
设置如何复位 LFO 初始相位。

Phase Shift Ofs Phase Shift Offset Tempo Phaser 设置相位调制的偏移值。
Phaser Sw Phaser SW Multi FX 设置移相器类型。
Pitch 1 Pitch 1 Pitch Change, Shimmer 

Reverb
设置第一条路径的音高（以半音为单位）。

Pitch 2 Pitch 2 Pitch Change, Shimmer 
Reverb

设置第二条路径的音高（以半音为单位）。

P1/P2 Balance Pitch 1/Pitch 2 
Balance

Shimmer Reverb 设置第一条路径上的音高变化声音与第
二条路径上的音高变化声音的音量平衡。

P1&P2 Dly Ofs Pitch 1 & Pitch 2 
Delay Offset

Shimmer Reverb 设置第一条路径上的音高变化声音与 
第二条路径上的音高变化声音的延迟偏
移值。

P1&P2 Panning Pitch 1/Pitch 2 
Panning

Shimmer Reverb 设置第一条路径上的音高变化声音与第
二条路径上的音高变化声音的声像。

Pitch Sweep Pitch Sweep Beat Repeat 将音高设置为在每次重复时逐渐变化。
Plate Type Plate Type HD Plate 设置声音的共鸣方式。
Play Speed Play Speed Beat Repeat 设置播放速度。
PM Depth PM Depth G Chorus, 2 Modulator, 

Tremolo
设置音高调制的深度。

Post-comp HPF Post-comp HPF Upward Compressor, 
Downward Compressor

设置紧跟压缩器的高通滤波器的截止 
频率。

Pre Mod HPF F Pre Mod HPF Cutoff 
Frequency

Tech Modulation 设置应用调制之前的高通滤波器的截止
频率。

Preamp Preamp British Lead 设置前置放大器的增益。
Pre-Delay Pre-Delay Shimmer Reverb 设置早期反射的延迟时间。
Pre-LPF Cutoff Pre-LPF Cutoff 

Frequency
Lo-Fi 设置用于减弱高频的低通滤波器的截止

频率。
Pre-LPF Res Pre-LPF Resonance Lo-Fi 向低通滤波器的输入添加特性。
Presence Presence Presence 设置效果的电平。

Amp Simulator 1, Comp 
Distortion Delay U.S. 
Combo, U.S. Hi Gain, British 
Lead, British Legend

增强高频。
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R
显示名称 参数名称 使用该参数的效果类型 说明

R/H Balance Rotor/Horn Balance Rotary Speaker 1, Rotary 
Speaker 2

设置喇叭（高音）和转子（低音）的音量
平衡。

Random Random Beat Repeat 创建随机重复。
Ratio Ratio Comp Distortion, VCM 

Compressor 376, Classic 
Compressor, Downward 
Compressor, Upward 
Compressor

设置压缩器的比率。

Release Release Comp Distortion, VCM 
Compressor 376, Classic 
Compressor, Downward 
Compressor, Upward 
Compressor

设置压缩器效果消失所需的时长。

Release Curve Release Curve Dynamic Flanger, Dynamic 
Phaser, Dynamic Ring 
Modulator, Dynamic Filter

设置包络跟随器的释音曲线。

Release Time Release Time Dynamic Flanger, Dynamic 
Phaser, Dynamic Ring 
Modulator, Dynamic Filter

设置包络跟随器的释音时间。

Beat Repeat 设置应用于整个声音的 Gate 的 Release
时间

Repeat Repeat Beat Repeat 打开或关闭重复。
Resonance Resonance Dynamic Filter, Control 

Filter, VCM Mini Filter, VCM 
Mini Booster

向滤波器添加特性。

Beat Repeat 设置效果声音滤波器的共鸣。
Resonance Ofs Resonance Offset VCM Auto Wah, VCM Touch 

Wah, VCN Pedal Wah
设置共鸣的偏移值。

Retrigger Cycle Retrigger Cycle Beat Repeat 设置重新触发 Repeat 的周期
Reverb Delay Reverb Delay R3 Hall, R3 Room, R3 Plate, 

SPX Hall, SPX Room, SPX 
Stage, Space Simulator

设置从早期反射到混响的延迟时间。

Reverb Time Reverb Time REV-X Hall, REV-X Room, R3 
Hall, R3 Room, R3 Plate, SPX 
Hall, SPX Room, SPX Stage, 
Space Simulator, HD Hall, 
HD Room, HD Plate

设置混响时长。

Room Size Room Size REV-X Hall, REV-X Room, 
Early Reflection, HD Hall, 
HD Room, Gated Reverb, 
Reverse Reverb

设置房间的大小。

Rotor Accel Rotor Acceleration Rotary Speaker 2, VCM 
Rotary Speaker Classic, VCM 
Rotary Speaker Overdrive, 
VCM Rotary Speaker Studio

设置转子（低音）从 Slow 变化为 Fast 的
旋转速度

Rotor Decel Rotor Deceleration Rotary Speaker 2, VCM 
Rotary Speaker Classic, VCM 
Rotary Speaker Overdrive, 
VCM Rotary Speaker Studio

设置转子（低音）从 Fast 变化为 Slow 的
旋转速度

Rotor Fast Rotor Speed Fast Rotary Speaker 1, Rotary 
Speaker 2, VCM Rotary 
Speaker Classic, VCM Rotary 
Speaker Overdrive, VCM 
Rotary Speaker Studio

将转子（低音）的旋转速度设置为 Fast 
设置
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显示名称 参数名称 使用该参数的效果类型 说明

Rotor Level Rotor Level VCM Rotary Speaker Classic, 
VCM Rotary Speaker 
Overdrive, VCM Rotary 
Speaker Studio

设置转子（低音）的音量。

Rotor Slow Rotor Speed Slow Rotary Speaker 1, Rotary 
Speaker 2, VCM Rotary 
Speaker Classic, VCM Rotary 
Speaker Overdrive, VCM 
Rotary Speaker Studio

将转子（低音）的旋转速度设置为 Slow
设置

Rotor Slow/Fast Rotor Slow/Fast Time Rotary Speaker 1 设置转子（低音）旋转速度从 Slow 变为
Fast 的转换时间

Rtg Attack T Retrigger Attack Time Beat Repeat 设置应用于整个声音的 Gate 的 Attack 
时间

Rtg Gate Time Retrigger Gate Time Beat Repeat 设置整个声音的 Gate 时间

Rtg Quantize Retrigger Quantize Beat Repeat 当此参数设置为 On 时，声音会在内置音
序器中设置的小节的开头重复。

Rtg Release T Retrigger Release 
Time

Beat Repeat 设置应用于整个声音的 Gate 的 Release
时间

S
显示名称 参数名称 使用该参数的效果类型 说明

Sample Rate Sample Rate Bit Crusher 降低 Sample Rate

Sampling Freq Sampling Frequency 
Control

Lo-Fi 控制采样频率。

SC EQ Freq Side Chain EQ 
Frequency

Downward Compressor, 
Upward Compressor

设置用于检测压缩器电平的 EQ 的频率。

SC EQ Gain Side Chain EQ Gain Downward Compressor, 
Upward Compressor

设置用于检测压缩器电平的 EQ 的增益。

SC EQ Q Side Chain EQ Q Downward Compressor, 
Upward Compressor

设置用于检测压缩器电平的 EQ 的 Q。

Scale Type Spiral Step Scale 
Type

Spiralizer P, Spiralizer F, 
Tempo Spiralizer P, Tempo 
Spiralizer F

设置当 Step Mode 设置为 Scale 时如何实
现变化

Semitones Spiral Step 
Semitones

Spiralizer P, Spiralizer F, 
Tempo Spiralizer P, Tempo 
Spiralizer F

指定当 Step Mode 设置为 Semitone 时的
变奏宽度（以半音为单位）

Send to Noise Dry Send to Noise Digital Turntable 设置发送到噪音效果的干信号。

Sensitivity Sensitivity Dynamic Flanger, Dynamic 
Phaser, Dynamic Ring 
Modulator, Dynamic Filter

设置应用于输入变化的调制的灵敏度。

VCM Touch Wah 设置应用于输入变化的哇音滤波器变化
的灵敏度。

SEQ Clock SEQ Clock Wave Folder 调整内置音序器的速度。

SEQ Depth SEQ Depth Wave Folder 调整内置音序器中效果的深度。

SEQ Pattern SEQ Pattern Wave Folder 选择内置音序器中的模板。

SEQ Ph Reset SEQ Phase Reset Wave Folder 设置复位内置音序器的模式。

SEQ Variation SEQ Variation Wave Folder 改变内置音序器的行为。

Shimmer Fdbk Shimmer Feedback Shimmer Reverb 调整音高变化声音的反馈电平。

Shimmer Gain Shimmer Gain Shimmer Reverb 调整音高变化声音的电平。
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显示名称 参数名称 使用该参数的效果类型 说明

Shimmer HPF Shimmer HPF 
Frequency

Shimmer Reverb 设置用于减弱音高变化声音的低频的高
通滤波器的截止频率。

Shimmer LPF Shimmer LPF 
Frequency

Shimmer Reverb 设置用于减弱音高变化声音的高频的低
通滤波器的截止频率。

Side Bit Side Bit Bit Crusher 降低侧链的位精度。

Side Chain EQ Side Chain EQ Switch Downward Compressor, 
Upward Compressor

打开或关闭用于检测压缩器电平的 EQ。

Side Chain Lvl Side Chain Input 
Level

VCM Compressor 376, 
Classic Compressor, Dyna 
Flanger, Dyna Phaser, Dyna 
Ring Mod, Dyna Filter, Multi 
Band Comp

设置侧链控制电路的输入电平。

Side Smpl Rate Side Sample Rate Bit Crusher 降低侧链的 Sample Rate

Size Size Shimmer Reverb 设置混响空间的表现大小。

Smpl Rate Link Sample Rate Link Bit Crusher 设置当 M/S 打开时，与 Mid 值匹配的 Side
设置的级别

Space Type Space Type Space Simulator 选择空间模拟类型。

Speaker Air Speaker Air U.S. Combo, Jazz Combo, 
U.S. High Gain, British Lead, 
British Combo, British 
Legend

强调音箱箱体的特点。

Speaker Type Speaker Type Amp Simulator 1, Comp 
Distortion Delay

选择扬声器模拟类型。

U.S. Combo, Jazz Combo, 
U.S. High Gain, British Lead, 
Small Stereo, British Combo, 
British Legend, Multi FX

设置扬声器类型。

Speed Speed VCM Flanger 设置控制延迟调制循环变化的 LFO 波形
的频率。

VCM Phaser Mono, VCM 
Phaser Stereo

设置控制相位调制循环变化的 LFO 波形
的频率。

VCM Auto Wah 设置 LFO 的速度。

Vinyl Break 设置让声音停止的时长。

Speed Adjust Speed Adjust Vinyl Break 精细调整速度。

Speed Control Speed Control Rotary Speaker 1, Rotary 
Speaker 2

切换旋转速度 (Slow/Fast)

VCM Rotary Speaker Classic, 
VCM Rotary Speaker 
Overdrive, VCM Rotary 
Speaker Studio

切换旋转速度 (Slow/Stop/Fast)

Spiral Spiral Switch Spiralizer P, Spiralizer F, 
Tempo Spiralizer P, Tempo 
Spiralizer F

打开或关闭 LFO。

Spiral Speed Spiral Speed Spiralizer P, Spiralizer F, 
Tempo Spiralizer P, Tempo 
Spiralizer F

设置音高变化的速度。

Spiral Sync Spiral Sync Spiralizer P, Spiralizer F, 
Tempo Spiralizer P, Tempo 
Spiralizer F

设置以步进方式改变音高的标准周期。

Spread Spread Ensemble Detune, VCM 
Flanger, VCM Phaser Stereo, 
Control Phaser

设置声音扩散的方式。
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显示名称 参数名称 使用该参数的效果类型 说明

Stage Stage VCM Phaser Mono, VCM 
Phaser Stereo, Tempo 
Phaser, Dynamic Phaser, 
Control Phaser

设置移相器的步进数。

Step Mode Spiral Step Mode Spiralizer P, Spiralizer F, 
Tempo Spiralizer P, Tempo 
Spiralizer F

将音高设置为连续（平滑）变化或以步进
方式变化。

Step Transition Spiral Step Transition 
Rate

Spiralizer P, Spiralizer F, 
Tempo Spiralizer P, Tempo 
Spiralizer F

设置音高以步进方式变化的转换时间。

Sample Rate Sample Rate Bit Crusher 降低 Sample Rate

Sampling Freq Sampling Frequency 
Control

Lo-Fi 控制采样频率。

T
显示名称 参数名称 使用该参数的效果类型 说明

Texture Texture Parallel Compressor, 
Presence, VCM Mini Filter, 
VCM Mini Booster

为效果的质感创造各种变化。

Threshold Threshold Comp Distortion, Classic 
Compressor, Downward 
Compressor, Upward 
Compressor

设置要应用的效果的输入电平。

Threshold Level Dyna Threshold Level Dynamic Flanger, Dynamic 
Phaser, Dynamic Ring 
Modulator, Dynamic Filter

设置包络跟随器启动的最低电平。

Time Sweep Time Sweep Beat Repeat 在每次重复时渐进式地改变时长。

Tone Tone Rotary Speaker 2, VCM 
Rotary Speaker Classic, VCM 
Rotary Speaker Overdrive, 
VCM Rotary Speaker Studio

设置音调控制。

Tone Shift Tone Shift British Lead 切换音调控制的特性。

Transition Rate Delay Transition Rate Control Delay 设置将当前 Delay Time 更改为新值
Delay Time 的变化速度

Treble Treble British Combo, British Lead, 
British Legend, Jazz Combo, 
U.S. High Gain

调整高音的音质。

Type Type VCM Flanger, Control 
Flanger

选择镶边类型。

VCM Auto Wah, VCM Touch 
Wah, VCN Pedal Wah

选择哇音类型。

Early Reflection, Gated 
Reverb, Reverse Reverb

选择反射类型。

US High Gain, British Lead 选择功放类型。

Analog Delay Retro, Analog 
Delay Modern

设置延迟的特性。

Parallel Compressor 设置压缩器类型。

Mini Filter, Mini Boost 设置滤波器类型。
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U
显示名称 参数名称 使用该参数的效果类型 说明

Upper Range Upper Range VCM Auto Wah, VCM Touch 
Wah, VCN Pedal Wah

设置哇音滤波器可变范围的最大值。

Control Flanger 设置 Flanger Control 可变范围的最大值

Control Phaser 设置 Phase Control 可变范围的最大值

V
显示名称 参数名称 使用该参数的效果类型 说明

Vib Speed Vib Speed Jazz Combo 设置颤音的速度。当 Chorus 设置为 Vib
时可用。

Vocoder Attack Vocoder Attack Vocoder 设置声码器输出的起音值。

Vocoder Rls Vocoder Release Vocoder 设置声码器输出的释音值。

Volume Volume U.S. Combo, Jazz Combo 设置前置放大器的电平。

Vowel Vowel Talking Modulator 选择元音类型。

W
显示名称 参数名称 使用该参数的效果类型 说明

Wah Pedal Wah Pedal Multi FX 设置哇音踏板的位置。

Wah Sw Wah SW Multi FX 设置哇音类型。

Wall Vary Wall Vary Space Simulator 设置模拟房间的墙壁类型。值越高，产生
的漫反射越多。

Width Width Space Simulator 设置模拟房间的宽度。

Width High Width High Stereophonic Optimizer 调整 High 频段的立体声平衡

Width Low Width Low Stereophonic Optimizer 调整 Low 频段的立体声平衡

Width Mid 1 Width Mid1 Stereophonic Optimizer 调整 Mid1 频段的立体声平衡

Width Mid 2 Width Mid2 Stereophonic Optimizer 调整 Mid2 频段的立体声平衡

Width Mid 3 Width Mid3 Stereophonic Optimizer 调整 Mid3 频段的立体声平衡

Word Length Word Length Lo-Fi 设置声音的分辨率，或者设置声音的粗糙
程度。
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快捷方式和特殊操作
除了使用 [SHIFT] 按钮等进行快捷操作外，还可以通过按两次按钮或按住按钮进行特殊操作。

快捷方式
操作 功能

[SHIFT] + 旋钮 1至 4（5至 8） 将旋钮切换到高精度模式（减慢值变化）
当您想要微调一个值时很有用

[SHIFT] + [EDIT/ ] 调出 Copy/Exchange 画面

[SHIFT] + KNOB POSITION [LEFT] 将分配给旋钮的 Assign 1–8 值注册到 KNOB POSITION [LEFT] 按钮

[SHIFT] + KNOB POSITION [MID] 将分配给旋钮的 Assign 1–8 值注册到 KNOB POSITION [MID] 按钮

[SHIFT] + KNOB POSITION [RIGHT] 将分配给旋钮的 Assign 1–8 值注册到 KNOB POSITION [RIGHT] 按钮

[SHIFT] + [PAGE JUMP] 更改可使用 [QUICK EDIT] 按钮切换的参数，以便匹配画面上当前显示的参数

[SHIFT] + [PART SELECT] 启用 PART 按钮来打开或关闭静音设置

[SHIFT] + 声部组 [1–8/9–16] 启用 PART 按钮和滑杆以在声部 9–16 之间切换

[SHIFT] + [COMMON] 为元素、操作器和振荡器选择 Common。

[SHIFT] + PART [1]–[8] 从音素 1–8、操作器 1–8、振荡器 1–3 和噪声中选择一项。

[SHIFT] + OCTAVE [ − ] 将移调值设置为− 1（减小）

[SHIFT] + OCTAVE [+] 将移调值设置为 +1（增大）

[SHIFT] + OCTAVE [−] + OCTAVE [+] 将移调值设置为 0（复位）。

[SHIFT] + SCENE [1]–[8] 将创建的场景注册到其中一个 SCENE [1]–[8] 按钮。

[SHIFT] + [DEC/NO] 将所选参数值设置为− 10（减小）
返回 Live Set 画面的上一页

[SHIFT] + [INC/YES] 将所选参数值设置为 +10（增大）
移至 Live Set 画面的下一页

[SHIFT] + [ARP] 调出 Arp Edit 画面

[SHIFT] + [MSEQ] 调出 Motion Seq Edit 画面

[SHIFT] + [CONTROL ASSIGN] 调出 Control View 画面

[SHIFT] + [PERFORMANCE (HOME)] 调出 info 画面（property 画面）（仅限 Home 画面）

[SHIFT] + [LIVE SET] 移至 Live Set Register 画面

[SHIFT] + [CATEGORY] 打开所选声部的 Part Category Search 画面

[SHIFT] + [UTILITY] 显示参数值。

[SHIFT] + [NAVIGATION] 调出 FX Overview 画面

[SHIFT] + [QUICK SETUP] 调出 Effect Switch 画面

[SHIFT] + [STORE] 调出 Load 画面

[SHIFT] + [SPLIT] 调出 Home 画面，并选择 Part-Note 视图

[SHIFT] + [SONG/PATTERN] 调出 Rhythm Pattern 画面

[SHIFT] + [TEMPO/TAP] 打开或关闭面板锁定功能（仅在 Home 画面或 Live Set 画面）

[SHIFT] + [A/D INPUT] 调出 Audio In Mixing 画面

[SHIFT] + [PORTAMENTO] 调出 Pitch Edit 画面

[SHIFT] + [ASSIGN 1]/[ASSIGN 2] 调出 Control Settings 画面

[UTILITY] + [DAW REMOTE] 选择 Calibration Touch Panel

OCTAVE [ − ] + OCTAVE [+] 复位八度音高位。
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其他操作
操作 功能

快速按两次PART按钮 在 Internal 和 External 之间切换
当切换到 External 时，声部名称显示为蓝色

按住 [CATEGORY] 按钮 将 Bank/Favorite (Bank/Favorite Select) 复位为 All
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信息列表
信息 说明 所需操作

** library will be overwritten. 当您尝试加载库时，已加载同名的库文
件。加载新数据时，会覆盖现有数据。
您尝试加载的库文件的名称将显示在

“**”的位置。

** Control Assign full. 由于没有可用的控制器设置，无法执行
该操作。
您尝试添加到控制器设置中的声部名
称将显示在 ** 的位置。

删除不需要的控制器设置并重做操作。

** will be deleted. 执行此操作会删除数据。

** will be loaded to Pattern. .mid 文件将被加载到模板中。

** will be loaded to Song. .mid 文件将被加载到乐曲中。

** will be loaded. 系统会加载该文件。

** will be overwritten. 保存时，已存在同名的演奏组、文件、
文件夹或快速设置。当前正在保存的数
据将会覆盖现有数据。
您尝试保存的演奏组、文件、文件夹或
快速设置的名称将显示在“**”的位置。

Activate the source controller to 
assign.

您可以为要操作的控制器分配参数。 操作您想要分配的控制器。

Advanced settings will be 
initialized.

初始化 [UTILITY] → Settings → 
Advanced 选项卡的设置。

All data and libraries will be 
initialized.Unsaved user data will 
be lost.

恢复出厂默认设置。 我们还建议提前将任何想要保留的必
要设置保存到 USB 闪存。

All data is initialized upon power-
on.

乐器已设置为在打开乐器时恢复出厂
默认设置。

All data will be overwritten by ** 执行加载时，覆盖所有数据。
您尝试加载的备份文件的名称将显示
在“**”的位置。

All Favorite Marks will be cleared. 删除所有喜好标记。

All settings will be initialized. User 
data is kept.

乐器的设置将初始化。不会删除用户 
数据。

All sound will be stopped during 
optimization.

还原内置存储器。

All user data will be initialized.
Unsaved user data will be lost.

用户存储器中的用户区域将会初始化。 我们还建议提前将任何想要保留的必
要设置保存到 USB 闪存。

Arpeggio bypass disabled. Arpeggio Bypass 已禁用。

Arpeggio full. 由于 Arpeggio 已满，无法执行该操作。 从 [UTILITY] → Contents → Data 
Utility 画面删除不必要的 User 
Arpeggio 的数据。
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信息 说明 所需操作

Assignable knob full. 因为控制器设置中使用了所有可指定
旋钮，无法执行该操作。

删除任何将可指定旋钮设置为源的不
必要的控制器设置，然后重做操作。

Audio file is not found. 找不到指定的音频文件。

Audio Rec stopped due to lack of 
memory space.

由于 USB 闪存已满，音频录音自动 
停止。

使用新的 USB 闪存或删除不需要的文
件，然后重试此操作。

Audition full. 由于 User Audition 数据已满，无法执
行该操作。

从 [UTILITY] → Contents → Data 
Utility 画面删除不必要的 User 
Audition 的数据。

Auto power off disabled. 已禁用 Auto Power Off 功能。

Bulk data protected. 由于设置原因，无法接收批量数据。

Can’t process. 无法处理请求的操作。

Can’t register unstored 
performance.

由于尚未设置正在编辑的库或程序编
号，因此无法将演奏组注册到 Live Set。

Completed. 指定的加载、保存、格式化或其他作业
已完成。

Connecting to USB device... 正在将 USB 闪存连接至乐器。

Converting Pattern to Song. 正在转换模板。

CPU Fan Error 内置冷却风扇已停止。 这种情况可能会导致内部温度升高，乐
器可能会停止工作。
立即备份所有必要的数据，关闭乐器并
联系 Yamaha 经销商。

Current user data will be 
overwritten by **.

用户数据已存在于待加载文件的目标
位置。如果继续，会覆盖现有用户数据。
您尝试加载的用户文件的名称将显示
在“**”的位置。

Curve full 由于 User Curve 数据已满，无法执行
该操作。

从 [UTILITY] → Contents → Data 
Utility 画面删除不必要的 User Curve
数据。

Data memory full. （加载库文件时）由于乐器存储器已满，
无法保存库中的内容数据。

Device number is off. 由于设备编号已关闭，无法发送或接收
批量数据。

Device number mismatch. 由于设备编号不匹配，无法发送或接收
批量数据。

Dividing the drum track 
makes new performance data. 
Performance full.

因为使用 Divide Drum Track 创建的演
奏组中没有空间，无法运行。

Dividing the drum track makes 
new performance data. You can’t 
undo this operation.

将使用 Divide Drum Track 创建新的演
奏组。此操作无法撤销。

File is not found. 没有所选类型的文件。

File or folder already exists. 已存在同名的文件或文件夹。
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信息 说明 所需操作

File or folder path is too long. 因为路径名太长，无法打开指定的文件
或文件夹。

Folder is not empty. 您正在尝试删除包含数据的文件夹。

Folder is too deep. 因为文件夹层级结构太深，无法打开该
文件夹。

Illegal bulk data. 接收批量数据或批量请求时发生错误。

Illegal file name. 文件名无效。

Illegal file. 指定的文件无法处理或加载到本乐器中。

Illegal parameters. 指定了错误的参数。

Illegal sample data. 不支持指定的样本数据。

Illegal smart morph data. 不支持指定的 Smart Morph 数据。

Keybank full. 加载时，键库总数超过最大数量。

Keyboard control lock disabled. Keyboard Lock 已禁用。

Knob value stored. Knob Value 已存储。

Library full. 库总数超过最大数量。

Micro Tuning full. 因为 User Micro Tuning 数据已满，无
法运行。

从 [UTILITY] → Contents → Data 
Utility 画面删除不必要的 User Micro 
Tuning 的数据。

MIDI buffer full. 由于一次接收到的 MIDI 数据过多，无
法处理。

MIDI checksum error. 收到的系统专用信息的校验和不正确。

No data. 所选音轨或指定范围内没有数据。
再次选择范围。

No read/write authority to the file. 没有此文件的读或写权限。

Note ranges will be initialized. 音符范围将初始化。

Now initializing all data... 正在恢复出厂设置。

Now initializing... 正在初始化一些数据。

Now loading... 正在加载文件。

Now receiving MIDI bulk data... 乐器正在接收 MIDI 批量数据。

Now saving... 正在保存文件。

Now transmitting MIDI bulk data... 乐器正在发送 MIDI 批量数据。

Panel unlocked. 已禁用面板锁定。

Part *** will be overwritten. 复制目的地已经有一个声部。如果继续
操作，则会覆盖复制目的地处的现有声
部。

Part full. 因为没有可用的声部，无法打开
Rhythm Pattern 画面。

删除不需要的声部并重做操作。

Pattern full. 由于模板已满，无法执行该操作。

Pattern will be converted to Song. 模板将转换为乐曲。
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信息 说明 所需操作

Performance data in *** will be 
loaded.

将加载过去模型文件中的
Performance Data。

Performance full. 由于 Performance 已满，无法执行该
操作。

Please connect USB device. 连接 USB 闪存。

Please keep power on. 正在将数据写入闪存 ROM。 当显示此信息时请勿关闭乐器。
如果在显示此信息时关闭乐器，则用户
数据可能会丢失或系统可能会损坏，从
而导致在下次打开乐器时无法正常启
动系统。

Please reboot to enable the new 
Audio I/O Mode.

重新启动乐器来启用对音频输入和输
出设置的更改。

Please reboot to enable the new 
USB Driver Mode.

重新启动乐器来启用对 USB 驱动程序
模式设置的更改。

Please reboot to maintain internal 
memory.

重新启动乐器来修复乐器存储器。

Please stop audio play/rec. 停止音频录音或播放，然后重试。

Please stop sequencer. 停止音序器（模板或乐曲），然后重试。

Please store the pattern to change 
the chain play mode.

在更改连接播放模式之前存储模板。

Please wait... 正在处理。 请稍等。

Press [SHIFT]+[TEMPO/TAP] to 
unlock panel.

已启用面板锁定。
按 [SHIFT] + [TEMPO/TAP] 来解锁 
面板。

Quick Setup ** is loaded. Quick Setup 已加载。

Recall latest edits. 调出最后编辑的演奏组数据并将其放
入编辑缓存中。

Redo **. 再次执行 (Redo) 已撤销的操作。
操作的名称显示在“**”的位置。

Sample is protected. 样本受到保护，无法更改。

Sample is too long. 样本大小太大，无法加载。

Turn on Memory Switch to 
memorize ** into this scene.

要将功能注册到场景，必须提前打开该
功能的 Memory (Memory Switch)。

从 [PERFORMANCE (HOME)] → 
Scene 打开画面，并打开开关。

Undo **. 取消上一个操作 (undo)。
操作的名称显示在“**”的位置。

Unsupported USB device. 本乐器不支持该 USB 设备。

USB connection terminated. 由于电流异常，已关闭 USB 闪存。 断开 USB 闪存的连接，然后按顶部面
板的任意按钮。

USB device is full. USB 闪存已满，无法保存文件。 使用新的 USB 闪存或删除不需要的文
件，然后重试此操作。
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信息 说明 所需操作

USB device is write-protected. 您正在使用的 USB 闪存具有写保护。

USB device read/write error. 读 / 写 USB 闪存时发生错误。

USB device will be formatted. USB 闪存将格式化。

User auditions will be overwritten 
with stored songs.

当前存储的乐曲会覆盖现有的 User 
Audition。

VCM Rotary is disabled except in 
Part 1.

VCM Rotary 只能与声部 1 一起使用。它
不能用于其他声部。

Voice data in *** will be loaded. 将加载过去模型文件中的 Voice Data。

Waveform full. 波形总数超过最大数量。
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当出现问题时
没有声音？声音失常？出现这样的问题时，在假定产品出现故障前，请务必检查使用说明书中的故障排除章节。
在将数据备份到 USB 闪存后，执行 Initialize All Data 可以解决许多问题。
如果问题依然存在，请咨询您所在地的 Yamaha 经销商。

触摸屏的响应不佳

•	光标是否指向您在触摸屏上触摸的精确位置？
如果没有，请校准触摸屏。
[UTILITY] + [DAW REMOTE] → Calibrate Touch Panel
[UTILITY] → Settings → System → Calibrate Touch Panel

没有声音

•	控制滑杆 1-8 是否处于最低设置？
尝试移动控制滑杆 1-8 来改变其位置。

•	乐器上是否连接了放大器、扬声器或耳机？
由于本乐器没有内置扬声器，因此需要连接放大器、扬声器或耳机才能听到声音。

•	本乐器以及任何连接的设备是否已打开？

•	您是否已进行所有适当的电平设置，包括乐器上的主音量和所连接设备上的音量设置？
当踏板控制器连接到 FOOT CONTROLLER 插孔时，尝试移动踏板控制器。

•	Local Control 是否设置为关闭？
当 Local Control 设置为 Off 时，弹奏键盘时不会发出声音。
[UTILITY] → Settings → MIDI I/O → Local Control

•	是否选择了空白声部？
如果是这样，请将声音分配给该声部或选择另一个声部。

•	每个声部的静音开关是否已打开？
当静音开关打开时，弹奏键盘时不会发出声音。
[PERFORMANCE (HOME)] → Part 选择 → Mute

•	各声部的Keyboard Control Switch 是否已关闭？
[PERFORMANCE (HOME)] → Part 选择 → Keyboard Control Switch

•	所选声部的 Arp Play Only 是否已打开？
当 Arp Play Only 打开时，相应声部仅通过琶音播放发出声音。
[PERFORMANCE (HOME)] → Part 选择 → [EDIT/ ] → General / Pitch → Part Settings → Arp Play Only
[PERFORMANCE (HOME)] → Part 选择 → [EDIT/ ] → Arpeggio → Common → Arp Play Only
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•	使用外接控制器时，MIDI 音量或MIDI 表情设置是否太低？

•	效果和滤波器设置是否合适？
如果您使用滤波器，请尝试更改截止频率。某些截止频率设置可能会滤除所有声音。
[SHIFT] + [NAVIGATION]
[PERFORMANCE (HOME)] → Common 选择 → [EDIT/ ] → Effect

对于标准声部 (AWM2) 和鼓声部
[PERFORMANCE (HOME)] → Part 选择 → [EDIT/ ] → 选择 Element 或 Drum Key → Filter
[PERFORMANCE (HOME)] → Part 选择 → [EDIT/ ] → Effect

对于标准声部 (FM-X) 和标准声部 (AN-X)
[PERFORMANCE (HOME)] → Part 选择 → [EDIT/ ] → Filter / Amp
[PERFORMANCE (HOME)] → Part 选择 → [EDIT/ ] → Effect

•	是否选择声码器作为声部的插入效果类型？
如果是这样，请将与 A/D INPUT 插孔相关的参数设置为适当的值，然后一边对着连接到本乐器的麦克风说话或唱歌，一
边弹奏键盘。检查上方面板的 A/D INPUT [GAIN] 旋钮是否设置为 0 以外的值。
[PERFORMANCE (HOME)] → Part 选择 → [EDIT/ ] → Effect → Routing
[PERFORMANCE (HOME)] → Common 选择 → [EDIT/ ] → Audio In

•	音量或电平设置是否太低？
[UTILITY] → Settings → Sound → Tone Generator Volume
[PERFORMANCE (HOME)] → Common 选择 → [EDIT/ ] → General/Pitch → Perf Settings → Volume
[PERFORMANCE (HOME)] → Part 选择 → [EDIT/ ] → General/Pitch → Part Settings → Volume
[PERFORMANCE (HOME)] → Part 选择 → [EDIT/ ] → Part Settings → Dry Level

对于标准声部 (AWM2) 和鼓声部
[PERFORMANCE (HOME)] → Part 选择 → [EDIT/ ] → Element 或 Drum Key 选择 → Amplitude → Level/Pan → 
Level

对于标准声部 (FM-X)
[PERFORMANCE (HOME)] → Part 选择 → [EDIT/ ] → Operator 选择 → Level → Level

对于标准声部 (AN-X)
[PERFORMANCE (HOME)] → Part 选择 → [EDIT/ ] → Oscillator 选择 → OSC/Tune → Out Level

•	Element Switch、Note Limit、Velocity Limit 和 Velocity Offset 设置是否合适？
对于标准声部 (AWM2) 和鼓声部
[PERFORMANCE (HOME)] → Part 选择 → [EDIT/ ] → General/Pitch → Part Settings
[PERFORMANCE (HOME)] → Part 选择 → [EDIT/ ] → Element 或 Drum Key 选择 → Osc/Tune

对于标准声部 (FM-X) 和标准声部 (AN-X)
[PERFORMANCE (HOME)] → Part 选择 → [EDIT/ ] → General/Pitch → Part Settings
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•	声部的各个音素或操作器的静音开关是否已打开？
[PERFORMANCE (HOME)] → Part Common 选择 → 导航栏上的 Element、Operator 或 Oscillator 状态

•	对于标准声部 (FM-X)，载波电平是否设置为“0”？
[PERFORMANCE (HOME)] → Part 选择 → [EDIT/ ] → Operator 选择 → Level → Level

•	各声部的输出设置是否已关闭？
[PERFORMANCE (HOME)] → Part 选择 → [EDIT/ ] → General/Pitch → Part Settings → Part Output

•	控制器设置是否合适？
当 Destination 设置为 Volume 或 Cutoff 时，不会产生声音，具体取决于设置和控制器状态。
[PERFORMANCE (HOME)] → Part 选择 → [EDIT/ ] → Mod/Control → Control Assign

A/D INPUT 插孔没有声音

•	连接的麦克风是否已打开？

•	乐器上是否连接了动圈麦克风？

•	麦克风或音频设备与本乐器之间的电缆是否正确连接？

•	A/D INPUT [GAIN] 旋钮是否转到最小？

•	 [A/D INPUT] 按钮是否已打开（亮起）？

•	检查 A/D INPUT 插孔的电缆连接是否与插孔的Mono/Stereo 设置匹配。
[PERFORMANCE (HOME)] → Common 选择 → [EDIT/ ] → Audio In → Mixing → A/D In Input Mode

•	Mic 或 Line 设置是否合适？
当连接麦克风或任何具有低输出电平的设备时，设置为 Mic。当连接音频设备、电子乐器或任何具有高输入电平的设备时，
设置为 Line。
[UTILITY] → Settings → Audio I/O → A/D Input

•	A/D 输入声部的音量设置是否太低？
[PERFORMANCE (HOME)] → Common 选择 → [EDIT/ ] → Audio In → Mixing → A/D In Volume

•	A/D 输入声部的效果设置是否合适？
[PERFORMANCE (HOME)] → Common 选择 → [EDIT/ ] → Audio In → Routing

•	A/D 输入声部的输出设置是否合适？
[PERFORMANCE (HOME)] → Common 选择 → [EDIT/ ] → Audio In → Mixing → A/D In Output Select

•	检查是否选择了声码器效果。
如果插入效果设置为使用声码器，则除非弹奏键盘，否则来自 A/D INPUT 接口的输入声可能不会发出声音。
[PERFORMANCE (HOME)] → Part 选择 → [EDIT/ ] → Effect → Routing
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播放会继续而不停止

•	当 [KEYBOARD HOLD] 按钮打开时，尝试将其关闭。

•	当 [ARP] 按钮打开时，尝试将其关闭。

•	对于Pattern/Song/Audio 画面，按 []（停止）按钮。

•	当效果音（例如延迟）继续而不停止时，请更改效果设置或选择另一个演奏组。

•	当节拍声继续时，检查以下设置。
如果设置为 Always，节拍声将始终发出声音。将此参数设置为 Always 之外的其他设置。
[UTILITY] → Tempo Settings → Click Mode

声音失真

•	音量是否设置得太高？
[UTILITY] → Settings → Sound → Tone Generator Volume
[UTILITY] → Settings → Audio I/O
[PERFORMANCE (HOME)] → Common 选择 → [EDIT/ ] → General/Pitch → Perf Settings → Volume
[PERFORMANCE (HOME)] → Part 选择 → [EDIT/ ] → General/Pitch → Part Settings → Volume

对于标准声部 (AWM2)
[PERFORMANCE (HOME)] → Part 选择 → [EDIT/ ] → Element 选择 → Amplitude → Level/Pan → Level

对于鼓声部
[PERFORMANCE (HOME)] → Part 选择 → [EDIT/ ] → Key 选择 → Level/Pan → Level

对于标准声部 (FM-X)
[PERFORMANCE (HOME)] → Part 选择 → [EDIT/ ] → Operator 选择 → Level → Level

对于标准声部 (AN-X)
[PERFORMANCE (HOME)] → Part 选择 → [EDIT/ ] → Oscillator 选择 → OSC/Tune → Out Level

声音被切断

•	整个声音是否超过了最大复音数？
•	 AWM2（预置波形）：128 个声音（立体声和单声道波形）
•	 AWM2（用户或库波形）：128 个声音（立体声和单声道波形）
•	 FM-X ：128
•	 AN-X ：12
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一次仅发出一个音符声音

•	检查音源模式是否设置为Mono。
如果您想弹奏和弦，请将此参数设置为 Poly。
[PERFORMANCE (HOME)] → Part 选择 → [EDIT/ ] → General/Pitch → Part Settings → Mono/Poly

音高错误

•	调音设置是否距离 0值太远？
[UTILITY] → Settings → Sound → Tone Generator Tune

•	每个声部的音高切换或失谐是否设置为 0以外的任何值？
[PERFORMANCE (HOME)] → Part 选择 → [EDIT/ ] → General/Pitch → Pitch → Note Shift
[PERFORMANCE (HOME)] → Part 选择 → [EDIT/ ] → General/Pitch → Pitch → Detune

•	如果该声部的音高不准确，是否在微调设置中选择了特殊音律？
[PERFORMANCE (HOME)] → Part 选择 → [EDIT/ ] → General/Pitch → Pitch → Micro Tuning Name

•	您是否在Global Tuning 中设置了特殊音律？
[UTILITY] → Settings → Sound → Global Settings

•	当声部产生错误音高时，LFO Pitch Modulation Depth 是否设置得太高？
对于标准声部 (AWM2)
[PERFORMANCE (HOME)] → Part 选择 → [EDIT/ ] → Element 选择 → Element LFO → Pitch Mod

对于标准声部 (FM-X)
[PERFORMANCE (HOME)] → Part 选择 → [EDIT/ ] → Mod/Control → 2nd LFO → Pitch Modulation Depth

对于标准声部 (AN-X)
[PERFORMANCE (HOME)] → Part 选择 → [EDIT/ ] → General/Pitch → Pitch LFO → Pitch LFO Depth

•	如果声部的音高不准确，粗调和微调是否未对准？
对于标准声部 (AWM2) 和鼓声部
[PERFORMANCE (HOME)] → Part 选择 → [EDIT/ ] → Element or Drum Key 选择 → Osc/Tune → Coarse
[PERFORMANCE (HOME)] → Part 选择 → [EDIT/ ] → Element or Drum Key 选择 → Osc/Tune → Fine

对于标准声部 (FM-X)
[PERFORMANCE (HOME)] → Part 选择 → [EDIT/ ] → Operator 选择 → Form/Freq → Coarse
[PERFORMANCE (HOME)] → Part 选择 → [EDIT/ ] → Operator 选择 → Form/Freq → Fine

•	如果该声部的音高不准确，控制器目标是否设置为音高？
[PERFORMANCE (HOME)] → Part 选择 → [EDIT/ ] → Mod/Control → Control Assign → Destination

•	对于 AN-X 声部，Voltage Drift 是否设置为过大的值？
[PERFORMANCE (HOME)] → Part 选择 → [EDIT/ ] → General/Pitch → AN-X Settings → Voltage Drift
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没有应用效果
使用 [SHIFT] + [NAVIGATION] 检查效果设置。

•	效果开关是否已关闭？
[UTILITY] → Effect Switch

•	变奏发送和混响发送值是否设置在最低水平？
[PERFORMANCE (HOME)] → Part 选择 → [EDIT/ ] → Effect → Routing → Var Send
[PERFORMANCE (HOME)] → Part 选择 → [EDIT/ ] → Effect → Routing → Rev Send

•	变奏返回和混响返回值是否设置在最低水平？
[PERFORMANCE (HOME)] → Common 选择 → [EDIT/ ] → Effect → Routing → Var Return
[PERFORMANCE (HOME)] → Common 选择 → [EDIT/ ] → Effect → Routing → Rev Return

•	声部中所有音素或所有键的插入效果是否设置为 Thru ？
[PERFORMANCE (HOME)] → Part 选择 → [EDIT/ ] → Effect → Routing → Connect 或 Element 1–8

•	（对于系统效果）为每个效果选择的效果类型是否设置为No Effect ？

•	（对于插入效果）为每个效果选择的效果类型是否设置为 Thru ？

•	插入开关设置是否合适？
[PERFORMANCE (HOME)] → Part 选择 → [EDIT/ ] → Effect → Ins A 或 Ins B

无法启动琶音

•	 [ARP] 按钮是否打开？
检查琶音开关打开的声部数量。您可以同时为最多八个声部播放琶音。

•	琶音的音符限制和力度限制设置是否合适？
[PERFORMANCE (HOME)] → Part 选择 → [EDIT/ ] → Arpeggio → Common

•	琶音类型是否设置为Off？
[PERFORMANCE (HOME)] → Part 选择 → [EDIT/ ] → Arpeggio → Individual → Name

•	检查每个声部的琶音开关设置。
当琶音开关设置为关闭时，即使打开上方面板的 [ARP] 按钮，也不会播放琶音。
[PERFORMANCE (HOME)] → Part 选择 → [EDIT/ ] → Arpeggio → Common、Individual 或 Advanced → Arp Part
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无法停止琶音

• 如果您无法通过从琴键上松开手指来停止琶音播放，请将琶音保持开关更改为Off。
[PERFORMANCE (HOME)] → Part 选择 → [EDIT/ ] → Arpeggio → Common → Hold

• 关闭上方面板的 [KEYBOARD HOLD] 按钮。

按 []（播放）按钮无法开始播放模板或乐曲

• 所选模板或乐曲中是否有数据？

无法录制模板或乐曲音频

• 是否有任何存储空间可用于录制模板或乐曲？
乐器上的存储空间最多可容纳 128 个模板和 128 首乐曲。如果您尝试录制超过 128 首乐曲或模板，您将收到 Song full 消
息，并且无法再录制。

乐器与连接的计算机之间的数据通信无法正常工作

• 计算机上的端口设置是否合适？

• 您在Utility 画面上是否选择了正确的端口（MIDI 或 USB）？
[UTILITY] → Settings → MIDI I/O → MIDI IN/OUT

MIDI 批量转储数据发送或接收无法正常工作

•  Receive Bulk 是否受到保护？
将 MIDI Receive Bulk 设置为 On。
[UTILITY] → Settings → Advanced → MIDI Receive Bulk

• 要启用使用本乐器的批量转储功能记录的数据的接收，必须为发送和接收设置相同的设备编号。
[UTILITY] → Settings → Advanced → MIDI Device Number

• 连接的MIDI 设备是否设置了相同的设备编号？
[UTILITY] → Settings → Advanced → MIDI Device Number
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无法保存到USB闪存

•	USB闪存是否具有写保护？

•	USB闪存上是否有足够的可用空间？
打开 Content 画面并将设备设置为 USB 闪存。检查画面右上角显示的可用存储空间是否为 0.0KB。
[UTILITY] → Contents → Save

•	您使用的USB闪存是否已确认可与本乐器配合使用？
检查以下 URL 以获取已确认可与本乐器配合使用的 USB 设备列表。

https://download.yamaha.com/

显示屏上，有一些黑点（不亮）或白点（常亮）
这是彩色 LCD 的特性，并非故障。

https://download.yamaha.com/
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恢复出厂默认设置 (Initialize All Data)

须知
执行 Initialize All Data 功能时，已存储在用户存储器中的所有演奏组和乐曲以及Utility 画面上整个乐器的设置都将恢复出厂默认设置。
我们还建议提前将任何想要保留的重要数据保存到USB闪存。

1. 从以下位置打开设置画面：[UTILITY] → Settings → System。
调出整个乐器的设置画面。

2. 点击 Initialize All Data。
确认画面出现。
要取消操作，点击画面上的 Cancel(NO) 按钮或按上方面板的 [DEC/NO] 按钮。

3. 点击画面上的 Initialize(YES) 按钮或按上方面板的 [INC/YES] 按钮。
执行 Initialize All Data 操作。



© 2025 Yamaha Corporation
2025 年 10 月 发行 LBA0


	关于本文档
	1.	MODX M的工作原理
	什么是MODX M？
	音源模块
	内置存储器

	2.	现场演奏组设置
	选择演奏组
	对整个演奏组使用整体功能
	编辑设置
	保存编辑的设置
	创建Live Set
	从Live Set中选择演奏组
	弹奏键盘

	3.	录制和播放
	术语
	录制和播放模板
	录制和播放乐曲
	录制音频和播放音频文件

	4.	管理备份
	可用的文件格式
	USB闪存将格式化。
	将设置保存到USB闪存
	从USB闪存加载设置

	5.	连接外接MIDI乐器
	连接麦克风或音频设备
	连接到计算机或外接MIDI设备

	6.	画面和参数
	导航栏
	Performance画面
	Common Edit 画面
	Part Edit (AWM2) Part Common Edit 画面
	Part Edit (AWM2) Element Edit 画面
	Drum Part Edit (AWM2) Part Common Edit 画面
	Drum Part Edit (AWM2) Key Edit画面
	Part Edit (FM-X) Part Common Edit 画面
	Part Edit (FM-X) Operator Edit 画面
	Part Edit (AN-X) Part Common Edit 画面
	Part Edit (AN-X) Oscillator Edit 画面
	Part Edit (AN-X) Noise Edit 画面
	Category Search 画面
	Live Set 画面
	Utility 画面
	按特定按钮时显示的画面

	7.	其他信息
	效果类型
	效果参数
	快捷方式和特殊操作
	信息列表
	当出现问题时


